Microsoft Dynamics is a line of integrated, adaptable business management solutions that enables you and your people to make business decisions with greater confidence. Microsoft Dynamics works like and with familiar Microsoft software, automating and streamlining financial, customer relationship, and supply chain processes in a way that helps you drive business success.

U.S. and Canada Toll Free 1-888-477-7989
Worldwide +1-701-281-6500
www.microsoft.com/dynamics

Copyright © 2015 Microsoft. All rights reserved.
This document is provided "as-is." Information and views expressed in this document, including URL and other Internet Web site references, may change without notice. You bear the risk of using it.
Some examples are for illustration only and are fictitious. No real association is intended or inferred.
This document does not provide you with any legal rights to any intellectual property in any Microsoft product.
You may copy and use this document for your internal, reference purposes.
Microsoft, Microsoft Dynamics, the Microsoft Dynamics logo, Active Directory, Excel, MSDN, SharePoint, SQL Server, Visual Studio, Windows, Windows PowerShell, Windows Server, and Windows Vista are trademarks of the Microsoft group of companies. All other trademarks are property of their respective owners.

Announcements:
To see known issues and recent fixes, use Issue search in Microsoft Dynamics Lifecycle Services (LCS).
# Table of Contents

Plan the base topology of Microsoft Dynamics AX .......................................................... 10
Sample deployment scenarios ............................................................................................ 10
  Single-server deployment ............................................................................................... 10
  Small-scale deployment ............................................................................................... 10
  Large-scale deployment .............................................................................................. 12
AOS topology .................................................................................................................. 14
  Batch server overview .............................................................................................. 14
  AOS clusters without a dedicated load balancer ......................................................... 17
  AOS clusters with a dedicated load balancer .............................................................. 19
SQL Server topology recommendations for availability and performance ...................... 20
  General topology recommendations ......................................................................... 20
  Availability recommendations .................................................................................... 21
  Performance recommendations .................................................................................. 22

Prepare for the installation ............................................................................................... 23
Overview of the installation ............................................................................................ 23
  Servers in the Microsoft Dynamics AX environment ............................................... 23
  Microsoft Dynamics AX components ........................................................................ 24
  Installation types ........................................................................................................ 33
Before you begin ............................................................................................................. 34
  Pre-installation checklist ............................................................................................ 34
  Create service accounts ............................................................................................. 35
  Create a shared directory for installation .................................................................. 42
  Include cumulative updates and hotfixes in a new installation (slipstreaming) ......... 43
  Verify that you have the required permissions for installation .................................. 45
  Check prerequisites .................................................................................................... 47

Install the databases ........................................................................................................ 49
Configure SQL Server and storage settings .................................................................... 49
  Minimal SQL Server infrastructure ............................................................................ 49
  Configuring Windows Server ..................................................................................... 49
  Configuring the server that runs SQL Server ............................................................ 50
  Configuring the instance of SQL Server .................................................................... 50
  Configuring the Microsoft Dynamics AX business database .................................... 53
  Plan database storage ............................................................................................... 53
  Configuring physical storage ..................................................................................... 54
  Summary ..................................................................................................................... 54
Install the Microsoft Dynamics AX databases ................................................................. 54
  Before you install the Microsoft Dynamics AX databases ....................................... 55
  Default models .......................................................................................................... 55
  Include additional model files in the installation (optional) ...................................... 58
  Install the Microsoft Dynamics AX databases .......................................................... 59
  Create a Microsoft Dynamics AX database manually .............................................. 60

Install server and web server components .................................................................... 61
Install an Application Object Server (AOS) instance ...................................................... 61
Install an AOS instance.................................................................................................................. 61
Install multiple AOS instances........................................................................................................ 64
Troubleshoot installation issues with AOS ....................................................................................... 65
Install Enterprise Portal .................................................................................................................. 65
Checklists for deploying Enterprise Portal sites .............................................................................. 66
Install Enterprise Portal on a single server ....................................................................................... 69
Deploy Enterprise Portal in a server farm .......................................................................................... 73
Deploy a claims-mode Enterprise Portal site .................................................................................. 89
Install Enterprise Portal in a traditional perimeter network ............................................................ 127
Install Enterprise Portal Help content ............................................................................................. 137
Install multiple Enterprise Portals on the same server .................................................................. 138
Enterprise Portal administration with Windows PowerShell and AXUpdatePortal ...................... 140
Set up Enterprise Portal and Role Centers ..................................................................................... 140
Deploy Microsoft Dynamics AX Web parts to a SharePoint site .................................................... 141
Troubleshoot installation issues with Enterprise Portal and Role Centers ..................................... 142
Install Search .................................................................................................................................. 144
Checklist: Deploy Microsoft Dynamics AX Enterprise Search ..................................................... 144
Install and configure Search prerequisites ...................................................................................... 145
Configure the Search Crawler account .......................................................................................... 148
Configure SharePoint Services logging .......................................................................................... 148
Install Microsoft Dynamics AX Enterprise Search ........................................................................ 149
Add AOT queries to the Search configuration .................................................................................. 152
Install Enterprise Search on FAST Search Server ......................................................................... 153
Configure Enterprise Search by using the Search Configuration wizard ....................................... 158
Troubleshoot installation issues with Enterprise Search ................................................................. 159
Install help server ........................................................................................................................... 161
Before you install the help server .................................................................................................... 161
Install the help server ...................................................................................................................... 162
Install Help content at an alternative location ............................................................................... 164
Install Management Reporter components .................................................................................... 165
Install Management Reporter server components ......................................................................... 165
Before you install Management Reporter ...................................................................................... 165
Install Management Reporter ......................................................................................................... 166
After you install Management Reporter .......................................................................................... 167
Install business intelligence components ....................................................................................... 168
Install Reporting Services extensions for Microsoft Dynamics AX ................................................. 168
Checklist: Install the Reporting Services extensions and deploy reports ....................................... 168
Before you install the Reporting Services extensions ..................................................................... 169
Install the Reporting Services extensions ....................................................................................... 173
Complete the Reporting Services integration .................................................................................. 175
Deploy language-specific versions of a report .................................................................................. 180
Run the SRSReportServerWarmup class ....................................................................................... 182
How to: Deploy reports to a report server ....................................................................................... 184
Configure Analysis Services ........................................................................................................... 185
Checklist: Configure Analysis Services and deploy cubes ............................................................... 185
Before you configure Analysis Services .......................................................................................... 186
Configure Analysis Services by running Setup ................................................................................ 187
Install client components........................................................................................................... 200
Install the Microsoft Dynamics AX client .................................................................................. 200
Install a client ............................................................................................................................. 200
Configure clients to use a shared configuration ........................................................................ 202
Configure clients to access data in a partition ........................................................................... 204
Install Office Add-ins ............................................................................................................... 205
Before you install the Office Add-ins ...................................................................................... 205
Install the Office Add-ins ......................................................................................................... 205
After you install the Office Add-ins ......................................................................................... 206
Install Remote Desktop Services integration ............................................................................ 207
Before you install the Remote Desktop Services integration components ............................. 207
Install the Remote Desktop Services integration components ................................................. 207
Install Report Designer for Management Reporter ................................................................ 207
Before you install Report Designer .......................................................................................... 208
Install Report Designer ............................................................................................................ 208
After you install Report Designer ............................................................................................ 208
Troubleshoot installation issues with client components .......................................................... 208
User not recognized error when you try to start the client ....................................................... 209
Open the client configuration utility ......................................................................................... 209
Connection with Application Object Server cannot be established ........................................ 209
Mass deployment of the Microsoft Dynamics AX Windows client ........................................... 209
Deploy the client by using Microsoft System Center Configuration Manager 2007 ............... 209
Deploy the client by using Microsoft System Center 2012 Configuration Manager ................ 215
Deploy the client by using Group Policy .................................................................................. 218
Install developer tools .............................................................................................................. 222
Install the debugger .................................................................................................................. 222
Before you install the debugger ............................................................................................... 222
Install the debugger .................................................................................................................. 222
After you install the debugger .................................................................................................. 223
Install Visual Studio Tools ....................................................................................................... 223
Before you install Visual Studio Tools ....................................................................................... 223
Install Visual Studio Tools ....................................................................................................... 223
Install the Trace Parser ............................................................................................................ 224
Before you install the Trace Parser .......................................................................................... 224
Install the Trace Parser ............................................................................................................ 224
Troubleshoot installation issues with the developer tools ......................................................... 226
Trace Parser installation fails ................................................................................................. 226
Install integration components ............................................................................................... 227
Install web services on IIS ......................................................................................................... 227
Before you install the Web services on IIS .............................................................................. 227
Install the web services on IIS .................................................................................................. 228
After you install the Web services on IIS .................................................................................. 229
Install .NET Business Connector ............................................................................................. 230
Before you install .NET Business Connector .......................................................................... 230
Install .NET Business Connector ............................................................................................. 231

Microsoft Dynamics AX 2012 Installation Guide 5
Install the synchronization proxy for Microsoft Project Server ................................................. 232
Before you install the synchronization proxy ........................................................................ 232
Install the synchronization proxy .......................................................................................... 232
Install the synchronization service for Microsoft Project Server ............................................ 233
Before you install the synchronization service ........................................................................ 234
Install the synchronization service ...................................................................................... 234
Install management utilities .................................................................................................... 236
Before you install management utilities ................................................................................. 236
Install management utilities .................................................................................................... 236
Install retail components ........................................................................................................ 238
Install retail components in AX 2012 R3 .............................................................................. 238
Install retail components in AX 2012 R2 and AX 2012 Feature Pack ..................................... 238
Install Retail essentials ........................................................................................................... 239
Deployment topologies for Retail ............................................................................................ 239
  Deployment topologies for Retail in AX 2012 R3 ................................................................. 239
Deployment topologies for Retail in AX 2012 R2 and AX 2012 Feature Pack ....................... 240
Install Retail Headquarters .................................................................................................... 248
Before you install Retail Headquarters ................................................................................... 248
Install Retail Headquarters ..................................................................................................... 249
After you install Retail Headquarters ..................................................................................... 249
Install Retail POS .................................................................................................................... 250
Before you install Retail POS .................................................................................................. 250
Install Retail POS .................................................................................................................... 250
After you install Retail POS ................................................................................................... 251
Install Retail Modern POS .................................................................................................... 251
Before you install Retail Modern POS .................................................................................... 251
Install Retail Modern POS ...................................................................................................... 251
Install a customized Retail Modern POS app on a computer .................................................... 252
After you install Retail Modern POS ...................................................................................... 252
Uninstall Retail Modern POS ................................................................................................ 253
Manually install Modern POS prerequisites ........................................................................... 253
Install a retail channel database .............................................................................................. 254
Before you install a retail channel database .......................................................................... 255
Option 1: Install a retail channel database by using Setup ....................................................... 255
Option 2: Install a retail channel database by using Windows PowerShell ............................... 255
After you install a retail channel database .............................................................................. 258
Install Commerce Data Exchange: Synch Service (Retail Store Connect) ............................... 258
Before you install Synch Service ............................................................................................ 259
Install Synch Service ............................................................................................................. 259
Install Commerce Data Exchange: Real-time Service (Retail Transaction Service) ............... 260
Before you install Real-time Service ........................................................................................ 260
Option 1: Install Real-time Service by using Setup (AX 2012 R3) ........................................... 261
Option 2: Install Real-time Service by using Windows PowerShell (AX 2012 R3) .................... 262
Install Real-time Service (AX 2012 Feature Pack or AX 2012 R2) ......................................... 265
Deploy Real-time Service (required for AX 2012 R2 only) ..................................................... 266
After you install and deploy Real-time Service ....................................................................... 268
Install Commerce Data Exchange: Async Server ................................................................... 268
Before you install Async Server .................................................................................................................. 268
Option 1: Install Async Server by using Setup.......................................................................................... 269
Option 2: Install Async Server by using Windows PowerShell................................................................. 270
After you install Async Server .................................................................................................................... 273
Install Commerce Data Exchange: Async Client ....................................................................................... 273
Before you install Async Client .................................................................................................................. 274
Option 1: Install Async Client by using Setup.......................................................................................... 274
Option 2: Install Async Client by using Windows PowerShell................................................................. 275
After you install Async Client .................................................................................................................... 278
Install the Retail Channel Configuration Utility (Retail Store Database Utility) ..................................... 279
Before you install the Retail Channel Configuration Utility............................................................... 279
Install the Retail Channel Configuration Utility (AX 2012 R3) ........................................................... 279
Install the Retail Store Database Utility (AX 2012 Feature Pack and AX 2012 R2)............................. 280
After you install the Retail Channel Configuration Utility ..................................................................... 281
Install Retail Server ................................................................................................................................ 281
Before you install Retail Server ................................................................................................................ 281
Option 1: Install Retail Server by using Setup......................................................................................... 281
Option 2: Install Retail Server by using Windows PowerShell................................................................. 282
After you install Retail Server .................................................................................................................... 287
Install Retail Hardware Station .................................................................................................................. 287
Before you begin ........................................................................................................................................ 287
Option 1: Install Hardware Station by using Setup .................................................................................. 288
Option 2: Install Hardware Station by using Windows PowerShell.......................................................... 289
After you install Hardware Station ........................................................................................................... 292
Install a Retail online store (e-commerce) ............................................................................................... 292
Before you begin ........................................................................................................................................ 292
Option 1: Install the Retail online store by using Setup ....................................................................... 296
Option 2: Deploy the Retail online store by using Windows PowerShell.............................................. 297
Next steps for developers ......................................................................................................................... 315
Uninstall an online store ............................................................................................................................ 315
Install multiple Microsoft Dynamics AX Retail online stores ............................................................... 317
Before you begin ........................................................................................................................................ 317
Install a second online store ..................................................................................................................... 317
Install the Retail mass deployment toolkit ............................................................................................... 318
Before you install the Retail mass deployment toolkit ........................................................................... 319
Install the Retail mass deployment toolkit ............................................................................................. 319
After you install the Retail mass deployment toolkit .............................................................................. 319
Install Retail SDK (Retail POS Plug-ins) ................................................................................................. 320
Before you install Retail SDK ................................................................................................................... 320
Install Retail SDK .................................................................................................................................... 320
Install Retail Online Channel ................................................................................................................... 321
Before you install Retail Online Channel ................................................................................................. 321
Install Retail Online Channel ................................................................................................................... 321
After you install Retail Online Channel .................................................................................................. 321
Install Retail essentials at headquarters ................................................................................................. 322
Recommended topology ........................................................................................................................... 323
Install Retail essentials on the database server ....................................................................................... 324
Install Retail essentials on the Microsoft Dynamics AX server .............................................................. 325
Install the Data import/export framework (DIXF, DMF) ................................................................. 342
Install the version of the Data Import/Export Framework that is available in Microsoft Dynamics AX 2012 R3 ............................... 342
Install the version of the Data Import/Export Framework that is available in cumulative update 7 for Microsoft Dynamics AX 2012 R2 ................................................................. 342
Install the Data Import/Export Framework from InformationSource ...................................................... 343
Install the Data Import/Export Framework binary components (InformationSource) ..................................................... 343
Install the Data Import/Export Framework model (InformationSource) ............................................................. 344
Troubleshoot an installation of the Data Import/Export Framework from cumulative update 7 for Microsoft Dynamics AX 2012 R2 .................................................................................. 345
You receive an "Assembly containing type Microsoft.Dynamics.AX.DMF.ServiceProxy.DmfEntityProxy is not referenced." error ................................................................. 345
Troubleshoot an installation of the Data Import/Export Framework from InformationSource ...................................................... 345
The Data Import/Export Framework does not compile ........................................................................ 345
Exception message while you use Data Import/Export Framework ...................................................... 346
Changes to the location of the Data Import/Export Framework service ..................................................... 346
Install the Data import/export framework (AX 2012 R3) ........................................................................ 346
Install the version of the Data Import/Export Framework that is available in AX 2012 R3 ......................... 347
Configure the Data Import/Export Framework ..................................................................................... 348
Configure the Data Import/Export Framework for use by external services, such as Lifecycle Services ............. 348
Install the AX 2012 R2 CU7 version of the Data import/export framework for use with SQL Server 2014 (DIXF) ....................... 349
Before you begin ................................................................................................................................. 349
Install the AX 2012 R2 CU7 Data import/export framework for use with SQL Server 2014 Integration Services .......................................................................................................................... 349
Verify installation ............................................................................................................................. 349
Install the Data import/export framework Client and Server Components ......................................................... 350
Optional: Create a silent installation Windows PowerShell script .............................................................................. 350
Configure the version of SQL Server Integration Services used by the Data import/export framework in an environment with multiple versions (DIXF) ............................................................. 351
Force the Data import/export framework to use a version of Integration Services other than the default ................................................................................................................................. 351
Install the VSS writer for Microsoft Dynamics AX ..................................................................................... 354
Before you install the AX VSS writer ...................................................................................................... 354
Troubleshoot the installation ........................................................................................................... 354
Next steps ........................................................................................................................................ 355

Install Connector for Microsoft Dynamics .......................................................................................... 356
Before you install Connector for Microsoft Dynamics ........................................................................ 356
Install Connector for Microsoft Dynamics .......................................................................................... 356
After you install Connector for Microsoft Dynamics ........................................................................... 357

Perform a single-computer installation of Microsoft Dynamics AX .................................................... 358
Perform a single-computer installation .............................................................................................. 358
Before you perform a single-computer installation ......................................................................... 358
Perform a single-computer installation .............................................................................................. 358
Considerations for installing multiple instances on a computer ......................................................... 359

Install Microsoft Dynamics AX in silent mode ................................................................................ 361
Run Setup in silent mode .................................................................................................................... 361
Determine which parameters to use ................................................................................................... 361
Specify installation parameters at the command prompt .................................................................. 362
Specify installation parameters by using a parameter file .................................................................. 362

Firewall settings for Microsoft Dynamics AX components .................................................................. 363

Troubleshoot the installation ............................................................................................................. 368
Troubleshoot general installation issues ............................................................................................ 368
The Setup wizard does not start automatically .................................................................................. 368
Cannot locate file <Drive>\setup.exe AutoRun=1 ........................................................................... 368
Setup fails ........................................................................................................................................... 369
Exception: System.Runtime.InteropServices.COMException .......................................................... 369
Exception from HRESULT: 0x8024402C .......................................................................................... 369
Buttons are not visible on Setup pages .............................................................................................. 369
You must set a value for the parameter ClientAosServer ................................................................. 370
Label IDs are displayed instead of label text ..................................................................................... 370
Troubleshoot prerequisite issues ...................................................................................................... 371
Prerequisite errors related to Enterprise Portal ................................................................................... 371
Prerequisite errors related to Enterprise Search ................................................................................... 371
Prerequisite check for Windows Search Service fails after you configure the service by using the prerequisite validation utility .................................................................................................................. 371
Cumulative Update 3 for Microsoft SQL Server 2008 R2 cannot be installed ................................... 371
Required restart after you install the Microsoft .NET Framework version 4.0 .................................... 372
Prerequisite check failure for the Microsoft SQL Server Reporting Services service ...................... 372
Prerequisite check failure for Microsoft Visual Studio 2010 Tools for the Microsoft Office system ...... 372
Prerequisite check warning for the startup type of the SQL Server Full-text Filter Daemon Launcher service. 372
Plan the base topology of Microsoft Dynamics AX

**Applies to:** Microsoft Dynamics AX 2012 R3

Before you install Microsoft Dynamics AX, you should determine the arrangement of computers, or the topology, that you will use in your implementation. This chapter describes the types of servers that are required in a Microsoft Dynamics AX implementation. It also describes typical single-server, small-scale, and large-scale Microsoft Dynamics AX deployment scenarios. This chapter also explains topology options for the availability and performance of the core components of Microsoft Dynamics AX Application Object Server (AOS) and Microsoft SQL Server.

Sample deployment scenarios

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes sample deployment scenarios for Microsoft Dynamics AX. The scenarios range from a single-server deployment to a large-scale, distributed deployment. The scenarios are provided to help you understand requirements for the infrastructure and servers. These scenarios do not provide any guidelines for infrastructure sizing.

See also
- [System architecture](on TechNet)
- [Hardware and software requirements](on TechNet)
- [Getting started with associated technologies](on TechNet)

Single-server deployment

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

A single-server deployment occurs when you deploy all the Microsoft Dynamics AX components on a single computer. We recommend that you consider a single-server deployment only for development or demonstration environments.

You must make sure that the single-server deployment fits in with your overall strategy for IT infrastructure and development. Carefully consider the hardware and software that are required for the single-server deployment to guarantee appropriate response times for your developers. For the current hardware and software requirements for Microsoft Dynamics AX, download Microsoft Dynamics AX 2012 System Requirements from the [Microsoft Download Center](on Microsoft.com).

See also
- [Small-scale deployment](on TechNet)
- [Large-scale deployment](on TechNet)

Small-scale deployment

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The topology for a small-scale deployment of Microsoft Dynamics AX expands on the topology for a single-server deployment that is described in the [Single-server deployment](on TechNet) section.
This topology does not offer scalability or high availability. Scalability and high availability are introduced in the large-scale topology that is described in the Large-scale deployment section. This topology is suitable as a test environment and for training purposes.

The following diagram shows a sample topology for a small-scale deployment.

The following list describes how the computers in this sample topology are used:

- An Active Directory domain controller is required to deploy Microsoft Dynamics AX components.
- Windows clients for Microsoft Dynamics AX that connect over a wide area network (WAN) are configured to use Terminal Services to communicate with Application Object Server (AOS). Windows clients on the local area network (LAN) are configured to communicate with AOS directly.
- AOS is deployed on a single-server computer. AOS can host the following components:
  - Workflow
  - Services and Application Integration Framework (AIF)
- External applications use services and AIF to exchange data with Microsoft Dynamics AX.
- A web server can host the following components:
  - Search server
  - Enterprise Portal for Microsoft Dynamics AX
  - Web services on IIS
  - Microsoft Project Server
- The server that runs Microsoft SQL Server can host the following components:
  - Microsoft Dynamics AX online transaction processing (OLTP) database
  - Model files in the OLTP database
  - Microsoft SQL Server Analysis Services (SSAS)
  - Microsoft SQL Server Reporting Services (SSRS)
See also
- System architecture (on TechNet)
- Single-server deployment
- Large-scale deployment

Large-scale deployment

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The sample topology for a large-scale deployment of Microsoft Dynamics AX focuses on high availability. To achieve high availability, the topology includes load-balancing server clusters for the application servers and failover server clusters for the database server.

Topology diagram

The following diagram shows the sample topology for a large-scale deployment.
This diagram shows a layered topology that helps provide security through the strategic placement of firewalls and the use of a perimeter network. A perimeter network, which is also known as a demilitarized zone (DMZ) or a screened subnet, prevents external users from directly accessing the corporate intranet.

Inside the corporate intranet, servers are divided among the following layers:

- An applications layer, which contains servers that specialize in serving information to clients.
- A database and platform layer, which contains servers that specialize in storing information that can be retrieved by servers in the applications layer. This layer also contains servers that provide company-wide administrative and security functions, such as directory servers and mail servers.

Microsoft Dynamics AX Windows clients that connect over a wide area network (WAN) are configured to use Terminal Services to communicate with Application Object Server (AOS). Microsoft Dynamics AX Windows clients on the local area network (LAN) are configured to communicate with AOS directly.

**Perimeter network**

The perimeter network provides external users access to Microsoft Dynamics AX functionality through the following types of server clusters:

- A Terminal Services cluster provides virtual private network (VPN) access to authorized users.
- An Internet Information Services (IIS) cluster provides access to services through the Web services on IIS feature for Microsoft Dynamics AX.
- An IIS cluster is dedicated to Enterprise Portal for Microsoft Dynamics AX (EP).

**Applications layer**

The applications layer contains servers that provide information both to internal clients and to external clients that access Microsoft Dynamics AX through the perimeter network. This layer contains the following servers:

1. A single AOS cluster supports clients and application components. You can configure one or more AOS instances in the cluster to act as batch servers. The AOS cluster natively provides functionality for services and Application Integration Framework (AIF), Workflow, and batch processing tasks. This cluster typically uses Network Load Balancing (NLB) to distribute the workload among the AOS instances.
2. A cluster of integration servers connects to pre-existing systems.
3. Dedicated servers provide internal clients access to Enterprise Portal, Microsoft Dynamics AX Help Server, Search Server, and Microsoft Project Server.

**Database and platform layer**

The database and platform layer contains the following servers:

- A Microsoft SQL Server failover cluster contains the Microsoft Dynamics AX database. This cluster may support additional database requirements. For example, the cluster may host the database that is required for Microsoft SharePoint 2010 products.

  **Note**
  
  You must determine whether additional database clusters are required, based on the expected workload.

- A second SQL Server failover cluster is dedicated to Microsoft SQL Server Analysis Services and Microsoft SQL Server Reporting Services.
- All data is backed up through a storage area network (SAN).
- System Center Operations Manager (SCOM) enables monitoring for the whole system.
An Active Directory domain controller is required to deploy Microsoft Dynamics AX components.

See also

- System architecture (on TechNet)
- Single-server deployment
- Small-scale deployment

AOS topology

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

An Application Object Server (AOS) instance is a core component of your Microsoft Dynamics AX installation and is installed by using Setup. An AOS instance enforces security, manages connections between clients and the database, and provides the foundation where Microsoft Dynamics AX business logic runs. This section describes the various roles in which AOS can function.

See also

- AOS architecture (on TechNet)
- Deploy Application Object Servers (on TechNet)

Batch server overview

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes batch processing and batch servers, and how to plan for their use.

The batch framework provides an asynchronous, server-based batch processing environment that can process tasks across multiple Application Object Server (AOS) instances. There is no need for an interactive client for server-side batches. Client-side batch jobs are supported, but are required only for end-user-defined batch tasks. A job can contain both client-side and server-side batch tasks. A job that has client-side tasks requires a Microsoft Dynamics AX client to be open in order to process the client-side tasks.

You should become familiar with the following aspects of the batch framework:

- A **batch job** is a process that is used to achieve a specific goal. A batch job consists of one or more batch tasks.
- A **batch task** is an activity that is run by a batch job. You can add batch tasks that have multiple types of dependencies to a batch job. You can also configure AOS servers to run multiple threads, with each thread executing a task. All batch tasks that are waiting for execution can be executed by any available AOS server that is configured as a batch server. You can choose to define a batch job as many tasks, and then use a batch server to execute the tasks against all available AOS instances to improve throughput and reduce overall execution time.
- A **batch group** is an attribute of a batch task that allows the administrator to determine which AOS runs the task. When you create a new task, it is put in the default batch group. All batch servers are configured to process the default batch group and to process waiting tasks from any job. You can create a named batch group and set an affinity between the batch group and specific AOS servers. When you have created this affinity, only the configured AOS servers will process tasks from the named batch group only. You can also add the default batch group to the configured servers, if it is required.
**Batch server topology planning**

You can configure any active AOS server as a batch server. To create a dedicated batch server that does not act as an active AOS server, you must put the batch server in a cluster separate from the active AOS server. You must also make sure that users are not connecting to this dedicated batch server.

**Note**

A dedicated load balancer cannot be configured as a batch server.

The capacity of a batch server is determined based on the maximum number of threads that can run on the AOS server concurrently. Each thread executes one batch task. You can add complex dependencies between or among tasks. You can run these tasks in a serial steps or parallel steps, depending on the business logic and requirements. All tasks that do not have any dependencies are considered parallel tasks. AOS servers that are configured as batch servers periodically check for tasks that are waiting for processing. The batch server assigns each parallel task to a thread and starts to process the thread.

You can run multiple threads across multiple AOS servers. Each AOS automatically runs multiple threads, depending on capacity that is defined in the configuration settings. Therefore, parallel tasks from a job can execute on multiple threads across multiple AOS servers.

A batch server checks for available threads once a minute. Therefore, you might have to wait for a minute before you can see a waiting task being picked up for processing by an available thread.

**Batch server management planning**

All batch servers can be managed from a single location.

One common use of batch servers is to load balance jobs across multiple time zones and servers. You can define the time period during which an AOS acts as a batch server. You can also set the number of threads that the batch server will process during the time period. The applicable time is based on the user’s time zone and not on the time zone of the location of the AOS server. The time period is configured based on a schedule of start time and end time.

Because batch servers are also active AOS servers that service requests from Microsoft Dynamics AX clients and other Microsoft Dynamics AX components, determine carefully when an AOS is available to process batches. For example, a batch server might be set to process only two batch threads from 8:00 to 6 pm in the time zone that it is located in. But from 6 pm to 7:30 am, it could be set to process 20 threads.
Walkthroughs
The following walkthroughs describe how tasks are processed, and how batch groups can be used to associate batch jobs with batch servers.

Batch processing of dependent tasks
Consider that you have created a job that is called JOB 1. As shown in the following diagram, the job has seven tasks: TASK 1, TASK 2, TASK 3, TASK 4, TASK 5, TASK 6, and TASK 7.

The dependencies of your tasks are as follows:
- TASK 1 is the first task.
- TASK 2 runs on completion of TASK 1 (regardless of the success or failure of TASK 1).
- TASK 3 runs on success of TASK 2.
- TASK 4 runs on success of TASK 2.
- TASK 5 runs on failure of TASK 2.
- TASK 6 runs on failure of TASK 3.
- TASK 7 runs on success of both TASK 3 and TASK 4.
Let us assume that two batch servers, Batch1 and Batch2, are configured with a capacity of one thread each. Batch1 checks for waiting tasks, assigns TASK 1 to its thread, and starts execution. Although Batch2 is also available with one thread, TASK 2 will keep waiting until TASK 1 is completed successfully.

As soon as TASK 1 is completed successfully, TASK 2 is ready for execution. Let us assume this time that Batch2 checks for waiting tasks, assigns TASK 2 to its thread, and starts execution of TASK 2. If TASK 2 is successful, TASK 3 and TASK 4 are awaiting execution. Let us assume that Batch2 checks for waiting tasks, assigns TASK 3 to its thread, and starts execution. Batch1 also checks for waiting tasks, assigns TASK 4 to its thread, and starts execution. If TASK 3 and TASK 4 are completed successfully, one of the batch servers will execute TASK 7.

If TASK 2 fails, one of the batch servers will execute TASK 5. If TASK 3 fails, one of the available batch servers will execute TASK 6.

Note

Note that we are using Batch1 and Batch2 to explain the concept. Any batch server that has available threads will start executing a waiting task. You must create a batch group to determine or specify which batch job runs on which server.

Batch processing with batch groups

The following describes how batch jobs can be processed on specific batch servers:

1. You have configured three batch servers: AOS1, AOS2, and AOS3.
   By default, all of the batch servers process tasks from all batch jobs, depending on the number of available threads.

2. You now create a named batch group, BG1, and configure it to run on AOS2 and AOS3. Tasks from jobs in BG1 will run only on AOS2 and AOS3, depending on the number available threads. AOS1 will not process tasks from jobs in BG1. Likewise, AOS2 and AOS3 will process tasks from only BG1.
   You can configure AOS2 and AOS3 to process tasks from other batch groups. This includes the default batch group.

See also

- Configure an AOS instance as a batch server (on TechNet)

AOS clusters without a dedicated load balancer

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

You can configure Microsoft Dynamics AX Application Object Server (AOS) clusters that include a dedicated load balancer. You can also configure clusters that do not include a dedicated load balancer. This section describes planning considerations for an AOS cluster that does not include a dedicated load balancer.

Overview

The following figure shows how a client establishes a connection with an AOS instance in a cluster when a dedicated load balancer is not present.

1. When a Microsoft Dynamics AX client starts, the client reads the list of AOS instances that is specified in the Microsoft Dynamics AX 2012 Configuration utility. The client initiates a handshake with the first AOS instance
in the list. If the first AOS instance does not respond, the client initiates a handshake with the next AOS instance in the list. The client continues in this manner until the handshake occurs.

2. The AOS instance that received the client request queries the database and all active AOS instances in the cluster. The AOS instance returns to the client a list of all active AOS instances in the cluster, sorted by workload. The server that has the smallest workload is at the top of the list. The workload is based on the number of connected clients, divided by the maximum number of clients that are allowed on the server.

3. The client attempts to connect to each AOS instance in the sorted list until a successful connection is established. The client then uses the AOS instance that it connected to for the whole session.

**Considerations for using an AOS instance in a cluster that does not include a dedicated load balancer**

- If a dedicated load balancer is not present, each AOS instance in the cluster functions as both an active AOS instance and a load balancer.
- An active AOS instance has higher hardware requirements than an AOS instance that functions as a dedicated load balancer.

For information about how to configure load balancing clusters, see [Create a load balancing cluster](https://technet.microsoft.com) on TechNet.

**See also**

- [AOS clusters with a dedicated load balancer](https://technet.microsoft.com)
- [Manage a client configuration](https://technet.microsoft.com) (on TechNet)
- [Configure an AOS instance as a batch server](https://technet.microsoft.com) (on TechNet)
- [AOS architecture](https://technet.microsoft.com) (on TechNet)
AOS clusters with a dedicated load balancer

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

You can configure Microsoft Dynamics AX Application Object Server (AOS) clusters that include a dedicated load balancer. You can also configure clusters that do not include a dedicated load balancer. This section describes planning considerations for an AOS cluster that includes a dedicated load balancer.

**Overview**

The following figure shows how a client establishes a connection with an AOS instance in a cluster when a dedicated load balancer is present.

1. When a Microsoft Dynamics AX client starts, the client reads the list of active AOS instances that is specified in the Microsoft Dynamics AX 2012 Configuration utility. The client initiates a handshake with the first AOS instance in the list. In this scenario, the administrator has configured the first AOS instance as a dedicated load balancer.

2. The load balancing AOS instance that received the client request queries the database and all active AOS instances in the cluster. The AOS instance returns to the client a list of all active AOS instances in the cluster, sorted by workload. The server that has the smallest workload is at the top of the list. The workload is based on the number of connected clients, divided by the maximum number of clients that are allowed on the server.

3. The client attempts to connect to each AOS instance in the sorted list until a successful connection is established. The client then uses the AOS instance that it connected to for the whole session.
Considerations for using an AOS instance as a dedicated load balancer

- An AOS instance that is configured as a load balancer does not accept any client connections as either an application server or a batch server. This AOS instance functions only as a load balancer.

- A dedicated load balancer can be used only for remote procedure call (RPC) connections. To balance the load of connections for Application Integration Framework (AIF) and services, you must use Microsoft Network Load Balancing (NLB). For more information, see Configuring network load balancing for services on TechNet.

- An AOS instance that is configured as a load balancer does not require an AOS license, because the server does not provide any application services to the clients.

- If you configure an AOS instance as a dedicated load balancer, you do not have to update client configurations when AOS instances are added to or removed from the cluster.

- A dedicated load balancer has lower hardware requirements than an AOS instance that functions as an application server, because the load balancer does not process application requests or business logic.

- You can configure multiple AOS instances to function as dedicated load balancers. However, you must make sure that dedicated load balancers appear first in the list of active servers in the client configuration.

For information about how to configure load balancing clusters, see Create a load balancing cluster on TechNet.

See also

- AOS clusters without a dedicated load balancer
- Manage a client configuration (on TechNet)
- Configure an AOS instance as a batch server AOS architecture (on TechNet)

SQL Server topology recommendations for availability and performance

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The choice topology of the Microsoft SQL Server environment that supports Microsoft Dynamics AX is driven primarily by requirements for availability and performance.

**General topology recommendations**

We recommend the following guidelines as a baseline for your topology:

- Follow the documented best practices for SQL Server.

- Use a dedicated server that is running SQL Server 2012, SQL Server 2008 R2 or SQL Server 2008.

- Use a single instance of SQL Server that is dedicated to running the Microsoft Dynamics AX production database.

- Store your test and development databases on a separate server from the production database.
**Availability recommendations**

SQL Server provides several options that can help you achieve high availability: Windows Server Failover Clustering, SQL Server database mirroring, SQL Server log shipping, and SQL Server 2012 AlwaysOn Availability Groups. Of these options, failover clustering and availability groups provide the least amount of downtime. However, replication, database mirroring, log shipping, and availability groups can satisfy other requirements. For example, some of these options can be used to provide a reporting environment that can reduce the load on your production server. The high availability option that you select for your implementation of Microsoft Dynamics AX depends on your availability requirements, a cost/benefit analysis, and the risk tolerance of your organization.

⚠️ **Important**

Before you select a high availability option for SQL Server, we strongly recommend that you contact your value-added reseller (VAR) or Microsoft Support to make sure that the option that you want to use is supported.

Determine and document your availability needs carefully, and test the solution that you select to make sure that it provides the expected availability. The following table lists supported high availability configurations.

<table>
<thead>
<tr>
<th>High availability configuration</th>
<th>Support status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server Failover Clustering (WSFC)</td>
<td>Supported</td>
</tr>
<tr>
<td>Log shipping</td>
<td>Supported</td>
</tr>
<tr>
<td>Transactional replication</td>
<td>Supported. Requires KB 2765281.</td>
</tr>
<tr>
<td>Snapshot replication</td>
<td>Supported</td>
</tr>
<tr>
<td>Database mirroring</td>
<td>Supported</td>
</tr>
<tr>
<td>Merge replication</td>
<td>Not supported, because complex resolution is required to guarantee data integrity</td>
</tr>
<tr>
<td>SQL Server 2012 AlwaysOn Availability groups</td>
<td>Supported. Both synchronous and asynchronous secondary configurations are supported.</td>
</tr>
</tbody>
</table>

If you are running SQL Server 2012, we recommend that you deploy AlwaysOn Availability Groups.
If you are running SQL Server 2008, we recommend that you deploy a Windows Server Failover Cluster with one active node and one inactive node.
Availability groups and failover clusters do not require a restart of the Application Object Server (AOS) service.
The following figure shows a SQL Server failover topology.

When you use SQL Server failover clustering, note the following behavior:

- The failover is transparent to AOS, and the service typically does not require a restart.
- In-process transactions are rolled back, and the user may have to reenter data that was being entered at the time of failure.

**Note**

We recommend that a failover cluster be configured so the active node will fail over to an inactive node. If the active node fails over to another active node in the cluster, you must make sure there is sufficient capacity to sustain the Microsoft Dynamics AX database workload, otherwise performance may be degraded significantly.

**Caution**

Microsoft SQL Server Reporting Services cannot be installed on a failover cluster, because you cannot run the Reporting Services service as part of a failover cluster. However, you can install the report server database on a computer that has a failover cluster installed.

For more information about availability options, see:

- [Getting started with SQL Server 2008 R2 Failover Clustering](on Microsoft.com)
- [Windows Server Failover Clustering (WSFC) with SQL Server](on TechNet)
- [Database mirroring](on Microsoft.com)
- [Log shipping](on Microsoft.com)
- [Transactional replication](on Microsoft.com)
- [Log shipping](on Microsoft.com)
- [Host a Report Server Database in a SQL Server Failover Cluster](on TechNet)

**Performance recommendations**

The performance of the database can significantly affect overall Microsoft Dynamics AX performance. To achieve the best performance, the SQL Server environment and storage subsystem must be correctly configured. For more information, see the [Configure SQL Server and storage settings](section).
Prepare for the installation

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This chapter provides an overview of the installation process and explains the procedures that you must complete before you start the installation.

Overview of the installation

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides an overview of the components that you can install by using the Setup wizard. It also describes the installation types that are available in Setup.

For information about new installation features in Microsoft Dynamics AX 2012, see What’s new: Installation (on TechNet).

Servers in the Microsoft Dynamics AX environment

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

A production deployment of Microsoft Dynamics AX requires multiple servers. This section describes the types of server that may be required in your implementation.

Servers in a minimum installation of Microsoft Dynamics AX

A minimum installation of Microsoft Dynamics AX consists of a business database, a model store, an instance of Application Object Server (AOS), and at least one client. These components can be installed on computers that are arranged in various topologies, but the system does not run unless all elements are installed.

Application Object Server

An AOS server is a computer that runs the AOS Windows service. The AOS service controls communications among Microsoft Dynamics AX clients, databases, and applications. You can install the AOS on a single computer, or you can create a server cluster for load balancing.

Database server

A Microsoft SQL Server database server hosts the database that stores Microsoft Dynamics AX transaction data. The database server also hosts the model store, which is the database that stores application elements. These application elements include customizations.

Note

In Microsoft Dynamics AX 2012 R3 and AX 2012 R2, the model store and the business data are stored in separate databases. In earlier versions of AX 2012, the model store and business data are stored in a single database.

Servers in a complete installation of Microsoft Dynamics AX

For some Microsoft Dynamics AX functionality, you must have one or more of the following additional servers.
Report server
A report server is a server that runs Microsoft SQL Server Reporting Services. Reporting Services is a server-based solution that lets users create and publish both traditional, paper-based reports and interactive, web-based reports.
For more information about how to set up a report server, see the Install Reporting Services extensions for Microsoft Dynamics AX section.

Analysis server
An analysis server enhances the reporting functionality in Microsoft Dynamics AX by linking to Microsoft SQL Server Analysis Services. An analysis server provides enhanced support for online analytical processing (OLAP).
For more information about how to set up an analysis server, see the Configure Analysis Services section.

Web server
A web server hosts the websites that are required for some Microsoft Dynamics AX features. These features include Enterprise Portal for Microsoft Dynamics AX, Help server, Enterprise Search, Warehouse Mobile Devices Portal, web services on IIS, and the Retail online store.

Other servers in the environment
The following servers are typically found in infrastructures that run Microsoft Dynamics AX. This documentation provides information about how to use Microsoft Dynamics AX together with these servers. For information about how to install and set up these servers, see the documentation for each server.

Domain controller
A domain controller in an Active Directory network manages user logons and access to network and shared resources.

Messaging server
A messaging server enables email messages and instant messages to be sent and received. Microsoft Dynamics AX can use email to send alerts to users. Microsoft Dynamics AX requires that the messaging server support SMTP.

Microsoft Dynamics AX components

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes the components of Microsoft Dynamics AX that you can install by using the Setup wizard.

Databases
Databases include the Microsoft Dynamics AX database, the model store, and the baseline database. The AOS connects to the Microsoft Dynamics AX database to process transactions. The AOS connects to the model store to display application elements such as forms and reports. The baseline database contains a model store that is used to upgrade X++ code to Microsoft Dynamics AX 2012. The baseline database is used to analyze application updates before they are applied.

**Note**
In Microsoft Dynamics AX 2012 R3 and Microsoft Dynamics AX 2012 R2, the model store and the business data are stored in separate databases. In earlier versions of Microsoft Dynamics AX 2012, the model store and business data are stored in a single database.
For information about how to install the databases, see the Install the Microsoft Dynamics AX databases section. Other Microsoft Dynamics AX components, such as Enterprise Portal and Reporting Services extensions, also include databases. The additional databases are created when you install those components and their prerequisites. They are not installed as part of the Microsoft Dynamics AX databases component.

**Server components**

Server components include AOS and the Microsoft Dynamics AX components that run on Internet Information Services (IIS). For information about how to install one of the server components, click the corresponding link in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Object Server (AOS)</td>
<td>The AOS service controls communications among Microsoft Dynamics AX clients, databases, and applications.</td>
<td>Install an Application Object Server (AOS) instance</td>
</tr>
<tr>
<td>Enterprise Portal for Microsoft Dynamics AX (web server)</td>
<td>Enterprise Portal is a SharePoint site that lets trusted users access Microsoft Dynamics AX data and functionality. Anonymous users can access only limited functionality, such as catalog information and questionnaires.</td>
<td>Install Enterprise Portal</td>
</tr>
<tr>
<td>Enterprise Search (web server)</td>
<td>Enterprise Search lets client users and Enterprise Portal users search for data, forms, and reports in Microsoft Dynamics AX by entering simple search terms. Enterprise Search uses Microsoft Search Server Express or SharePoint Server and the Business Data Connectivity Service (BCS).</td>
<td>Install Search</td>
</tr>
<tr>
<td>Help Server (web server)</td>
<td>Help server is an IIS website that stores Help documentation that is used in Microsoft Dynamics AX. Help server simplifies the task of updating and customizing Help.</td>
<td>Install help server</td>
</tr>
</tbody>
</table>

**Business intelligence components**

Business intelligence components provide reporting and analytical functionality that you can use to view and interpret business data. For information about how to install one of the business intelligence components, click the corresponding link in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting Services extensions</td>
<td>Integration with Microsoft SQL Server Reporting Services lets you create reports by using Reporting Services.</td>
<td>Install Reporting Services extensions for Microsoft Dynamics AX</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
<td>More information</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Analysis Services configuration</td>
<td>Integration with Microsoft SQL Server Analysis Services lets you use cubes for business intelligence and analytical reporting in Microsoft Dynamics AX.</td>
<td>Configure Analysis Services by running Setup</td>
</tr>
</tbody>
</table>

**Management Reporter components**

Management Reporter for Microsoft Dynamics ERP is the recommended financial reporting solution for Microsoft Dynamics AX 2012. For information about how to install one of the Management Reporter components, click the corresponding link in the following table.

✅ **Note**

Management Reporter components are available in the Setup wizard in AX 2012 R3 and cumulative update 7 for Microsoft Dynamics AX 2012 R2.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Reporter for Microsoft Dynamics ERP</td>
<td>Use Management Reporter to create, distribute, and analyze financial statements and other financial reports.</td>
<td>Install Management Reporter server components</td>
</tr>
<tr>
<td>Report Designer for Management Reporter</td>
<td>Report Designer is a component of Management Reporter that is used to create the building blocks that define a report.</td>
<td>Install Report Designer for Management Reporter</td>
</tr>
</tbody>
</table>
Client components

Client components give users access to Microsoft Dynamics AX data and functionality. For information about how to install one of the client components, click the corresponding link in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Dynamics AX Windows client</td>
<td>The Microsoft Dynamics AX client is an interface to Microsoft Dynamics AX data and functionality.</td>
<td>Install the Microsoft Dynamics AX client</td>
</tr>
<tr>
<td>Microsoft Office Add-ins</td>
<td>Use the Office Add-ins to integrate the Microsoft Dynamics AX client with Microsoft Excel or Microsoft Word.</td>
<td>Install Office Add-ins</td>
</tr>
<tr>
<td></td>
<td>In Microsoft Dynamics AX 2012 R3 and cumulative update 7 for Microsoft Dynamics AX 2012 R2, the Microsoft Project client add-in is included with the Office Add-ins. With the Microsoft Project client add-in, users can take advantage of features in both Microsoft Dynamics AX and Microsoft Project to manage a project.</td>
<td></td>
</tr>
<tr>
<td>Remote Desktop Services integration</td>
<td>The Remote Desktop Services integration components support integration with local applications, such as Microsoft Word and Microsoft Excel, when Microsoft Dynamics AX is hosted on a Remote Desktop server.</td>
<td>Install Remote Desktop Services integration</td>
</tr>
</tbody>
</table>

Developer tools

Developer tools are used to customize Microsoft Dynamics AX. For example, you can create customizations or extensions to Enterprise Portal, or you can create advanced production reports for Microsoft Dynamics AX by using Reporting Services. For information about how to install one of the developer tools, click the corresponding link in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debugger</td>
<td>The debugger tool provides debugging capabilities for X++ developers.</td>
<td>Install the debugger</td>
</tr>
<tr>
<td>Visual Studio Tools</td>
<td>Visual Studio Tools integrate the development of Microsoft Dynamics AX with Visual Studio. Developers can use these tools to create managed code that accesses X++ objects.</td>
<td>Install Visual Studio Tools</td>
</tr>
</tbody>
</table>
Component | Description | More information
--- | --- | ---
Trace Parser | The Trace Parser consolidates information from multiple sources, such as RPC and SQL, to provide an integrated view of the application’s performance at run time. | Install the Trace Parser

Integration components
Integration components enable integration between Microsoft Dynamics AX and external applications. For information about how to install one of the integration components, click the corresponding link in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web services on IIS</td>
<td>Web services on IIS are an optional component. Services that are hosted on AOS are available to users and applications over the intranet. However, to consume services over the Internet, you must host services on IIS.</td>
<td>Install web services on IIS</td>
</tr>
<tr>
<td>.NET Business Connector</td>
<td>The .NET Business Connector enables applications to interact with instances of Application Object Server (AOS).</td>
<td>Install .NET Business Connector</td>
</tr>
<tr>
<td>Synchronization proxy and synchronization service for Microsoft Project Server</td>
<td>The synchronization proxy and synchronization service for Microsoft Project enable you to synchronize project data in Microsoft Dynamics AX with data in Microsoft Project Server.</td>
<td>• Install the synchronization proxy for Microsoft Project Server • Install the synchronization service for Microsoft Project Server</td>
</tr>
</tbody>
</table>

Management utilities
Management utilities let you configure and manage Microsoft Dynamics AX components and artifacts, such as reports and web controls, from the metadata store.
For information about how to install management utilities, see the Install management utilities chapter.

Retail components
Microsoft Dynamics AX for Retail provides mid-market and large retailers a complete head office and point of sale (POS) solution. It can help retailers increase financial returns, improve service, manage growth, and streamline...
Microsoft Dynamics AX for Retail consists of several components that are typically distributed across multiple computers and locations.

For information about how to install one of the retail components, click the corresponding link in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retail headquarters</td>
<td>Retail headquarters includes components that are necessary to use Retail functionality in Microsoft Dynamics AX.</td>
<td>Install Retail Headquarters</td>
</tr>
<tr>
<td>Retail POS</td>
<td>Retail POS is the point of sale (POS) program for Microsoft Dynamics AX.</td>
<td>Install Retail POS</td>
</tr>
<tr>
<td>Retail Modern POS</td>
<td>Modern POS (point of sale) provides the services that enable Windows 8.1 clients to interface with Retail.</td>
<td>Install Retail Modern POS</td>
</tr>
<tr>
<td></td>
<td>✓ Note Modern POS is available only in AX 2012 R3.</td>
<td></td>
</tr>
<tr>
<td>Retail channel database</td>
<td>Channel databases hold Retail data for one or more retail channels, such as online stores or brick-and-mortar stores.</td>
<td>Install a retail channel database</td>
</tr>
<tr>
<td></td>
<td>✓ Note Retail channel database is available only in AX 2012 R3.</td>
<td></td>
</tr>
<tr>
<td>Commerce Data Exchange: Synch Service (Retail Store Connect)</td>
<td>Synch Service shares data among the head office, stores, and individual point of sale (POS) terminals.</td>
<td>Install Commerce Data Exchange: Synch Service (Retail Store Connect)</td>
</tr>
<tr>
<td></td>
<td>✓ Note In AX 2012 R3, deploy this component only if you need to support previous versions of Retail POS while you upgrade (N-1).</td>
<td></td>
</tr>
<tr>
<td>Commerce Data Exchange: Real-time Service (Retail Transaction Service)</td>
<td>Real-time Service is an integrated service that provides real-time communication between Microsoft Dynamics AX and individual point of sale (POS) devices.</td>
<td>Install Commerce Data Exchange: Real-time Service (Retail Transaction Service)</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
<td>More information</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Commerce Data Exchange: Async Server</td>
<td>Async Server is part of the asynchronous system that shares data between the Microsoft Dynamics AX database and channel databases. Async Server is installed at headquarters and communicates with the Microsoft Dynamics AX database.</td>
<td>Install Commerce Data Exchange: Async Server</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>&lt;br&gt;Async Server is available only in AX 2012 R3.</td>
<td></td>
</tr>
<tr>
<td>Commerce Data Exchange: Async Client</td>
<td>Async Client is part of the asynchronous system that shares data between the Microsoft Dynamics AX database and channel databases. Async Client is installed at the channel and communicates with the channel database.</td>
<td>Install Commerce Data Exchange: Async Client</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>&lt;br&gt;Async Client is available only in AX 2012 R3.</td>
<td></td>
</tr>
<tr>
<td>Retail Channel Configuration Utility (Retail Store Database Utility)</td>
<td>The Retail Channel Configuration Utility is used to configure Retail databases and database connections.</td>
<td>Install the Retail Channel Configuration Utility (Retail Store Database Utility)</td>
</tr>
<tr>
<td>Retail Server</td>
<td>Retail Server provides services and business logic for Modern POS (point of sale) clients.</td>
<td>Install Retail Server</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>&lt;br&gt;Retail Server is available only in AX 2012 R3.</td>
<td></td>
</tr>
<tr>
<td>Retail hardware station</td>
<td>Retail Hardware Station provides services for Modern POS (point of sale) clients and peripherals such as printers, cash drawers, or payment devices that enable these devices to communicate with Retail Server.</td>
<td>Install Retail Hardware Station</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>&lt;br&gt;Hardware station is available only in AX 2012 R3.</td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
<td>More information</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retail Online Channel</td>
<td>Retail Online Channel includes components that are needed to provision an online sales channel using SharePoint. This component allows you to integrate data from Microsoft Dynamics AX into the SharePoint site.</td>
<td>Install a Retail online store (e-commerce)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>&lt;br&gt;Retail Online Channel is available only in AX 2012 R3 and AX 2012 R2.</td>
<td></td>
</tr>
<tr>
<td>Retail mass deployment toolkit</td>
<td>The Retail mass deployment toolkit enables you to use System Center Configuration Manager (SCCM) to deploy retail components.</td>
<td>Install the Retail mass deployment toolkit</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>&lt;br&gt;Retail mass deployment toolkit is available only in AX 2012 R3.</td>
<td></td>
</tr>
<tr>
<td>Retail SDK</td>
<td>The Retail Software Development Kit (SDK) includes sample code and templates that can be used to customize Retail for Microsoft Dynamics AX.</td>
<td>Install Retail SDK (Retail POS Plug-ins)</td>
</tr>
</tbody>
</table>
| Retail essentials                 | Retail essentials is a retail-centric configuration option for Microsoft Dynamics AX. Retail essentials provides a simplified, streamlined user experience that is optimized for organizations that use only the retail management functions of Microsoft Dynamics AX. | - Install Retail essentials at headquarters  
- Install Retail essentials at the store or at the point of sale                                      |

**Connector for Microsoft Dynamics**

Connector can be used to integrate data between Microsoft Dynamics CRM and Microsoft Dynamics AX. For example, you can integrate Microsoft Dynamics AX customers with Microsoft Dynamics CRM accounts. This gives you access to up-to-date customer and account information in both systems.

**Note**

Connector is available through the Microsoft Dynamics AX Setup wizard in AX 2012 R3 and cumulative update 7 for Microsoft Dynamics AX 2012.

For more information about how to install Connector, see the [Install Connector for Microsoft Dynamics](#) chapter.
RapidStart Connector
The Rapid Start Connector for Microsoft Dynamics AX enables RapidStart Services for Microsoft Dynamics ERP to communicate with an on-premises Microsoft Dynamics AX implementation.

Note
The RapidStart Connector is available through the Microsoft Dynamics AX Setup wizard in AX 2012 R3, AX 2012 R2, and Microsoft Dynamics AX 2012 Feature Pack.
For more information about how to install RapidStart Connector, see the Install the RapidStart Connector chapter.

VSS writer
The Volume Shadow Copy Service writer for Microsoft Dynamics AX, (AX VSS writer) can be used with Microsoft System Center 2012 Data Protection Manager (DPM) to protect Microsoft Dynamics AX data and servers. The AX VSS writer coordinates backup and restore operations.

Note
The AX VSS writer is available through the Microsoft Dynamics AX Setup wizard in AX 2012 R3 and cumulative update 7 for Microsoft Dynamics AX 2012 R2.
For more information about how to install the VSS writer, see the Install the VSS writer for Microsoft Dynamics AX chapter.

Warehouse Mobile Devices Portal
Warehouse Mobile Devices Portal enables users to complete tasks on mobile devices in the warehouse facility. It includes a website that can be accessed by mobile devices. Warehouse Mobile Devices Portal communicates with AOS by using Windows Communication Foundation (WCF) services.

Note
The Warehouse Mobile Devices Portal is available through the Microsoft Dynamics AX Setup wizard only in AX 2012 R3.
For more information about how to install the Warehouse Mobile Devices Portal, see the Install Warehouse Mobile Devices Portal chapter.

Data Import/Export Framework
The Microsoft Dynamics AX 2012 Data Import/Export Framework is an extension that helps you export data and import it into Microsoft Dynamics AX. Examples of the data that you can import include master data, open stock, and balances.

Note
The Data Import/Export Framework is available through the Microsoft Dynamics AX Setup wizard only in AX 2012 R3.
For more information about how to install the Data Import/Export Framework, see the Install the Data import/export framework (DIXF, DMF) chapter.
Installation types

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Two types of installation are available from the Setup wizard: **Custom installation** and **Single-computer installation**.

**Custom installation**

Select **Custom installation** to install specific Microsoft Dynamics AX components on multiple computers. Use this type of installation in a production environment.

**Single-computer installation**

Select Single-computer installation to install a complete Microsoft Dynamics AX system on one computer. Setup uses default settings to configure all components, and new Microsoft Dynamics AX databases are created. User names and passwords are the only input that is required.

If you want to connect to an existing database or specify other custom settings, you must perform a custom installation.

⚠️ **Important**

Do not perform a single-computer installation in a production environment. Use this type of installation only for development and testing.

A single-computer installation includes the following components:

- Databases
- Application Object Server (AOS)
- Enterprise Portal
- Help server
- Reporting Services extensions
- Analysis Services configuration
- Client
- Office add-ins
- Remote Desktop Services integration
- Debugger
- Visual Studio Tools
- Trace Parser
- .NET Business Connector
- Management utilities

For information about how to install a Microsoft Dynamics AX system on a single computer, see the **Perform a single-computer installation of Microsoft Dynamics AX** chapter.
### Before you begin

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides the procedures that you must complete before you start to install Microsoft Dynamics AX.

### Pre-installation checklist

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Before you install Microsoft Dynamics AX, you must plan the implementation and complete the pre-installation tasks that are listed in the following table.

<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Plan the deployment of Microsoft Dynamics AX.</td>
<td>Implementation Planning Guide (PDF) (on Microsoft.com)</td>
</tr>
<tr>
<td>3. Review the system requirements.</td>
<td>System requirements on the Web (PDF) (on Microsoft.com)</td>
</tr>
<tr>
<td><strong>Important</strong></td>
<td></td>
</tr>
<tr>
<td>If you plan to upgrade the operating system, you must perform the upgrade before you install Microsoft Dynamics AX. If you upgrade the operating system after Microsoft Dynamics AX has been installed, you may experience problems. For example, instances of Application Object Server (AOS) may not start, or registry entries may be deleted.</td>
<td></td>
</tr>
<tr>
<td>4. Create service accounts that Windows services can run as. For example, you must create accounts to run Microsoft Dynamics AX services and Microsoft SQL Server services.</td>
<td>Create service accounts</td>
</tr>
<tr>
<td>5. Copy the DVD contents to a shared directory.</td>
<td>Create a shared directory for installation</td>
</tr>
<tr>
<td>6. Obtain product updates, and copy them to the installation directory for Microsoft Dynamics AX.</td>
<td>Include cumulative updates and hotfixes in a new installation (slipstreaming)</td>
</tr>
<tr>
<td>7. Make sure that your domain account has the appropriate permissions to perform the installation.</td>
<td>Verify that you have the required permissions for installation</td>
</tr>
<tr>
<td>8. Verify that prerequisites have been met.</td>
<td>Check prerequisites</td>
</tr>
</tbody>
</table>
Create service accounts

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

An implementation of Microsoft Dynamics AX requires many services to run. Set up accounts to run the services. Each account that you set up must have the following characteristics:

- Unless otherwise noted, it must be a dedicated account. A dedicated account is used only for a specific service.
- It must have a password that does not expire.
- It must have minimal access to network resources.
- It must be able to log on as a service.

If you are using Windows Server 2008 R2 or a later version of Windows Server, you can use managed service accounts. For more information, see the Service Accounts Step-by-Step Guide on Microsoft.com.

**Note**

If an account must be a Microsoft Dynamics AX user, it cannot be a managed service account.

The accounts in this section must be configured in order to install the components of Microsoft Dynamics AX. For information about additional service accounts that are used when you configure Microsoft Dynamics AX, see Configure system accounts on TechNet.
Create accounts for Microsoft Dynamics AX services

Create the accounts in the following table to run Microsoft Dynamics AX services.

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
<th>Configuration procedure</th>
</tr>
</thead>
</table>
| Application Object Server (AOS) service account | The account that the **Microsoft Dynamics AX Object Server** Windows service runs as. This account is used to communicate with the database server. Consider the following points when you select an account:  
- We strongly recommend that you use a domain account or a managed service account in a production environment. Use the Network Service account only in development and testing environments.  
- If you plan to use a managed service account, you must first create that account as described in the [Service Accounts Step-by-Step guide](https://www.microsoft.com) on Microsoft.com.  
- If Microsoft SQL Server and the AOS are on different computers, you must use a domain account or a managed service account.  
- If you plan to install any Microsoft Dynamics AX components on a domain controller, you must use a domain account.  
- If you plan to use Message Queuing, which is also known as MSMQ, for document exchange with web services on Internet Information Services (IIS), and you want to send signed messages, you must use a domain account. However, if you want to send unsigned messages by using web services on IIS, the AOS can run under the Network Service account. | Enter this account when you run the Setup wizard to install an AOS instance. For more information, see the [Install an AOS instance](https://www.microsoft.com) section. |
<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
<th>Configuration procedure</th>
</tr>
</thead>
</table>
| Business Connector proxy account             | The account that the .NET Business Connector runs as. This account is used to connect to the AOS on behalf of a Microsoft Dynamics AX user, but without granting that user excessive privileges in the system.  
**Note**  
This account must not be a Microsoft Dynamics AX user. | Enter this account when you run the Setup wizard or select this account in the **System service accounts** form.                                                                                                                                                                      |
| Search crawler account                       | The account that Enterprise Search runs as. This account is used by the Microsoft SharePoint Indexing Service to crawl Microsoft Dynamics AX data. This account must be assigned to the **Search crawler** security role in Microsoft Dynamics AX. We recommend that you configure this account so that it has no local logon rights. | Enter this account when you run the Setup wizard to install Enterprise Search. For more information, see the [Install Microsoft Dynamics AX Enterprise Search](#) section.  
Use the **Assign users to roles** form to assign this account to the **Search crawler** security role.                                                                                                                |
| Management Reporter integration user account (optional) | The account that is used to run integrations between Management Reporter and Microsoft Dynamics AX.  
This account must have read permission and view change tracking permission on the Microsoft Dynamics AX transaction database and model database.  
Setup will add the account as a user in Microsoft Dynamics AX, and will assign the user to the **System administrator** security role. | Enter this account when you run the Setup wizard to install Management Reporter. For more information, see the [Install Management Reporter server components](#) section.                                                                                   |
| Management Reporter service account (optional) | The account that the Management Reporter Windows service runs as.  
We recommend that you use the AOS service account to run the Management Reporter service.                                                                 | Enter this account when you run the Setup wizard to install Management Reporter. For more information, see the [Install Management Reporter server components](#) section.                                                                 |
| Synchronization service account (optional)   | The account that the Microsoft Project Server synchronization service runs as. We recommend that you configure this account so that it has no local logon rights. | Select this account in the **System service accounts** form.  
For more information, see the [Install the synchronization service for Microsoft Project Server](#) section.                                                                                                           |
| Connector integration user account (optional) | The account that is used to connect to Microsoft Dynamics AX.  
Setup will add the account as a user in Microsoft Dynamics AX, and will assign the user to the **System administrator** security role. | Enter this account when you run the Setup wizard to install Connector. For more information, see the [Install Connector for Microsoft Dynamics](#) chapter.                                                                                      |
<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
<th>Configuration procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector service account (optional)</td>
<td>The account that is used to run integrations with Microsoft Dynamics AX. This account is also used to send notification emails. If the Simple Mail Transfer Protocol (SMTP) server that you use to send notifications requires authentication to submit emails, you must give this service account permission to authenticate and submit emails.</td>
<td>Enter this account when you run the Setup wizard to install Connector. For more information, see the <a href="#">Install Connector for Microsoft Dynamics AX</a> chapter.</td>
</tr>
<tr>
<td>RapidStart Connector account (optional)</td>
<td>The account that the RapidStart Connector Windows service runs as.</td>
<td>Enter this account when you run the Setup wizard to install the RapidStart Connector. For more information, see the <a href="#">Install the RapidStart Connector</a> chapter. Use the <strong>Assign users to roles</strong> form to assign this account to the <strong>System administrator</strong> security role.</td>
</tr>
<tr>
<td>VSS writer account (optional)</td>
<td>The account that the VSS writer Windows service runs as. This account must be a local administrator, and must have read/write access to the location where temporary backups are stored.</td>
<td>Enter this account when you run the Setup wizard to install the VSS writer. For more information, see the <a href="#">Install the VSS writer for Microsoft Dynamics AX</a> chapter.</td>
</tr>
<tr>
<td>Application pool identity for Warehouse Mobile Devices Portal (optional)</td>
<td>The account that is used to run the application pool for the web application for Warehouse Mobile Devices Portal. You must install an instance of Warehouse Mobile Devices Portal for each company in Microsoft Dynamics AX. Create a separate service account for each instance. Service accounts must be assigned to the <strong>Warehouse mobile device user</strong> security role in Microsoft Dynamics AX. The default company for the user must be the legal entity in which the warehouse operates. The language that you select for the user is the default language for the portal.</td>
<td>Enter this account when you run the Setup wizard to install Warehouse Mobile Devices Portal. For more information, see the <a href="#">Install Warehouse Mobile Devices Portal</a> chapter. Use the <strong>Assign users to roles</strong> form to assign this account to the <strong>Warehouse mobile device user</strong> security role. Use the <strong>Options</strong> form to set the default company and language for the user.</td>
</tr>
</tbody>
</table>
### Create accounts for Retail services

Create the accounts in the following table to run the services that are used in Retail.

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
<th>Configuration procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application pool identity for Commerce Data Exchange: Real-time Service</td>
<td>The account that is used to run the application pool for the web application for Real-time Service.</td>
<td>Enter this account when you run the Setup wizard to install Real-time Service. For more information, see the Install Commerce Data Exchange: Real-time Service (Retail Transaction Service) section. Use the Assign users to roles form to assign this account to the BusinessConnector Role.</td>
</tr>
<tr>
<td><img src="image" alt="Note" /></td>
<td><img src="image" alt="Note" /></td>
<td></td>
</tr>
<tr>
<td>In Microsoft Dynamics AX 2012 Feature Pack, Commerce Data Exchange: Real-time Service is called Retail Transaction Service.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service account for Commerce Data Exchange: Async Client</td>
<td>The account that the Async Client Windows service runs as. The account is not required to be a domain account. It can be a member of a workgroup on the local computer.</td>
<td>Enter this account when you run the Setup wizard to install Async Client. For more information, see the Install Commerce Data Exchange: Async Client section.</td>
</tr>
<tr>
<td>Application pool identity for Commerce Data Exchange: Async Server</td>
<td>The account that is used to run the application pool for the web application for Async Server.</td>
<td>Enter this account when you run the Setup wizard to install Async Server. For more information, see the Install Commerce Data Exchange: Async Server section.</td>
</tr>
<tr>
<td>Account</td>
<td>Description</td>
<td>Configuration procedure</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-------------------------</td>
</tr>
</tbody>
</table>
| Service accounts for Commerce Data Exchange: Synch Service | The accounts that the Synch Service Windows service runs as. These accounts are used to communicate with the database server. Consider the following points when you select an account:  
- Guest or temporary user accounts are not supported.  
- The service user account on head-office instances of Synch Service must be a Microsoft Dynamics AX user.  
- If you are installing a forwarder instance of Synch Service at headquarters, the service user account can be any valid domain account.  
- If you are installing an instance of Synch Service for a channel, you can use a valid local user account on the computer where the instance runs.  
- The account must be a member of the db_datareader and db_datawriter database roles in the message database.  
- This account must be created on POS computers where offline databases are located. | Enter this account when you run the Setup wizard to install Synch Service. For more information, see the Install Commerce Data Exchange: Synch Service (Retail Store Connect) section. |
| Application pool identity for Retail Server | The account that is used to run the application pool for the web application for Retail Server. The account is not required to be a domain account. It can be a member of a workgroup on the local computer. | Enter this account when you run the Setup wizard to install Retail Server. For more information, see the Install Retail Server section. |
| Application pool identity for Retail hardware station | The account that is used as the identity of the application pool for Retail hardware station. The account is not required to be a domain account. It can be a member of a workgroup on the local computer. | Enter this account when you run the Setup wizard to install Retail hardware station. For more information, see the Install Retail Hardware Station section. |
| Service account for Offline Sync Service | The account that the Offline Sync Service Windows service runs as. This account must be a member of the sysadmin server role in SQL Server on the computer where the offline database is installed. | Add this account to the RetailUsers local group. Use the Services control panel to manually set this account as the identity for the Offline Sync Service. |
### Retail online store service accounts

- **Product catalog app pool user:** The account that is used as the identity of the application pool for the Retail online store product catalog website. This account must be a member of the SharePoint Farm Administrators group so that it can edit properties in the root website.

- **Store front app pool user:** The account that is used as the identity of the application pool for the Retail online store site. This account must be a member of the SharePoint Farm Administrators group so that it can edit properties in the root website.

- **STS app pool user:** The account that is used to run the application pool for the Security Token Service. This account must be a member of the SharePoint Farm Administrators group so that it can edit properties in the root website. This account is specified when you install SharePoint.

- **Retail job user:** The account that is used to run the SharePoint Timer Service. This account is specified when you install SharePoint.

Enter these accounts when you run the Setup wizard to install the Retail online store or when you install the store by using Windows PowerShell. For more information, see the Install a Retail online store (e-commerce) section.

### Create accounts for SQL Server services

Create the accounts in the following table to run SQL Server services.

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
<th>Configuration procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server Database Engine account</td>
<td>The account that the SQL Server (MSSQLSERVER) Windows service runs as.</td>
<td>Select this account when you install the Database Engine. For more information, see the SQL Server documentation.</td>
</tr>
<tr>
<td>Microsoft SQL Server Reporting Services account</td>
<td>The account that the SQL Server Reporting Services (MSSQLSERVER) Windows service runs as.</td>
<td>When you install Reporting Services, specify that you want the Reporting Services Windows service to run as the .NET Business Connector account.</td>
</tr>
<tr>
<td>Account</td>
<td>Description</td>
<td>Configuration procedure</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Microsoft SQL Server Analysis Services account</td>
<td>The account that the SQL Server Analysis Services (MSSQLSERVER) Windows service runs as.</td>
<td>Select this account when you install Analysis Services.</td>
</tr>
</tbody>
</table>

⚠️ Important

The account that you select must have read access to the online transaction processing (OLTP) database for Microsoft Dynamics AX.

Create a shared directory for installation

Appears to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Before you install Microsoft Dynamics AX and subsequent cumulative updates, we recommend that you create a shared directory on a file server. Then copy the contents of the Microsoft Dynamics AX DVD and the updates to this network location. Perform all installations from this network location instead of the DVD.

By giving users a shared network location from which to install Microsoft Dynamics AX, you can make sure that the same version of the software is installed on all computers.

Additionally, the installation program may later require access to files from the location where Setup was run. For example, the installation program may require access to the files when you upgrade, when you modify the installation, or when you uninstall a component or update. If Setup was run from a network location, the installation program can retrieve the files silently from the network. However, if Setup was run from a DVD, the user is prompted to insert the DVD when files are required.

Before you install Microsoft Dynamics AX, follow these steps to create a shared directory for the contents of the DVD.

1. Create a directory that is named DynamicsAX6.
2. Share the DynamicsAX6 directory:
   - Give the Administrator group full control, or owner access.
   - Give the Everyone group read access.

As a security best practice, we recommend that you prevent users from making changes to this directory. Only read access is required to perform an installation from the directory.

3. Copy the contents of the Microsoft Dynamics AX DVD to the DynamicsAX6 directory.
4. Copy the installation files for cumulative updates and hotfixes to the directory. For more information about how to include updates, see the Include cumulative updates and hotfixes in a new installation (slipstreaming) section.
Include cumulative updates and hotfixes in a new installation (slipstreaming)

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

If you are installing Microsoft Dynamics AX components for the first time, and cumulative updates, binary hotfixes, or service packs for Microsoft Dynamics AX are available, you can incorporate the updates into the installation by using a process that is known as slipstreaming. When updates are slipstreamed, Setup automatically detects and applies them. In this way, the time that is required to install the whole Microsoft Dynamics AX solution is reduced.

Note

Components that were previously installed are not updated during a later slipstream installation. For example, an instance of Application Object Server (AOS) is installed on a server. Later, you add updates to the installation source, and you also install another Microsoft Dynamics AX component on the same server. In this scenario, the existing AOS instance is not updated.

You can slipstream the following kinds of updates:

- Cumulative updates
- Binary hotfixes
- Help content updates
- Service packs

Application (database) hotfixes cannot be included in the slipstreaming process. They must be installed by using AxUpdate.exe.

The Updates folder

Before you install Microsoft Dynamics AX, you copy the DVD to a network location. This lets you modify the installation media to create a slipstream installation. Incorporate updates into the installation process by copying files to the Updates folder in the shared network location.

Note

For more information about how to install Microsoft Dynamics AX from a shared network folder, see the Create a shared directory for installation section.

In the Updates folder, create a subfolder for each update package that you download. We recommend that you use the Knowledge Base article numbers of the updates as the names of the subfolders. For example, for the update that is associated with Knowledge Base article number 123456, create a subfolder that is named KB123456.
Extract each update into the appropriate subfolder. The following illustration shows an example of the recommended folder structure:

```
 AX 2012 R2 DVD
  Updates
   CU7 (KB 2885603)
     databaseupgrade
     granularmodels
     licenseterms
   models
   msi
   support
   Hotfix (KB 456491)
     licenseterms
     msi
     support
```

Any time that you apply a cumulative update package or a binary hotfix to your environment, we strongly recommend that you add the installation package to the Updates folder. This practice ensures that you can deploy new servers, clients, and other components of the correct version quickly. You should also make a copy of the updated installation media per your system recovery strategy.

**The slipstreaming process**

The following is a high-level overview of the slipstreaming process:

1. To find cumulative updates:
   - For AX 2012 R3, go to Microsoft Dynamics Lifecycle Services, and after selecting a project, click Updates. In the **Updates to include with new installations** section, select the slipstreamable update package that you want, and download it.
   - For AX 2012 R2 or earlier, visit the hotfix pages for Microsoft Dynamics AX 2012 or Microsoft Dynamics AX 2012 R2 on the CustomerSource website. Logon is required.
2. Create a shared network location from which to install Microsoft Dynamics AX.
3. In the Updates folder, create a subfolder for each update package that you download. Then extract each update into the appropriate subfolder.
4. Run Setup and select the components that you want to install. Setup detects and installs the updates.
   - Follow the usual installation procedures to install Microsoft Dynamics AX components. For detailed installation instructions for each Microsoft Dynamics AX 2012 component, see see Install Microsoft Dynamics AX 2012 TechNet.
   - To install updates for Help content, you must select the Help Server component, and then select the updated content sets on the Language and content selection page.
Verify that you have the required permissions for installation

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Before you begin the installation of Microsoft Dynamics AX, work with a system administrator to make sure that the account that you log on with at each server has appropriate permissions. The permissions in the following table are recommended based on the principle of least privilege.

In all cases, you must be a member of the **Administrators** group on the local computer where you are installing a component. The following table lists the permissions that are required in addition to administrator access on the local computer.

<table>
<thead>
<tr>
<th>Component</th>
<th>Additional permissions that are required to install the component</th>
</tr>
</thead>
</table>
| Databases                                | • Membership in the `dbcreator` role in Microsoft SQL Server  
                                         • Membership in the `securityadmin` server role in SQL Server  
                                         • Membership in the `db_accessadmin` database role in SQL Server for the Microsoft Dynamics AX database  
                                         If you install the databases remotely from a computer other than the database server, you must log on to the remote computer by using an account that is an administrator on the SQL Server computer. Setup requires access to SQL Server services. |
| Application Object Server (AOS)          | Membership in the `sysadmin` role on the instance of SQL Server that you want to connect to |
| Enterprise Portal for Microsoft Dynamics AX | • Membership in the **System administrator** role in Microsoft Dynamics AX  
                                          • Membership in the **Administrators** group in Windows on the Web server  
                                          • Membership in the **Farm Administrators** group in Microsoft SharePoint 2010 products  
                                          • Membership in the `dbcreator` role on the instance of SQL Server that is used for SharePoint 2010 products  
                                          • Membership in the `WSS_Content_Application_Pools` database role in the SharePoint_Config database |
| Enterprise Search                        | • Membership in the **System administrator** role in Microsoft Dynamics AX  
                                          • Membership in the **Administrator** group in Microsoft SharePoint Services  
                                          • Membership in the `dbcreator` role on the instance of SQL Server that is used for Microsoft SharePoint Services |
| Help server                              | Membership in the **System administrator** role in Microsoft Dynamics AX |
| Management Reporter (server components) | • Membership in the `sysadmin` role on the instance of SQL Server that you want to connect to.  
                                          • To finish the initial configuration of Management Reporter, membership is required in the **Administrator** role in Management Reporter. |
| Microsoft SQL Server Reporting Services extensions | Membership in the **System administrator** role in Microsoft Dynamics AX |
| Microsoft SQL Server Analysis Services configuration | • Membership in the **System administrator** role in Microsoft Dynamics AX  
                                          • Membership in the SQL Server `securityadmin` server role  
                                          • Membership in the SQL Server `db_owner` database role for the Microsoft Dynamics AX database |
<p>| Client                                   | None |</p>
<table>
<thead>
<tr>
<th>Component</th>
<th>Additional permissions that are required to install the component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office add-ins</td>
<td>None</td>
</tr>
<tr>
<td>Remote Desktop Services integration</td>
<td>None</td>
</tr>
<tr>
<td>Report Designer for Management Reporter (client component)</td>
<td>None</td>
</tr>
<tr>
<td>Debugger</td>
<td>None</td>
</tr>
<tr>
<td>Visual Studio Tools</td>
<td>None</td>
</tr>
<tr>
<td>Trace Parser</td>
<td>None</td>
</tr>
<tr>
<td>Web services on Internet Information Services (IIS)</td>
<td>Membership in the <strong>System administrator</strong> role in Microsoft Dynamics AX</td>
</tr>
<tr>
<td>.NET Business Connector</td>
<td>None</td>
</tr>
<tr>
<td>Synchronization proxy</td>
<td>• Membership in the <strong>dbowner</strong> database role in the SQL Server database for Microsoft Project Server&lt;br&gt;• Membership in the <strong>System administrator</strong> role in Microsoft Dynamics AX</td>
</tr>
<tr>
<td>Synchronization service</td>
<td>Membership in the <strong>System administrator</strong> role in Microsoft Dynamics AX</td>
</tr>
<tr>
<td>Management utilities</td>
<td>None</td>
</tr>
<tr>
<td>Retail Headquarters</td>
<td>None</td>
</tr>
<tr>
<td>Retail POS</td>
<td>None</td>
</tr>
<tr>
<td>Commerce Data Exchange: Synch Service (Retail Store Connect)</td>
<td>To install Synch Service, no additional permissions are required. To configure Synch Service, membership is required in the <strong>sysadmin</strong> role on the instance of SQL Server that you want to connect to.</td>
</tr>
<tr>
<td>Commerce Data Exchange: Real-time Service (Retail Transaction Service)</td>
<td>None</td>
</tr>
<tr>
<td>Commerce Data Exchange: Async Server</td>
<td>To install Async Server, no additional permissions are required. To configure Async Server, membership is required in the <strong>sysadmin</strong> role on the instance of SQL Server that you want to connect to.</td>
</tr>
<tr>
<td>Commerce Data Exchange: Async Client</td>
<td>To install Async Client, no additional permissions are required. To configure Async Client, membership is required in the <strong>sysadmin</strong> role on the instance of SQL Server that you want to connect to.</td>
</tr>
<tr>
<td>Retail Channel Configuration Utility (Retail Store Database Utility)</td>
<td>To install the utility, no additional permissions are required. To configure databases, membership is required in the <strong>sysadmin</strong> role on the instance of SQL Server that you want to connect to.</td>
</tr>
<tr>
<td>Retail SDK (Retail POS Plug-ins)</td>
<td>None</td>
</tr>
<tr>
<td>Retail Online Channel</td>
<td>None</td>
</tr>
<tr>
<td>Retail Server</td>
<td>None</td>
</tr>
<tr>
<td>Retail mass deployment toolkit</td>
<td>None</td>
</tr>
<tr>
<td>Modern POS</td>
<td>None</td>
</tr>
</tbody>
</table>
### Check prerequisites

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Run the prerequisite validation utility for Microsoft Dynamics AX to determine whether a computer meets the requirements to install a Microsoft Dynamics AX component. You can run the utility before you install any components in your environment. If requirements are not met, the utility helps you install or configure most prerequisites. Additionally, you can view or print a report that shows the results of the prerequisite validation. Prerequisite validation is also built into Setup. Therefore, the same prerequisites are validated when you install a component by using the Setup wizard.

**Note**

The prerequisite validation utility validates the software prerequisites that Microsoft Dynamics AX depends on. However, the utility does not verify whether Microsoft Dynamics AX components that are also required are installed or configured. For example, the utility verifies whether a supported version of Windows is installed, but does not verify whether an Application Object Server (AOS) is running in the environment. Prerequisite Microsoft Dynamics AX components are validated when you run Setup.

To review the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](https://microsoft.com) on Microsoft.com.

Use the following procedure to run the prerequisite validation utility.

1. Start Microsoft Dynamics AX Setup.
2. Under **Prepare**, click **Validate system requirements**.
   
   **Note**

   To avoid errors, run only one instance of the utility at a time.

3. The **Prerequisite validation** page is displayed. Select the components that you plan to install on the local computer, and then click **Next**.

---

<table>
<thead>
<tr>
<th>Component</th>
<th>Additional permissions that are required to install the component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retail channel database</td>
<td>None</td>
</tr>
<tr>
<td>Retail hardware station</td>
<td>None</td>
</tr>
<tr>
<td>RapidStart Connector</td>
<td>None</td>
</tr>
<tr>
<td>Warehouse Mobile Devices Portal</td>
<td>None</td>
</tr>
<tr>
<td>Data Import/Export Framework</td>
<td>- Membership in the <code>dbdatareader</code> and <code>dbdatawriter</code> roles on the instance of SQL Server that you want to connect to</td>
</tr>
<tr>
<td></td>
<td>- Membership in the <strong>System administrator</strong> role in Microsoft Dynamics AX</td>
</tr>
<tr>
<td>VSS writer</td>
<td>Membership in the <strong>Administrators</strong> group on the computer where Microsoft System Center 2012 Data Protection Manager (DPM) is installed</td>
</tr>
<tr>
<td>Connector for Microsoft Dynamics</td>
<td>- Permission to query for entries in Active Directory</td>
</tr>
<tr>
<td></td>
<td>- Membership in the SQL Server <code>dbcreator</code> server role</td>
</tr>
<tr>
<td></td>
<td>- Membership in the SQL Server <code>securityadmin</code> server role</td>
</tr>
<tr>
<td></td>
<td>- Membership in the SQL Server <code>sysadmin</code> database role on the SQL Server instance that hosts the Microsoft Dynamics Integration (MSDI) database</td>
</tr>
</tbody>
</table>
4. The Prerequisite validation results page is displayed. Each prerequisite is assigned one of the following statuses.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The local computer meets the prerequisite.</td>
</tr>
<tr>
<td></td>
<td>![Check Mark]</td>
</tr>
<tr>
<td>Error</td>
<td>The local computer does not meet the prerequisite. You cannot install the component until this prerequisite is installed or configured.</td>
</tr>
<tr>
<td></td>
<td>![X Mark]</td>
</tr>
<tr>
<td>Warning</td>
<td>The local computer does not meet the prerequisite, but you can still install the Microsoft Dynamics AX component.</td>
</tr>
<tr>
<td></td>
<td>![Warning Triangle]</td>
</tr>
</tbody>
</table>

5. For more information about a prerequisite, click its status. For information about all the prerequisites that were validated, click View report to display the Microsoft Dynamics AX Prerequisite check report. Both options provide a description of the prerequisite, the validation status, and recommendations for resolving any problems.

6. Resolve prerequisite issues. For many errors and warnings, the prerequisite validation utility can attempt to resolve the issue for you.
   - If a link is available in the Download column, click it to download and install the missing prerequisite. Internet access is required to download some prerequisites that are not included on the installation media. In some cases, the download starts immediately when you click the link. In other cases, a download page is displayed when you click the link.
     
     **Note**
     
     If network or computer security prevents a prerequisite from being downloaded from the utility, you must download the prerequisite by using another method. Click the Error link on the prerequisite validation page to obtain the download URL.
     
   - If a check box is available in the Configure column, select it, and then click the Configure button to resolve the issue.

Some prerequisites depend on other prerequisites. In these cases, the prerequisites must be installed or configured in a specific order. For example, the Windows Search Service must be installed before it can be started.

7. After you have resolved prerequisite issues, click Revalidate to run the prerequisite validation again.

8. When you have finished validating prerequisites, click Close.

**Important**

Prerequisite software that is installed or configured by the prerequisite validation utility may not include the latest updates. We strongly recommend that you run Windows Update to identify and install the latest updates before you continue with the installation of Microsoft Dynamics AX.

**See also**

- Troubleshoot prerequisite issues
Install the databases

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This chapter describes how to configure Microsoft SQL Server and install the Microsoft Dynamics AX databases.

Configure SQL Server and storage settings

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides information about how to configure Microsoft SQL Server to support the business and model store databases for Microsoft Dynamics AX. To achieve optimal Microsoft Dynamics AX performance, you must correctly configure the database infrastructure.

This section does not describe how to configure the infrastructure for reporting and analytics databases. For information about those features, see Reporting in Microsoft Dynamics AX and Analytics in Microsoft Dynamics AX on TechNet.

This information is designed for Microsoft Dynamics AX administrators and Microsoft SQL Server database administrators who are responsible for administration of the Microsoft Dynamics AX application.

To benefit from this section, you must have knowledge in the following areas:

- Windows Server administration.
- SQL Server administration. Specific areas of knowledge include advanced configuration options, memory management, performance management, and troubleshooting.
- Microsoft Dynamics AX system administration.

Minimal SQL Server infrastructure

The configuration of Windows Server and SQL Server greatly affects the performance of the Microsoft Dynamics AX business database. This section provides detailed recommendations for the configuration of Windows Server and SQL Server.

The configuration recommendations are based on the following assumptions:

- You are following the documented best practices for Windows Server and SQL Server.
- You are using a dedicated server that runs SQL Server 2008 R2.
- You are using a single instance of SQL Server that is dedicated to running the Microsoft Dynamics AX production databases.
  - We recommend that you store your test and development databases on a separate server from the production databases.

Configuring Windows Server

Verify that SQL Server is configured to run as a background service in Windows.

1. In Windows Server 2008 R2, in Control Panel, click System and Security, and then click System.
2. Click Advanced system settings.
3. On the Advanced tab, under Performance, click Settings.
4. On the **Advanced** tab, under **Processor scheduling**, select **Background services**, and then click **OK**.

## Configuring the server that runs SQL Server

In addition to the documented best practices for SQL Server, we recommend the following configuration settings for the SQL Server service.

- Run the SQL Server service under an Active Directory domain account that has the minimum necessary privileges. For more information, see [SQL Server 2008 Security Overview for Database Administrators](https://www.microsoft.com) on Microsoft.com.
- Confirm that the account for the SQL Server service has been granted the **Lock pages in memory** privilege. We recommend this setting, because it significantly affects whether other processes affect SQL Server. For instructions, see [How to: Enable the Lock Pages in Memory Option (Windows)](https://www.microsoft.com) on Microsoft.com. For more information, see the following webpages:
  - The [Microsoft Customer Service and Support (CSS) SQL Server Engineers blog](https://www.microsoft.com)
  - Knowledge base article 981483, [How to reduce paging of buffer pool memory in the 64-bit version of SQL Server](https://www.microsoft.com)
  - [Slava Oks’s WebLog](https://www.microsoft.com)
- Configure the account for the SQL Server service for instant file initialization. Instant file initialization is only available if the account for the SQL Server service, MSSQLSERVER, has been granted the SE_MANAGE_VOLUME_NAME right. Members of the Windows Administrator group have this right and can grant it to other users by adding them to the Perform Volume Maintenance Tasks security policy. For more information, see [Database file initialization](https://www.microsoft.com) on Microsoft.com.
- Enable the TCP/IP network protocol. Depending on the edition of SQL Server that you use, this protocol may be automatically installed during installation. For instructions, see [How to: Enable or Disable a Server Network Protocol (SQL Server Configuration Manager)](https://www.microsoft.com) on Microsoft.com.
- Disable hyperthreading. This step must be performed in the BIOS settings of the server. For instructions, see the hardware documentation for your server.

## Configuring the instance of SQL Server

In addition to the documented best practices for SQL Server, we recommend the following storage settings for the instance of SQL Server.

### Configuring max degree of parallelism

The **max degree of parallelism** option is a setting that affects the entire instance of SQL Server. Microsoft Dynamics AX workloads generally perform better when intra-query parallelism is disabled. However, the upgrade process benefits from parallelism, as do activities that are used exclusively for batch jobs or maintenance. Use the following settings when the system performs maintenance activities or an upgrade:

- Before an upgrade to a new release of Microsoft Dynamics AX, or before a large number of maintenance or batch activities, set **max degree of parallelism** to the smallest of the following values:
  - 8
  - The number of physical processor cores
  - The number of physical processor cores per non-uniform memory access (NUMA) node
- When the Microsoft Dynamics AX database is used in a production environment, set **max degree of parallelism** to 1.
Use the following statements to set the value of **max degree of parallelism**.

Examine the output from the second `sp_configure 'max degree of parallelism'` statement, and confirm that the value has been changed. In the following query, the first `sp_configure 'max degree of parallelism'` statement sets the value of **max degree of parallelism** to 1. The second `sp_configure 'max degree of parallelism'` statement returns a value of 1.

```sql
EXEC sp_configure 'show advanced options', 1;
RECONFIGURE;
GO
EXEC sp_configure 'max degree of parallelism', 1;
RECONFIGURE;
GO
EXEC sp_configure;
```

For more information, see [max degree of parallelism Option](https://docs.microsoft.com) on Microsoft.com. For general guidelines, see Knowledge base article 329204, [General guidelines to use to configure the MAXDOP option](https://support.microsoft.com). For tips from the SQL Server team, visit the SQL Server Relational Engine team’s blog, [SQL Server Engine Tips](https://learn.microsoft.com).

**Configuring max server memory**

SQL Server dynamically acquires and frees memory as required. Typically, an administrator does not have to specify how much memory is allocated to SQL Server. However, the **max server memory** option can be useful in some environments. Make sure that sufficient memory is available for the operation of Windows Server. For more information, see the Configure SQL Server and storage settings section.

If you find that the dynamic allocation of memory adversely affects the operation of Windows Server, adjust the value of **max server memory** based on the available random access memory (RAM). For more information, see [Effects of min and max server memory](https://learn.microsoft.com) on Microsoft.com.

**Monitoring available memory**

Make sure that sufficient memory is available for the operation of Windows Server. For example, make sure that you run a dedicated instance of SQL Server on a server that has at least 4 gigabytes (GB) of memory. If the available memory for the server drops below 500 megabytes (MB) for extended periods, the performance of the server may degrade.

Use the **Memory: Available Mbytes** performance counter for the Windows Server operating system to determine whether the available memory drops below 500 MB for extended periods. If the available memory drops below 500 MB frequently or for extended periods, we recommend that you reduce the **max server memory** setting for SQL Server or increase the physical memory of the server.

Detailed guidance about memory management is beyond the scope of this section. For more information about how to monitor memory and troubleshoot performance issues, see the Windows Server and SQL Server documentation.

**Allocating storage for tempdb**

We recommend that you determine the total size of the data files and transaction log files that are required for the tempdb database, and that you set a specific value. Do not use automatic growth, or autogrow, setting for space management. Instead, use autogrow as a safety mechanism, so that tempdb can grow if tempdb files use
the space that was originally allocated to them. Follow this process to determine the number and placement of data files.

- Determine the number of processors that are available to SQL Server. Unless you are using an affinity mask, this number is the same as the total number of processors that you see on the Performance tab of Windows Task Manager. When hyperthreading is not enabled, each processor corresponds to a processor core. Affinity masks and processor cores are beyond the scope of this section. For more information, see the Windows Server and SQL Server documentation.

- Based on performance testing of the OLTP workload for Microsoft Dynamics AX, we recommend that you maintain one tempdb data file per processor. For more information, see the performance benchmark reports on PartnerSource or CustomerSource.

- Isolate tempdb on dedicated storage, if you can. We recommend that you move the primary data file and log file for tempdb to high-speed storage, if high-speed storage is available. The Microsoft Dynamics AX database runs in read committed snapshot isolation (RCSI) mode. In RCSI mode, row versions are stored in tempdb. By creating multiple files for tempdb data, even if these files reside on the same storage device, you can improve the performance of tempdb operations.

- Determine the size of the tempdb data files and log files. You must create one primary data file and one log file. Determine how many additional, secondary data files you require for the tempdb data. For best results, create data files of equal size. The total number of data files must equal the total number of processor cores. The aggregate size of the primary data file and all other data files must equal the total data size that you determined for the tempdb database.

  For more information, see Optimizing tempdb performance on Microsoft.com.

- Resize the primary data file and log file for tempdb. Move the primary data file and log file to dedicated storage, if dedicated storage is available. The primary tempdb data file cannot be moved while the instance of SQL Server is running. To complete the move, you must use an ALTER DATABASE statement and restart the instance of SQL Server. For more information, see ALTER DATABASE on Microsoft.com.

  ✓ Note

  The data files and transaction log files for tempdb can reside on the same storage device.

- If space is available on the drive where tempdb files are allocated, do not configure the autogrow property for data files and log files as a percentage. Instead, configure the autogrow property as a specific number of megabytes. If you can, configure the data files and log files to grow by 100 to 500 MB, depending on the available space. Monitor the data files, and when they grow, adjust the original allocation to prevent automatic growth later. If the autogrow property is configured in megabytes instead of as a percentage, the allocation of space is more predictable, and the chance of extremely small or large growth increments is reduced.

- Monitor the tempdb data files and log files to make sure that they are all sized correctly, and that all data files are of equal size. Use SQL Server Management Studio or a transact-SQL query to view the database properties. Verify that all the data files are of equal size, and that they have the same size as the value that you originally provided. If one or more files have grown, adjust the initial size of all files.
Configuring the Microsoft Dynamics AX business database

We recommend the following settings for the Microsoft Dynamics AX business database. You can use SQL Server Management Studio or the appropriate ALTER DATABASE statement to configure these settings. For more information, see ALTER DATABASE on Microsoft.com.

- Set COMPATIBILITY_LEVEL to 110 for SQL Server 2012, or to 100 for SQL Server 2008 or SQL Server 2008 R2.
- Set READ_COMMITTED_SNAPSHOT to on. Performance testing has shown that Microsoft Dynamics AX performs better when the READ_COMMITTED_SNAPSHOT isolation option is set to on. You must use an ALTER DATABASE statement to set this option. This option cannot be set by using SQL Server Management Studio.

Run the following query, where <database name> is the name of the Microsoft Dynamics AX database. There can be no other active connections in the database when you run this query.

```
ALTER DATABASE <database name>
    SET READ_COMMITTED_SNAPSHOT ON;
```

Query the sys.databases catalog view, and verify that the Microsoft Dynamics AX database contains a value of 1 in the is_read_committed_snapshot_on column. For more information, see the following webpages:

- sys.databases
- Choosing Row Versioning-based Isolation Levels

- Set AUTO_CREATE_STATISTICS and AUTO_UPDATE_STATISTICS to on. Set AUTO_UPDATE_STATISTICS_ASYNC to off. Performance testing has shown that Microsoft Dynamics AX performs better when the options have these settings.

- Make sure that the AUTO_SHRINK option is set to off. When database files are automatically shrunk, performance of the database degrades. We recommend that the database administrator manually shrink the database files on a predefined schedule. For more information, see Turn AUTO_SHRINK OFF! on the SQL Server Storage Engine Team’s blog.

⚠️ Important

All Microsoft Dynamics AX databases must use the same SQL collation. These databases include the business database, model store database, Microsoft SQL Server Reporting Services database, and Microsoft SQL Server Analysis Services database.

Plan database storage

Designing a data storage solution involves multiple interrelated aspects. We recommend that you follow this process when you must complete this task.

1. Characterize the input/output (I/O) load of the application. The I/O characteristics depend on your business requirements, and on the Microsoft Dynamics AX modules and components that you deploy. To determine your I/O characteristics, answer the following questions:
   - What is the read ratio versus write ratio of the application?
   - What is the typical I/O volume, or I/O per second (IOPs)?
   - How much of the I/O is sequential, and how much is random?
2. Determine the availability and performance requirements for the database system.
3. Determine the hardware that is required to support the analysis that you performed made in steps 1 and 2.
4. Configure SQL Server to take advantage of the hardware that you determined in step 3.
5. Track the performance as the workload changes.
Step-by-step guidance about database architecture and storage is beyond the scope of this section. For more detailed recommendations from the SQL Server team, see Microsoft SQL Server Storage Top 10 Best Practices and Physical Database Storage Design on Microsoft.com.

Configuring physical storage

This section provides general recommendations for physical storage. Determine the applicability of these recommendations to your environment. Some storage area network (SAN) vendors may have alternative recommendations that take precedence. Recommendations are listed in order of priority.

- Many factors contribute to optimal I/O performance for a disk. By default, Windows Server 2008 aligns partitions. When you upgrade to Windows Server 2008, preexisting partitions are not automatically aligned and must be manually rebuilt to guarantee optimal performance. Therefore, until you rebuild the migrated partitions, alignment of disk partitions remains a relevant technology.

  Check existing disks on the server, and be aware of the differences in the analysis of basic partitions and dynamic volumes. Rebuild the partitions, if you can, and appropriate and create all new partitions based on guidance from the SAN vendor. If the vendor does not provide recommendations, follow the best practices for SQL Server. See Disk Partition Alignment Best Practices for SQL Server on Microsoft.com.

  The partition offset value must be a multiple of the stripe size. In other words, the expression, \( \text{partition offset} / \text{stripe size} \), must resolve to an integer value.

- Create the tempdb database files, data files for the Microsoft Dynamics AX database, and Microsoft Dynamics AX log files on disk arrays of type RAID 1, RAID 0 + 1, or RAID 10. We recommend RAID 10 for these files. Do not use RAID 5.

- Store the data files for the Microsoft Dynamics AX database on separate physical stores from the transaction log files.

- Store the tempdb data files on a separate physical store from the data files and log files for the Microsoft Dynamics AX database.

- Store other database files on separate physical stores from the data files and log files for tempdb and the Microsoft Dynamics AX database.

Summary

To help achieve optimal Microsoft Dynamics AX performance, you must correctly plan and configure and the settings for SQL Server and storage. Additionally, you may have to adjust the database configuration periodically.

See also

- System architecture (on TechNet)
- Planning hardware infrastructure (on TechNet)
- Reporting in Microsoft Dynamics AX (on TechNet)
- Analytics in Microsoft Dynamics AX (on TechNet)
- Microsoft Dynamics AX Performance Team’s blog (on Microsoft.com)

Install the Microsoft Dynamics AX databases

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install the Microsoft Dynamics AX databases and model files.
There are three database components: the Microsoft Dynamics AX transaction database, the model store, and the baseline model store. The Application Object Server (AOS) connects to the Microsoft Dynamics AX database to process transactions. The AOS connects to the model store to display forms and reports. The baseline model store is used to upgrade X++ code to Microsoft Dynamics AX 2012, and to analyze application updates before they are applied.

In Microsoft Dynamics AX 2012 R3 and Microsoft Dynamics AX 2012 R2, the model store and the transaction data are stored in separate databases. In earlier versions of Microsoft Dynamics AX 2012, the model store and transaction data are stored in a single database.

Note

If you are upgrading databases between AX 2012, AX 2012 Feature Pack, AX 2012 R2, and AX 2012 R3, you should review Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3 on TechNet.

Model files contain metadata information about application objects and are stored in the model store. For more information about model files, see Models, Layers, and the Model Store on TechNet.

Caution

If you plan to enable database mirroring in Microsoft SQL Server, you must enable it after you install the Microsoft Dynamics AX database and AOS. If you enable database mirroring before you install Microsoft Dynamics AX components, warnings are generated when the AOS is installed.

Before you install the Microsoft Dynamics AX databases

Verify that the following steps are completed before you install the Microsoft Dynamics AX databases.

- Configure SQL Server. For more information, see the Configure SQL Server and storage settings section.
- On the computer where you plan to install the databases, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.
- Make sure that you have the required permissions to install the database. For more information, see the Verify that you have the required permissions for installation section.
- Make sure that the appropriate firewall ports are open. For more information, see the Firewall settings for Microsoft Dynamics AX components chapter.

Default models

The default models that are available in Setup vary based on the release of Microsoft Dynamics AX 2012 that you are installing.

Default models in AX 2012 R3 and Microsoft Dynamics AX 2012 R2

If you are installing AX 2012 R3 or AX 2012 R2, the following models are available in Setup by default.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>The base Microsoft Dynamics AX model, which contains the application framework, the core application, extensions for industries, and localizations for countries/regions. This model is required.</td>
</tr>
<tr>
<td>Model</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Foundation Upgrade</td>
<td>The model that is used to upgrade from Microsoft Dynamics AX 2009 or</td>
</tr>
<tr>
<td></td>
<td>Microsoft Dynamics AX 4.0.</td>
</tr>
<tr>
<td>Foundation Labels</td>
<td>Application labels for the foundation model. This model includes labels for</td>
</tr>
<tr>
<td></td>
<td>the following languages:</td>
</tr>
<tr>
<td></td>
<td>- Arabic (Saudi Arabia)</td>
</tr>
<tr>
<td></td>
<td>- Chinese (China)</td>
</tr>
<tr>
<td></td>
<td>- Czech (Czech Republic)</td>
</tr>
<tr>
<td></td>
<td>- Danish (Denmark)</td>
</tr>
<tr>
<td></td>
<td>- Dutch (Belgium and The Netherlands)</td>
</tr>
<tr>
<td></td>
<td>- English (Australia, Canada, India, Ireland, Malaysia, New Zealand,</td>
</tr>
<tr>
<td></td>
<td>Singapore, South Africa, United Kingdom, and United States)</td>
</tr>
<tr>
<td></td>
<td>- Estonian (Estonia)</td>
</tr>
<tr>
<td></td>
<td>- Finnish (Finland)</td>
</tr>
<tr>
<td></td>
<td>- French (Belgium, Canada, France, and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- German (Austria, Germany, and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- Hungarian (Hungary)</td>
</tr>
<tr>
<td></td>
<td>- Icelandic (Iceland)</td>
</tr>
<tr>
<td></td>
<td>- Italian (Italy and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- Japanese (Japan)</td>
</tr>
<tr>
<td></td>
<td>- Latvian (Latvia)</td>
</tr>
<tr>
<td></td>
<td>- Lithuanian (Lithuania)</td>
</tr>
<tr>
<td></td>
<td>- Norwegian Bokmal (Norway)</td>
</tr>
<tr>
<td></td>
<td>- Polish (Poland)</td>
</tr>
<tr>
<td></td>
<td>- Portuguese (Brazil)</td>
</tr>
<tr>
<td></td>
<td>- Russian (Russia)</td>
</tr>
<tr>
<td></td>
<td>- Spanish (Mexico and Spain)</td>
</tr>
<tr>
<td></td>
<td>- Swedish (Sweden)</td>
</tr>
<tr>
<td></td>
<td>- Thai (Thailand)</td>
</tr>
</tbody>
</table>

**Default models in Microsoft Dynamics AX 2012 Feature Pack**

If you are installing AX 2012 Feature Pack, the following models are available in Setup by default.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>The base Microsoft Dynamics AX model, which contains the application</td>
</tr>
<tr>
<td></td>
<td>framework and the application foundation. This model also contains</td>
</tr>
<tr>
<td></td>
<td>functionality for the discrete manufacturing industry. This model is</td>
</tr>
<tr>
<td></td>
<td>required.</td>
</tr>
<tr>
<td>Update for Foundation</td>
<td>Cumulative update for the Foundation model. If you selected to install</td>
</tr>
<tr>
<td></td>
<td>the Foundation model, this model is installed automatically.</td>
</tr>
<tr>
<td>Foundation Upgrade</td>
<td>The model that is used to upgrade from Microsoft Dynamics AX 2009 or</td>
</tr>
<tr>
<td></td>
<td>Microsoft Dynamics AX 4.0.</td>
</tr>
<tr>
<td>Update for Foundation</td>
<td>Cumulative update for the Foundation Upgrade model. If you selected to</td>
</tr>
<tr>
<td></td>
<td>install the Foundation Upgrade model, this model is installed automatically.</td>
</tr>
<tr>
<td>Model</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Foundation Labels</td>
<td>Application labels for the foundation model. This model includes labels for the following languages:</td>
</tr>
<tr>
<td></td>
<td>- Danish (Denmark)</td>
</tr>
<tr>
<td></td>
<td>- Dutch (Belgium and The Netherlands)</td>
</tr>
<tr>
<td></td>
<td>- English (Australia, Canada, India, Ireland, Malaysia, New Zealand, Singapore, South Africa, United Kingdom, and United States)</td>
</tr>
<tr>
<td></td>
<td>- French (Belgium, Canada, France, and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- German (Austria, Germany, and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- Italian (Italy and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- Spanish (Mexico and Spain)</td>
</tr>
<tr>
<td>Foundation Labels II</td>
<td>Application labels for the foundation model. These labels are for languages that were released after Microsoft Dynamics AX 2012 was made generally available. This model includes labels for the following languages:</td>
</tr>
<tr>
<td></td>
<td>- Arabic (Saudi Arabia)</td>
</tr>
<tr>
<td></td>
<td>- Finnish (Finland)</td>
</tr>
<tr>
<td></td>
<td>- Icelandic (Iceland)</td>
</tr>
<tr>
<td></td>
<td>- Norwegian Bokmal (Norway)</td>
</tr>
<tr>
<td></td>
<td>- Swedish (Sweden)</td>
</tr>
<tr>
<td></td>
<td>- Thai (Thailand)</td>
</tr>
<tr>
<td>SYP labels</td>
<td>Cumulative update of labels that were added by software updates in the SYP layer.</td>
</tr>
<tr>
<td>Extensions</td>
<td>Microsoft Dynamics AX extensions for the following industries:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Process Manufacturing</strong> – Process manufacturing production and logistics for Microsoft Dynamics AX. Allows you to manage production, inventory, and costs in a process-controlled environment, such as in the food, chemical, and pharmaceutical industries.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Public Sector</strong> – Addresses the special controls, rules, and regulations of Public Sector organizations.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Project Management</strong> – Allows you to invoice customers for various billing scenarios, such as billing per unit of delivery and billing when a milestone is completed. You can also create customer and vendor retentions, and manage workers on projects.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Retail</strong> – Provides mid-market and large retailers a complete head office and point of sale (POS) solution.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong></td>
</tr>
<tr>
<td></td>
<td>This model is required when you install AX 2012 Feature Pack. If the model includes functionality that you do not plan to use, turn off the appropriate license codes and configuration keys. Do not uninstall this model to remove unwanted functionality. Uninstalling models that are released by Microsoft will put the system in an unsupported state. If you have uninstalled this model, you must reinstall it using the instructions found in <a href="#">How to: Export and Import a Model</a> on TechNet.</td>
</tr>
<tr>
<td>Extensions Upgrade</td>
<td>The model that is used to upgrade Process Manufacturing, Public Sector, Project Management, or Retail from Microsoft Dynamics AX 2009 or Microsoft Dynamics AX 4.0.</td>
</tr>
</tbody>
</table>
Default models in Microsoft Dynamics AX 2012

If you are installing the original release of Microsoft Dynamics AX 2012, the following models are available in Setup by default.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>The base Microsoft Dynamics AX model, which contains the application framework and the application foundation. This model also contains functionality for the discrete manufacturing industry. This model is required.</td>
</tr>
<tr>
<td>Foundation Upgrade</td>
<td>The model that is used to upgrade from Microsoft Dynamics AX 2009 or Microsoft Dynamics AX 4.0.</td>
</tr>
<tr>
<td>Foundation Labels</td>
<td>Application labels for the foundation model. This model includes labels for the following languages:</td>
</tr>
<tr>
<td></td>
<td>- Danish (Denmark)</td>
</tr>
<tr>
<td></td>
<td>- Dutch (Belgium and The Netherlands)</td>
</tr>
<tr>
<td></td>
<td>- English (Australia, Canada, Ireland, Malaysia, New Zealand, Singapore, South Africa, United Kingdom, and United States)</td>
</tr>
<tr>
<td></td>
<td>- French (Belgium, Canada, France, and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- German (Austria, Germany, and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- Italian (Italy and Switzerland)</td>
</tr>
<tr>
<td></td>
<td>- Spanish (Mexico and Spain)</td>
</tr>
<tr>
<td>Process Manufacturing</td>
<td>The model that contains features for Process manufacturing production and logistics for Microsoft Dynamics AX. You can use these features to manage production, inventory, and costs in a process-controlled environment, such as in the food, chemical, and pharmaceutical industries.</td>
</tr>
<tr>
<td>Process Manufacturing Upgrade</td>
<td>The model that is used to upgrade Process manufacturing production and logistics from Microsoft Dynamics AX 2009 or Microsoft Dynamics AX 4.0.</td>
</tr>
<tr>
<td>Public Sector</td>
<td>The Public Sector model for Microsoft Dynamics AX. This model addresses the special controls, rules, and regulations of Public Sector organizations.</td>
</tr>
<tr>
<td>Project Management</td>
<td>The model that contains additional project-related features for Microsoft Dynamics AX. You can use these features to invoice customers for various billing scenarios, such as billing per unit of delivery and billing when a milestone is completed. You can also use these features to create customer and vendor retentions, and to manage workers on projects.</td>
</tr>
<tr>
<td>Project Management Upgrade</td>
<td>The model that is used to upgrade Project Management from Microsoft Dynamics AX 2009 or Microsoft Dynamics AX 4.0.</td>
</tr>
</tbody>
</table>
Follow these steps to include additional models in the installation:

1. Browse to the directory where the files from the Microsoft Dynamics AX DVD are shared. For more information, see the Create a shared directory for installation section.
2. Create a subfolder in the CD\Models\ folder. We recommend that you create different folders to store the models that are received from different sources. For example, create a folder for each independent software vendor (ISV) or each value-added reseller (VAR).
3. Copy the additional .axmodel files to the folders that you created.

⚠️ Caution

Do not copy your model files to the Standard folder. The Standard folder must be used only for models that are mandatory, such as the Foundation model (Foundation.axmodel).

Install the Microsoft Dynamics AX databases

Use this procedure to install the Microsoft Dynamics AX databases and model files. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you're installing AX 2012 R3, on the Select an installation option page, click Microsoft Dynamics AX, and then click Next.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Databases, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Select databases page, select whether you want to create new databases by using Setup, or whether you want to configure existing databases. If you are upgrading, you should select to configure existing databases.
9. If you want Setup to create the databases, on the Create new databases page, in the Server name list, select the name of the computer that runs SQL Server. Provide database names or accept the default database names. By default, the transaction database is named MicrosoftDynamicsAX. The baseline database is optional. By default, the baseline database is named MicrosoftDynamicsAX_baseline.

If you created the databases manually, or if you are upgrading a database, on the Configure existing databases page, select the name of the computer that runs SQL Server, and then select the names of the existing databases that you want to configure.

⚠️ Important

The database name must not include any spaces or any of the following characters: backslashes (\), slashes (/), periods (.), commas (,), colons (:), brackets ([ ]), parentheses ([ ]), or hyphens (-). For more information about characters that are allowed by SQL Server, see the Identifiers topic on MSDN.

Click Next.
10. On the **Select additional models** page, select models in the **Available Models** list. Setup lists all the models that are contained in the Models folder and its subfolders. Required models are selected by default, and you cannot clear the selection.

**Security Note**

You may have models, or .axmodel files, that are not electronically signed. The Setup program cannot verify the publisher of an unsigned model file. If you import an unsigned model file into the model store, you create a security risk. Setup displays an error message if a selected model file does not have a digital signature. Before you decide whether you want to continue or cancel the installation, carefully review the models that you have selected.

11. If you install models other than the Foundation models, you must complete the **Compile application** task when you run the initialization checklist. If you do not complete the **Compile application** task, you encounter errors when you run the **Synchronize database** task in the initialization checklist. For more information about the initialization checklist, see Initialize Microsoft Dynamics AX on TechNet.

12. Click **Next** to continue.

13. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

14. On the **Ready to install** page, click **Install**.

15. After the installation is completed, click **Finish** to close the wizard.

### Create a Microsoft Dynamics AX database manually

If you want to create databases manually for Microsoft Dynamics AX, you must first create databases using Setup as a template.

1. Follow the procedure above to create business and model store databases using Setup.
3. Copy all objects, users, and user permissions from the template database to the new database.
4. Manually create a second model database using SQL Server Management Studio. It must have the same name as the new business database that you created in step 2, with _model at the end of the name.
5. Copy all objects, users, and user permissions from the template database to the new database.
6. Configure an AOS instance to connect to the new business database. Installing an AOS instance sets the appropriate rights for the AOS service account on the selected database server and creates stored procedures used for session management.
7. If you want an existing AOS instance to connect to the manually created database, you must set the appropriate rights for the AOS account. Set the following permissions in the database:
   a. Make the account a login on the database server. (This login already exists if you are installing on the same SQL Server computer as the first database.)
   b. Assign the user to the db_ddladmin, db_datareader, and db_datawriter database roles.
   c. Grant the user execute rights on the createserversessions and createusersessions stored procedures.
Install server and web server components

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This chapter provides information about how to install the server and web server components for Microsoft Dynamics AX.

Install an Application Object Server (AOS) instance

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The Application Object Server (AOS) is a Windows service that controls communications among Microsoft Dynamics AX clients, databases, and applications.

Use the following sections to install an AOS instance.

Install an AOS instance

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install an Application Object Server (AOS) instance for Microsoft Dynamics AX 2012.

Note

If you are upgrading AOS instances between AX 2012, AX 2012 Feature Pack, AX 2012 R2, and AX 2012 R3, you should review Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3 on TechNet.

Before you install the AOS instance

- On the computer where you will install the AOS instance, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

  Note

  A 64-bit computer is not required to install an AOS instance. However, if you need to complete a full Common Intermediate Language (CIL) generation, such as in a development environment, a 64-bit computer is required.

- Verify that you have the appropriate permissions to install the AOS instance. For more information, see the Verify that you have the required permissions for installation section.

- If you plan to enable database mirroring in SQL Server, you must do so after installing the Microsoft Dynamics AX database and Application Object Server (AOS). If you enable database mirroring before installing Microsoft Dynamics AX components, the AOS instance will install with warnings.

- Select a service account for the AOS service. Before you install an AOS instance, you must determine which account you want the AOS service to run as. The AOS service can run as a domain account, as a managed service account, or as the Network Service account of the computer that you install the AOS service on. For more information about how to set up an account for the AOS service, see the Create service accounts section.
Choose a name for the AOS instance. We recommend that you use a uniform naming convention for all aspects of the installation, such as the database name and the name of the AOS instance. Because Microsoft Dynamics AX installations typically include one database and multiple AOS instances, make sure that the name of each AOS instance is unique but consistent with the naming convention. For example, you can use a name such as Fabrikam_DYNAX6_Live_AOS1, which includes a shortened form of your business name, the Microsoft Dynamics AX version, a code that describes the purpose of the installation, and an identifier for the AOS instance.

The instance name must not include any blank characters or any of the following characters: ampersand (&), backslash (\), slash (/), colon (:), brackets ([]), parentheses (()), angle brackets (<>), quotation marks (""), question mark (?), exclamation point (!), asterisk (*), percent (%), caret (^), or pipe (|).

You must install an initial AOS instance and complete the Initialization checklist on that instance before you install additional AOS instances. If you install additional AOS instances before you have completed the Initialization checklist those AOS instances will not start. For more information about how to install additional AOS instances, see the Install multiple AOS instances section.

### Install the first or only AOS instance

Use this procedure to install a single or first instance of AOS on a server. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages vary, based on the components that you are installing.

#### Install an AOS instance

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the initial wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you're installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Application Object Server (AOS)**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.
8. On the **Select a file location** page, select the location where you want 32-bit versions of Microsoft Dynamics AX files to be installed, and then click **Next**.
9. On the **Connect to the databases** page, in the **Server name** box, type or select the name of the Microsoft SQL Server computer. In the **Database name** box, select the name of the Microsoft Dynamics AX transaction database. Optionally, select the name of the baseline database.

If you are upgrading code or data from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009, you must select **Register database for upgrade** and select a baseline database. The Register database for upgrade option is available when you install the first AOS in the computing environment. If you install more AOSs, this option is not available. You can determine whether the database was registered for upgrade by opening the Microsoft Dynamics AX client. If the database was registered for upgrade, the Data upgrade checklist is displayed when you open the client. Click **Next**.
10. On the **Configure an Application Object Server (AOS) instance** page, assign a name to the AOS instance. Optionally, you can specify the ports that are listed in the following table.
### Port | Purpose | Default  
--- | --- | ---  
TCP/IP port | Used by other Microsoft Dynamics AX components to communicate with AOS. | 2712  
Services WSDL port | Used by external applications to access the WSDL for AOS-based Microsoft Dynamics AX Web services. | 8101  
Services endpoint port | Used by external applications to access AOS-based Microsoft Dynamics AX Web services. | 8201

11. On the **Specify an AOS account** page, select the Network Service account of the local computer (recommended only for development environments), a managed service account, or a domain account for the AOS service. If you select to use a managed service account, make sure to specify the account in the format Domain\AccountName$.

**Caution**

The process of manually changing the service account for an AOS is complicated and prone to error. For this reason, if you must change the service account for an AOS, we recommend that you uninstall and reinstall the AOS by using Setup.exe. For more information, see [Change the account used by AOS](https://technet.microsoft.com) on TechNet.

12. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

13. On the **Ready to install** page, click **Install**.

14. After the installation is complete, click **Finish** to close the wizard.

The AOS service can take several minutes to start the first time after it is installed. To determine whether the AOS service has started, click **Administrative tools** > **Services**, and review the status of the **Microsoft Dynamics AX Object Server** service.

### Start the AOS Windows service

After you install an AOS instance, you must wait for the **Microsoft Dynamics AX Object Server** Windows service to start.

By default, if a Windows service takes longer than 30 seconds to start, the system displays a message informing you that the service did not respond to a start command. The AOS Windows service can take longer than 30 seconds to start, and the lack of a response in 30 seconds can cause the service to stop. Therefore, if an AOS instance repeatedly does not start, you may want to configure the registry to give Windows services more time, such as 120 seconds, to start before the error message is displayed.

**Caution**

This section describes how to modify the registry so that the AOS Windows service has enough time to start before Windows displays an error message. Be aware that serious problems can occur if you modify the registry incorrectly. We recommend that you back up the registry before you modify it. If a problem occurs, you can restore it. For more information about how to back up and restore the registry, see [Backup and recovery](https://microsoft.com) on Microsoft.com.

1. Click **Start**, click **Run**, type **regedit**, and then click **OK**.
2. Locate and then click the following registry subkey: 
\HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control
3. Right-click **Control**, and then click **New** > **DWORD (32-Bit) Value**.
4. Right-click the new key, and then click **Rename**. Enter the name **ServicePipeTimeout**.
5. Right-click the key again, and then click **Modify**.
6. In the **Value data** text box, enter **120000**, and then click **OK**. The AOS Windows service now has 120 seconds to start before the system displays an error message.

If the AOS instance does not start after you implement this registry key, use the Microsoft Dynamics AX Server Configuration utility to verify that the AOS instance is using a unique port. Port conflicts prevent AOS instances from starting. For more information, see [Change AOS ports](#) on TechNet.

### Run the initialization checklist

After you install and start an AOS instance, and before you complete any other tasks in Microsoft Dynamics AX, you must run the initialization checklist. For more information, see [Initialize Microsoft Dynamics AX](#) on TechNet.

**See also**
- Install multiple AOS instances
- Troubleshoot installation issues with AOS

### Install multiple AOS instances

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install multiple instances of Application Object Servers (AOS) for Microsoft Dynamics AX 2012. You can install up to 99 AOS instances in your environment.

**Important**

You must install an initial AOS instance and complete the Initialization checklist on that instance before you install additional AOS instances. If you install additional AOS instances before you have completed the Initialization checklist those AOS instances will not start. For more information, see the **Install an AOS instance** section.

### Install an AOS instance on multiple computers

In most production environments, you install multiple AOS instances, each on a different server. You can use multiple AOS instances to support batch processing and load balancing. Install each AOS instance in the way that is described in the **Install an AOS instance** section, and make sure that you point every AOS instance to the same database. The first user who installs an AOS instance is automatically added to Microsoft Dynamics AX as an administrator. If subsequent AOS instances are installed by different users, you must manually add those users to the Microsoft Dynamics AX System administrator role to grant them administrative rights in Microsoft Dynamics AX.

You can use a single domain account for all instances of the AOS service, or you can specify a different account for each instance.

### Install multiple AOS instances on one computer

In some testing and development scenarios, you may want to install multiple AOS instances on the same computer. For example, if you are developing code for multiple versions of Microsoft Dynamics AX, you can install different versions of AOS side by side.

Install each AOS instance in the way that is described in the **Install an AOS instance** section. If you install an AOS instance on a server that already has an AOS instance, you must specify a unique port number for each instance.

By default, every time that you install an additional AOS instance on a computer, the TCP/IP, WSDL, and NET-TCP
port numbers are incremented by 1. If the same port number is used for more than one AOS instance on a computer, one of the AOS instances that have conflicting port numbers does not start.

See also
- Application Object Server security and protection (on TechNet)
- Configure an AOS instance as a batch server (on TechNet)
- Manage an AOS configuration (on TechNet)

Troubleshoot installation issues with AOS

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The following section provides information that can help you troubleshoot issues that you may encounter when you install Application Object Server (AOS).

**An error occurred during the install custom action step within the AOS Server installer**

If the AOS installation fails, you may receive the following message: "An error occurred during the install custom action step within the AOS Server installer." This error may indicate that the event logs on the computer have conflicting names. In this case, the following message also appears in the log file: "Only the first eight characters of a custom log name are significant, and there is already another log on the system using the first eight characters of the name given."

When AOS is installed, an event log that is named **Microsoft Dynamics AX Workflow** is created for the Workflow service. The custom action in Windows Installer that creates the Workflow event log does not verify whether an event log already exists that has the same first eight characters in the name. If another application has already created an event log that has the same first eight characters in the name, the operation to create the Workflow event log may fail. Therefore, the custom action fails, and Windows Installer rolls back the installation.

To work around this issue, you can rename the conflicting event log and attempt to install AOS again. Event logs are listed as subkeys under the following registry key: `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog`. After AOS is successfully installed, you can rename the conflicting registry key to its original name.

⚠️ **Caution**

This section describes how to modify the registry. Be aware that serious problems can occur if you modify the registry incorrectly. We recommend that you back up the registry before you modify it. Then, if a problem occurs, you can restore the registry. For more information about how to back up and restore the registry, see Microsoft Knowledge Base article number 256986.

Install Enterprise Portal

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section contains information about how to install Microsoft Dynamics AX 2012 Enterprise Portal. Use the following sections to help you install Enterprise Portal.

💡 **Note**

If you are upgrading Enterprise Portal between AX 2012, AX 2012 Feature Pack, AX 2012 R2, and AX 2012 R3, you should review **Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3** on TechNet.
Checklists for deploying Enterprise Portal sites

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides checklists that can help you deploy different types of sites in Enterprise Portal for Microsoft Dynamics AX.

See also
- Enterprise Portal architecture (on TechNet)
- Overview of Enterprise Portal for Microsoft Dynamics AX (on TechNet)

Checklist: Deploy an internal Enterprise Portal site that has Role Centers

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides checklists that can help you deploy Enterprise Portal for Microsoft Dynamics AX and Role Centers for an employee portal that is for internal use only. An employee portal for internal use only provides access to the following modules sites in Enterprise Portal. If your business or organization deploys Role Centers, users can also access their Role Center page on the Home site.

- Home site/Role Center
- Sales
- Procurement
- Employee services
- Project
- Compliance
- Service Management

User access to modules sites is determined by Microsoft Dynamics AX security roles. For a description of the features and reports that are available on each of these modules sites, see Overview of Enterprise Portal for Microsoft Dynamics AX on TechNet. If you want to deploy an employee self-service portal that gives employees access to expense management, time and attendance, and other personal information, see the Checklist: Deploy an employee self-service portal section.

The following table describes the tasks that you must complete to deploy Enterprise Portal and Role Centers. After you complete the tasks in this checklist, internal users can access the employee portal in the network.

<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
</table>
| Install Enterprise Portal. | • Install Enterprise Portal on a single server  
• Install Enterprise Portal in a web farm |
| Install Enterprise Portal Help content. | Install Enterprise Portal Help content |
| Configure security and enable users to access the Enterprise Portal site. | Checklist: Configure Enterprise Portal security (on TechNet) |
| Configure parameters for Enterprise Portal. | Specify Enterprise Portal parameters (on TechNet) |
| Configure Enterprise Portal for Role Centers. | Checklist: Configure Role Centers (on TechNet) |

See also
- Create an Enterprise Portal site (on TechNet)
• Install multiple Enterprise Portals on the same server
• Checklist: Deploy an employee self-service portal
• Checklist: Deploy an unsolicited vendor portal
• Checklist: Deploy a vendor registration portal

**Checklist: Deploy an employee self-service portal**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides checklists that can help you deploy an employee self-service portal for Enterprise Portal for Microsoft Dynamics AX. An employee self-service portal gives users access to expense management, time and attendance, and other personal information. For a complete description of the features and reports that are available on an employee self-service portal, see Overview of Enterprise Portal for Microsoft Dynamics AX on TechNet. If you want to deploy an employee portal that is for internal use only, and that gives users access to Microsoft Dynamics AX module sites and Role Centers, see the Checklist: Deploy an internal Enterprise Portal site that has Role Centers section.

The following table describes the tasks that you must complete to deploy Enterprise Portal. After you complete the tasks in this checklist, internal users can access the employee self-service portal in the network.

<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Enterprise Portal.</td>
<td>• Install Enterprise Portal on a single server</td>
</tr>
<tr>
<td></td>
<td>• Install Enterprise Portal in a web farm</td>
</tr>
<tr>
<td>Install Enterprise Portal Help content.</td>
<td>Install Enterprise Portal Help content</td>
</tr>
<tr>
<td>Configure security and enable users to access the Enterprise Portal site.</td>
<td>Checklist: Configure Enterprise Portal security (on TechNet)</td>
</tr>
<tr>
<td>Configure parameters for Enterprise Portal.</td>
<td>Specify Enterprise Portal parameters (on TechNet)</td>
</tr>
</tbody>
</table>

**See also**

• Create an Enterprise Portal site (on TechNet)
• Install multiple Enterprise Portals on the same server
• Checklist: Deploy an unsolicited vendor portal
• Checklist: Deploy a vendor registration portal

**Checklist: Deploy an unsolicited vendor portal**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

An unsolicited vendor portal enables vendor prospects to register with your company.

The following table describes tasks that you must complete to set up and configure an unsolicited vendor portal.

<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Enterprise Portal.</td>
<td>• Install Enterprise Portal on a single server</td>
</tr>
<tr>
<td></td>
<td>• Install Enterprise Portal in a web farm</td>
</tr>
<tr>
<td>Install Enterprise Portal Help content.</td>
<td>Install Enterprise Portal Help content</td>
</tr>
</tbody>
</table>
Create an Enterprise Portal public site.  
Enable guest users to access the public Enterprise Portal site.  
Configure user provisioning for vendor-add requests.  
Configure security and enable users to access the Enterprise Portal site.

See also
- Install multiple Enterprise Portals on the same server
- Checklist: Deploy a vendor registration portal

Checklist: Deploy a vendor registration portal

Applications: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides checklists that can help you deploy Enterprise Portal for Microsoft Dynamics AX for vendor access. Vendors who have registered with your business or organization can perform a variety of tasks from a vendor self-service portal. Some of the common tasks include the following:

- Update a profile
- Update contacts
- View purchase orders that have not yet been invoiced
- Request to be added to additional procurement categories
- Request to add users from your organization to the vendor self-service portal
- Create invoices from purchase orders

For a complete description of the features and reports available on a vendor portal, see Overview of Enterprise Portal for Microsoft Dynamics AX on TechNet. For information about how to deploy an unsolicited vendor portal, see the Checklist: Deploy an unsolicited vendor portal section.

Checklist for a vendor portal deployment

The following table describes tasks that you must complete to deploy Enterprise Portal.

<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Enterprise Portal.</td>
<td></td>
</tr>
</tbody>
</table>
- Install Enterprise Portal on a single server  
- Install Enterprise Portal in a web farm |
| Install Enterprise Portal Help content. | Install Enterprise Portal Help content |
| Configure Enterprise Portal security. | Checklist: Configure Enterprise Portal security (on TechNet) |
Configure Microsoft Dynamics AX to enable vendor user provisioning. Users are provisioned either as part of the user request process, or automatically through specific tasks in the user request workflow. User provisioning automates the creation of Microsoft Dynamics AX user accounts and user permission assignments. This ensures proper control of users and their access to the Vendor portal and simplifies the process of creating users.

Specify vendor roles on the External roles form.

Configure Enterprise Portal parameters

Click **System administration > Setup > Security > External roles.**

**Specify Enterprise Portal parameters** (on TechNet)

**Next step**

After you finished preparing the Enterprise Portal environment for vendor access, you must configure vendor portal pages and vendor portal workflow templates in the Microsoft Dynamics AX client. For more information, see **Configuring Enterprise Portal for vendor requests** in the Microsoft Dynamics AX online Help.

**See also**

- [Create an Enterprise Portal site](on TechNet)
- [Install multiple Enterprise Portals on the same server](on TechNet)
- [Checklist: Deploy an internal Enterprise Portal site that has Role Centers](on TechNet)
- [Checklist: Deploy an employee self-service portal](on TechNet)

**Install Enterprise Portal on a single server**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install Enterprise Portal for Microsoft Dynamics AX on a single server. Businesses and organizations typically use a single-server deployment for development environments or testing.

For information about scale-out deployments, see the [Install Enterprise Portal in a web farm](on TechNet) section. For information about how to install Enterprise Portal in an environment with two domain controllers and two firewalls for extranet deployments, see the [Install Enterprise Portal in a traditional perimeter network](on TechNet) section.

**Before you install Enterprise Portal**

Complete the following tasks before you install Enterprise Portal and Role Centers:

- If you installed a non-SYS layer model file in the Microsoft Dynamics AX environment, compile Microsoft Dynamics AX before you install Enterprise Portal. If you do not compile Microsoft Dynamics AX, the Enterprise Portal installation might fail.
- If you want to deploy Enterprise Portal in multiple languages, you must download and deploy SharePoint language packs onto the web server before you install Enterprise Portal. You can download SharePoint language packs from Microsoft.com. Enterprise Portal is currently supported in the following languages:
  - Arabic
  - Chinese (Simplified)
  - French (Belgium)
  - French (Switzerland)
To deploy Enterprise Portal in one of the languages list here, you must create a Web application in SharePoint and specify the new language. For more information, see Create an Enterprise Portal site on TechNet.

Verify that the name of the server that will host Enterprise Portal does not include an underscore, for example EPserver_1. If an Enterprise Portal server includes an underscore in the server name, lookups and webpages might display errors.

On the computer where you will install Enterprise Portal, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Verify that you have the appropriate permissions to install Enterprise Portal. If you are installing Enterprise Portal on a server that already hosts an Enterprise Portal deployment and you want to overwrite that deployment, you must have Full Control permission in SharePoint for the existing Enterprise Portal site collection. If you do not have Full Control permission, you will not be able to delete the existing site collection by using Setup. For more information about permissions, see the Verify that you have the required permissions for installation section.

If you intend to deploy multiple Enterprise Portals on the same server and those portals will connect to different Application Object Servers, then you must update the web.config file. For more information, see the Install multiple Enterprise Portals on the same server section.

For Secure Sockets Layer (SSL) encryption, you cannot install Enterprise Portal on a Web application that is already configured to use HTTP and HTTPS bindings. You must remove the HTTP binding from the site by using Internet Information Services (IIS) Manager before you install Enterprise Portal.
If you plan to use host headers, review the SharePoint documentation about host headers and web farms before you install Enterprise Portal.

⚠ Important
If you attempt to install Enterprise Portal on an existing Internet Information Services (IIS) site that is already configured to use a host header, the installation fails, unless you create a BackConnectionHostNames registry entry. For more information, see Changes to NTLM authentication for HTTPWebRequest in Version 3.5 SP1 on Microsoft.com.

Pre-installation tasks
Perform the following tasks to verify that you can deploy Enterprise Portal on the Web server.
2. Verify that you have the appropriate permissions to create sites by using SharePoint 2010 Central Administration to create a SharePoint team site.
3. Verify that you can browse the team site without prompts and resolve the URL without proxy errors or other problems.
4. If you intend to deploy or configure Enterprise Portal at a command prompt, verify that you can start the SharePoint 2010 Management Shell.

Install Enterprise Portal
This section describes how to install Enterprise Portal by using Setup. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages vary, based on the components that you are installing.

⚠ Tip
By default, when you install SharePoint, the system creates a Web application on port 80. Microsoft Dynamics AX Setup deploys an Enterprise Portal site on the port 80 Web application unless you specify a different Web application. If you do not intend to deploy Enterprise Portal on the default port-80 Web application, you must use SharePoint Central Administration to create a new Web application before you install Enterprise Portal. Also note, if you intend to deploy Enterprise Portal on a Web application that is already configured to use a host header, you must use SharePoint Central Administration to create a new Web application using the host header before you install Enterprise Portal. For any new Web application, you must specify the Business Connector proxy account as the application pool account in the Configurable list.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Enterprise Portal (EP), and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the **Select a file location** page, select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.

9. On the **Specify a location for configuration settings** page, specify whether you want Enterprise Portal to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click **Next**.

10. On the **Connect to an AOS instance** page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

    **Note**
    
    If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this screen is not displayed. Subsequent installations on this computer reuse the existing AOS connection.

11. On the **Specify Business Connector proxy account information** page, enter the password for the proxy account that is used by the .NET Business Connector. Click **Next**.

12. On the **Configure a Web site for Enterprise Portal** page, select a website. If no websites are available in the list, you must cancel Setup, create a website by using SharePoint Central Administration, and then try the installation again.

    We recommend that you select the **Configure for Windows SharePoint Services** option. If you select this option, Setup verifies that the site is a SharePoint site. If the site is not a SharePoint site, Setup extends the site in SharePoint. Setup also sets the application pool to run under the service account and sets the authentication method to Windows NTLM.

    **Important**
    
    Note the following important information about the **Create Web site** option:
    
    - Clear this option if you are installing Enterprise Portal for a public site, such as an unsolicited vendor portal. For public sites, you must create the Enterprise Portal site by using the public site template. For more information, see [Create a public Enterprise Portal site](http://technet.microsoft.com) on TechNet.
    - If you are installing Enterprise Portal for a stand-alone installation select the **Create Web site** option to create a site at the following URL: http://ServerName/sites/DynamicsAX. Setup creates a new site that uses port 80.

    Click **Next**.

    **Note**
    
    If your business or organization purchased a developer license for Microsoft Dynamics AX, you can change the URL for the website, title, and description before you complete the installation. Modify the EPSetupParams file in the Application Object Tree (AOT) ([Web > Web Files > Static Files > EPSetupParams](http://technet.microsoft.com)).

13. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

14. On the **Ready to install** page, click **Install**.

15. After the installation is complete, click **Finish** to close the wizard.

**Next steps**

**Configure the firewall on the Enterprise Portal server:** For information about the recommended firewall settings on an Enterprise Portal server, see the [Firewall settings for Microsoft Dynamics AX components](http://technet.microsoft.com) chapter.
See also

- Enterprise Portal architecture (on TechNet)
- Checklists for deploying Enterprise Portal sites

Deploy Enterprise Portal in a server farm

 Applies to: Microsoft Dynamics AX 2012 R3

This section provides information about how to install Enterprise Portal for Microsoft Dynamics AX in a server farm.

Install and configure Windows AppFabric for Enterprise Portal

 Applies to: Microsoft Dynamics AX 2012 R3

This section provides sample configurations and settings for installing Windows Server AppFabric with Enterprise Portal for Microsoft Dynamics AX. (For more information about AppFabric, see Introducing Windows Server AppFabric on Microsoft.com.) AppFabric is required to run Enterprise Portal in a web farm with Microsoft Dynamics AX 2012 R2. AppFabric is not required for single-server Enterprise Portal deployments.

Windows Server AppFabric is a set of integrated technologies that make it easier to build, scale and manage Web and composite applications that run on Internet Information Services (IIS). AppFabric extends Windows Server to provide enhanced hosting, management, and caching capabilities for Web applications and middle-tier services. Enterprise Portal uses the AppFabric distributed, in-memory caching services to improve the performance and scalability of the application.

⚠️ Important

This document includes sample settings and configurations to help you install AppFabric for Enterprise Portal. Depending on your hardware, software, and computing environment, you might select different settings and configurations from those specified in this document.

✅ Note

Previous versions of Windows Server AppFabric were called Velocity Server. This document includes code blocks that make reference to “Velocity”.

Install and configure Windows Server AppFabric on a single server

Use the following procedures to install Windows Server AppFabric single server and then run the configuration wizard. To install AppFabric in a cluster, see Install Windows Server AppFabric in a cluster in this document. The installation program provides the following functionality:

- Enables you to select specific features to install.
- Validates the operating system to make sure that the product is not installed in an unsupported state, and indicates which prerequisites have to be installed.
- Installs AppFabric.
- Enables you to remove specific AppFabric features or AppFabric as a whole. This makes sure that the computer can be left in a state in which the features or AppFabric can be reinstalled.
- Creates the AppFabric Caching Service. Sets the services to a startup type of manual and a status of stopped.

The AppFabric Setup program sets configuration settings in the root (server level) Web.config file, the machine.config file, and the applicationHost.config file. You can configure AppFabric either immediately after
installation, or in a separate process. Installing and configuring Windows Server AppFabric on a single server requires that you:

1. Run Setup
2. Run the configuration wizard
3. Configure cache settings with Windows PowerShell
4. Install and configure the cache client
5. Validate deployment

Each of these processes is described in this section.

**Run Setup**

1. Run one of the following Setup applications on the Enterprise Portal server:
   - For AppFabric 1.1, download [WindowsServerAppFabricSetup_x64](#) and run WindowsServerAppFabricSetup_x64.
2. On the **Accept License Terms** page, read the license terms, and then accept the terms and then click **Next** to continue, or do not accept the terms and then exit the setup wizard.
3. On the **Customer Experience Improvement Program** page, select **Yes** to participate in the Customer Experience Improvement program, or **No** not to participate, and then click **Next**.
4. Clear the **Yes, download and install critical updates** option.
5. On the **Feature Selection** page, select **Caching Services** and **Cache Administration**, and then click **Next**.
   - **Caching Services** – The distributed Caching Service and related components that enable you to prepare this host as a Caching Service, turning the server into the node of a cluster. You can create a new cluster or join this host to an existing cluster by using the Caching Service.
   - **Cache Administration** – Components that enable you to administer a cache cluster. You can select Cache Administration as an independent component, without other features selected. In that instance, you could use administration tools to administer the Caching Service installed on a separate computer.

**Note**

If prerequisite software has to be installed, the setup wizard will display the Platform Validation page after the Feature Selection page. You must install the missing prerequisites manually. If all prerequisites have already been installed, the setup wizard will continue to the Confirm Installation Selections page.

6. On the **Platform Validation** page, review the information and download any prerequisite software. Click the link for a component or a configuration issue for more information. After installing components and resolving issues, click **Refresh** to verify that the problem has been fixed and then click **Next** to continue with the setup wizard.
7. The **Confirm Installation Selections** page will display a list of the features that were selected in the **Feature Selection** page, and will be installed. It displays a list of the required Windows components and the AppFabric features that will be installed. Verify that the lists are correct, and then click **Install** to begin installation.

**Note**

The Application Server role is required for AppFabric. This role will be included in the list of the required Windows components even if it is already installed, and the installation wizard will verify that it has been installed.

8. On the **Installation Progress** page, you can monitor the progress of the installation.
9. On the **Installation Results** page, verify that the installation has succeeded. To display a list of recommended updates that you can install, click the **Recommended Updates** link. To run the configuration wizard, select the **Launch configuration tool** check box, and then click **Finish** to complete the installation wizard. Click **Detailed Installation report** to display a log of setup events.

**Run the configuration wizard**

This section describes recommended settings for Windows Server AppFabric with Enterprise Portal. The following table lists settings as they appear in the Windows Server AppFabric Configuration Wizard. For more information about the options or settings in the configuration wizard, see [Configure Windows Server AppFabric](#) on Microsoft.com.

<table>
<thead>
<tr>
<th>Configuring Caching service parameters</th>
<th>Suggested settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Caching Service configuration</td>
<td>Select this option</td>
</tr>
<tr>
<td>Caching Service configuration provider</td>
<td>XML</td>
</tr>
</tbody>
</table>
| File share (UNC server share required: `\server\share`) | Create a file share on the C drive of the Enterprise Portal server. Configure permissions for the share as follows:
- Grant read access for the account under which the Enterprise Portal application pool is running in IIS (This is also the .NET Business Connector proxy account).
- Grant read access for the application caching account. |
| New cluster                            | Select this option |
| Cluster size                           | Select Small (1-5 computers) |

Click **Next** to view the next page of the wizard.

<table>
<thead>
<tr>
<th>Configure AppFabric Cache Node</th>
<th>Suggested settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node ports</td>
<td>Retain default settings</td>
</tr>
<tr>
<td>Windows firewall exceptions</td>
<td>Select Windows Server AppFabric: AppFabric Caching Service</td>
</tr>
</tbody>
</table>

Click **Finish**. When prompted, click **Yes**.

**Configure cache settings with Windows PowerShell**

The procedure in this section uses Windows PowerShell cmdlets to configure cache settings. For more information, about these cmdlets, see [AppFabric Caching PowerShell Cmdlets](#) on MSDN.

1. Open the Caching Administration Windows PowerShell command prompt as an administrator.

2. Execute the **Use-CacheCluster** command to set the context of your Windows PowerShell session to a particular cache cluster. For more information, see **Use-CacheCluster** on Microsoft.com.

3. Execute the **New-Cache** command to create a new named cache. Make a note of the name you specified. You will enter this cache name in the next procedure. For more information, see **New-Cache** on Microsoft.com.

4. Execute the **Grant-CacheAllowedClientAccount** command and specify the .NET Business Connector proxy (the account that is used by the Enterprise Portal application pool). For more information, see **Grant-CacheAllowedClientAccount** on Microsoft.com.
5. Execute the **Start-CacheCluster** command to start the cache. For more information, see [Start-CacheCluster](#) on Microsoft.com.

### Install and configure the cache client

2. On the **Feature Selection** page, select **Cache Client** and clear all other options. Click **Next**.
   - **Cache Client** – The client libraries that enable you to use cache functionality in your applications during development or run time. You can install this component even if you are not installing the Caching Services.
3. Complete the setup wizard.
4. In Windows explorer, open the `c:\inetpub\wwwroot\<Enterprise Portal web app>` folder. Locate the `web.config` file and create a backup of this file in a different location.
5. Open the `web.config` file.
6. Locate the `<configSections>` tag. Add the following section tag:
   ```xml
   <section name="dataCacheClient" type="Microsoft.ApplicationServer.Caching.DataCacheClientSection, Microsoft.ApplicationServer.Caching.Core, Version=1.0.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" allowLocation="true" allowDefinition="Everywhere" />
   ```
7. Add the following AppFabric cache client tags to the `web.config` file *after* the `<configSections>` tag. Replace "Host_server_name" with the name of the name of the server where you installed Windows Server AppFabric. Replace "default" with the name specified when you executed the `New-Cache` command.
   ```xml
   <dataCacheClient>
   <localCache isEnabled="false" />
   <hosts>
   <!-- List of hosts -->
   <!-- Replace Host_server_name with velocity server name -->
   <host name="Host_server_name" cachePort="22233" />
   </hosts>
   </dataCacheClient>
   ```

#### Required configurations for AppFabric 1.1

If you installed AppFabric 1.1, you must choose option 1 or option 2 in this section and perform the procedures for that option. If you installed AppFabric 1.0, you can skip this section.

You must choose one of these options because AppFabric 1.1 DLLs are not stored in the Global Assembly Cache (GAC). If you run Enterprise Portal in an AppFabric 1.1 environment without performing the procedures for option 1 or option 2, Enterprise Portal returns an error.

- **Option 1: Add AppFabric codeBase tags to the web.config file** – This option is more complex than Option 2, but it reduces overall administration time and troubleshooting because you only have to perform the procedure one time.
- **Option 2: Copy AppFabric DLLs to the bin folder** – This option is a simple copy/paste, but if the AppFabric DLLs are ever updated, you must repeat this procedure with the updated AppFabric DLLs. Updated DLLs can
include AppFabric hotfixes, updates, or version releases. If you do not repeat this procedure whenever AppFabric DLLs are updated, you might receive errors in Enterprise Portal.

**Option 1: Add AppFabric codeBase tags to the web.config file**

Use the procedures in this section to add tags to the Enterprise Portal web.config file.

1. Open the web.config file in Microsoft Visual Studio or a text editor, such as Notepad. By default, the file is located in the following directory on the Enterprise Portal server:
   C:\inetpub\wwwroot\wss\VirtualDirectories\80\web.config
2. Add the codebase tag for the following AppFabric DLLs:

⚠️ **Important**

The href attribute for the codeBase tag must specify the location of the AppFabric DLLs. By default, the DLLs are located in the following directory: C:\Program Files\AppFabric 1.1 for Windows Server\.

```xml
<runtime>
  <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
  ...-- velocity -->
  <dependentAssembly>
    <assemblyIdentity name="Microsoft.ApplicationServer.Caching.Core" publicKeyToken="31bf3856ad364e35" culture="neutral" />
    <codeBase version="1.0.0.0" href="C:\Program Files\AppFabric 1.1 for Windows Server\Microsoft.ApplicationServer.Caching.Core.dll"/>
  </dependentAssembly>
  <dependentAssembly>
    <assemblyIdentity name="Microsoft.ApplicationServer.Caching.Client" publicKeyToken="31bf3856ad364e35" culture="neutral" />
    <codeBase version="1.0.0.0" href="C:\Program Files\AppFabric 1.1 for Windows Server\Microsoft.ApplicationServer.Caching.Client.dll"/>
  </dependentAssembly>
  <dependentAssembly>
    <assemblyIdentity name="Microsoft.WindowsFabric.Common" publicKeyToken="31bf3856ad364e35" culture="neutral" />
    <codeBase version="1.0.0.0" href="C:\Program Files\AppFabric 1.1 for Windows Server\Microsoft.WindowsFabric.Common.dll"/>
  </dependentAssembly>
  <dependentAssembly>
    <assemblyIdentity name="Microsoft.WindowsFabric.Data.Common" publicKeyToken="31bf3856ad364e35" culture="neutral" />
    <codeBase version="1.0.0.0" href="C:\Program Files\AppFabric 1.1 for Windows Server\Microsoft.WindowsFabric.Data.Common.dll"/>
  </dependentAssembly>
</runtime>
```
3. Search the web.config file for the following tag:

```xml
<system.web>
<securityPolicy>
<trustLevel name="WSS_Medium" policyFile="C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\config\wss_mediumtrust.config" />
</runtime>
</system.web>
```

4. Open the directory specified in the trustLevel > policyFile section of this tag. For example: C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\config\wss_mediumtrust.config

5. Make a copy of the wss_mediumtrust.config file in this directory. Rename the copy as wss_mediumtrust_appfabric.config.

6. Open the wss_mediumtrust_appfabric.config file.

7. Search the file for the following tag: class="FirstMatchCodeGroup"

8. Add the UnionCodeGroup section in a new `<CodeGroup>` section beneath the “FirstMatchCodeGroup” section. Be sure to add it down to the first closing </CodeGroup> tag. The closing tag is not included in the following example:

```xml
<CodeGroup class="FirstMatchCodeGroup"
version="1"
PermissionSetName="Nothing">
<IMembershipCondition
class="AllMembershipCondition"
version="1"/>
</CodeGroup>
<CodeGroup class="UnionCodeGroup"
version="1"
PermissionSetName="FullTrust">
<IMembershipCondition
class="UrlMembershipCondition"
version="1"
Url="file:///C:/Program Files/AppFabric 1.1 for Windows Server/*"/>
```

9. In the web.config file, search for the `<system.web>` tag.

10. Add the following tag in the `<securityPolicy>` section:

```xml
<trustLevel name="WSS_Medium_Custom" policyFile="C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\config\wss_mediumtrust_appfabric.config" />
```

11. Search the file for the `<trust originUrl="" level="WSS_Medium" />` tag.

12. Change the trust level to “WSS_Medium_Custom”. For example:

```xml
<trust originUrl="" level="WSS_Medium_Custom" />
```

13. Save your changes in the file.

14. From the Run dialog, type `iisreset` to restart the web service.
**Option 2: Copy AppFabric DLLs to the bin folder**

1. Copy the following files from the C:\Program Files\AppFabric 1.1 for Windows Server directory:
2. Paste these files into the following directory: C:\inetpub\wwwroot\wss\VirtualDirectories\80\_app_bin
3. From the Run dialog, type iisreset and press Enter.

**Caution**

If the AppFabric 1.1 DLLs are ever updated, for example if AppFabric 1.2 or 2.0 is released, then you must repeat this procedure with the updated DLLs.

**Validate deployment**

Use the following procedure to verify that the AppFabric cache stores Enterprise Portal sessions on the server.

1. On the AppFabric server, verify in the Windows Services console that AppFabricCachingService is running.
2. Open a Windows PowerShell command prompt as an administrator.
3. Execute the `Get-CacheStatistics` default command. (For more information, see [Get-CacheStatistics](#) on Microsoft.com.) The results should display all zeros.
4. Open Enterprise Portal and submit an Expense report.
5. Execute the `Get-CacheStatistics` default command again and verify that the cache displays values. This indicates that cache distribution is working.

**Install and configure Windows Server AppFabric in a cluster**

Use the following procedures to install Windows Server AppFabric in a cluster and then run the configuration wizard. The installation program provides the following functionality:

- Enables you to select specific features to install.
- Validates the operating system to make sure that the product is not installed in an unsupported state, and indicates which prerequisites must be installed.
- Installs AppFabric.
- Enables you to remove specific AppFabric features or AppFabric as a whole, making sure that the computer can be left in a state in which the features or AppFabric can be reinstalled.
- Creates the AppFabric Caching Service. Sets the services to a startup type of manual and a status of stopped.

The AppFabric Setup program sets configuration settings in the root (server level) Web.config file, the machine.config file, and the applicationHost.config file. You can configure AppFabric either immediately after installation, or in a separate process. Installing and configuring Windows Server AppFabric on a single server requires that you:

1. Run Setup
2. Run the configuration wizard
3. Configure additional servers in the AppFabric cluster
4. Configure the cluster cache settings with Windows PowerShell
5. Install and configure the cache client
6. Validate deployment

Each of these processes is described in this section.
Run Setup

1. Download and run the WindowsServerAppFabricSetup_x64_6.1.exe file on the host server in the cluster.
2. On the Accept License Terms page, read the license terms, and then accept the terms and then click Next to continue, or do not accept the terms and then exit the setup wizard.
3. On the Customer Experience Improvement Program page, select Yes to participate in the Customer Experience Improvement program, or No not to participate, and then click Next.
4. Clear the Yes, download and install critical updates option.
5. On the Feature Selection page, select Caching Services and Cache Administration, and then click Next.
   - Caching Services – The distributed Caching Service and related components that enable you to prepare this host as a Caching Service, turning the server into the node of a cluster. You can create a new cluster or join this host to an existing cluster by using the Caching Service.
   - Cache Administration – Components that enable you to administer a cache cluster. You can select Cache Administration as an independent component, without other features selected. In that instance, you could use administration tools to administer the Caching Service installed on a separate computer.

   ✓ Note
   
   If prerequisite software must be installed, the setup wizard will display the Platform Validation page after the Feature Selection page. You must install the missing prerequisites manually. If all prerequisites have already been installed, the setup wizard will continue to the Confirm Installation Selections page.

6. On the Platform Validation page, review the information and download any prerequisite software. Click the link for a component or a configuration issue for more information. After installing components and resolving issues, click Refresh to verify that the problem has been fixed and then click Next to continue with the setup wizard.

7. The Confirm Installation Selections page will display a list of the features that were selected in the Feature Selection page, and will be installed. It displays a list of the required Windows components and the AppFabric features that will be installed. Verify that the lists are correct, and then click Install to begin installation.

   ✓ Note
   
   The Application Server role is required for AppFabric. This role will be included in the list of the required Windows components even if it is already installed, and the installation wizard will verify that it has been installed.

8. On the Installation Progress page, you can monitor the progress of the installation.

9. On the Installation Results page, verify that the installation has succeeded. To display a list of recommended updates that you can install, click the Recommended Updates link. To run the configuration wizard, select the Launch configuration tool check box, and then click Finish to complete the installation wizard. Click Detailed Installation report to display a log of setup events.

Run the configuration wizard

This section describes recommended settings for Windows Server AppFabric with Enterprise Portal. The following table lists settings as they appear in the Windows Server AppFabric Configuration Wizard. For more information about the options or settings in the configuration wizard, see Configure Windows Server AppFabric on Microsoft.com.

<table>
<thead>
<tr>
<th>Configuring Caching service parameters</th>
<th>Suggested settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Caching Service configuration</td>
<td>Select this option</td>
</tr>
</tbody>
</table>
Configuring Caching service parameters | Suggested settings
--- | ---
Caching Service configuration provider | SQL Server AppFabric Caching Service Configuration Store Provider
New cluster | Select this option
Cluster size | Select an option

Specify settings to create and register an AppFabric Caching Service configuration database that uses the Microsoft SQL Server provider | Suggested settings
--- | ---
Register AppFabric Caching Service configuration database | Select this option
Create AppFabric Caching Service configuration database | Select this option

Enter required information in the Server and Database fields and then click OK.

Configure AppFabric Cache Node | Suggested settings
--- | ---
Node ports | Retain default settings
Windows firewall exceptions | Select Windows Server AppFabric: AppFabric Caching Service

When prompted, click Yes.

Configure additional servers in the AppFabric cluster

On each server in the cluster, repeat the procedures that are described in this section for running Setup and running the configuration wizard. In the configuration wizard, you must select the following options.

Configuring Caching service parameters | Suggested settings
--- | ---
Set Caching Service configuration | Select this option
Caching Service configuration provider | SQL Server AppFabric Caching Service Configuration Store Provider
Join cluster | Select this option

Specify settings to create and register an AppFabric Caching Service configuration database that uses the Microsoft SQL Server provider | Suggested settings
--- | ---
Register AppFabric Caching Service configuration database | Select this option
Create AppFabric Caching Service configuration database | Clear this option
Enter the same information that you previously specified in the **Server** and **Database** fields and then click **OK**.

**Configure the cluster cache settings with Windows PowerShell**

The procedure in this section uses Windows PowerShell cmdlets to complete the process of configuring the cache. For more information, about these cmdlets, see [AppFabric Caching PowerShell Cmdlets](https://msdn.microsoft.com) on MSDN.

1. Open a Windows PowerShell command prompt as an administrator.
2. Execute the `Use-CacheCluster` command to set the context of your Windows PowerShell session to a particular cache cluster. For more information, see [Use-CacheCluster](https://msdn.microsoft.com) on Microsoft.com.
3. Execute the `New-Cache` command to create a new named cache. Make a note of the name you specified. You will enter this cache name in the next procedure. For more information, see [New-Cache](https://msdn.microsoft.com) on Microsoft.com.
4. Execute the `Grant-CacheAllowedClientAccount` command and specify the .NET Business Connector proxy (the account that is used by the Enterprise Portal application pool). For more information, see [Grant-CacheAllowedClientAccount](https://msdn.microsoft.com) on Microsoft.com.
5. Execute the `Set-CacheConfig` command and specify the `–Secondaries` parameter. For more information, see [Set-CacheConfig](https://msdn.microsoft.com) on Microsoft.com.
6. Export the configuration with this command: `Export-CacheClusterConfig` and specify a name for the file.
7. Open the file that you just created and add the following configuration to the `<advancedProperties>` section:

   ```xml
   <transportProperties maxBufferSize="1000000000" />
   ```

8. Import the configuration with this command: `Import-CacheClusterConfig`
9. Execute the `Start-CacheCluster` command to start the cache. For more information, see [Start-CacheCluster](https://msdn.microsoft.com) on Microsoft.com.

**Install and configure the cache client**

2. On the **Feature Selection** page, select **Cache Client** and clear all other options. Click **Next**.
   - **Cache Client** – The client libraries that enable you to use cache functionality in your applications during development or run time. You can install this component even if you are not installing the Caching Services.
3. Complete the setup wizard.
4. In Windows explorer, open the `\$\inetpub\wwwroot\` folder. Locate the web.config file and create a backup of this file in a different location.
5. Open the web.config file.
6. Locate the `<configSections>` tag. Add the following section tag:

   ```xml
   <configSections>
     <!-- velocity -->
     <section name="dataCacheClient" type="Microsoft.ApplicationServer.Caching.DataCacheClientSection; Microsoft.ApplicationServer.Caching.Core, Version=1.0.0.0; Culture=neutral, PublicKeyToken=31bf3856ad364e35" allowLocation="true" allowDefinition="Everywhere" />
     <sectionGroup name="Microsoft.Dynamics">
       <section name="Session" type="System.Configuration.SingleTagSectionHandler, System, Version=1.0.5000.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" />
       <section name="ServerState" type="System.Configuration.SingleTagSectionHandler, System, Version=1.0.5000.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" />
       <section name="AppFabricCaching" type="System.Configuration.SingleTagSectionHandler, System, Version=1.0.5000.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" />
     </sectionGroup>
   </configSections>
   ```
7. Add the following `dataCacheClient` tag to the `web.config` file after the `</configSections>`. Replace each instance of “Host_server_name” with the name of a server. Replace “default” with the name specified when you executed the New-Cache command.

```xml
<dataCacheClient>
  <localCache isEnabled="false"/>
  <hosts>
    <!-- List of hosts -->
    <!-- Replace Host_server_name with velocity server name -->
    <host name="Host_server_name1" cachePort="22233"/>
    <host name="Host_server_name2" cachePort="22233"/>
    <host name="Host_server_name3" cachePort="22233"/>
  </hosts>
</dataCacheClient>
</Microsoft.Dynamics>
```

Validate deployment

Use the following procedure to verify that the AppFabric cache stores Enterprise Portal session on the server.

1. On the AppFabric server, verify in the Windows Services console that AppFabricCachingService is running.
2. Open a Windows PowerShell command prompt as an administrator.
3. Execute the `Get-CacheStatistics` default command. (For more information, see [Get-CacheStatistics](https://docs.microsoft.com) on Microsoft.com.) The results should display all zeros.
4. Restart the web service on the Enterprise Portal server.
5. Open Enterprise Portal and submit an Expense report.
6. Execute the `Get-CacheStatistics` default command again and verify that the cache displays values. This indicates that cache distribution is working.

See also
- [Install Enterprise Portal in a web farm](https://docs.microsoft.com)

Install Enterprise Portal in a web farm

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install and configure Enterprise Portal for Microsoft Dynamics AX in a web farm. A web farm distributes Enterprise Portal requests and processing across multiple servers, which can improve performance and availability.
For information about how to install Enterprise Portal in an environment with two domain controllers and two firewalls for extranet deployments, see the Install Enterprise Portal in a traditional perimeter network section.

**Note**

If you are upgrading Enterprise Portal between Microsoft Dynamics AX 2012, Microsoft Dynamics AX 2012 Feature Pack, and Microsoft Dynamics AX 2012 R2, you should review Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3 on TechNet.

**Before you begin**

Complete the following tasks before you install Enterprise Portal in a web farm:

- Install and configure Windows Server AppFabric in your server farm. For more information, see the Install and configure Windows AppFabric for Enterprise Portal section.
- If you installed a non-SYS layer model file in the Microsoft Dynamics AX environment, compile Microsoft Dynamics AX before you install Enterprise Portal. If you do not compile Microsoft Dynamics AX, the Enterprise Portal installation might fail.
- Verify that the name of each server in the Enterprise Portal web farm does not include an underscore, for example EPserver_1. If an Enterprise Portal server includes an underscore in the server name, lookups and webpages might display errors.
- On each computer where you will install Enterprise Portal, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
- For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.
- Verify that you have the appropriate permissions to install Enterprise Portal.
  - Member of the Administrator group in Windows on each server in the farm.
  - Member of the dbcreator and securityadmin roles in the Microsoft Dynamics AX SQL Server instance.
  - Member of the System administrator role in Microsoft Dynamics AX.
  - Member of the SharePoint farm administrators group (if SharePoint is already installed on each server)
  - If you are installing Enterprise Portal on a server that already hosts an Enterprise Portal deployment and you want to overwrite that deployment, you must have Full Control permission in SharePoint for the existing Enterprise Portal site collection. If you do not have Full Control permission, you will not be able to delete the existing site collection by using Setup.
- For Secure Sockets Layer (SSL) encryption, you cannot install Enterprise Portal on a Web application that is already configured to use HTTP and HTTPS bindings. You must remove the HTTP binding from the site by using IIS Manager before you install Enterprise Portal.
- If you plan to deploy multiple Enterprise Portals on the same server and those portals will connect to different Application Object Servers, you must update the web.config file. For more information, see the Install multiple Enterprise Portals on the same server section.
- If you plan to use host headers, review the SharePoint documentation about host headers and web farms before you install Enterprise Portal.

**Important**

If you attempt to install Enterprise Portal on an existing Internet Information Services (IIS) site that is already configured to use a host header, the installation fails, unless you create a BackConnectionHostNames registry entry. For more information, see Changes to NTLM authentication for HTTPWebRequest in Version 3.5 SP1 on Microsoft.com.
**Topology overview**

This section uses the following Web server topology. The database, Application Object Server (AOS), and report server are not included in this list. Your Web server topology might differ.

<table>
<thead>
<tr>
<th>Server</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Server</td>
<td>The following components and services are installed and running:</td>
<td>• This server is the SharePoint farm administration server.</td>
</tr>
<tr>
<td></td>
<td>• Internet Information Services (IIS)</td>
<td>• The Microsoft SharePoint Foundation Web Application service must be running. You must configure this service in SharePoint Central Administration.</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SharePoint Server</td>
<td>• You must install Enterprise Portal on each front-end Web server before you install Enterprise Portal on this server.</td>
</tr>
<tr>
<td></td>
<td>• SharePoint Central Administration Service</td>
<td>• When you install Enterprise Portal on this server by using Microsoft Dynamics AX Setup, you can select the Create Web site option or you can create the site later using SharePoint Central Administration. You must not select the Create Web site option on any front-end Web server.</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SharePoint Foundation Web Application service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Microsoft Dynamics AX Enterprise Portal</td>
<td></td>
</tr>
<tr>
<td>Web front-end servers</td>
<td>• IIS</td>
<td>• SharePoint is installed on each server as a Web front-end.</td>
</tr>
<tr>
<td></td>
<td>• SharePoint Server</td>
<td>• You must install Enterprise Portal on each front-end Web server before you install Enterprise Portal on the SharePoint farm administration server.</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SharePoint Foundation Web Application service</td>
<td>• When you install Enterprise Portal on each Web front-end server by using Microsoft Dynamics AX Setup, you must clear the Create Web site option.</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Dynamics AX Enterprise Portal</td>
<td></td>
</tr>
</tbody>
</table>

**Install and configure SharePoint**

Install and configure SharePoint on each farm in the server.

Note the following requirements for the SharePoint installation.

1. If you are using a load balancer, specify a site name in the **Load Balanced URL** field on the Web application that will host the Enterprise Portal site.
2. The Microsoft SharePoint Foundation Web Application service must be running on the farm administration server. You must configure this service in SharePoint Central Administration.
3. Configure the Web application to use the Business Connector proxy account. This means you must select the **Configurable** option and then enter the proxy credentials.
**Supported languages**

If you want to deploy Enterprise Portal in multiple languages, you must download and deploy SharePoint language packs onto the web server before you install Enterprise Portal. You can download SharePoint language packs from Microsoft.com. Enterprise Portal is currently supported in the following languages:

- Arabic
- Chinese (Simplified)
- Czech
- Danish – 1030
- Dutch (Netherlands)
- Dutch (Belgium)
- English
- English (Australia)
- English (Canada)
- English (India)
- English (Ireland)
- English (Malaysia)
- English (New Zealand)
- English (Singapore)
- English (South Africa)
- English (UK)
- English (US)
- Estonian
- Finnish
- French (France)
- French (Canada)
- French (Belgium)
- French (Switzerland)
- German (Germany)
- German (Austria)
- German (Switzerland)
- Hungarian
- Icelandic
- Italian
- Italian (Switzerland)
- Japanese
- Latvian
- Lithuanian
- Norwegian
- Polish
- Portuguese (Brazilian)
- Russian
- Spanish (international)
- Spanish (Mexico)
- Swedish
- Thai

To deploy Enterprise Portal in one of the languages list here, you must create a Web application in SharePoint and specify the new language. For more information, see Create an Enterprise Portal site on TechNet. You do not have to create portals for specific languages. You just have to install SharePoint language packs, and then create a site as described in Create an Enterprise Portal site on TechNet. Portals are then displayed in the language that is specified for each user in the Options form in Microsoft Dynamics AX.

**Before you install Enterprise Portal**

Perform the following tasks to verify that you can deploy Enterprise Portal in the SharePoint server farm.

- Verify that you can open SharePoint Central Administration on the Enterprise Portal administration server.
- Verify that you have the appropriate permissions to create sites by using SharePoint Central Administration to create a SharePoint team site.
- Verify that you can browse the team site without prompts and resolve the URL without proxy errors or other problems.
Install Enterprise Portal

This section describes how to install Enterprise Portal by using Setup. You must install Enterprise Portal on each Web front-end server before you install on the farm administration server. When you install Enterprise Portal on the Web front-end servers, you clear the option to create a site. This means that when you install Enterprise Portal on the Web front-end servers, Setup deploys files and configures settings on the server, but no site is created. When you install Enterprise Portal on the farm administration server, you select the option to create a site.

Tip

By default, when you install SharePoint, the system creates a Web application on port 80. Microsoft Dynamics AX Setup deploys an Enterprise Portal site on the port 80 Web application unless you specify a different Web application. If you do not intend to deploy Enterprise Portal on the default port-80 Web application, you must use SharePoint Central Administration to create a new Web application before you install Enterprise Portal. Also note, if you intend to deploy Enterprise Portal on a Web application that is already configured to use a host header, you must use SharePoint Central Administration to create a new Web application using the host header before you install Enterprise Portal. For any new Web application, you must specify the Business Connector proxy account as the application pool account in the Configurable list.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Enterprise Portal (EP), and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Select a file location page, select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Specify a location for configuration settings page, specify whether you want Enterprise Portal to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click Next.
10. On the Connect to an AOS instance page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click Next.

Note

If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this screen is not displayed. Subsequent installations on this computer reuse the existing AOS connection.

11. On the Specify Business Connector proxy account information page, enter the password for the proxy account that is used by the .NET Business Connector. Click Next.
12. On the **Configure a Web site for Enterprise Portal** page, select a website. If no websites are available in the list, you must cancel Setup, create a website by using SharePoint Central Administration, and then try the installation again.

We recommend that you select the **Configure for Windows SharePoint Services** option. If you select this option, Setup verifies that the site is a SharePoint site. If the site is not a SharePoint site, Setup extends the site in SharePoint. Setup also sets the application pool to run under the service account and sets the authentication method to Windows NTLM.

**Important**

Note the following important information about the **Create Web site** option:

- When you install Enterprise Portal on Web front-end servers in a server farm, you must clear this option. The site must be created only on the administration server for the web farm.

- If you are installing Enterprise Portal on an administration server for a web farm, select the **Create Web site** option to create a site at the following URL: http://ServerName/sites/DynamicsAX. Setup creates a new site that uses port 80.

- Clear this option if you are installing Enterprise Portal for a public site, such as an unsolicited vendor portal. For public sites, you must create the Enterprise Portal site by using the public site template. For more information, see [Create a public Enterprise Portal site](http://technet.microsoft.com) on TechNet.

Click **Next**.

**Note**

If your business or organization purchased a developer license for Microsoft Dynamics AX, you can change the URL for the website, title, and description before you complete the installation. Modify the EPSetupParams file in the Application Object Tree (AOT) (**Web > Web Files > Static Files > EPSetupParams**).

13. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

14. On the **Ready to install** page, click **Install**.

15. After the installation is complete, click **Finish** to close the wizard.

16. Repeat this procedure on every Web server in the server farm.

**Optional: Specify machineKey values in web.config files for sites in a web farm**

If Enterprise Portal pages display authentication and access errors after you installed Enterprise Portal on each server in the web farm, you might have to specify values for machineKey properties in the web.config file of each server in the web farm. MachineKey properties, `validationKey` and `decryptionKey`, are used to hash and decrypt authentication tickets and cookies. Values for machineKey properties must be the same on all servers in the web farm.

1. On the administration server for the web farm, open the web.config file in a text editor such as Notepad. By default, the file is located in the following directory: `C:\inetpub\wwwroot\wss\VirtualDirectories\PortNumber`.

2. Locate the `machineKey` section, and copy the `validationKey` and `decryptionKey` values to a separate text file.

   The following is an example of a `machineKey` section:
   ```xml
   <machineKey validationKey="4785A9C8F5FA32B47E5245AC48671291F1CE55735A475EB7" decryptionKey="D961976E181646326D64E01AB2052F5D076F0ABDE2C702FB" validation="SHA1" />
   ```

3. Edit the web.config files on the other servers in the web farm. Replace the existing machineKey values with the values that you copied from the administration server for the web farm.

For more information about how to configure machineKey properties, see [How to: Configure MachineKey in ASP.NET 2.0](http://msdn.microsoft.com) on Microsoft.com, especially the “Web Farm Deployment Considerations” section.
Configure firewall settings on Enterprise Portal servers
For information about the recommended firewall settings on an Enterprise Portal server, see the Firewall settings for Microsoft Dynamics AX components chapter.

Next steps
After you deploy Enterprise Portal in the web farm, you must enable users to access the Enterprise Portal site. For more information, see Enable users to access Enterprise Portal on TechNet. For information about other Enterprise Portal deployment and configuration tasks, see the Checklists for deploying Enterprise Portal sites section.

See also
- Install and configure Windows AppFabric for Enterprise Portal
- Troubleshoot installation issues with Enterprise Portal and Role Centers

Deploy a claims-mode Enterprise Portal site

Applies to: Microsoft Dynamics AX 2012 R3
This section provides information about how to install Enterprise Portal for Microsoft Dynamics AX with claims-based authentication. Enterprise Portal supports forms-based authentication or Active Directory Federations Services authentication.

Deploy an Enterprise Portal site that uses forms-based authentication

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012
This section describes how to deploy an Enterprise Portal for Microsoft Dynamics AX site that uses the claims-mode authentication that is provided by SharePoint. In the context of Microsoft Dynamics AX, this kind of authentication is called flexible authentication. Flexible authentication enables businesses and organizations to authenticate Enterprise Portal users without having to store user accounts in Active Directory Domain Services. By using flexible authentication, you can configure a claims-aware Enterprise Portal site to authenticate users by using one of the following services: forms-based authentication or Microsoft Active Directory Federation Services (AD FS). This section describes how to deploy an Enterprise Portal site that uses forms-based authentication. Forms-based authentication validates credentials that are entered in a logon form and stored in an ASP.NET database.

Note
Active Directory Domain Services (AD DS) is still required for Enterprise Portal administration tasks.

Before you create a forms-based Enterprise Portal site, we recommend that you learn about the concepts of claims-based authentication. The procedures in this section assume that you are familiar with the concepts in the following documents.

- Forms Authentication Provider (on Microsoft.com)
- Implementing Claims-Based Authentication with SharePoint Server 2010 (on Microsoft.com)
## Before you begin

Complete the following tasks before you install Enterprise Portal.

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
</table>
| Install Microsoft Dynamics AX hotfixes for claims-mode authentication (required for Microsoft Dynamics AX 2012 R2 or earlier; not required for Microsoft Dynamics AX 2012 R3). | 1. [Download](#) and install the Microsoft Dynamics AX 2012 claims-mode authentication hotfix (KB 2823664).  
2. [Download](#) and install the Microsoft Dynamics AX 2012 R2 claims-mode authentication hotfix (KB 2824690). |
| Create a domain account | Create a domain account for the Microsoft Dynamics AX .NET Business Connector proxy.  
**Caution**  
The account should not be a member of the Microsoft Dynamics AX system administrator group or a member of the Windows administrator group on the Enterprise Portal server. The login should not be used for standard logon purposes. Only those individuals who are responsible for deploying and configuring Microsoft Dynamics AX should know the credentials for this login. If a malicious user gained access to the credentials for this login, that person could potentially impersonate any Microsoft Dynamics AX user.  
Enter the account in the Microsoft Dynamics AX client on the **System administration > System > System service accounts** form. |
| Install SharePoint | After you install SharePoint on the web server, run the SharePoint configuration wizard. Specify the Microsoft Dynamics AX .NET Business Connector proxy account on the **Specify Configuration Database Settings > Specify Database Access Account** page of the SharePoint configuration wizard. |
| Compile Microsoft Dynamics AX if you installed any non-SYS layer mode files | If you installed a non-SYS layer model file in the Microsoft Dynamics AX environment, compile Microsoft Dynamics AX before you install Enterprise Portal. If you do not compile Microsoft Dynamics AX, the Enterprise Portal installation might fail. |
| Download and deploy language packs | If you want to deploy Enterprise Portal in multiple languages, download and deploy the SharePoint language packs on the Web server before you install Enterprise Portal. You must create a unique Web application in SharePoint for each language. You can download language packs from Microsoft.com. |
| Verify the server name | Verify that the name of the server that will host Enterprise Portal does not include an underscore, for example EPserver_1. If an Enterprise Portal server includes an underscore in the server name, lookups and webpages might display errors. |
| Verify prerequisites and system requirements | On the computer where you will install Enterprise Portal, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.  
For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](#) on Microsoft.com. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify permissions</td>
<td>Verify that you have the appropriate permissions to install Enterprise Portal. If you are installing Enterprise Portal on a server that already hosts an Enterprise Portal deployment and you want to overwrite that deployment, you must have Full Control permission in SharePoint for the existing Enterprise Portal site collection. If you do not have Full Control permission, you will not be able to delete the existing site collection by using Setup. For more information about permissions, see the Verify that you have the required permissions for installation section.</td>
</tr>
<tr>
<td>Verify SSL settings</td>
<td>For Secure Sockets Layer (SSL) encryption, you cannot install Enterprise Portal on a web application that is already configured to use HTTP and HTTPS bindings. You must remove the HTTP binding from the site by using Internet Information Services (IIS) Manager before you install Enterprise Portal.</td>
</tr>
</tbody>
</table>

**Pre-installation tasks**

Perform the following tasks to verify that you can deploy Enterprise Portal on the web server.

1. Verify that you can open SharePoint Central Administration on the Enterprise Portal server.
2. Verify that you have the appropriate permissions to create sites by using SharePoint Central Administration to create a SharePoint team site.
3. Verify that you can browse the team site without prompts and resolve the URL without proxy errors or other problems.
4. If you intend to deploy or configure Enterprise Portal at a command prompt, verify that you can start the SharePoint Management Shell.

**Install Enterprise Portal binaries**

This section describes how to install Enterprise Portal binaries by using Setup. During this initial install, you will not install create an Enterprise Portal site. You will create the site later in this document.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Enterprise Portal (EP) and .NET Business Connector, and then click Next.
7. On the Prerequisite validation results page, resolve any warnings or errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no warnings or errors remain, click Next.
8. On the Select a file location page, select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Specify a location for configuration settings page, specify whether you want Enterprise Portal to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click Next.
10. On the **Connect to an AOS instance** page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. If necessary, verify name of the AOS instance, the TCP/IP port number, and the WSDL port for services before you click **Next**. If the AOS details are correct, click **Next**.

11. On the **Specify Business Connector proxy account information** page, enter the user name and password for the proxy account that is used by the .NET Business Connector. Click **Next**.

12. On the **Configure a Web site for Enterprise Portal** page, select the SharePoint – 80 (SharePoint Web application). If no web applications are available in the list, you must cancel Setup, create a web application by using SharePoint Central Administration, and then try the installation again.

   **Caution**
   
   Do not select any other options on this page. Verify that you specified the SharePoint – 80 web application and that all other options are cleared before you click **Next**.

13. Click **Next**.

14. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

15. On the **Ready to install** page, click **Install**.

16. After the installation is complete, click **Finish** to close the wizard.

   **Important**
   
   Before you proceed to the next section, verify that the .NET Business connector proxy account was added to the **WSS_WPG** group on the web server computer: From a command prompt type `net localgroup wss_wpg` and press Enter.
Configure certificates

The procedures in this section require secure sockets layer (SSL) and security token service (STS) certificates. These certificates help ensure that a user’s claim is not changed in transit. The following certificates are required.

<table>
<thead>
<tr>
<th>Certificate</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSL certificate for the Enterprise Portal site</td>
<td>Referred to as SSLCert1 in this document</td>
</tr>
<tr>
<td>SSL certificate for the STS site</td>
<td>Referred to as SSLCert2 in this document</td>
</tr>
<tr>
<td>STS signing certificate for the token service</td>
<td>Referred to as STScertSigningCert</td>
</tr>
</tbody>
</table>

For test environments, you can create self-signed certificates by using Internet Information Services (IIS) manager. (For more information, see Create and export a self-signed certificate on Microsoft.com.) However, for production environments you must acquire certificates from a valid certificate authority. Before you proceed in this section, install SSLCert1 and SSLCert2 into the Personal node in the certificate store on the web server. You will configure the STScertSigningCert later in this document. For information about how to work with certificates see Certificate Overview on Microsoft.com.

1. On the Windows server that will host the forms-based Enterprise Portal site, click Start > Run, type mmc, and then click OK.
2. Click File > Add/remove snap-in.
3. Click Certificates, and then click Add.
4. When the system prompts you to specify which type of account to manage certificates for, click Computer Account, and then click Next.
5. Click Local computer, and then click Finish.
6. In the Add or Remove Snap-ins dialog box, click.
7. In the MMC snap-in, click the Certificates (Local Computer) node.
8. Right-click Personal, and then click All tasks > Import. The Certificate Import Wizard opens. Click Next.
9. Browse to the certificate, and then click Next.
10. Enter the password for the certificate, and then click Next.
11. Select the Mark this key as exportable option, and then click Next. The Certificate Store dialog box appears. Click Next.

Enable SharePoint Claims to Windows Token Service

You must enable the SharePoint claims to Windows token service (C2WTS) for claims-based authentication. Use the following procedure to start this service.

1. In SharePoint Central Administration, under System Settings, click Manage services on server.
2. Locate the Claims to Windows Token Service.
3. In the Action column, click Start.
4. In Windows, click Start > Run, type services.msc and press Enter.
5. In the Services console, verify that the Claims to Windows Token Service is running.

Note

Do not use the services.msc to start the C2WTS because the service will be automatically disabled after a period of time. You must use SharePoint Central Administration to start this service.
Create a claims-aware Enterprise Portal site

This section describes how to create a claims-aware Enterprise Portal site by using a Microsoft Windows PowerShell cmdlet. The cmdlet in this section first creates a claims-aware web application in SharePoint, and then deploys an Enterprise Portal site on that web application. If you are not familiar with Windows PowerShell cmdlets for Microsoft Dynamics AX, see Administering Microsoft Dynamics AX by using Windows PowerShell on Microsoft.com for more information. You can also create a claims-aware Enterprise Portal site on an existing SharePoint web application. Complete one of the following procedures.

- Create a claims-aware site on a new SharePoint web application
- Create a claims-aware site on an existing SharePoint web application

Create a claims-aware site on a new SharePoint web application

Note

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to Restricted, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to RemoteSigned by using the Set-ExecutionPolicy cmdlet. This setting allows you to run scripts that you’ve written and scripts that have been signed by a trusted publisher.

1. Open the Microsoft Dynamics AX 2012 Management Shell with administrator privileges. Click Start > Administrative Tools > right-click Microsoft Dynamics AX 2012 Management Shell and click Run as administrator.

2. Enter the following command and press Enter.
   
   `$Cred = Get-Credential
   
3. When prompted, enter the credentials for the .NET Business Connector proxy account. The credentials must be the .NET Business Connector proxy account and password that were specified when Enterprise Portal binaries were installed earlier in this document. If you specify an account other than the .NET Business Connector proxy account, then the cmdlet overwrites the existing .NET Business Connector account, which can cause existing Enterprise Portal installations to stop working. Also note, this cmdlet designates the .NET Business Connector proxy account as the Enterprise Portal site administrator.

4. Execute the following command, replacing "PathToSSLCert1" with the path to SSLCert1, which you imported earlier in this document.

   `$SSLCert = Get-PfxCertificate "PathToSSLCert1"

   When prompted, enter the password that you specified when you exported the SSL certificate.


   The following example shows the cmdlet with the required parameters. Note that the port value of 8000 is a user-defined value. You can specify any available port number. If you specify port 443, then you do not need to specify the port number when you type the website URL.

   `new-AXClaimsAwareEnterprisePortalServer -Credential $Cred -Port 8000 -SSLCertificate $SSLCert`

   This cmdlet can take several minutes to be completed. After the cmdlet is completed, you can access a new instance of Enterprise Portal at the following URL: https://ServerName:PortNumber/sites/DynamicsAx.

Browse this site to verify that the command was executed properly. If you viewed the site, then you skip to the Install the ASP.NET database section. If you were not able to view the site, see the Troubleshooting issues with a claims-aware site section.
Create a claims-aware site on an existing SharePoint web application

If you want to create a new claims-aware site on an existing SharePoint web application, note the following requirements.

- The web application must be configured for Integrated Windows/NTLM authentication in SharePoint Central Administration. This is required even if the web application is already configured as a claims-mode web application.
- You must be a member of the site collection administrator group in SharePoint to perform the following procedures.

⚠️ Important

We recommend that the web application be configured with SSL to enhance data security.

Verify that the existing web application uses the Windows authentication provider

Use the following procedure to verify that the existing web application uses the Windows authentication provider.

1. In SharePoint Central Administration, click Application Management.
2. Under Web applications, click Manage web applications.
3. Click the application and then click Authentication Providers.
4. Verify that the Zone lists Default and the Membership Provider Name lists Windows.
5. Click the Zone link.
6. In either the IIS Authentication Settings section or the Claims Authentication Types section, verify that Integrated Windows and NTLM are selected.
7. Save your changes.

Create an Enterprise Portal site on the web application

Choose one of the following options to create an Enterprise Portal site on the existing web application.

- Use Microsoft Dynamics AX Setup
- Use Microsoft Dynamics AX 2012 Management Shell

Use Microsoft Dynamics AX Setup

To create an Enterprise Portal site on the existing web application by using Microsoft Dynamics AX Setup, complete the procedure described earlier, in the Install Enterprise Portal binaries section. However, when you
perform that procedure, you must select the existing web application and select the following options: **Configure for Windows SharePoint Services**, **Create Web site**, and **Restart IIS after installation is completed**.

![Microsoft Dynamics AX 2012 Management Shell](image)

Use the Microsoft Dynamics AX 2012 Management Shell

You can create an Enterprise Portal site on the existing web application by using the Microsoft Dynamics AX 2012 Management Shell.

1. Determine the name of the web application where you want to create the site. In SharePoint Central Administration, click **Manage web applications**. Find the name of the application. For example, SharePoint – 443.

2. On the Enterprise Portal server, execute the **New-AXClaimsAwareEnterprisePortalServer** cmdlet by using the following parameters.

   ```powershell
   new-AXClaimsAwareEnterprisePortalServer -Credential $Cred -WebApplication "ExistingWebApplicationName"
   ``

   For example:

   ```powershell
   new-AXClaimsAwareEnterprisePortalServer -Credential $Cred -WebApplication "SharePoint - 443"
   ```

   This cmdlet can take several minutes to be completed. After the cmdlet is completed, you can access a new instance of Enterprise Portal at the following URL: https://ServerName:PortNumber/sites/DynamicsAx. Browse this site to verify that the command was executed properly. If you viewed the site, then you skip to the **Install the ASP.NET database** section. If you were not able to view the site, see the **Troubleshooting issues with a claims-aware site** section.
Troubleshooting issues with a claims-aware site

Error: A specified logon session does not exist.
This error is caused by incorrect certificate information. Verify that you selected Mark this key as exportable when you imported the certificate.

Error: Setup could not find the IIS virtual server by using the name you specified.
This error occurs when the web application and Enterprise Portal site already exist on the server, so that the Windows PowerShell cmdlet detects a conflict.

To resolve this issue:
1. Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
2. Expand the server node, and then expand the Web sites node.
3. Click the Enterprise Portal site.
4. In the center pane, under IIS, double-click Authentication.
5. Click ASP.NET Impersonation, and then, in the Actions pane, click Disable.
6. Use Microsoft Dynamics AX Setup to install Enterprise Portal on the web application created by the New-AXClaimsAwareEnterprisePortalServer cmdlet. For more information, see the Install Enterprise Portal section.

噪声 Note

On the Configure a Web site for Enterprise Portal page of the Setup Wizard, clear all options. You will configure SharePoint and create the website later in this procedure.

7. After you install Enterprise Portal on the web application, click Start > SharePoint Central Administration.
8. Click Application Management.
9. Under Site Collections, click Create site collections.
10. Under Select a template, click the Custom tab.
11. Select the Microsoft Dynamics Enterprise Portal template.
12. After SharePoint creates the site collection, select the Enterprise Portal site in IIS Manager. In the center pane, under IIS, double-click Authentication.

Install the ASP.NET database

Enterprise Portal users who are external to your business or organization will enter their credentials during sign-up, and those credentials will be stored in an ASP.NET database. Use the following procedure to create the ASP.NET database.

噪声 Note

You can install the ASP.NET database on a separate server. If you do install this database on a separate server, then you must specify a SQL connection string that will permit access to the database. You can specify the connection string by using the -ConnectionString parameter when you execute the Add-AXSharepointClaimsAuthenticationProvider Windows PowerShell cmdlet later in this document.
Open a Command Prompt window by using an administrator account on the server. Execute the following command.

1. `%windir%\Microsoft.NET\Framework64\v4.0.30319\aspnet_regsql.exe`
2. The ASP.NET SQL Server Setup Wizard opens.
3. Accept all default values, and complete the wizard. The wizard creates a new database in Microsoft SQL Server called aspnetdb.

**Grant the Business Connector proxy access to the ASP.NET database**

Complete the following procedure to add the .NET Business Connector proxy to the ASP.NET database.

1. Open SQL Server Manager on the server where you installed the ASP.NET database.
2. Expand then ASP.NET database in the left column, and then expand the Security node.
3. Right-click the Users node and select New User.
4. Enter the domain/user_name of the .NET Business Connector proxy.
5. In the Database Role Membership section, click db_owner.
6. Save your changes.

**Create a signing certificate to establish trust between the Enterprise Portal site and the forms-based site**

This section describes how to create a signing certificate that is used to establish trust between the claims-aware Enterprise Portal site and the forms-based site. The makecert.exe command in the following procedures creates a self-signed certificate and registers that certificate with the local computer. For the following procedures, refer to Option A if Visual Studio is installed on the Enterprise Portal server, or refer to Option B if Visual Studio is installed on a separate server and you need to export the certificate after you create it.

**Option A: Visual Studio is installed on the Enterprise Portal server**

Use this procedure to create a signing certificate. You must use Visual Studio to create the certificate. This procedure describes how to create the certificate when Visual Studio is installed on the Enterprise Portal server. If Visual Studio is not installed on the Enterprise Portal server, go to Option B.

1. On the Enterprise Portal server, click Start > All Programs.
2. Click Microsoft Visual Studio 2010.
4. Execute following command, replacing `<string>` with a name for your certificate. For example: FORMS-CERT. Make a note of the name of this string because you will specify it again in the next procedure.

```
makecert.exe -r -pe -a sha1 -n "CN=<string>" -ss My -sr LocalMachine -sky exchange -len 2048 -sp "Microsoft Enhanced RSA and AES Cryptographic Provider" -sy 24 c:\certs\<string>.cer
```

After the command completes go to the [Grant the .NET Business Connector proxy access to the signing certificate](#) section.

**Option B: Visual Studio is not installed on the Enterprise Portal server**

Use this procedure to create a signing certificate. You must use Visual Studio to create the certificate. This procedure describes how to create the certificate with Visual Studio and then import the certificate to the Enterprise Portal server.

1. On the Visual Studio server, click Start > All Programs.
2. Click Microsoft Visual Studio 2010.
4. Execute following command, replacing <string> with a name for your certificate. For example: FORMS-CERT. Make a note of the name of this string because you will specify it again in the next procedure.

    makecert.exe -r -pe -a sha1 -n "CN=<string>" -ss My -sr LocalMachine -sky exchange -len 2048 -sp "Microsoft Enhanced RSA and AES Cryptographic Provider" -sy 24 c:\certs\<string>.cer

5. Click Start > Run, type mmc and press Enter.
6. In the Microsoft Management Console, click File > Add/Remove snap-in.
7. Add the Certificates snap-in and click OK.
8. Click Computer account and then click Next.
9. Click Local computer and then click Finish.
10. Click OK to close the Add or Remove Snap-ins dialog box.
11. Expand the Certificates (Local Computer) node.
12. Expand the Trusted Root Certification Authorities > Certificates node.
13. Right-click the certificate that you created in Step 4 of this procedure and click All Tasks/Export.
14. Click Next, and then click Yes, Export the private key.
15. Click Next, and then enter a password for the certificate. Make a note of the password because you will need to specify it when you import the certificate in the next procedure.
16. Click Next, and then specify a location and name for the certificate.
17. Click Finish.
18. Copy the certificate file (.PFX file) to a location that is accessible by the Enterprise Portal server. You can now import the certificate to the Enterprise Portal server.

**Import the certificate to the Enterprise Portal server**

Use this procedure to import the signing certificate that you created in the previous procedure to the Enterprise Portal server.

1. On the Enterprise Portal server, click Start > Run, type mmc and press Enter.
2. In the Microsoft Management Console, click File > Add/Remove snap-in.
3. Add the Certificates snap-in and click OK.
4. Click Computer account, and then click Next.
5. Click Local computer, and then click Finish.
6. Click OK to close the Add or Remove Snap-ins dialog box.
7. Expand the Certificates (Local Computer) node.
8. Right-click Trusted Root Certification Authorities, and then click All tasks\Import.
9. Click Next, and then specify the file location.
10. Click Next, and then enter the password for the pfx certificate.
11. Select the Mark this key as exportable option, and then click Next.
12. Click Next, and then click Finish.
13. You are now ready to grant the .NET Business Connector proxy access to the signing certificate.
Grant the .NET Business Connector proxy access to the signing certificate

Use the following procedure to grant the .NET Business Connector proxy access to the signing certificate you created in the previous section.

1. On the Enterprise Portal server, click Start > Run, type mmc and press Enter.
2. In the Microsoft Management Console, click File > Add/Remove snap-in.
3. Add the Certificates snap-in and click OK.
4. Click Computer account, and then click Next.
5. Click Local computer, and then click Finish.
6. Click OK to close the Add or Remove Snap-ins dialog box.
7. Expand the Certificates (Local Computer) > Personal > Certificates node.
8. Right-click the certificate you created in the previous section and select All Tasks > Manage Private Keys.
9. Add the .NET Business Connector as a user and grant Full control permissions.
10. Save your changes.

Create a forms-based Security Token Service site

An Enterprise Portal site can support multiple identity providers. When a user selects the forms authentication provider, they are redirected to the Security Token Service (STS) site that you will create in this section. The user can then login to Enterprise Portal using their forms-based credentials.

1. Click Start > Administrative Tools.
2. Click Microsoft Dynamics Ax 2012 Management Shell.
3. Execute the following command, replacing "PathToSSLCert2" with the path of the SSL certificate that you registered earlier in this document.

   $SSLCert = Get-PfxCertificate "PathToSSLCert2"

4. Execute the following command. Note that the value of <string>.cer is the same value you specified for the Create a signing certificate to establish trust between the Enterprise Portal site and the forms-based site procedure.

   $SigningCert = Get-PfxCertificate c:\certs\<string>.cer

5. On the Enterprise Portal server, execute the Add-AXSharepointClaimsAuthenticationProvider cmdlet. For descriptions of the required parameters and syntax, see Add-AXSharepointClaimsAuthenticationProvider on TechNet.

   The following example shows the cmdlet with the required parameters. Note that the name FormsAuth and the port value 8088 are user-specified values. You can specify any name and available port.

   Add-AXSharepointClaimsAuthenticationProvider -Type Forms -Name FormsAuth -SigningCertificate $SigningCert -Credential $Cred -Port 8088 -SSLCertificate $SSLCert

Note

The command assumes that the ASP.NET database is installed on the Enterprise Portal server. If the ASP.NET database is installed on a separate server, you must also specify the –ConnectionString parameter.

   –ConnectionString "Data Source=<AspNetDbMachineName>;Initial Catalog=aspnetdb;Trusted_Connection=true"

The following example shows the cmdlet with the required parameters.

```
Add-AXEnterprisePortalClaimsAuthenticationProvider -URL "https://ServerName:PortNumber" -Name FormsAuth
```

This cmdlet adds the forms-based authentication trusted identity provider to the claims-aware Enterprise Portal site. The URL must be the URL of the Enterprise Portal site that you created earlier in this document: https://ServerName:PortNumber. Users should now see this provider in the providers list when they navigate to the site (https://ServerName:PortNumber/sites/DynamicsAx).

**Force new users to change their password at first logon**

By default, the forms-based authentication provider does not require new users to change the default password that was specified when the user account was enabled. As a security best practice, we recommend that you force new users to change their password at first logon.

1. Open the forms-based authentication provider web.config file. By default, the file path is:
   
   C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\template\layouts\FormsAuth\web.config

2. Locate the `enableForceChangePasswordOnce` key.

3. Change the key setting to "true". For example:
   
   ```xml
   <add key="enableForceChangePasswordOnce" value="true" />
   ```

4. Save your changes in the file.

5. Restart the web service.

⚠️ **Important**

By default, the maxinvalidPasswordAttempts property in the web.config file is configured to allow unlimited logon attempts. We recommend that you configure the property to limit the number of logon attempts. For more information, see the SqlMembershipProvider.MaxInvalidPasswordAttempts property on MSDN.

**Create a new user for forms-based authentication**

The New-AXUser cmdlet creates a new user in the System user role in Microsoft Dynamics AX. After you create the new user using the following command, add the user to other roles, if needed. For more information about adding users to Microsoft Dynamics AX or configuring user roles, see Set up user security in Microsoft Dynamics AX on TechNet.

If you are creating a claims user, specify the name of the claims provider in the `UserDomain` parameter. If you are using forms-based claims authentication, you can also create a new user in the provider.

1. Click Start > Administrative Tools.
2. Click Microsoft Dynamics Ax 2012 Management Shell.
3. On the Enterprise Portal server, execute the **New-AXUser** cmdlet. For descriptions of the required parameters and syntax, see **New-AXUser** on TechNet.

   The following example shows the cmdlet with the required parameters. The **AXUserId**, **UserName**, **UserDomain**, and **Password** are user-specified values. The **UserDomain** is the same value specified for Name in Step 7 of the previous procedure.

   ```
   New-AXUser -AccountType ClaimsUser -AXUserId jdd -UserName johndoe -UserDomain FormsAuth -CreateInProvider -ClearTextPassword "Yukon!!90"
   ```

4. Assign security roles for the user by using the **Add-AXSecurityRoleMember** cmdlet or by using the **Users** form in the Microsoft Dynamics AX client. For more information about the **Add-AXSecurityRoleMember** cmdlet, see **Add-AXSecurityRoleMember** on TechNet.

**Log on to the site using forms-based authentication**

If you browse the Enterprise Portal site by using the following URL: https://ServerName:PortNumber/sites/DynamicsAx, the Sign In page prompts you to select a logon option from the drop-down list. If you select FormsAuth, you are redirected to the forms-based authentication logon site, such as https://ServerName.contoso.com:PortNumber/_Layouts/Login.aspx. Verify that you can log on to the site using forms-based authentication.

**Deploy an Enterprise Portal site that uses AD FS authentication**

**Applies to:** Microsoft Dynamics AX 2012 R3

This section describes how to deploy Enterprise Portal for Microsoft Dynamics AX in an Active Directory Federation Services (AD FS) environment. AD FS simplifies access to systems and applications by using a claims-based authorization mechanism to help maintain application security. AD FS supports web single sign-on technologies that help IT organizations collaborate across organizational boundaries. AD FS is a server role in Windows Server 2008 R2 and Windows Server 2012. For more information about AD FS, see **Active Directory Federation Services** on Microsoft.com.
### Before you begin

Complete the following tasks before you install Enterprise Portal.

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
</table>
| Install Microsoft Dynamics AX hotfixes for claims-mode authentication (required for Microsoft Dynamics AX 2012 R2 or earlier; not required for Microsoft Dynamics AX 2012 R3). | 1. [Download](#) and install the Microsoft Dynamics AX 2012 claims-mode authentication hotfix (KB 2823664).  
2. [Download](#) and install the Microsoft Dynamics AX 2012 R2 claims-mode authentication hotfix (KB 2824690). |
| Create a domain account                                              | Create a domain account for the Microsoft Dynamics AX .NET Business Connector proxy.  
  **Caution**  
  The account should not be a member of the Microsoft Dynamics AX system administrator group or a member of the Windows administrator group on the Enterprise Portal server. The login should not be used for standard logon purposes. Only those individuals who are responsible for deploying and configuring Microsoft Dynamics AX should know the credentials for this login. If a malicious user gained access to the credentials for this login, that person could potentially impersonate any Microsoft Dynamics AX user.  
  Enter the account in the Microsoft Dynamics AX client on the [System administration > System > System service accounts](#) form. |
| Install SharePoint                                                    | After you install SharePoint on the web server, run the SharePoint configuration wizard. Specify the Microsoft Dynamics AX .NET Business Connector proxy account on the [Specify Configuration Database Settings > Specify Database Access Account](#) page of the SharePoint configuration wizard. |
| Compile Microsoft Dynamics AX if you installed any non-SYS layer mode files | If you installed a non-SYS layer model file in the Microsoft Dynamics AX environment, compile Microsoft Dynamics AX before you install Enterprise Portal. If you do not compile Microsoft Dynamics AX, the Enterprise Portal installation might fail. |
| Download and deploy language packs                                  | If you want to deploy Enterprise Portal in multiple languages, download and deploy the SharePoint language packs on the Web server before you install Enterprise Portal. You must create a unique Web application in SharePoint for each language. You can download language packs from Microsoft.com. |
| Verify the server name                                               | Verify that the name of the server that will host Enterprise Portal does not include an underscore, for example EPserver_1. If an Enterprise Portal server includes an underscore in the server name, lookups and webpages might display errors. |
| Verify prerequisites and system requirements                         | On the computer where you will install Enterprise Portal, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](#) on Microsoft.com. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify permissions</td>
<td>Verify that you have the appropriate permissions to install Enterprise Portal. If you are installing Enterprise Portal on a server that already hosts an Enterprise Portal deployment and you want to overwrite that deployment, you must have Full Control permission in SharePoint for the existing Enterprise Portal site collection. If you do not have Full Control permission, you will not be able to delete the existing site collection by using Setup. For more information about permissions, see the <strong>Verify that you have the required permissions for installation</strong> section.</td>
</tr>
<tr>
<td>Verify SSL settings</td>
<td>For Secure Sockets Layer (SSL) encryption, you cannot install Enterprise Portal on a web application that is already configured to use HTTP and HTTPS bindings. You must remove the HTTP binding from the site by using Internet Information Services (IIS) Manager before you install Enterprise Portal.</td>
</tr>
</tbody>
</table>

**Pre-installation tasks**

Perform the following tasks to verify that you can deploy Enterprise Portal on the web server.

1. Verify that you can open SharePoint Central Administration on the Enterprise Portal server.
2. Verify that you have the appropriate permissions to create sites by using SharePoint Central Administration to create a SharePoint team site.
3. Verify that you can browse the team site without prompts and resolve the URL without proxy errors or other problems.
4. If you intend to deploy or configure Enterprise Portal at a command prompt, verify that you can start the SharePoint Management Shell.

**Install Enterprise Portal binaries**

This section describes how to install Enterprise Portal binaries by using Setup. During this initial install, you will not install create an Enterprise Portal site. You will create the site later in this document.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you're installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Enterprise Portal (EP)** and **.NET Business Connector**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any warnings or errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no warnings or errors remain, click **Next**.
8. On the **Select a file location** page, select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.
9. On the **Specify a location for configuration settings** page, specify whether you want Enterprise Portal to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click **Next**.
10. On the **Connect to an AOS instance** page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. If necessary, verify name of the AOS instance, the TCP/IP port number, and the WSDL port for services before you click **Next**. If the AOS details are correct, click **Next**.

11. On the **Specify Business Connector proxy account information** page, enter the user name and password for the proxy account that is used by the .NET Business Connector. Click **Next**.

12. On the **Configure a Web site for Enterprise Portal** page, select the SharePoint – 80 (SharePoint Web application). If no web applications are available in the list, you must cancel Setup, create a web application by using SharePoint Central Administration, and then try the installation again.

   **Caution**
   
   Do not select any other options on this page. Verify that you specified the SharePoint – 80 web application and that all other options are cleared before you click **Next**.

13. Click **Next**.

14. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

15. On the **Ready to install** page, click **Install**.

16. After the installation is complete, click **Finish** to close the wizard.

**Important**

Before you proceed to the next section, verify that the .NET Business connector proxy account was added to the **WSS_WPG** group on the web server computer: From a command prompt type **net localgroup wss_wpg** and press Enter.
Register an SSL certificate on the AD FS server

For testing, you can create a self-signed SSL certificate. If you create self-signed certificates, we recommend that you have one self-signed SSL certificate for the Enterprise Portal server (SSLCert1) and one self-signed SSL certificate for the AD FS server (SSLCert2). For more information, see Create a Self-Signed Server Certificate in IIS 7.0 on Microsoft.com. For production servers, you must register an SSL certificate from a certification authority on the AD FS server. The certificate will help make sure that the user’s claim was not changed in transit. We recommend that you register separate SSL certificates for the AD FS and Enterprise Portal servers. After you have created self-signed certificates or acquired certificates, complete the following procedure.

1. On the Windows Server that will host the claims-based Enterprise Portal site, click Start > Run, type mmc, and then click OK.
2. Click File > Add/remove snap-in.
3. Click Certificates, and then click Add.
4. When the system prompts you to specify which type of account to manage certificates for, click Computer Account, and then click Next.
5. Click Local computer, and then click Finish.
6. In the Add or Remove Snap-ins dialog box, click OK.
7. In MMC snap-in, click the Certificates (Local Computer) node.
8. Right-click Personal, and then click All tasks > Import. The Certificate Import Wizard opens. Click Next.
9. Browse to the certificate, and then click Next.
10. Enter the password for the certificate, and then click Next.
11. Select the Mark this key as exportable option, and then click Next. The Certificate Store dialog box appears.
12. Click Next.
13. Click Finish.

Enable SharePoint Claims to Windows Token Service

You must enable the SharePoint claims to Windows token service (C2WTS) for claims-based authentication. Use the following procedure to start this service.

1. In SharePoint Central Administration, under System Settings, click Manage services on server.
2. Locate the Claims to Windows Token Service.
3. In the Action column, click Start.
4. In Windows, click Start > Run, type services.msc and press Enter.
5. In the Services console, verify that the Claims to Windows Token Service is running.

⚠️ Note
Do not use the services.msc to start the C2WTS because the service will be automatically disabled after a period of time. You must use SharePoint Central Administration to start this service.

Create a claims-aware Enterprise Portal site

This section describes how to create a claims-aware Enterprise Portal site by using a Microsoft Windows PowerShell cmdlet. The cmdlet in this section first creates a claims-aware web application in SharePoint, and then deploys an Enterprise Portal site on that web application. If you are not familiar with Windows PowerShell cmdlets for Microsoft Dynamics AX, see Administering Microsoft Dynamics AX by using Windows PowerShell on...
Microsoft.com for more information. You can also create a claims-aware Enterprise Portal site on an existing SharePoint web application. Complete one of the following procedures.

- Create a claims-aware site on a new SharePoint web application
- Create a claims-aware site on an existing SharePoint web application

**Create a claims-aware site on a new SharePoint web application**

**Note**

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to Restricted, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to RemoteSigned by using the Set-ExecutionPolicy cmdlet. This setting allows you to run scripts that you’ve written and scripts that have been signed by a trusted publisher.

1. Open the Microsoft Dynamics AX 2012 Management Shell with administrator privileges. Click Start > Administrative Tools > right-click Microsoft Dynamics AX 2012 Management Shell and click Run as administrator.
2. Enter the following command and press Enter.
   ```
   $Cred=Get-Credential
   ```
3. When prompted, enter the credentials for the .NET Business Connector proxy account. The credentials must be the .NET Business Connector proxy account and password that were specified when Enterprise Portal binaries were installed earlier in this document. If you specify an account other than the .NET Business Connector proxy account, then the cmdlet overwrites the existing .NET Business Connector account, which can cause existing Enterprise Portal installations to stop working. Also note, this cmdlet designates the .NET Business Connector proxy account as the Enterprise Portal site administrator.
4. Execute the following command, replacing "PathToSSLCert1" with the path to SSLCert1, which you imported earlier in this document.
   ```
   $SSLCert = Get-PfxCertificate "PathToSSLCert1"
   ```
   When prompted, enter the password that you specified when you exported the SSL certificate.
5. On the Enterprise Portal server, execute the **New-AXClaimsAwareEnterprisePortalServer** cmdlet. For descriptions of the required parameters and syntax, see **New-AXClaimsAwareEnterprisePortalServer** on TechNet.

The following example shows the cmdlet with the required parameters. Note that the port value of 8000 is a user-defined value. You can specify any available port number. If you specify port 443, then you do not need to specify the port number when you type the website URL.

```
new-AXClaimsAwareEnterprisePortalServer -Credential $Cred -Port 8000 -SSLCertificate $SSLCert
```

This cmdlet can take several minutes to be completed. After the cmdlet is completed, you can access a new instance of Enterprise Portal at the following URL: https://ServerName:PortNumber/sites/DynamicsAx.

Browse this site to verify that the command was executed properly. If you viewed the site, then you skip to the **Install Active Directory Federation Services 2.0** section. If you were not able to view the site, see the **Troubleshooting issues with a claims-aware site** section.
Create a claims-aware site on an existing SharePoint web application
If you want to create a new claims-aware site on an existing SharePoint web application, note the following requirements.

- The web application must be configured for Integrated Windows/NTLM authentication in SharePoint Central Administration. This is required even if the web application is already configured as a claims-mode web application.
- You must be a member of the site collection administrator group in SharePoint to perform the following procedures.

⚠️ Important
We recommend that the web application be configured with SSL to enhance data security.

Verify that the existing web application uses the Windows authentication provider
Use the following procedure to verify that the existing web application uses the Windows authentication provider.
1. In SharePoint Central Administration, click Application Management.
2. Under Web applications, click Manage web applications.
3. Click the application and then click Authentication Providers.
4. Verify that the Zone lists Default and the Membership Provider Name lists Windows.
5. Click the Zone link.
6. In either the IIS Authentication Settings section or the Claims Authentication Types section, verify that Integrated Windows and NTLM are selected.
7. Save your changes.

Create an Enterprise Portal site on the web application
Choose one of the following options to create an Enterprise Portal site on the existing web application.

- Use Microsoft Dynamics AX Setup
- Use Microsoft Dynamics AX 2012 Management Shell

Use Microsoft Dynamics AX Setup
To create an Enterprise Portal site on the existing web application by using Microsoft Dynamics AX Setup, complete the procedure described earlier, in the Install Enterprise Portal binaries section. However, when you
perform that procedure, you must select the existing web application and select the following options: **Configure for Windows SharePoint Services**, **Create Web site**, and **Restart IIS after installation is completed**.

![Configure a Web site for Enterprise Portal](image)

**Use the Microsoft Dynamics AX 2012 Management Shell**

You can create an Enterprise Portal site on the existing web application by using the Microsoft Dynamics AX 2012 Management Shell.

1. Determine the name of the web application where you want to create the site. In SharePoint Central Administration, click **Manage web applications**. Find the name of the application. For example, SharePoint – 443.

2. On the Enterprise Portal server, execute the **New-AXClaimsAwareEnterprisePortalServer** cmdlet by using the following parameters.

   ```powershell
   new-AXClaimsAwareEnterprisePortalServer -Credential $Cred -WebApplication "ExistingWebApplicationName"
   ``

   For example:

   ```powershell
   new-AXClaimsAwareEnterprisePortalServer -Credential $Cred -WebApplication "SharePoint - 443"
   ``

   This cmdlet can take several minutes to be completed. After the cmdlet is completed, you can access a new instance of Enterprise Portal at the following URL: https://ServerName:PortNumber/sites/DynamicsAx. Browse this site to verify that the command was executed properly. If you viewed the site, then you skip to the **Install Active Directory Federation Services 2.0** section. If you were not able to view the site, see the **Troubleshooting issues with a claims-aware site** section.
Troubleshooting issues with a claims-aware site

Error: A specified logon session does not exist.
This error is caused by incorrect certificate information. Verify that you selected Mark this key as exportable when you imported the certificate.

Error: Setup could not find the IIS virtual server by using the name you specified.
This error occurs when the web application and Enterprise Portal site already exist on the server, so that the Windows PowerShell cmdlet detects a conflict.

To resolve this issue:
1. Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
2. Expand the server node, and then expand the Web sites node.
3. Click the Enterprise Portal site.
4. In the center pane, under IIS, double-click Authentication.
5. Click ASP.NET Impersonation, and then, in the Actions pane, click Disable.
6. Use Microsoft Dynamics AX Setup to install Enterprise Portal on the web application created by the New-AXClaimsAwareEnterprisePortalServer cmdlet. For more information, see the Install Enterprise Portal section.

Note
On the Configure a Web site for Enterprise Portal page of the Setup Wizard, clear all options. You will configure SharePoint and create the website later in this procedure.

7. After you install Enterprise Portal on the web application, click Start > SharePoint Central Administration.
8. Click Application Management.
9. Under Site Collections, click Create site collections.
10. Under Select a template, click the Custom tab.
11. Select the Microsoft Dynamics Enterprise Portal template.
12. After SharePoint creates the site collection, select the Enterprise Portal site in IIS Manager. In the center pane, under IIS, double-click Authentication.

Install Active Directory Federation Services 2.0
This section describes how to install AD FS on an Enterprise Portal server.
1. Download AD FS, and run Setup.
2. When prompted to select a server role, click Federation server.
3. After the installation is completed, restart the server as recommended by Setup, and then run the AD FS 2.0 Management tool. In Windows, click Start > Administrative Tools > AD FS 2.0 Management.
4. Under Configure This Federation Server, click AD FS 2.0 Federation Server Configuration Wizard.
5. Click Create a new Federation Service, and then click Next.
6. Click Stand-alone federation server, and then click Next.
7. Specify the SSL certificate that you created earlier in this document, and then click Next.
8. Complete the wizard. AD FS creates a new application named adfs on the Default Web Site in IIS.
Add a trusted relying party
A relying party trust is a trust object that is created to maintain the relationship with a Federation Service or an application that consumes claims from the Federation Service. This section describes how to configure a trusted relying party in AD FS 2.0 Management.

1. In AD FS 2.0 Management, click **Require: Add a trusted relying party**. The Add Relying Party Trust Wizard opens.
2. Click **Start**.
3. Click **Enter data about the relying party manually**, and then click **Next**.
4. In the **Display Name** field, enter a name, such as **ADFS Sign-on**, and then click **Next**.
5. Click **ADFS 1.0 and 1.1 profile**, and then click **Next**.
6. In the **WS-Federation Passive URL** field, enter the URL of the claims-aware Enterprise Portal site. The URL must use the following format: https://ServerName:portnumber/_trust/. The server name and port must be the values that you specified earlier in this document when you created the claims-aware Enterprise Portal site. For example: https://TestServer:8000/_trust/
7. Type an identifier in the format urn:ServerName:ProviderName, and then click **Add**. For example: urn:TestServer:ADFSProvider
8. Remove the following entry from the list of providers: https://ServerName:PortNumber/_trust/
9. Click **Next**.
10. Click **Permit all users to access this relying party**, and then click **Next**.
11. On the **Ready to Add Trust** page, click **Next**.
12. On the **Finish** page, click **Open the Edit Claim Rules** for the relying party trust.
13. Click **Add Rule**.
14. Select the **Send LDAP Attributes as Claims** claim rule template, and then click **Next**.
15. Enter a claims rule name, such as **ADFS sign-on**.
16. In the **Select an attribute store** section, click **Active Directory**.
17. Click **LDAP Attribute**, and then click **SAM-Account-Name**.
18. In the **Outgoing claim type** section, click **E-mail address**.
19. Click **Finish**.

Manage the AD FS token-signing certificate
1. In AD FS 2.0 Management, expand **Service**, and then click **Certificates**.
2. In the center pane, in the **Token-signing** section, right-click the **CN=ADFS Signing** certificate, and then click **View Certificate**.
3. Click **Details**, and then click **Copy to file**.
4. Save the file as **Name.cer** by using the **DER Encoded Binary X.509** option and then copy it to a directory on the Enterprise Portal server. For example, you could save the certificate as **adfs-TokenSigningCert.cer** and save it in a **cert** directory on the C: drive of the Enterprise Portal server.

**Note**
Users must specify a valid email address for their account logon.
Specify the claims provider in SharePoint

1. In Windows, click Start > Administrative Tools.
2. Click Microsoft Dynamics AX 2012 Management Shell.
3. Execute the following command, replacing “path-to-token signing certificate from the AD FS server” with the path of the Name.cer file that you configured in step 4 of the previous procedure.

   ```
   $SigningCert = Get-PfxCertificate "path-to-token signing certificate from the AD FS server"
   ```

4. On the Enterprise Portal server, execute the Add-AXSharepointClaimsAuthenticationProvider cmdlet. For descriptions of the required parameters and syntax, see Add-AXSharepointClaimsAuthenticationProvider on TechNet.

   The following example shows the cmdlet with the required parameters.

   ```
   Add-AXSharepointClaimsAuthenticationProvider -Type ADFS -Name ADFSProvider -SigningCertificate $SigningCert -ServerUrl "https://ServerName/adfs/ls/"
   ```

   You can specify any name for the provider. In this example, the name is ADFSProvider. The server URL must be the FQDN of the server that runs AD FS, followed by /adfs/ls/.

5. On the Enterprise Portal server, execute the Add-AXEnterprisePortalClaimsAuthenticationProvider cmdlet. For descriptions of the required parameters and syntax, see Add-AXEnterprisePortalClaimsAuthenticationProvider on TechNet.

   The following example shows the cmdlet with the required parameters.

   ```
   Add-AXEnterprisePortalClaimsAuthenticationProvider -URL "https://ServerName:PortNumber" -Name ADFSProvider
   ```

   This cmdlet adds the AD FS-based authentication trusted identity provider to the claims-aware Enterprise Portal site. The URL must be the URL of the Enterprise Portal site that you created earlier in this document: https://ServerName:PortNumber. The name of the provider must be the name that was used to create the provider in the previous procedure. Users should now see this provider in the providers list when they browse the site (https://ServerName:PortNumber/sites/DynamicsAx).

Register the AD FS signing certificate as a trusted root authority with SharePoint

1. Click Start > All Programs > Microsoft SharePoint Products > SharePoint Management Shell.
2. Execute the following commands, replacing <Path-to-certificate>\Name.cer with the path and name of the AD FS signing certificate.

   ```
   $spcert = New-SPTrustedRootAuthority -Certificate $cert -Name "ADFSSigningCert"
   ```

   ✓ Note

   “ADFSSigningCert” is a user-specified value.

Create a new user for AD FS authentication

The New-AXUser cmdlet creates a new user in Microsoft Dynamics AX. You can specify the type of user to add. If you are creating a claims user, specify the name of the claims provider in the UserDomain parameter, as described in the following procedure.

1. In Windows, click Start > Administrative Tools.
2. Click Microsoft Dynamics AX 2012 Management Shell.
3. On the Enterprise Portal server, execute the **New-AXUser** cmdlet. For descriptions of the required parameters and syntax, see **New-AXUser** on TechNet.

   The following example shows the cmdlet with the required parameters. AXUser, UserName, and UserDomain are user-specified values. The value of UserDomain is the same value that you specified in step 4 of the **Specify the claims provider in SharePoint** procedure.

   ```powershell
   New-AXUser -AccountType ClaimsUser -AXUserId april -UserName aprilbuckley -UserDomain ADFSProvider
   ```

**Assign security roles for users**

You must assign security roles for each user who was created by using the **New-AXUser** cmdlet. For information about how to assign security roles in the Microsoft Dynamics AX client, see **Assign users to security roles**. For information about how to assign security roles by using Windows PowerShell, see the **Add-AXSecurityRoleMember** cmdlet Help on TechNet.

**Validate AD FS configurations**

1. Open a web browser, and browse the Enterprise Portal site: https://ServerName:PortNumber/sites/DynamicsAx
2. In the list of providers, select the AD FS provider. For example, **ADFSProvider**.
3. Log on to Enterprise Portal by using the credentials that you created in the previous procedure. You should be able to log on to Microsoft Dynamics AX as a system user.

**Troubleshooting AD FS issues**

**Error: Users see a blank page after logging on to Enterprise Portal by using the AD FS provider.**

This error occurs when the logon URL for the AD FS provider (for example, https://TestServer.contoso.com/adfs/ls/) cannot be opened in a web browser. To resolve this issue, you must update the hosts file on the server.

1. Open the hosts file. By default, the file is located in the following directory: C:\Windows\System32\drivers\etc folder
2. Add an entry for the AD FS provider in the form `<IP address of AD FS server> <AD FS Server Name> <FQDN of AD FS server>`
   For example: 10.10.50.215 TestServer TestServer.contoso.com
3. In Internet Explorer, open **Internet options**.
4. Click the **Connections** tab, and then click **LAN settings**.
5. Clear the **Automatically detect settings** option. You might have to instruct all Enterprise Portal users to change this setting in their web browser.

**Error: Users select the AD FS provider on the logon page, and then receive a “404: Page not found” error.**

To resolve this issue, use IIS Manager to verify that Default Web Site or the site that hosts the AD FS provider is running.

**Error: There was a problem accessing the site.**

To learn more about this error, view the details in the AD FS 2.0 Admin event log. If you need more details about this issue, you can enable the AD FS debug log, as described in the following procedure.

1. In Event Viewer, click **View > Show Analytic and Debug Logs**.
2. To view events in the debug log, click **AD FS 2.0 Tracing > Debug**.
3. Right-click the **Debug** log, and then click **Enable Log**.
Error in the AD FS Admin log: An error was encountered during a federation passive request.

Exception details:
Microsoft.IdentityServer.Web.InvalidScopeException: MSIS7007: The requested relying party trust 'urn:ServerName:Provider' is unspecified or unsupported. If a relying party trust was specified, it is possible that you do not have permission to access the trust relying party. Contact your administrator for details at: Microsoft.IdentityServer.Web.FederationPassiveAuthentication.SubmitRequest(MSISRequestSecurityToken request

To resolve this issue:
1. In AD FS 2.0 Management, click Trust Relationships > Relying Party.
2. Double click ADFS Sign-on.
3. Click the Identifiers tab.
4. In the Relying party identifiers field, verify that the address matches the address shown in the error message. Addresses are case sensitive.

Specify which trusted identity provider is available for users at logon
You can select which flexible authentication provider is available in the Sign-in list when a user accesses the Enterprise Portal site.
1. In SharePoint Central Administration on the Enterprise Portal server, click Manage web applications.
2. Click the claims-aware Enterprise Portal site.
3. Click Authentication providers.
4. Click Default.
5. In the Claims Authentication Types section, select the providers that you want to appear in the Sign-in list.
6. Click OK.

See also
• Deploy an Enterprise Portal site that uses forms-based authentication

Deploy Enterprise Portal for vendor registration with Windows Azure Active Directory Access Control

Applies to: Microsoft Dynamics AX 2012 R3
This section describes how to create a claims-aware Enterprise Portal site for vendor registration. The vendor registration process begins when a potential vendor requests registration by using a public Enterprise Portal site that is configured for anonymous authentication. After completing a series of steps in the registration workflow, the registered vendor can access Enterprise Portal outside of your Active Directory domain by using one of the following types of accounts: Microsoft Account, Google, Yahoo, or Facebook.

The claims-aware Enterprise Portal site uses Windows Azure Active Directory Access Control (also known as Access Control Service or ACS). ACS is a cloud-based service that provides user authentication and authorization to web applications and services. Instead of implementing an authentication system with user accounts that are specific to your application, ACS manages user authentication and authorization on the web.

This section describes how to deploy and configure Enterprise Portal with ACS for a vendor registration portal.
Before you begin
Complete the following tasks before you deploy Enterprise Portal for vendor registration.

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about Windows Azure Active Directory Access Control (ACS)</td>
<td><a href="https://msdn.microsoft.com">Access Control Services 2.0</a> on MSDN.</td>
</tr>
<tr>
<td>Purchase an Azure subscription so that you can use ACS</td>
<td><a href="https://azure.microsoft.com">Windows Azure sign-up</a> on Microsoft.com.</td>
</tr>
</tbody>
</table>

Process flow: Enterprise Portal vendor registration with Access Control Services
The diagrams in this section describe how users complete the vendor on-boarding process by using an Enterprise Portal site that is configured for claims-based authentication with ACS. After you configure Enterprise Portal with ACS, as described in this section, unsolicited vendors use this process to register with your company for consideration as vendors.

Unsolicited vendor sign up with an Enterprise Portal public site and ACS
This section describes the process by which an unsolicited vendor authenticates with ACS to use the Enterprise Portal sign up page.

The following figure shows the unsolicited vendor sign-up process flow with an Enterprise Portal public site and ACS.

1. A vendor wants to register with your company and locates the public site. The user is regarded as a Guest user with the security role **Vendor anonymous (external)**.
2. The vendor clicks the **sign-up** button. This button is visible when a guest user has the **Vendor anonymous (external)** security role in Microsoft Dynamics AX. The site redirects the request to ACS.
3. ACS provides the user with a list of links to registered identity providers. The user enters credentials for a third-party provider such as one of the following: Microsoft Account, Google, Yahoo, or Facebook. The provider authenticates the credentials.
4. After the user is authenticated, ACS redirects the user’s browser to the URL for the sign up form and includes an identity token.
5. Enterprise Portal determines that the user’s identity has been verified. Enterprise Portal displays the sign up form. The user completes the form and submits their information.
After the user submits their information in the **Sign up** form, Microsoft Dynamics AX stores the request as an unsolicited vendor requests with a user alias derived from the identity token. This information is used to create a Microsoft Dynamics AX user account. The new user account is assigned to the **Prospective vendor** security role in Microsoft Dynamics AX. The user creation is handled by the Microsoft Dynamics AX New User request workflow. The user is now considered to be a **Prospective Vendor** by the system. The system sends the user a private URL for more information, as described by the next process flow.

**Prospective vendor registration with an Enterprise Portal private site and ACS**

This section describes the process by which a prospective vendor (a user who has completed the sign up form described in the previous process flow) authenticates with ACS to use the Enterprise Portal vendor registration page.

The following figure shows the vendor prospect registration process flow with an Enterprise Portal private site and ACS.

1. A prospective vendor (a user) who wants to complete the registration process with your company to become a vendor locates the URL sent to their email after they completed the **Sign up** form.
2. The site determines that the user is not authenticated and redirects to ACS.
3. ACS provides the user with a list of links to registered identity providers. The user enters credentials for a third-party provider such as one of the following: Microsoft Account, Google, Yahoo, or Facebook. The provider authenticates the credentials.
4. After the user is authenticated, ACS redirects the user’s browser to the private Enterprise Portal URL and includes an identity token.
5. SharePoint determines that the user has been authenticated. Microsoft Dynamics AX authorizes the user to access the Prospective vendor registration form. The user completes the form and submits their information.

After the prospective vendor completes the registration form, the request is processed for approval by Microsoft Dynamics AX workflow. If the prospective vendor is accepted as a vendor, they are assigned a vendor security role. The vendor can then access the vendor portal pages.

**Deploy Enterprise Portal sites**

A vendor registration portal requires an internal Enterprise Portal site in your Active Directory domain and a public Enterprise Portal site configured for anonymous access. See the following procedures to install these sites:

- **Internal site**: Install [Enterprise Portal on a single server](on a single server) or [Deploy Enterprise Portal in a server farm](server farm)
- **Public site**: Create a [public Enterprise Portal site](public Enterprise Portal site) (on TechNet)

After you have deployed the internal site in your Active Directory domain and the public site with anonymous access, you can continue with the procedures in this section.
Register a site with Access Control Services (ACS)
This section includes multiple procedures to help you register a site with ACS and then configure the claims-aware site. You must complete each procedure in this section.

Create an ACS site on the Azure management portal
To perform the following procedure you must have an Azure subscription. For more information, see Windows Azure sign-up on Microsoft.com.

1. Open the Azure control panel on Microsoft.com.
2. In the left pane, click Active Directory and then click Access control namespace in the main header.

3. Create a new namespace. Click New at the bottom of the Azure webpage and complete the steps for App Services > Active Directory > Access Control > quick create. When the wizard is completed, you see an ACS URI in this format: https://<acs_namespace>.accesscontrol.windows.net

Note
Only the administrator of the Azure subscription can access the ACS Management Portal. This person must configure access for other administrators who need access to the ACS Access Control page. For more information, see Portal Administrators on Microsoft.com.

4. After the namespace is created, select it in the Access Control Namespaces list and click Manage at the bottom of the page.

5. In the Access Control Service management portal, click Identity Providers. Select the providers that you want to enable for your claims-aware Enterprise Portal site. If you select Microsoft Account, Google, or Yahoo, you can continue with the procedure to Add a relying party. If you want to enable Facebook as an identity provider, you must complete the steps in the Configure Facebook as an ACS identity provider procedure.
Configure Facebook as an ACS identity provider

Complete the following procedure to configure Facebook as an ACS identity provider for your claims-aware Enterprise Portal site.

1. Complete the configuration steps in the following article on MSDN: Facebook as an ACS Identity Provider. After you complete these steps in the article, continue with this procedure.

2. In the Access Control Service management portal, on the Basic page for the Facebook app, enter windows.net in the App Domains field.

3. In the Canvas URL field, enter the namespace URL in the format:
   http://ServerName.accesscontrol.windows.net/

Create relying party application #1

An application in a relying party role acts as a Web service that can request a set of claims from a trusted claims provider. The application also consumes the claims that it receives from its configured claims provider. Use the following procedure to create one of two relying party applications. You will create relaying party application #2 later in this document.

1. In the left pane of the ACS Management Portal, click Relying party applications.

2. Click Add.

3. Enter a name for the relying party. For example: Your_company_name Enterprise Portal. This name is used only in the ACS Management Portal.

4. Enter the name of a realm. A realm specifies where the authentication request will originate. This name can also be, for example, Your_company_name Enterprise Portal.

5. Enter a return URL. ACS redirects to this URL after successful authentication. For this website, the URL should be in the following format:
   https://<host_name>:<acs_port>/_trust
   You can specify any available port. Make a note of this port number because you will specify it again when you create the secure site on the host machine.

6. (Optional) Enter an error URL. If a user experiences an error, the web browser is redirected to this URL.
7. In the **Token format** field, specify **SAML1.1**.
8. In the **Token encryption policy** field, specify **None**.
9. In the **Token lifetime (secs)** field, enter a large number so that the token does not expire too frequently. For example, specify 86,400 seconds (24 hours).
10. Select the identify providers for this application.
11. In the **Rule group** section, create a new rule group.
12. Click **Save**.

**Configure the group**

Use this procedure to configure the new rule group that you created in the previous procedure.

1. Click **Add**.
2. Select the Identity providers to configure. You can select one provider or all of the providers.
3. In the **Input claim type** field, leave the default value of **Any**.
4. In the **Input claim** field, leave the default value of **Any**.
5. In the **Output claim type** field, click **Pass through first input claim type**.
6. In the **Output claim value** field, click **Pass through first input claim value**.
7. Click **Save**.

**Create a custom token signing certificate for the ACS site**

This procedure describes how to create a custom token signing certificate by using Internet Information Services (IIS) manager. The signing certificate is used to encrypt communications between the ACS application and the claims-aware Enterprise Portal site. This procedure creates a self-signed certificate for a developer or test environment. When you deploy a claims-aware Enterprise Portal vendor registration site in a production environment, you must acquire a valid certificate from a certificate authority. In commands throughout this document, this certificate is referred to as the `<ACS_signing_cert>`.

1. In IIS manager, in the center pane, click **Server Certificates**.
2. In the right pane, click **Create Self-Signed Certificate**.
3. Specify a friendly name for the certificate and click **OK**.
4. In the middle pane, right-click the certificate you just created and click **Export**.
5. Enter a path where you want to export the file and specify a password.
6. From the Windows Run dialog box, type `MMC.exe` and press Enter.
7. In Microsoft Management Console, click **File > Add/Remove Snap-ins**. Add the **Certificates** snap-in.
8. Click **Computer account** and then click **Local Computer**.
9. Click **Finish**.
10. In Microsoft Management Console, expand **Certificates (Local Computer) > Trusted Root Certification Authorities > Certificates** and locate the certificate you just created.
11. Right-click the certificate and click **All Tasks\Export**.
12. In the Certificate Export Wizard, select **No, do not export the private key** and retain all default settings. The wizard exports the certificate as a .cer file. Make a note of the path to this file because you will enter this information later in this section.
13. Verify that with this procedure you have successfully created both the `<acs_signing_cert>.pfx` file and the `<acs_signing_cert>.cer` file.
14. In the ACS Management Portal, in the left pane, click **Certificate and keys**.
15. Above the **Token Signing** section, click the **Add** link.

16. In the **Used for** section, click **Relying Party Application** and select the relying party application that you created in the previous procedure.

17. In the **Type** section, verify that **X.509 Certificate** is selected.

18. In the **Certificate** section, browse to the `<acs_signing_cert>.pfx` file, enter in the password, and click **Save**.

19. In the **Primary** section, verify that **Make Primary** is selected.

20. Click **Save**.

**Create the claims-aware Enterprise Portal site**

Use the procedures in this section to create a new SSL certificate for the claims-aware Enterprise Portal site and then create the site on a new SharePoint web application.

**Create an SSL certificate for the claims-aware site**

You created a custom token signing certificate by using IIS manager in the previous section. You must now create a second SSL certificate for the claims-aware Enterprise Portal site. This procedure creates a self-signed certificate for a developer or test environment. When you deploy a claims-aware Enterprise Portal vendor registration site in a production environment, you must acquire a valid certificate from a certificate authority.

⚠️ **Important**

You cannot use the custom token signing certificate that you created earlier. That certificate is specific to ACS. You must create a second SSL certificate, as described below.

1. In IIS manager, in the center pane, click **Server Certificates**.
2. In the right pane, click **Create Self-Signed Certificate**.
3. Specify a friendly name for the certificate and click **OK**.
4. In the middle pane, right-click the certificate you just created and click **Export**.
5. Enter a path where you want to export the file and specify a password.
6. From the Windows Run dialog box, type `MMC.exe` and press Enter.
7. In Microsoft Management Console, click **File > Add/Remove Snap-ins**. Add the **Certificates** snap-in.
8. Click **Computer account** and then click **Local Computer**.
9. Click **Finish**.
10. In Microsoft Management Console, expand **Certificates (Local Computer) > Trusted Root Certification Authorities > Certificates** and locate the certificate you just created.

11. Right-click the certificate and click **All Tasks\Export**.

12. In the Certificate Export Wizard, select **No, do not export the private key** and retain all default settings. The wizard exports the certificate as a .cer file. Make a note of the path to this file because you will enter this information later in this section.

**Create a claims-aware site on a new SharePoint web application**

This section describes how to create a claims-aware Enterprise Portal site by using a Microsoft Windows PowerShell cmdlet. The cmdlet in this section first creates a claims-aware web application in SharePoint, and then deploys an Enterprise Portal site on that web application. If you are not familiar with Windows PowerShell cmdlets for Microsoft Dynamics AX, see *Administering Microsoft Dynamics AX by using Windows PowerShell* on Microsoft.com for more information.

**Note**

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to **Restricted**, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to **RemoteSigned** by using the *Set-ExecutionPolicy* cmdlet. This setting allows you to run scripts that you’ve written and scripts that have been signed by a trusted publisher.

1. Open the Microsoft Dynamics AX 2012 Management Shell with administrator privileges. Click **Start > Administrative Tools**, right-click **Microsoft Dynamics AX 2012 Management Shell**, and click **Run as administrator**.

2. Enter the following command and press Enter.

   ```
   $Cred=Get-Credential
   ```

3. When prompted, enter the credentials for the .NET Business Connector proxy account. The credentials must be the .NET Business Connector proxy account and password that were specified when Enterprise Portal binaries were installed earlier in this document. If you specify an account other than the .NET Business Connector proxy account, then the cmdlet overwrites the existing .NET Business Connector account, which can cause existing Enterprise Portal installations to stop working. Also note, this cmdlet designates the .NET Business Connector proxy account as the Enterprise Portal site administrator.

4. Execute the following command, replacing “PathToSSLCert.pfx” with the path to the .PFX certificate file that you created in the previous procedure.

   ```
   $SSLCert = Get-PfxCertificate "PathToSSLCert.pfx"
   ```

   When prompted, enter the password that you specified when you created the SSL certificate.

5. On the Enterprise Portal server, execute the **New-AXClaimsAwareEnterprisePortalServer** cmdlet. For descriptions of the required parameters and syntax, see **New-AXClaimsAwareEnterprisePortalServer** on TechNet.

   **Important**

   The following example shows the cmdlet with the required parameters. For the port value, you must specify the port value of the Relying Party Application.

   ```
   new-AXClaimsAwareEnterprisePortalServer -Credential $Cred -Port 8000 -SSLCertificate $SSLCert
   ```
This cmdlet can take several minutes to be completed. After the cmdlet is completed, you can access a new instance of Enterprise Portal at the following URL:
https://ServerName:RelyingPartyAppPortNumber/sites/DynamicsAx.

The site is also listed in the **System administration** > **Enterprise Portal** > **Web sites** form.

Browse this site to verify that the command was executed properly. The site displays a certificate warning. You will not see this warning when you acquire a valid certificate from a certificate authority. You can ignore this warning for now and proceed to the site.

**Establish claims mapping**

Use the following Windows PowerShell commands to map three different claims to the ACS service.

1. **From the SharePoint Management Shell**, execute the following three commands:
   a. `$claim1 = New-SPClaimTypeMapping -IncomingClaimType "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/nameidentifier" -IncomingClaimTypeDisplayName "ACS Name Identifier Claim" -LocalClaimType "http://schemas.microsoft.com/custom/claim/type/2013/07/acs-nameidentifier"
   b. `$claim2 = New-SPClaimTypeMapping -IncomingClaimType "http://schemas.microsoft.com/accesscontrolservice/2010/07/claims/identityprovider" -IncomingClaimTypeDisplayName "ACS Identity Provider" -LocalClaimType "http://schemas.microsoft.com/custom/claim/type/2013/07/acs-identityprovider"
   c. `$claim3 = New-SPClaimTypeMapping -IncomingClaimType "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/name" -IncomingClaimTypeDisplayName "ACS username" -LocalClaimType "http://schemas.microsoft.com/custom/claim/type/2013/07/acs-username"

2. **Execute the following commands from the SharePoint Management Shell** to register a token:
   a. `$acscert = Get-PfxCertificate <ACS_signing_cert>
   b. New-SPTrustedIdentityTokenIssuer -Name <name_of_your_SP_Trusted_Identity_Provider> -Description <description_of_your_SP_Trusted_Identity_Provider> -Realm <realm_of_your_SP_trusted_identity_provider> -ImportTrustCertificate $acscert -SignInUrl "https://<acs_namespace>.accesscontrol.windows.net/v2/wsfederation" -ClaimsMappings $claim1,$claim2,$claim3 -IdentifierClaim $claim1.InputClaimType

   The following example shows parameters for Contoso Corporation's test environment

   New-SPTrustedIdentityTokenIssuer -Name "AzureACS" -Description "Azure ACS" -Realm urn:Contoso:AzureACS -ImportTrustCertificate $acscert -SignInUrl "https://ContosoTestServer1.accesscontrol.windows.net/v2/wsfederation" -ClaimsMappings $claim1,$claim2,$claim3 -IdentifierClaim $claim1.InputClaimType

3. **Execute the following commands in the SharePoint Management Shell** to import the `<ACS_signing_cert>` as trusted root certificate in SharePoint:
   b. $spcert = New-SPTrustedRootAuthority -Certificate $cert -Name "ACSTokenSigningCert"

**Configure the authentication provider in SharePoint Central Administration**

Use the following procedure to configure the "Azure ACS" identity provider for your claims-aware Enterprise Portal site.

1. In SharePoint Central Administration, click **Manage web applications** and then click the claims-aware Enterprise Portal site you created earlier in this section.
2. Click **Authentication providers** and then click **Default**.
3. In the **Trusted Identity provider** list, verify that **AzureACS** is selected.

4. From the SharePoint Central Administration home page, click **Security**.

5. Under **Users** click **Specify web application user policy**.

6. Click **Add Users**.

7. In the **Zones** list, click **Default**, and then click **Next**.

8. In the **Users** text box, enter **All Users\All Users (AzureACS)**.

9. Select **Full Read** permissions and then click **Finish**.
Verify sign-in

1. Enter the ACS URL for your Enterprise Portal site in a web browser. For example:
   https://ContosoTestServer1:8000/Sites/DynamicsAx.
2. In the **Sign In** list, select **AzureACS**.

![Sign In](image)

3. When prompted, specify valid credentials for one of the identity providers listed.

Create relying party application #2

Use the following procedure to create a relying party application for the public Enterprise Portal site.

1. In the left pane of the ACS Management Portal, click **Relying party applications**.
2. Click **Add**.
3. Enter a name for the relying party. For example: *Your_company_name* Unsolicited Vendor Sign-up. This name is used only in the ACS Management Portal.
4. Enter the name of a realm. A realm specifies where the authentication request will originate. This name can also be, for example, *Your_company_name* Unsolicited Vendor Sign-up.
5. Enter a return URL. ACS redirects to this URL after successful authentication. For a public website, the URL should be in the following format:
   
   http://ServerName:Port/sites/Public/Enterprise%20Portal/VendRequestSignUp.aspx
   
   Specify the port where you deployed the public Enterprise Portal site.
6. (Optional) Enter an error URL. If a user experiences an error, the web browser is redirected to this URL.
7. In the **Token format** field, specify SAML1.1.
8. In the **Token encryption policy** field, specify None.
9. In the **Token lifetime (secs)** field, enter a large number so that the token does not expire too frequently. For example, specify 86,400 seconds (24 hours).

10. Select the identify providers for this application.

11. In the **Rule group** section, create a new rule group.

12. Click **Save**.

### Configure a rule group for the public site

Use this procedure to configure a rule group for the public Enterprise Portal site.

1. Click **Add**.
2. Select the Identity providers to configure. You can select one provider or all of the providers.
3. In the **Input claim type** field, leave the default value of **Any**.
4. In the **Input claim** field, leave the default value of **Any**.
5. In the **Output claim type** field, click **Pass through first input claim type**.
6. In the **Output claim value** field, click **Pass through first input claim value**.
7. Click **Save**.

### Configure the login page for the public Enterprise Portal site

1. On the Azure ACS management portal, click **Development > Application Integration > Login pages**.
2. Select relaying party application #1. (The first relaying party application you created in this documented.)
3. Copy the link in the **Option 1: Link to an ACS-hosted login page** field.
4. In IIS Manager, select the Enterprise Portal public site web application.
5. In the center pane under **ASP.NET**, click **Application Settings**.
6. Click **Add** and specify the following:
   - **Name**: STSSignInURL
   - **Value**: The link that you copied in step 2 of this procedure.
7. Click **OK**.
8. On the Enterprise Portal server, open the C:\inetpub\wwwroot\wss\VirtualDirectories\ directory.
9. Open the directory for the Enterprise Portal public site. For example, directory 80.
10. Open the web.config file in Visual Studio or in a text editor like Notepad.
11. Choose one of the following options:
   - For SharePoint 2010, add the following to the `<configSections>` node:

```xml
  <section name="microsoft.identityModel" type="Microsoft.IdentityModel.Configuration.MicrosoftIdentityModelSection, Microsoft.IdentityModel, Version=3.5.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" />
  <microsoft.identityModel>
    <service>
      <securityTokenHandlers>
        <securityTokenHandlerConfiguration />
        <audienceUris>
          <add value="http://<host_name>/" />
        </audienceUris>
      </securityTokenHandlers>
    </service>
  </microsoft.identityModel>
</configSections>
```

• For SharePoint 2013, replace the following parameter:

```xml
<issuerNameRegistry type="Microsoft.SharePoint.IdentityModel.SPPassiveIssuerNameRegistry,
Microsoft.SharePoint, Version=15.0.0.0, Culture=neutral, PublicKeyToken=71e9bce11e9429c" />
```

With this parameter:

```xml
<issuerNameRegistry type="Microsoft.IdentityModel.Tokens.ConfigurationBasedIssuerNameRegistry,
Microsoft.IdentityModel, Version=3.5.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35">
  <trustedIssuers>
    <add thumbprint="<Thumbprint>" name="Unsolicited Vendor Request Token Signing Certificate" />
  </trustedIssuers>
</issuerNameRegistry>
```

Replace `<Thumbprint>` with the thumbprint of the token signing certificate for the Azure ACS relying party application. To locate the thumbprint, click the certificate at the bottom of the relying party application. Copy the thumbprint.

12. Enter the URL of your public Enterprise Portal site in a web browser. For example:

```
http://ServerName:Port/sites/Public/Enterprise%20Portal/VendRequestSignUp.aspx
```

The web browser redirects you to the ACS sign in page where you can select an identity provider and log in.
Configure Enterprise Portal parameters
You must configure the following parameters in the Microsoft Dynamics AX client.

1. Click **System administration > Setup > Enterprise Portal > Enterprise Portal parameters**.
2. Click the **User provisioning** page.
3. In the **Unsolicited vendor authentication** list, select **Azure ACS**.
4. In the **Unsolicited Vendor Domain** field, enter **AzureACS**.
5. In the **Vendor authentication method** list, select **Azure ACS**.

Next steps
You must configure the vendor on-boarding workflow process in the Microsoft Dynamics AX client. The process is described in detail in the following blog: [Step-by-step walkthrough of the vendor on-boarding process](#).

See also
- [Configuring Enterprise Portal for vendor requests](#) (on TechNet)
- [Deploy a claims-mode Enterprise Portal site](#)

Install Enterprise Portal in a traditional perimeter network

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to set up a traditional perimeter network to support Enterprise Portal for Microsoft Dynamics AX. A traditional perimeter network uses two firewalls and two domain controllers to restrict access to Microsoft Dynamics AX data, forms, and business processes. More specifically, a traditional perimeter network enables internal users of your corporate network (CORP users) to access Enterprise Portal in the perimeter network from either the intranet or the Internet. External users can access Enterprise Portal in the perimeter network from the Internet, but are not permitted to access files or information in the intranet. This restricted access is accomplished by using firewalls and a separate Active Directory forest with 1-way, outgoing, transitive, forest-level trust with the Active Directory forest in the intranet.

**Caution**
If you do not have experience setting up and configuring network security, contact a Microsoft Certified Partner for help. If you do not set up the perimeter network correctly, the system might be vulnerable to security threats.

**Note**
If you are upgrading Enterprise Portal between Microsoft Dynamics AX 2012, Microsoft Dynamics AX 2012 Feature Pack, and Microsoft Dynamics AX 2012 R2, you should review [Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3](#) on TechNet.
About traditional perimeter networks

A traditional perimeter network contains two Microsoft Active Directory domain controllers separated by firewall devices in two distinct networks, as shown in the following figure.

The perimeter network contains the Enterprise Portal Web server that is running IIS, SharePoint, and an Active Directory domain controller. The perimeter domain controller hosts accounts for those users who are external to the organization and who require Enterprise Portal access. These user accounts are set up on the perimeter domain controller as follows:

1. External users have no rights on the internal domain.
2. External users cannot access the internal network
3. The internal network contains a complete installation of Microsoft Dynamics AX. This includes the following components:
   a. An Active Directory domain controller that contains the accounts for all internal Microsoft Dynamics AX users
   b. A database that stores Microsoft Dynamics AX data
   c. A Microsoft Dynamics AX AOS

The internal forest has a one-way, incoming, transitive, forest-level trust with the perimeter forest. In the following description, the intranet/internal network is referred to as CORP. This configuration enables the following access scenarios.

- CORP users can access the AOS by using the Microsoft Dynamics AX Win32 client or the browser-based Enterprise Portal on an internal computer
- CORP users can access the AOS by using the Microsoft Dynamics AX Win32 client or browser-based Enterprise Portal from an external computer
- External users can access the AOS by using the browser-based Enterprise Portal from an external computer

The configurations in this document are only one example of how to configure internal and external users to access the AOS by using Enterprise Portal.
Before you begin

Complete the following tasks before you install Enterprise Portal in a traditional perimeter network.

- Verify that you have the appropriate permissions to install Enterprise Portal. For more information about permissions, see the Verify that you have the required permissions for installation section.

- Install and configure Microsoft Dynamics AX required components in your internal network. If you already installed Microsoft Dynamics AX required components, you must verify that the AOS service runs as a domain user account that is a member of your internal network. The AOS service cannot run as NT Authority\Network Service for a traditional perimeter network deployment that hosts Enterprise Portal. Verify that the unqualified AOS DNS hostname is not greater than 15 characters. At a minimum, you must install the Microsoft Dynamics AX client, the Application Object Server (AOS), and the database. You must be a local administrator on the server(s) you want to deploy these components. For more information, see Install Microsoft Dynamics AX 2012 on TechNet.

- If you installed a non-SYS layer model file in the Microsoft Dynamics AX environment, compile Microsoft Dynamics AX before you install Enterprise Portal. If you do not compile Microsoft Dynamics AX, the Enterprise Portal installation might fail.

- While logged in as a CORP user who is a local administrator on the server, install SharePoint on the perimeter-network server that will host Enterprise Portal. Verify that you are an administrator on the server and in the Microsoft SQL Server instance that will host SharePoint. When SharePoint prompts you to specify credentials for a service, specify a domain user account that is a member of the internal network. You will specify this same account as the .NET Business Connector proxy account when you install Enterprise Portal. The account does not have to be a member of the administrators group on the server.

- If you want to deploy Enterprise Portal in multiple languages, you must download and deploy SharePoint language packs onto the web server before you install Enterprise Portal. You can download SharePoint language packs from Microsoft.com. Enterprise Portal is currently supported in the following languages:

  - Arabic
  - Chinese (Simplified)
  - Czech
  - Danish – 1030
  - Dutch (Netherlands)
  - Dutch (Belgium)
  - English
  - English (Australia)
  - English (Canada)
  - English (India)
  - English (Ireland)
  - English (Malaysia)
  - English (New Zealand)
  - English (Singapore)
  - English (South Africa)
  - English (UK)
  - English (US)
  - Estonian
  - French (Belgium)
  - French (Switzerland)
  - German (Germany)
  - German (Austria)
  - German (Switzerland)
  - Hungarian
  - Icelandic
  - Italian
  - Italian (Switzerland)
  - Japanese
  - Latvian
  - Lithuanian
  - Norwegian
  - Polish
  - Portuguese (Brazilian)
  - Russian
  - Spanish (international)
  - Spanish (Mexico)
- Finnish
- French (France)
- French (Canada)
- Swedish
- Thai

To deploy Enterprise Portal in one of the languages list here, you must create a Web application in SharePoint and specify the new language. For more information, see Create an Enterprise Portal site on TechNet.

- Verify that the name of the server that will host Enterprise Portal does not include an underscore, for example EPserver_1. If an Enterprise Portal server includes an underscore in the server name, lookups and webpages might display errors.

- On the computer where you will install Enterprise Portal, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

- If you are installing Enterprise Portal on a server that already hosts an Enterprise Portal deployment and you want to overwrite that deployment, you must have Full Control permission in SharePoint for the existing Enterprise Portal site collection. If you do not have Full Control permission, you will not be able to delete the existing site collection by using Setup.

⚠️ Important

If you attempt to install Enterprise Portal on an existing Internet Information Services (IIS) site that is already configured to use a host header, the installation fails, unless you create a BackConnectionHostNames registry entry. For more information, see Changes to NTLM authentication for HTTPWebRequest in Version 3.5 SP1 on Microsoft.com.

Configure the traditional perimeter network

This section describes how to configure ports and a one-way trust for a traditional perimeter network that supports Enterprise Portal.

Configure ports

This section describes how to configure ports in the perimeter network and the internal network so that users can access the appropriate Microsoft Dynamics AX information by using Enterprise Portal. The table at the end of this
A request is processed as follows:

1. By default, the Enterprise Portal Web server receives the request from the firewall on TCP port 80 (or 443, if the Web server is configured for Secure Sockets Layer [SSL] encryption). The firewall therefore must have port 80 or 443 open for incoming Internet requests.
2. After the Web server receives the request, it sends the request to the perimeter domain controller on UDP port 53 to verify whether the user is an external or internal user.
3. The perimeter domain controller and the internal domain controller communicate by using various ports, as shown in Table 1 at the end of this section.
4. The perimeter domain controller identifies the user and then returns the request to the Web server on UDP port 53.
5. The Web server authenticates the user and then sends the request to the AOS using TCP. The default port is 2712. The Web server and the AOS communicate by using the Business Connector proxy account.
6. The AOS communicates with the Microsoft Dynamics AX SQL Server database on port 1433, by default.
7. After the AOS retrieves the necessary data from the database, it returns the response to the Web server.
8. The Web server responds back to the client (browser).

The following table shows the ports for a traditional perimeter network to support Enterprise Portal.

<table>
<thead>
<tr>
<th>Port</th>
<th>Direction</th>
<th>Connection</th>
<th>Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>80 or 443 (by default)</td>
<td>Inbound/Outbound</td>
<td>Perimeter firewall to the Enterprise Portal Web server</td>
<td>TCP</td>
<td>Verify which ports are used in your environment</td>
</tr>
<tr>
<td>2712 (by default)</td>
<td>Inbound/Outbound</td>
<td>Enterprise Portal server to Microsoft Dynamics AX AOS</td>
<td>TCP</td>
<td>Verify which port is used in your environment</td>
</tr>
<tr>
<td>Port</td>
<td>Direction</td>
<td>Connection</td>
<td>Type</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>8201</td>
<td>Inbound/Outbound</td>
<td>Enterprise Portal server to Microsoft Dynamics AX AOS</td>
<td>TCP</td>
<td>For WCF service interface</td>
</tr>
<tr>
<td>53</td>
<td>Inbound/Outbound</td>
<td>DNS</td>
<td>UDP</td>
<td>None</td>
</tr>
<tr>
<td>135</td>
<td>Outbound</td>
<td>Internal domain controller to perimeter domain controller</td>
<td>TCP</td>
<td>None</td>
</tr>
<tr>
<td>135</td>
<td>Inbound</td>
<td>Perimeter domain controller to internal domain controller</td>
<td>TCP</td>
<td>None</td>
</tr>
<tr>
<td>445</td>
<td>Outbound</td>
<td>Internal domain controller to perimeter domain controller</td>
<td>TCP</td>
<td>None</td>
</tr>
<tr>
<td>445</td>
<td>Inbound</td>
<td>Perimeter domain controller to internal domain controller</td>
<td>TCP</td>
<td>None</td>
</tr>
<tr>
<td>1638</td>
<td>Outbound</td>
<td>Internal domain controller to perimeter domain controller</td>
<td>TCP</td>
<td>None</td>
</tr>
<tr>
<td>1638</td>
<td>Inbound</td>
<td>Perimeter domain controller to internal domain controller</td>
<td>TCP</td>
<td>None</td>
</tr>
<tr>
<td>389</td>
<td>Outbound</td>
<td>Internal domain controller to perimeter domain controller</td>
<td>UDP</td>
<td>None</td>
</tr>
<tr>
<td>389</td>
<td>Inbound</td>
<td>Perimeter domain controller to internal domain controller</td>
<td>UDP</td>
<td>None</td>
</tr>
</tbody>
</table>

If necessary, use Telnet or Netmon to verify these ports. For more information about how to configure firewall ports, see [How to configure a firewall for domains and trusts](https://microsoft.com) on Microsoft.com.

**Configure DNS**

The following procedures describe how to configure your Domain Name System (DNS) to create a one-way trust between the domain controllers in your network. For Enterprise Portal, the perimeter network domain controller should trust the internal domain controller, but the internal domain controller should not trust the perimeter domain controller.

To create the one-way trust, complete the following procedures:

- Configure zone transfers on both domain controllers
- Create a secondary zone on both domain controllers
- Create trust from the internal domain controller to the perimeter domain controller
**Configure zone transfers on both domain controllers**
Complete this procedure to make sure that the domain controllers can communicate with each other.
1. Log on to the internal domain controller by using an account that is a member of the domain administrators group.
2. Open DNS (Start > Programs > Administrative Tools).
3. In the DNS console, expand the local name server.
4. Expand Forward Lookup Zones, right-click the domain name, and then click Properties.
5. Click the Zone Transfers tab.
6. Select Allow Zone Transfers, and then select Only to the Following Servers.
7. Enter the IP address for the perimeter network domain controller, and then click Add.
8. Click OK, and then restart the DNS server.
9. Repeat this procedure for the perimeter domain controller.

**Create a secondary zone on both domain controllers**
Complete this procedure to make sure that the domain controllers know each other’s fully qualified domain names.
1. Log on to the internal domain controller by using an account that is a member of the Domain Administrators group.
2. Open DNS (Start > Programs > Administrative Tools).
3. In the DNS console, expand the local name server.
4. Right-click Forward Lookup Zones, click New Zone, and then click Next.
5. On the Zone type page, select Secondary zone, and then click Next.
6. On the Zone Name page, enter the fully qualified domain name of the perimeter network, and then click Next.
7. Enter the IP address for the perimeter domain controller, and then click Next.
8. Click Finish to complete the wizard, and then restart the DNS server.
9. Repeat this procedure for the perimeter domain controller.

**Create a one-way trust between the domain controllers**
Complete this procedure to set up the one-way trust between the internal domain controller and the perimeter domain controller.
1. Log on to the perimeter domain controller by using an account that is a member of the Domain Administrators group.
2. Open Active Directory Domains and Trusts (Start > Programs > Administrative Tools).
3. In the console tree, right-click the domain name for the domain that you want to administer, and then click Properties.
4. Click the Trust tab.
5. Click New Trust, and then click Next.
6. On the Trust Name page, enter the fully qualified domain name for the internal domain, and then click Next.
7. Select One Way: Outgoing, and then click Next.
8. Select Both this domain and the specified domain, and then click Next.
9. Enter the domain administrator credentials for the internal domain, select Domain Wide Authentication, and then click Next.
10. Click **Next** two times, and then click **Yes** to confirm outgoing trust.
11. Click **Finish**.

**Name resolution**

The Enterprise Portal server, which is located in the perimeter network, must resolve the host name of the AOS, which is located on the internal or corporate network (CORP). If the AOS does not use a fully qualified domain name (FQDN) such as EP1.corp.contoso.com, then you must manually resolve hostnames. You can resolve hostnames by using one of the following options.

1. For environments that use a dynamic host configuration protocol (DHCP) server, add the CORP DNS suffix (for example, EP1.corp.contoso.com) to the DNS suffix search list on the DHCP server. Then verify that the perimeter network server resolves hostnames by using the DNS suffix list on the DHCP server.
2. Edit the hosts file on the Enterprise Portal server (%windir%/system32/drivers/etc/hosts). Add the non-FQDN AOS computer name to IP mapping. Be aware that making this change in the host file might change the IP address of the AOS server and result in name resolution failures.
3. For environments that do not use a DHCP server, add the CORP DNS suffix (for example, EP1.corp.contoso.com) to the DNS suffix search list on the Enterprise Portal server, as described in the following procedure.

**Configure the DNS suffix**

1. On the server that will host Enterprise Portal, click **Start > Control Panel**, and then click **Network and Sharing Center**.
2. Click **Change adapter settings**.
3. Right-click **Local Area Connection** and then click **Properties**.
4. Click **Internet Protocol Version 6 (TCP/IPv6)** and then click **Properties**.
5. Click **Advanced**.
6. In the **Advanced TCP/IP settings** dialog box, click the **DNS** tab.
7. Click **Append these DNS suffixes (in order)** and then click the **Add** button.
8. Enter the domain to append, for example, corp.contoso.com.
9. Click **OK** until you are returned to the **Local Area Connection Properties** page.
10. Click **Internet Protocol Version 4 (TCP/IPv4)** and then click **Properties**.
11. Repeat steps 5–8 of this procedure to append a DNS suffix for IPv4.
12. When you are finished, click **OK**.

**Enterprise Portal pre-installation tasks**

Perform the following tasks to verify that you can deploy Enterprise Portal on the Web server.

1. A member of the CORP network that has local administrator rights on the server must install SharePoint. If you did not install SharePoint on the server, then you must also verify the following points.
2. Verify that you are member of the CORP network.
3. Verify that you can open SharePoint Central Administration on the Enterprise Portal server.
4. Verify that you have the appropriate permissions to create sites by using SharePoint Central Administration to create a SharePoint team site.
5. Verify that you can browse the team site without prompts and resolve the URL without proxy errors or other problems.
6. If you intend to deploy or configure Enterprise Portal at a command prompt, verify that you can start the SharePoint Management Shell.

Install Enterprise Portal
This section describes how to install Enterprise Portal by using Setup. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages vary, based on the components that you are installing.

Tip
By default, when you install SharePoint, the system creates a Web application on port 80. Microsoft Dynamics AX Setup deploys an Enterprise Portal site on the port 80 Web application unless you specify a different Web application. If you do not intend to deploy Enterprise Portal on the default port-80 Web application, you must use SharePoint Central Administration to create a new Web application before you install Enterprise Portal. Also note, if you intend to deploy Enterprise Portal on a Web application that is already configured to use a host header, you must use SharePoint Central Administration to create a new Web application using the host header before you install Enterprise Portal. For any new Web application, you must specify the Business Connector proxy account as the application pool account in the Configurable list.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Enterprise Portal (EP), and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Select a file location page, select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Specify a location for configuration settings page, specify whether you want Enterprise Portal to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click Next.
10. On the Connect to an AOS instance page, enter the fully qualified domain name (FQDN) of the computer that is running the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the TCP/IP port number and the WSDL port for services. Click Next.

Note
If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this screen is not displayed. Subsequent installations on this computer reuse the existing AOS connection. For all Microsoft Dynamics AX installations that use a traditional perimeter network, you must specify the FQDN for the AOS when you are prompted.
11. On the Specify Business Connector proxy account information page, if the .NET Business Connector (BC) proxy account has not been configured in Microsoft Dynamics AX, then you must specify a username and password. The proxy must be a domain account from the CORP domain. If the BC proxy was previously configured, then you must enter the password. Click Next.
12. On the **Configure a Web site for Enterprise Portal** page, select a website. If no websites are available in the list, you must cancel Setup, create a website by using SharePoint Central Administration, and then try the installation again.

We recommend that you select the **Configure for Windows SharePoint Services** option. If you select this option, Setup verifies that the site is a SharePoint site. If the site is not a SharePoint site, Setup extends the site in SharePoint. Setup also sets the application pool to run under the service account and sets the authentication method to Windows NTLM.

**Important**

Note the following important information about the **Create Web site** option:

- Clear this option if you are installing Enterprise Portal for a public site, such as an unsolicited vendor portal. For public sites, you must create the Enterprise Portal site by using the public site template. For more information, see [Create a public Enterprise Portal site](https://docs.microsoft.com/en-us/previous-versions/ff628080(v=14.0.0)) on TechNet.
- If you are installing Enterprise Portal for a stand-alone installation select the **Create Web site** option to create a site at the following URL: `http://ServerName/sites/DynamicsAX`. Setup creates a new site in the SharePoint web application that uses port 80.

Click **Next**.

13. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

14. On the **Ready to install** page, click **Install**.

15. After the installation is complete, click **Finish** to close the wizard.

**Enable users to access the Enterprise Portal site**

Users must be listed in the Microsoft Dynamics AX **Users** form and be assigned to, at the very least, the System user role before they can access Enterprise Portal. You cannot provision users in Microsoft Dynamics AX by using Enterprise Portal. You must provision user by using the Microsoft Dynamics AX 32-bit client. For more information, see [Manage users](https://docs.microsoft.com/en-us/previous-versions/ff628080(v=14.0.0)) on TechNet. After you have verified that all users are listed in Microsoft Dynamics AX, you must enable users or groups to access the Enterprise Portal site in SharePoint as described in the following procedure.

1. Open the Enterprise Portal site in a Web browser. By default, the URL is `http://server_name/sites/DynamicsAX`.
2. On the menu bar, click **Site Actions** > **Site Permissions**.
3. Click **Grant Permissions**.
4. In the **Users/Groups** text box, enter the name of each user or group, and then click **Check Names**.
5. Under **Grant permissions**, click the permission level that you want to set. At a minimum, users and groups must have Read permissions.
   - If you do not want users to be able to personalize their Role Center pages or modify the shared view of a Web part, assign Read permissions.
   - If you want users to be able to personalized their Role Center pages and modify the shared view of a Web part, assign Contribute permissions.
   - If you want users to be able to personalize their Role Center pages, but you do not want them to be able to modify the shared view of a Web part, assign Read permissions, and then configure the set of Read permissions in SharePoint. From the Enterprise Portal site, click **Site Actions** > **Site Permissions** > **Permission Levels**. Click the **Read** permission link. Under **Personal Permissions**, select the options that you want.
   - If you want users to be able to filter reports using a custom parameter value, assign Design permissions.
If you want users to be able to add and modify financial indicators and key performance indicators (KPIs), assign Design permissions.

6. Click **OK**.

Internal users can now view Enterprise Portal in a Web browser. If you granted users access to an Enterprise Portal with Role Centers, then those users can now view content in their Role Centers. Page access and the content that is displayed in Enterprise Portal and Role Centers are automatically trimmed according to both the user’s security role in Microsoft Dynamics AX and the permissions that you specified in SharePoint.

**Note**

If users are prompted to enter their credentials when they view the Enterprise Portal site, they can automate authentication by adding the site to the list of local intranet sites. In Internet Explorer, click **Tools > Internet Options > Security > Local intranet > Sites**.

**See also**

- Deploy an Enterprise Portal site that uses forms-based authentication
- Checklists for deploying Enterprise Portal sites

### Install Enterprise Portal Help content

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The MS.EP.HC-LanguageCode.cab file contains Help topics for Enterprise Portal pages. The .cab file is automatically deployed and configured on the Web server when you install Enterprise Portal. If the Help does not display, use the procedure in this section to manually install Enterprise Portal Help.

**Before you begin**

- Deploy SharePoint language packs on the Enterprise Portal server. Note the SharePoint Language IDs for each language pack you deploy.
- Verify that the SharePoint Timer service is running. Enterprise Portal Help is installed as a job by the SharePoint Timer service.

**Install Enterprise Portal Help**

1. Locate the MS.EP.HC-LanguageCode.cab files on the Installation DVD. By default, the files are located in the `\Support\EPHelp` directory.

2. Copy each of the .cab files into its corresponding language ID directory on the Web server at the following location. This path applies to SharePoint 2010 servers. For SharePoint 2013 servers, replace ‘14’ with ‘15’:

   `Drive:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\HCCab\LanguageCode`

   For example, download the Arabic version of the MS.EP.HC-1025.cab file to this directory: C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\HCCab\1025 on a SharePoint 2010 server.

3. Open the SharePoint Management Shell on the Enterprise Portal Web server. Click **Start**, click **All Programs**, click **SharePoint Products**, and then click **SharePoint Management Shell**.

4. In the management shell, run the following command. Remember to change the ‘14’ to ‘15’ for SharePoint 2013 servers:

   `Install-SPHelpCollection -LiteralPath "Drive:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\HCCab\<language_code>\MS.EP.HC-LanguageCode.cab"`
For example, to install Enterprise Portal Help for Spanish on a SharePoint 2013 server, run the following command:

```
Install-SPHelpCollection -LiteralPath "Drive:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\15\HCCab\3082\MS.EP.HC-3082.cab"
```

5. Repeat the command for each language that you want to install. After SharePoint finishes the Timer job, you can open Enterprise Portal Help by clicking the Help icon on any Enterprise Portal page.

See also
- Checklists for deploying Enterprise Portal sites

### Install multiple Enterprise Portals on the same server

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install and configure multiple Enterprise Portals on the same server. Portals can be configured to access the same or different Microsoft Dynamics AX Application Object Server (AOS) instances, as described in this section.

⚠️ **Caution**

Before you continue, consider the following.

- If you install multiple portals on the same server, you create a single point of failure for all portals if SharePoint or IIS are not available on the server.
- Scheduled downtime for maintenance affects all portals on the server which might limit how often you can perform maintenance.
- If you plan to install portals for development, testing, and production on the same server (not recommended) you could unintentionally deploy development changes to production which could cause data-integrity problems.
- Multiple portals consume more resources on the server than a single portal. Plan your topology accordingly.
- You can deploy multiple portals on the same server as long as the user controls are the same. This means the controls must use the same AX model. Multiple portals on the same server are not supported if the codebase is different.

### Enterprise Portal and the AOS

Enterprise Portal determines which AOS instance to connect to by reading a Microsoft Dynamics AX client configuration. If you install Enterprise Portal on a server that hosts an AOS instance, the client configuration is stored, by default, in the registry on the AOS. If you install Enterprise Portal on a server that does not host an AOS or if Setup cannot locate a client configuration on the Web server, you are prompted to specify the location of the client configuration. If you create additional Enterprise Portals on the server, those portals use the AOS that is specified in the client configuration unless you specify a different client configuration, as described in this section.

### Multiple portals on the same server that use the same AOS

By default, when you install Enterprise Portal, Setup creates an Enterprise Portal site on the SharePoint-80 Web application. You can create additional sites on the port 80 Web application by using SharePoint Central Administration. All sites created in this manner use the same AOS. For more information about how to create an Enterprise Portal site, see [Create an Enterprise Portal site](https://technet.microsoft.com) on TechNet.
If you create additional web applications by using SharePoint Central Administration, you must deploy Enterprise Portal on the new web applications by using Microsoft Dynamics AX Setup. You can then create additional sites on the new web application by using SharePoint Central Administration. All sites created in this manner use the same AOS.

**Multiple portals on the same server that use different AOSs**

To install multiple portals on the same server and have those portals connect to different AOS instances, you must follow these steps.

**Before you begin**

Enterprise Portal determines which AOS to connect to by reading a Microsoft Dynamics AX client configuration. To install multiple portals on the same server and have those portals connect to different AOS instances, the portals must read separate Microsoft Dynamics AX client configurations. Create one or more Microsoft Dynamics AX client configuration files by using the Microsoft Dynamics AX 2012 Configuration utility and store the configuration files on a network share. For more information about how to create a configuration file, see Manage a client configuration on TechNet.

1. Use Microsoft Dynamics AX Setup to install Enterprise Portal on the server. By default, Setup creates an Enterprise Portal intranet site on the SharePoint-80 Web application. For the purpose of this procedure, this portal is called Portal1 and it is connected to AOS1. For more information about how to install Enterprise Portal, see the Install Enterprise Portal on a single server section.

2. Create a new web application on the Enterprise Portal server by using SharePoint Central Administration. For more information about how to create a new web application, see the SharePoint online Help.

3. Install Enterprise Portal on the new web application by using Microsoft Dynamics AX Setup. By default, a second portal is created on the port that is specified in SharePoint Central Administration. For the purpose of this procedure, this portal is called Portal2. Copy the URL of Portal2. You will need the URL later in this procedure when you register the portal. Portal2 is currently connected to AOS1.

4. Specify the new Microsoft Dynamics AX client configuration file for Portal2 by editing the web.config file. By default the web.config file is located in the following directory:
   C:\inetpub\wwwroot\wss\VirtualDirectories\<port number>

5. Add the following Microsoft.Dynamics element under </system.web>. Replace <server_name>, <path>, and <configuration_file>.axc with the information specific to your computing environment. For example: <Session Configuration="C:\inetpub\wwwroot\dynamicsax.axc" />

   ```xml
   <Microsoft.Dynamics>
   <Session Configuration="\<server_name>\<path>\<configuration_file>.axc" />
   </Microsoft.Dynamics>
   ```

6. Save your changes in the web.config file.

7. Verify that the Business Connector Proxy account for AOS2 is the same as AOS1. Click System administration > Setup > System > System service accounts.

8. Use the Microsoft Dynamics AX client to register Portal2 on AOS2. Click System administration > Setup > Enterprise Portal > Web sites. Enter the URL in the Internal URL and External URL fields.

9. In the Type field, click Full (Web parts and site templates). Portal2 is now connected to AOS2.

10. Delete Portal2 from the Web sites form on AOS1.

11. On the Enterprise Portal server, open a command prompt and run the following command. This command closes stale Business Connector connections: iisreset /noforce
Next steps
After you create the portals you must configure security, user access, and portal-wide settings. For more information, see the Checklists for deploying Enterprise Portal sites section.

See also
- Checklist: Configure Role Centers (on TechNet)

Enterprise Portal administration with Windows PowerShell and AXUpdatePortal

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2
You can programmatically administer Enterprise Portal for Microsoft Dynamics AX by using Windows PowerShell cmdlets or the AxUpdatePortal utility.

AXUpdatePortal.exe
The AxUpdatePortal utility, installed with Microsoft Dynamics AX, can be used to deploy Enterprise Portal sites. It can also be used to deploy modifications or additions you have made to existing Enterprise Portal Sites. The utility makes deployment easier, because it can deploy web-related changes to an Enterprise Portal site on an IIS site (virtual server) in just one step. It can also be used to deploy or update specific resources for an Enterprise Portal site. This utility and its parameters are described in detail in the AxUpdatePortal Utility topic on MSDN.

Windows PowerShell
You can administer Enterprise Portal by using the following Windows PowerShell cmdlets.

Enable-AXEnterprisePortal
This cmdlet deploys a new virtual server site to an IIS web server that already has Enterprise Portal installed. For more information, see Enable-AXEnterprisePortal on TechNet.

Publish-AXWebComponent
This cmdlet enables you to deploy proxies, images, and web components to an Enterprise Portal site. For more information, see Publish-AXWebComponent on TechNet.

Get-AXWebComponent
This cmdlet returns the web components associated with an Enterprise Portal site in a node of the AOT. For more information, see Get-AXWebComponent on TechNet.

See also
- Administering Microsoft Dynamics AX by using Windows PowerShell (on TechNet)

Set up Enterprise Portal and Role Centers

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012
By default, only the administrator who installed Enterprise Portal for Microsoft Dynamics AX can access the site and view content. For more information about configuring Enterprise Portal for different kinds of sites, see the Checklists for deploying Enterprise Portal sites section.
See also
- Enterprise Portal architecture (on TechNet)
- Enterprise Portal and Role Centers security and protection (on TechNet)

Deploy Microsoft Dynamics AX Web parts to a SharePoint site

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to deploy Web parts for Enterprise Portal for Microsoft Dynamics AX to sites for SharePoint. For example, if your organization uses a standard SharePoint team site, you can use the procedure in this section to deploy an Enterprise Portal Web part to that team site.

**Before you begin**

Install Enterprise Portal on the web application that hosts the site, such as SharePoint 80. In Microsoft Dynamics AX Setup, clear the Create Web site option. By clearing the Create Web site option, you install the required files on the web application, but you do not create a new website that uses the Enterprise Portal template. For more information about how to install Enterprise Portal, see the Install Enterprise Portal on a single server section.

**Deploy a Microsoft Dynamics AX Web part to a SharePoint site**

1. Click System administration > Setup > Enterprise Portal > Web sites.
2. Click New to add the SharePoint site to the list of sites. In the Internal URL field, enter the address of the SharePoint site.
3. In the Type list, click Web parts only.
4. Click the General tab.
5. If this site can be viewed only by users in a specific partition or company, configure the Partition independent and Company independent options.
6. Close the form to save your changes.
7. Open the SharePoint v4.master style sheet from the following location. This path applies to Microsoft SharePoint 2010 products. For Microsoft SharePoint 2013 Products, change ‘14’ in the file path to ‘15’:
   C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\TEMPLATE\GLOBAL\v4.master
8. Add the following element to the v4.master style sheet:
   ```xml
   <SharePoint:CSSRegistration name="/_LAYOUTS/1033/STYLES/Themable/AXEP.css" runat="server"/>
   ```
   **Important**
   To enable a Microsoft Dynamics AX unified work list Web part in a standard SharePoint site, you also must add the following Java script elements to the v4.master style sheet:
   ```javascript
   <script type="text/javascript" src="/_layouts/ep/scripts/jquery-min.js"> </script>
   <script type="text/javascript"> var $jQ = jQuery.noConflict(); </script>
   ```
9. Save your changes, and close the file.
10. On the SharePoint site, create a new Web part page or edit an existing page, and then click Add a Web part.
11. Beneath the Categories list, click Upload a Web part.
12. Browse to the following location, and then click the Web part to add. For SharePoint 2013, change ‘14’ in the file path to ‘15’:

```
C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\TEMPLATE\FEATURES\DynamicsAxWebParts\WebParts
```

13. Click **Upload**. The site automatically updates the list. Click **Add a Web part** again, and then locate the **Imported Web parts** folder in the **Categories** list.

14. In the **Web Parts** list, click the Web part to add, and then click **Add**.

**See also**
- [Deploy Enterprise Portal and Role Centers](on TechNet)
- [Create an Enterprise Portal site](on TechNet)

**Troubleshoot installation issues with Enterprise Portal and Role Centers**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The following sections provide information to help you troubleshoot issues you may encounter when you install Enterprise Portal for Microsoft Dynamics AX and Role Centers.

**Known Issues: SharePoint 2010 mode on SharePoint 2013**

The following changes in Enterprise Portal functionality or behavior result when you run on SharePoint 2013.

**Unable to install or configure Enterprise Portal**

Installation can fail if the Claims to Windows Token Service is not running in SharePoint Central Administration. The Setup log file includes the following error:

```
Server was unable to process request. --> Could not retrieve a valid Windows identity. --> The message could not be dispatched because the service at the endpoint address 'net.pipe://localhost/s4u/022694f3-9fbd-422b-b4b2-312e29daea2a' is unavailable for the protocol of the address.
```

To resolve this issue, in **SharePoint Central Administration**, click **System Settings > Manage services on server**. Start the Claims to Windows Token Service and then install Enterprise Portal.

**Experience all that SharePoint 2013 has to offer > Missing Site Templates**

After you install Enterprise Portal on SharePoint 2013 you see a message bar that says, “Experience all that SharePoint 2013 has to offer.” If you click the link provided, you see an error that states, “Missing Site Templates”. You can ignore this message. To retain important functionality, features, and design, Enterprise Portal uses the SharePoint 2010 mode provided by SharePoint 2013.

**Sign-in as a different user**

The option to sign-in as a different user was removed from SharePoint 2013. Because of this change, you cannot switch users when you are logged into Enterprise Portal. If you want to log in to Enterprise Portal as a different user, you must start the browser when logged in as that user or by using the `runas` command. For more information, see “[Sign in as Different User” menu option is missing in SharePoint Server 2013](on Microsoft.com).

**Search Enterprise Portal Help**

SharePoint 2013 does not support search in Help content that is disk-based. The application only supports searching through Help content that is hosted online or on a website. Users can still access Enterprise Portal Help by pressing F1 or by using the table of contents, but they cannot search the .cab-based system.
Permissions issues

Most installation issues for Enterprise Portal result from insufficient permissions by the person performing the installation. Verify that you have the appropriate permissions to perform the installation. If this list does not help you identify and resolve the problem, view the Windows Event Logs for more information about the error you are receiving.

- Membership in the **System administrator** role in Microsoft Dynamics AX
- Membership in the **Administrators** group in Windows on the Web server
- Membership in the **Farm Administrators** group in SharePoint
- Membership in the **dbcreator** role on the instance of SQL Server that is used for SharePoint
- Membership in the **WSS_Content_Application_Pools** database role in the SharePoint_Config database

We also recommend that you follow these steps before you deploy Enterprise Portal to verify that you have the correct permissions for the installation.

1. Verify that you can open SharePoint Central Administration on the Enterprise Portal server.
2. Verify that you have the appropriate permissions to create sites by using SharePoint Central Administration to create a SharePoint team site.
3. Verify that you can browse the team site without prompts and resolve the URL without proxy errors or other problems.
4. If you intend to deploy or configure Enterprise Portal at a command prompt, verify that you can start the SharePoint Management Shell.

**Tip**

By default, when you install SharePoint, the system creates a Web application on port 80. Microsoft Dynamics AX Setup deploys an Enterprise Portal site on the port 80 Web application unless you specify a different Web application. If you do not intend to deploy Enterprise Portal on the default port-80 Web application, you must use SharePoint Central Administration to create a new Web application before you install Enterprise Portal by using Setup. Also note, if you create a new Web application, you must specify the Business Connector proxy account as the application pool account in the **Configurable** list. If necessary, register a new managed account with SharePoint.

**Error installing Enterprise Portal: Access denied**

If Enterprise Portal could not be installed and the setup summary and the Microsoft Dynamics AX setup log displayed an access denied message, it might mean that you do not have permission to overwrite an existing site collection on the port 80 web application. If you are a member of the farm administrator group in SharePoint, you can use SharePoint Central administration to delete the existing site collection on the port 80 web application. After you delete the site collection, restart IIS (Start > Run, type iisreset, and press Enter). After IIS restarts, try installing Enterprise Portal again.

**Installing to a site that uses a host header fails**

If you attempt to install Enterprise Portal on an existing IIS site that is already configured to use a host header, the installation fails, unless you create a BackConnectionHostNames registry entry.
**Setup fails and the IIS application pool crashes when you attempt to install Enterprise Portal**

When installing Enterprise Portal and Role Centers, you may encounter the following error: “An error occurred when Setup was creating a new site. The underlying connection was closed: An unexpected error occurred on a receive. An existing connection was forcibly closed by the remote host.” This error occurs if SQL Server Analysis Management Objects (AMO) has not been installed on the Enterprise Portal server. To download AMO, download the Microsoft SQL Server 2008 R2 Analysis Management Objects package, which is included in Microsoft SQL Server 2008 R2 Feature Pack – June 2010, available from Microsoft.com. After you install AMO, restart IIS and attempt to install Enterprise Portal again.

**SharePoint Search stops working after you install Enterprise Portal**

If you install Enterprise Portal on a server that hosts a SharePoint Team site, the default Search settings for the team site can change. SharePoint Search returns errors. To restore Search for the SharePoint team site, reset the SharePoint Search settings to their default values.

1. Open the Search Settings page. By default, the URL is: http://<server_name>/_layouts/enhancedSearch.aspx
2. Under Site Collection Search Center, click Do not use custom scopes.
3. Under Site Collection Search Dropdown Mode, click Do not show scopes dropdown, and use contextual scope.
4. Under Site Collection Search Results Page, click /_layouts/OSSSearchResults.aspx, and then click OK.

**Multiple portals on a server**

If you intend to deploy multiple Enterprise Portals on the same server and those portals will connect to different Application Object Servers, then you must update the web.config file. For more information, see the Install multiple Enterprise Portals on the same server section.

**Install Search**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section contains information about installing Microsoft Dynamics AX 2012 Enterprise Search. Use the following sections to help you install Search.

**Checklist: Deploy Microsoft Dynamics AX Enterprise Search**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The following checklist can help you deploy Enterprise Search.

<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install and configure Search prerequisites.</td>
<td><a href="#">Install and configure Search prerequisites</a></td>
</tr>
<tr>
<td>Task</td>
<td>More information</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
</tr>
<tr>
<td>Install the Microsoft Dynamics AX client, database, and Application Object Server (AOS) in the environment before you install Enterprise Search, and then complete the initialization checklist. If you attempt to install Enterprise Search before you complete these other tasks, the installation fails.</td>
<td>Install Microsoft Dynamics AX 2012 (on TechNet)</td>
</tr>
<tr>
<td>Configure the domain account that is used to crawl search data.</td>
<td>Configure the Search Crawler account</td>
</tr>
<tr>
<td>Configure logging to conserve disk space.</td>
<td>Configure SharePoint Services logging</td>
</tr>
</tbody>
</table>
| Specify which queries (and the underlying database tables) are crawled and indexed for Search. Or, if Search is already configured on a different AOS, you can import Search configurations to a new AOS. | • Add AOT queries to the Search configuration  
• Import Search configurations to an AOS (on TechNet) |
| Deploy Search in the environment by using Setup. By default, Setup publishes queries that are configured for Search to the SharePoint Business Data Connectivity Service (BDS). The BDS then crawls and indexes Search data for Microsoft Dynamics AX. | • Install Search  
• Install Enterprise Search on FAST Search Server |
| Publish searchable queries to the Business Data Connectivity Service, so that the queries can be crawled by Microsoft SharePoint Services. This option is necessary if you configured additional AOT queries for Search after you installed Search. If you did not configure additional AOT queries for Search after you installed Search, you can skip this step. | Configure Enterprise Search by using the Search Configuration wizard |
| Verify that Search is installed and data is discoverable in Search results. | Open the Microsoft Dynamics AX client, enter a word such as a customer name in the Search box, and press Enter. |

**See also**
- Enterprise Search architecture (on TechNet)
- Troubleshoot installation issues with Enterprise Search

**Install and configure Search prerequisites**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

This section describes how to configure prerequisite software and services for Microsoft Dynamics AX Enterprise Search. If the Microsoft Dynamics AX Prerequisite Checker displayed an error when you tried to install Enterprise Search, this section might help you troubleshoot the error.

**Services required for Search**

Microsoft Dynamics AX Enterprise Search uses the following services.
## Microsoft Search Server service

The Microsoft Search Server service crawls, indexes, and retrieves Microsoft Dynamics AX data and metadata for Enterprise Search. This service is available in the following products.

- SharePoint Server 2010
- Microsoft Search Server 2010
- Microsoft Search Server Express 2010, which is a free download
- Microsoft FAST Search Server 2010
- Microsoft SharePoint Foundation 2013 or Microsoft SharePoint Server 2013

One of these products must be available in the computing environment before you can install Enterprise Search.

⚠️ **Caution**

If you intend to deploy Microsoft Dynamics AX Enterprise Search on Microsoft Fast Search Server 2010 know that FAST Search Server requires additional configurations beyond what is described in this section. For more information, see the Install Enterprise Search on FAST Search Server section.

## Business Data Connectivity (BDC) service

SharePoint uses the BDC service to display business data from back-end server applications, web services, and databases. Verify that the BDC service application is deployed by using the Manage Service Applications page in SharePoint Central Administration. Click Start > All Programs > Microsoft SharePoint Products, and then click SharePoint Central Administration. For more information about the BDC service, see the SharePoint documentation.

## Search Host Controller Service (SharePoint Server 2013)

This service manages the search topology components. The service is automatically started on all servers that run search topology components.

## SharePoint Server Search service

The SharePoint Server Search service crawls and indexes content for a SharePoint system. This service also provides a user interface for running queries against the catalog of crawled content. SharePoint Search is installed with Microsoft SharePoint Server and all Microsoft Search Server products.

Verify that the SharePoint Server Search service is available in the Services Control Panel. Click Start > Administrative Tools, and then click Services. If the service is not listed, install a supported version of Microsoft SharePoint Server or Microsoft Search Server. If the service exists, but is disabled then you must setup and configured the Search service in SharePoint Central Administration. Verify that the BDC service application is deployed by using the Manage Service Applications page in SharePoint Central Administration. Click Start > All Programs > Microsoft SharePoint Products, and then click SharePoint Central Administration.

---

**Verify SharePoint components before you install Enterprise Search**

Use the following procedure to verify that SharePoint Search is configured correctly. We recommend that you perform these checks before you attempt to install Microsoft Dynamics AX Enterprise Search.

1. Click **Start > All Programs > Microsoft SharePoint Products**, and then click **SharePoint Central Administration**.
2. Click **System Settings**, and then click **Manage Services on Server**.
3. Verify that the SharePoint Server Search service is running. Also verify that the SharePoint Foundation Search service is stopped. SharePoint Foundation Search is not required for Enterprise Search.

⚠️ Caution

If SharePoint Server Search does not appear in the list, you might be using SharePoint Foundation, which requires additional configuration. See SharePoint Search or SharePoint Server Search 14 service does not pass the prerequisite check in the Troubleshoot installation issues with Enterprise Search section.

4. From SharePoint Central Administration, click Manage Service Applications.
5. Click the Business Data Connectivity Service link and verify that the page loads without errors.
6. On the Manage Service Applications page, click the Search Service Application link and verify that the page loads without errors.
7. On the Search Administration page, click the Content Sources link and verify that the page loads without errors.

If all pages loaded without errors, you can install Microsoft Dynamics AX Enterprise Search in the environment. For more information, see the Install Microsoft Dynamics AX Enterprise Search section.

Verify the Business Connector Proxy Account for Search Services

The SharePoint Server Search service and the Search Host Controller service must run as the Microsoft Dynamics AX Business Connector Proxy (BC proxy) account to access Microsoft Dynamics AX data. If these services are not configured to run as the BC proxy, Search returns no results.

Use the following procedure to specify the BC proxy for the SharePoint Server Search service and the Search Host Controller service.

1. Locate the alias and domain for BC proxy in the Microsoft Dynamics AX client. Click System administration > Setup > System > System service accounts.
2. In SharePoint Central Administration, click Security, and then click Configure Service Accounts.
3. In the Credential Management list, click Windows Service – Search Host Controller Service.
4. In the Select an account for this component list, verify that the BC proxy is selected. If you do not see the BC proxy as an option, click the Register new managed account link and create an account that uses the alias and domain of the BC proxy. Click OK to save your changes.
5. Repeat steps 3 and 4 for the Windows Service – SharePoint Server Search service.
6. In SharePoint Central Administration, click System Settings, and then click Manage services on server.
7. Locate Search Host Controller Service in the list. Stop and restart this service.
8. In Windows, type services.msc in the Run dialog box and press Enter.
9. Locate SharePoint Server Search in the list of services. Stop and restart this service.

See also

- Checklist: Deploy Microsoft Dynamics AX Enterprise Search
- Troubleshoot installation issues with Enterprise Search
Configure the Search Crawler account

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to configure the Enterprise Search crawler account so that the Microsoft SharePoint indexing service can crawl Microsoft Dynamics AX data for Enterprise Search. Before you can configure the account, you must create a domain account for the search crawler. For more information, see the Create service accounts section.

1. Add the domain account as a user in Microsoft Dynamics AX. For more information, see Create new users in Microsoft Dynamics AX on TechNet.
2. Assign the user to the Search crawler role in Microsoft Dynamics AX. For more information, see Assign users to security roles on TechNet.
3. Repeat this procedure for each data partition. If you do not add the Search crawler account to a data partition, users will not see search results for that partition. For more information about data partitions, see Data partitioning architecture on TechNet.

See also
- Checklist: Deploy Microsoft Dynamics AX Enterprise Search
- Install Microsoft Dynamics AX Enterprise Search

Configure SharePoint Services logging

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

By default, there is no limit on the disk space that diagnostic logging for SharePoint can use. If you do not specify a limit, diagnostic logging can use all of the space on the hard disk of the Enterprise Search server.

Configure logging

Use the following procedure to specify limits for diagnostic logging.

1. In SharePoint Central Administration, click Monitoring.
2. Under Reporting, click Configure diagnostic logging.
3. In the Number of days to store log files section, enter a number.
4. Select the Restrict Trace Log disk space usage option.
5. In the Maximum storage space for Trace Logs (GB) field, enter a number.
6. Click OK.
7. Under Reporting, click Configure usage and health data collection.
8. In the Maximum log file size field, enter a number.
9. Click OK.

See also
- SharePoint documentation: Configure diagnostic logging (on Microsoft.com)
Install Microsoft Dynamics AX Enterprise Search

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install Microsoft Dynamics AX Enterprise Search. You must complete the installation procedure on each search server.

Before you install Enterprise Search

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify required services</td>
<td>Verify that required SharePoint services are configured correctly and are running. For more information, see the <a href="#">Install and configure Search prerequisites</a> section.</td>
</tr>
<tr>
<td>Install Microsoft Dynamics AX</td>
<td>Install the Microsoft Dynamics AX client, database, and Application Object Server (AOS) in the environment before you install Enterprise Search, and then complete the initialization checklist. If you attempt to install Enterprise Search before you complete these other tasks, the installation fails. For more information, see <a href="#">Install Microsoft Dynamics AX 2012</a> on TechNet.</td>
</tr>
<tr>
<td>Create a domain account</td>
<td>Create a domain account for Enterprise Search. This account must be configured as a Microsoft Dynamics AX user. The user account must be assigned to the <strong>Search crawler</strong> role before you install search. For more information, see the <a href="#">Configure the Search Crawler account</a> section.</td>
</tr>
<tr>
<td>Verify web application requirement</td>
<td>Verify that the SharePoint Web application used for Microsoft Dynamics AX Enterprise Search is configured for NTLM authentication. Also verify that the Web application is not configured for anonymous authentication.</td>
</tr>
<tr>
<td>Verify prerequisites</td>
<td>On the computer where you will install Enterprise Search, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the <a href="#">Check prerequisites</a> section. For more information about the hardware and software requirements for Microsoft Dynamics AX, see the <strong>system requirements</strong> on Microsoft.com.</td>
</tr>
<tr>
<td>Stop BDC service in load balanced environments</td>
<td>If you are setting up Enterprise Search in a load-balanced SharePoint server farm, verify that the Business Data Connectivity service (BDC) is only running on the Enterprise Search server. You must stop this service on all Web front-end servers in the farm. If you do not stop the service on all Web front-end servers, the Enterprise Search Configuration Wizard returns errors.</td>
</tr>
<tr>
<td>Install hotfix</td>
<td>If you are installing Enterprise Search on Microsoft Search Server 2010 Express, you must install the SharePoint Server 2010 hotfix package dated August 31, 2010. If you do not install the hotfix, you receive the following error message when you install Enterprise Search: “The trial period for this product has expired.” For more information and to download the hotfix package, see Microsoft Knowledge Base article number <a href="#">2276336</a>.</td>
</tr>
</tbody>
</table>

⚠️ **Important**

Search is not supported in an environment with multiple AOS servers on the same server, unless all AOS servers point to the same database. Limitations in the Search server configuration (mssdmn.exe.config) and the Microsoft Dynamics AX client configuration prevent support for a topology with multiple AOS servers on the same server.
**Install Enterprise Search**

Use this procedure to install Enterprise Search. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages vary, based on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you are installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Enterprise Search**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
8. On the **Select a file location** page, select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.
9. On the **Specify a location for configuration settings** page, specify whether you want Enterprise Search to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click **Next**.
10. On the **Connect to an AOS instance** page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

   ✓ **Note**

   If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this screen is not displayed. Subsequent installations on this computer reuse the existing AOS connection.

11. On the **Specify Business Connector proxy account information** page, enter the password for the proxy account that is used by the .NET Business Connector. Click **Next**.
12. On the **Specify the search crawler account** page, enter the account information, and then click **Next**.
13. On the **Configure a Web site for the search crawler** page, select a website from the list. If the site is not already configured as a SharePoint Web application, then Setup configures it in SharePoint.
14. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.
15. On the **Ready to install** page, click **Install**.
16. After the installation is complete, click **Finish** to close the wizard.

**Post-install configurations**

If you installed Enterprise Search on a computer separate from the AOS, you must specify the **Search server url** in the **Enterprise Portal parameters** form. If you do not specify the URL, Search does not retrieve data.

1. Click **System administration** > **Setup** > **Enterprise Portal** > **Enterprise Portal parameters**.
2. Click **Search**.
3. In the **Search server url** field, enter the URL to the SharePoint Search service where you just installed Search. Replace **server_name** with the name of the server where you installed Search: http://server_name/sites/DynamicsAXClientSearch/_vti_bin/search.asmx

4. Click **Close** to save changes.

**Configure Business Connector Proxy membership in the SQL db_owner role**
After you install Enterprise Search by using Setup, use SQL Server Management Studio to add the Business Connector proxy account and the search service application pool account (if different from the Business Connector proxy account) as members of the **db_owner** role for the following databases:

- Search_Service_Application_LinksStoreDB_<GUID> (SharePoint 2013 only)
- Search_Service_Application_CrawlStoreDB_<GUID>
- Search_Service_Application_DB_<GUID>
- Search_Service_Application_PropertyStoreDB_<GUID> (SharePoint 2010 only)

⚠️ **Important**
If you installed FAST Search Server 2010 for SharePoint each role is prefaced with the word FAST. For example, FAST_Search_Service_Application_CrawlStoreDB_<GUID>

**Configure queries for searchable data**
Data, metadata, and documents can only be crawled and indexed for search if the database table is included in a Microsoft Dynamics AX AOT query. After the table is specified in a query, the query must be configured for Search. You configure a query for Search by setting the **Searchable** property to **True** in the AOT. By default, only the following queries are configured for Search. These queries are automatically published and indexed after you install Enterprise Search:

- BdcDocuRef
- CustTableListPage
- EcoResProductPerCompanySearch
- EngChgCaseAssociationInventTable
- HcmWorkerListPage
- HcmWorkerListPage_NotAccounted
- HcmWorkerListPage_Present
- ProjCategory
- ProjGroupQuery
- SecurityRoleAllTasks
- smmBusinessRelations_NoFilter
- VendorEnterpriseSearch

For information about how to make data, metadata, and documents available in Search, see the [Add AOT queries to the Search configuration](#) section. After you have specified which queries should be available in Search, you must publish the queries to SharePoint. For more information, see the [Configure Enterprise Search by using the Search Configuration wizard](#) section.
Configure SharePoint Farm Search Settings

Use SharePoint Central Administration to configure time-out settings and start a full crawl on the Microsoft Dynamics AX content sources.

1. In SharePoint Central Administration, click **Manage service applications**, and then click **Search Service Application**.
2. Click **Farm Search Administration**.
3. In the **Time-out (seconds)** field, click the **60,60** link. Change the time-out to 600,600 and then click **OK**.
4. In the **Search Service Applications** section, click the **Search Service Application** link.
5. Click the **Content Sources** link.
6. Right-click the **Microsoft Dynamics AX** and **Microsoft Dynamics AX Metadata** content sources and click **Start Full Crawl**.
7. After the crawl completes, open an Microsoft Dynamics AX client and verify that the Search box appears in the upper-right corner. Also search on a term such as Sales and verify that the system returns results that are shown in both the middle pane (the data, metadata, and documents pane) and the **Help Topics** pane.

Troubleshooting: SharePoint Search stops working after you install Enterprise Portal

If you install Enterprise Portal on a server that hosts a SharePoint Team site, the default Search settings for the team site can change. SharePoint Search returns errors. To restore Search for the SharePoint team site, reset the SharePoint Search settings to their default values.

1. Open the **Search Settings** page. By default, the URL is: http://<server_name>/_layouts/enhancedSearch.aspx
2. Under **Site Collection Search Center**, click **Do not use custom scopes**.
3. Under **Site Collection Search Dropdown Mode**, click **Do not show scopes dropdown, and use contextual scope**.
4. Under **Site Collection Search Results Page**, click /_layouts/OSSSearchResults.aspx, and then click **OK**.

See also

- Checklist: Deploy Microsoft Dynamics AX Enterprise Search

Add AOT queries to the Search configuration

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to add a new query for the Microsoft Dynamics AX Application Object Tree (AOT) to the Search configuration. After you add one or more queries to the Search configuration, you can publish the configuration so that the underlying database tables are indexed for Search.

Before you begin

Before you configure AOT queries for Search, read **Enterprise Search security and protection** on TechNet to learn about restrictions for certain kinds of queries and database tables.

Add a new query to Search

1. In the AOT, expand the **Queries** node.
2. Select a query to add to the Search configuration.
3. In the **Properties** pane, click **Searchable**, and then click **Yes** in the list.
4. Right-click the query, click Add-ins, and then click Check best practices. Verify that there are no best practice errors. If there are errors, the query might not be configurable for Search. Review the errors to learn more.

5. After you have configured queries for Search, update caches so that the changes are available in the Search Configuration Wizard. In the AOT, click the Tools menu, click Caches, and then click Refresh elements.

**Update the Search Crawler role**

When you install Enterprise Search, the domain account that is assigned the Search Crawler role in Microsoft Dynamics AX is configured to have read-only permissions for queries that are configured for Search. When you configure new queries for Search, you must reset the permissions of the Search Crawler role to read-only for all searchable entities.

1. Click System administration > Setup > Search > Update search crawler role.
2. Click OK.

**Next steps**

The queries that you configured for Search are now ready to be published to the SharePoint Business Data Connectivity service. To publish the queries, you use the Search Configuration Wizard. After the queries are published to SharePoint, they are indexed, so that users can view results when they search in the Microsoft Dynamics AX client or Enterprise Portal for Microsoft Dynamics AX. For information about how to publish queries to SharePoint, see the Configure Enterprise Search by using the Search Configuration wizard section.

**See also**

- Import Search configurations to an AOS (on TechNet)

**Install Enterprise Search on FAST Search Server**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to deploy Microsoft Dynamics AX Enterprise Search on FAST Search Server 2010 for SharePoint.

**Prerequisites**

The following list includes links to documents that describe how to configure the prerequisites for Microsoft Dynamics AX Enterprise Search. The list also includes links to documents that describe how to install and configure FAST Search Server 2010 for SharePoint. You must complete all of the tasks in order before you install Microsoft Dynamics AX Enterprise Search on FAST Search Server 2010. If you do not complete every task, Enterprise Search on FAST Search Server 2010 is not installed correctly.

1. Configure the Search Crawler account
2. Add AOT queries to the Search configuration
3. Install SharePoint 2012 Products and Technologies (on Microsoft.com)
4. Install FAST Search Server 2010 for SharePoint (on Microsoft.com)
5. Configure a stand-alone deployment or a multiple server deployment (FAST Search Server 2010 for SharePoint) (on Microsoft.com)
6. Create and set up the Content Search Service Application (FAST Search Server 2010 for SharePoint) (on Microsoft.com)
7. Create and set up the Query Search Service Application (FAST Search Server 2010 for SharePoint) (on Microsoft.com)
8. Enable queries from Microsoft SharePoint Server (FAST Search Server 2010 for SharePoint) (on Microsoft.com)
9. Install Hotfix 2276339 on the SharePoint server (on Microsoft.com)

Configure the Business Connector proxy account for membership in the db_owner role

The Business Connector proxy account must be a member of the db_owner role for each FAST Search database. Use Microsoft SQL Server Management Studio to verify that the Business Connector proxy account is listed as a user for each database, and that the user account is a member of the db_owner role.

Increase the time-out for Farm Search Administration

After you install Microsoft Dynamics AX Enterprise Search as described later in this section, Setup starts a full crawl of the content sources for Microsoft Dynamics AX and Microsoft Dynamics AX metadata. The crawl must be completed without errors before you can configure managed properties as described later in this section. By default, the time-out for the filter daemon in SharePoint is too short. Therefore, you receive the following error message when the content source for Microsoft Dynamics AX metadata is crawled: The filter daemon did not respond within the time-out limit. Use the following procedure to increase the Farm Search Administration timeout.

1. In SharePoint Central Administration, click Manage Service Applications.
2. Select the search service application for the FAST Search connector.
3. In the left navigation pane, click Farm Search Administration.
4. Under Farm-Level Search Settings, change the default value of Time-out (seconds), 60,60, to larger numbers, such as 120,120.
5. Click OK to save your changes.

Install Enterprise Search

If FAST Search is present on the server when you install Enterprise Search by using Microsoft Dynamics AX Setup, the system configures only the default FAST Search Server application, as specified in SharePoint. All other search service applications are ignored. After the installation is completed, the system performs a full crawl of the Microsoft Dynamics AX content sources. The full crawl of the content sources must be completed without errors before you can continue with the remaining procedures in this section.

After the full crawl of the content sources is completed without errors, install Microsoft Dynamics AX Enterprise Search on the server. For more information, see the Install Microsoft Dynamics AX Enterprise Search section.

Create managed properties

FAST Search Server 2010 creates properties for crawled data. Microsoft Dynamics AX Enterprise Search enables a rich advanced search experience if these properties are mapped to Microsoft Dynamics AX managed properties. The following Windows PowerShell script creates managed properties for Microsoft Dynamics AX Enterprise
Search and registers these properties so that they can be used by FAST Search Server 2010 at crawl time. The script also maps the crawled properties to managed properties to enable a rich advanced search experience.

1. On the FAST Search Server, create a new *.ps1 file. Copy and paste the following code into the *.ps1 file.

**Windows PowerShell**

```powershell
function MapManagedPropertyToCrawledProperty()
{
    Param
    {
        [string]$managedProperty = $null,
        [string]$crawledProperty = $null,
        [int32]$managedPropertyType = 1
    }

    $EntityManagedProperty = New-FASTSearchMetadataManagedProperty -Name $managedProperty -Type $managedPropertyType
    $EntityCrawledProperty = Get-FASTSearchMetadataCrawledProperty -Name $crawledProperty
    $FullTextIndex = Get-FASTSearchMetadataFullTextIndex -Name Content
    $PropertyMapping = New-FASTSearchMetadataCrawledPropertyMapping -CrawledProperty $EntityCrawledProperty -ManagedProperty $EntityManagedProperty
    if ($managedPropertyType -eq 1)
    {
        New-FASTSearchMetadataFullTextIndexMapping -ManagedProperty $EntityManagedProperty -FullTextIndex $FullTextIndex -Level 1
    }

    Write-Host $managedProperty " mapped to " $crawledProperty
}

function MapManagedPropertyToCrawledProperties()
{
    Param
    {
        [string]$managedProperty = $null,
        [string]$crawledProperties = $null,
        [int32]$managedPropertyType = 2
    }

    $EntityManagedProperty = New-FASTSearchMetadataManagedProperty -Name $managedProperty -Type $managedPropertyType
    $crawledProperties.split(",") | ForEach-Object
    {
        $crawledProperty = $_;
        $EntityCrawledProperty = Get-FASTSearchMetadataCrawledProperty -Name $crawledProperty
        $PropertyMapping = New-FASTSearchMetadataCrawledPropertyMapping -CrawledProperty $EntityCrawledProperty -ManagedProperty $EntityManagedProperty
    }
```

---

Microsoft Dynamics AX 2012 Installation Guide 155
```powershell
$EntityCrawledProperty -ManagedProperty $EntityManagedProperty

$FullTextIndex = Get-FASTSearchMetadataFullTextIndex -Name Content
if ($managedPropertyType -eq 1)
{
    New-FASTSearchMetadataFullTextIndexMapping -ManagedProperty $EntityManagedProperty -FullTextIndex $FullTextIndex -Level 1
}

Write-Host $managedProperty " mapped to " $crawledProperty

# Map predefined values
MapManagedPropertyToCrawledProperty -managedProperty Entity -crawledProperty EntityName -managedPropertyType 1
MapManagedPropertyToCrawledProperty -managedProperty EntityPath -crawledProperty EntityKey.Path -managedPropertyType 1
MapManagedPropertyToCrawledProperty -managedProperty EntityHelpText -crawledProperty EntityKey.HelpText -managedPropertyType 1
MapManagedPropertyToCrawledProperty -managedProperty EntityType -crawledProperty EntityKey.Type -managedPropertyType 2
MapManagedPropertyToCrawledProperties -managedProperty PartitionKey -crawledProperty "CustTable,DocuRef,InventTable,EmployeeTable,HcmWorker,smmBusRelTable,VendTable" -managedPropertyType 2

# Create empty properties required by client search query
New-FASTSearchMetadataManagedProperty -Name Title1 -Type 1
New-FASTSearchMetadataManagedProperty -Name Title2 -Type 1
```
2. Run the *.ps1 file from the FAST Search Server 2010 Windows PowerShell command window. The following figure shows the results of the command.

The following list describes the actions of the script and the corresponding results in the output:

a. `MapManagedPropertyToCrawledProperty -managedProperty Entity -crawledProperty EntityName -managedPropertyType 1`

   The crawled property Entity was mapped to the managed property EntityName. The managed property is of type 1. Full-text index mapping was added to the property.

b. `MapManagedPropertyToCrawledProperty -managedProperty EntityPath -crawledProperty EntityKey.Path -managedPropertyType 1`

   The crawled property EntityPath was mapped to the managed property EntityKey.Path. The managed property is of type 1. Full-text index mapping was added to the property.

c. `MapManagedPropertyToCrawledProperty -managedProperty EntityHelpText -crawledProperty EntityKey.HelpText -managedPropertyType 1`

   The crawled property EntityHelpText was mapped to the managed property EntityKey.HelpText. The managed property is of type 1. Full-text index mapping was added to the property.
d. MapManagedPropertyToCrawledProperty -managedProperty EntityTypeName -crawledProperty EntityKey.Type -managedPropertyType 2

The crawled property EntityTypeName was mapped to the managed property EntityKey.Type.

e. New-FASTSearchMetadataManagedProperty -Name Title1 -Type 1

The managed property Title1 was registered.

f. New-FASTSearchMetadataManagedProperty -Name Title2 -Type 1

The managed property Title2 was registered.

3. After the managed properties are created, use SharePoint Central Administration to start a full crawl of the Microsoft Dynamics AX and Microsoft Dynamics AX metadata content sources.

See also
- Checklist: Deploy Microsoft Dynamics AX Enterprise Search

Configure Enterprise Search by using the Search Configuration wizard

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to configure Microsoft Dynamics AX Enterprise Search by using the Search Configuration Wizard.

Before you configure Enterprise Search

You must complete the following tasks before you can configure Enterprise Search by using the Search Configuration Wizard:

1. Deploy Enterprise Search. For more information, see the Install Microsoft Dynamics AX Enterprise Search section.

2. In the Queries node of the Application Object Tree (AOT), designate the queries that are available in search results by setting the Searchable property to True. For more information, see the Add AOT queries to the Search configuration section.

Configure Enterprise Search

The Search Configuration Wizard helps you publish Microsoft Dynamics AX queries to the Microsoft SharePoint Business Data Connectivity Service (BCS). The wizard lists the queries that passed all checks for best practices, and for which the Searchable property is set to True. You can select which queries and table fields you want to publish to the BCS. After you complete the wizard, the queries are published to the BCS, so that SharePoint can crawl the selected tables in the Microsoft Dynamics AX database. After the crawl is completed, users can view search results either in the Microsoft Dynamics AX 32-bit client or in Enterprise Portal.

Note

You can run the Search Configuration Wizard on a server where Enterprise Search is installed from the Microsoft Dynamics AX client or by double-clicking AXSearchSetup.exe in the following directory: %systemdrive%\Program Files\Microsoft Dynamics AX\60\SetupSupport.

1. Click System administration > Setup > Search > Search configuration.

2. Complete the wizard. Microsoft Dynamics AX informs you that the queries were successfully published to the BCS.

If one or more queries were not published to the BCS, an error message is displayed. Review the log file at the following location: %systemdrive%\ProgramData\Microsoft\Dynamics AX\Dynamics AX Setup Logs\.
After the queries are published to the BCS, you can view the list of queries and the status of the database crawl in SharePoint Central Administration.

1. Click **Start**, and then click **SharePoint Central Administration**.
2. Under **Application Management**, click **Manage service applications**, and then click **Search Service Application**.
3. In the left pane, under **Crawling**, click **Content Sources**.
4. To view the details, click either the content source for Microsoft Dynamics AX or the content source for Microsoft Dynamics AX metadata.

**Important**

By default, SharePoint schedules incremental crawls of the Microsoft Dynamics AX database. The incremental crawl only updates records if a parent table is modified. To ensure that the crawler updates records from joined tables, you should periodically perform a full crawl of the database.

**See also**

- **Enterprise Search operations** (on TechNet)

---

**Troubleshoot installation issues with Enterprise Search**

**Applies to**: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section includes information to help you troubleshoot issues you might encounter when you install Microsoft Dynamics AX Enterprise Search.

**Search prerequisite errors**

This section includes error messages you might experience when you run the Microsoft Dynamics AX Prerequisite Validation utility from Setup. Each error includes recommended actions for resolving the problem. For more information about Search prerequisites, see the Install and configure Search prerequisites section.

**Business Data connectivity (BDC) service application is not deployed**

The Business Data Connectivity (BDC) service is installed with SharePoint. To pass the prerequisite check, you must configure the service application in SharePoint Central Administration. If you configure the service application by using the SharePoint configuration wizard you might create other issues because the wizard creates a SharePoint application that runs on Port 80. This port 80 application can conflict with other IIS Web applications and could cause them to stop working.

Use the following procedure to manually configure the BDC service.

**Note**

Completing the steps in this procedure creates a BDC service database in SQL Server.

1. In SharePoint Central Administration, click **Application Management**, and then click **Manage Service Applications**.
2. Click **New > Business Data Connectivity service**.
3. Enter a name for the BDC service and the application pool, and then click **OK**. SharePoint displays a message that the Business Data Connectivity Service application was created.
4. Click **System Settings**, and then click **Manage Services on Server**. If the BDC service is in a status of **Stopped**, click the start link to start the service. Once the service is started, use Microsoft Dynamics AX Setup to run the Prerequisite validation utility.
SharePoint Search or SharePoint Server Search 14 service does not pass the prerequisite check

By default, the SharePoint Search service is not installed on SharePoint Foundation. If you are running SharePoint Foundation you must install Microsoft Search Server Express 2010, which is a free download.

After you installed Search Server Express 2010, use the Services Control Panel to verify that the SharePoint Server Search 14 service is running. If the service is listed but Disabled, then you must configure it in SharePoint Central Administration.

**Note**

Completing the steps in this procedure creates Search services databases in SQL server.

1. In SharePoint Central Administration, click Application Management, and then click Manage Service Applications.
2. Click New > Search Service Application.
3. Enter a name for the service and the application pool, and then click OK. SharePoint displays a message that the Search Service application was created.
4. Click System Settings, and then click Manage Services on Server. If the Search service is in a status of Stopped, click the Start link to start the service. Once the service is started, use Microsoft Dynamics AX Setup to run the Prerequisite validation utility.

The trial period for this product has expired

If you are using Microsoft Search Server 2010 Express, and you receive the error message "The trial period for this product has expired," you may have to install the SharePoint Server 2010 hotfix package dated August 31, 2010. For more information and to download the hotfix package, see Microsoft Knowledge Base article number 2276336.

The Business Connector proxy account does not have permission to perform the operation

The Business Connector (BC) proxy account and the account that is used for the SharePoint Search service application pool must be a member of the db_owner role for the following databases in SQL Server. If you receive this error, use SQL Server Management Studio to verify permissions for the following databases.

1. Search_Service_Application_CrawlStoreDB_<guid>
2. Search_Service_Application_DB_<guid>
3. Search_Service_Application_PropertyStoreDB_<guid>

**See also**

- Install Microsoft Dynamics AX Enterprise Search
Install help server

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The following sections explain how to install the Microsoft Dynamics AX Help server.

**Note**
If you are upgrading the Help server between AX 2012, AX 2012 Feature Pack, AX 2012 R2, and AX 2012 R3, you should review [Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3](#) on TechNet.

**Before you install the help server**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes the tasks that you must complete before you can install the Microsoft Dynamics AX Help server.

**Check for required permissions**

Verify that you have the permissions that are required to install the Help server. For more information, see the [Verify that you have the required permissions for installation](#) section.

**Install prerequisites**

On the computer where you will install the Help server, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [Microsoft Dynamics AX 2012 System Requirements](https://microsoft.com) guide on Microsoft.com.

**Select a website for the Help server**

The Help server must be installed on a website in Internet Information Services (IIS). You can create a new website for the Help server, or you can use an existing site. The following sections describe these options.

**Create a new website**

If you want to create a new website for the Help server, see the IIS documentation for information about how to create a website.

**Use an existing website**

You can install the Help server on an existing website that is used by other applications. However, you must verify that neither Microsoft SharePoint Foundation 2010 nor Microsoft SharePoint Server 2010 is running on the same site.

If you install the Help server on the default website in IIS, and you later install Microsoft SharePoint Foundation or Microsoft SharePoint Server on the server, the SharePoint installation program stops the default website and creates a new site for SharePoint. This new site runs on port 80. You must then open Internet Information Services (IIS) Manager and follow these steps:

1. Configure the default website to run on a different port.
2. Restart the default website.
Install help content updates

If updates for the Microsoft Dynamics AX help content are available, you can incorporate the updates into the installation.

Use the following steps to include help updates in the installation:

1. Locate and download help content updates from the CustomerSource website (logon required).
2. Browse to the directory where the files from the Microsoft Dynamics AX DVD are shared. For more information, see the Create a shared directory for installation section.
3. Navigate to the \Msi\HelpContent folder.
4. Copy the new or updated help .msi files to the appropriate language folder.
5. When you run Setup and select the Help Server component, the new content will be displayed as an option. Select the content sets that you want to install. Any content that was previously installed will be replaced. If you clear the check box for a content set that was previously installed, it will be removed.

Install the help server

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Use this procedure to install the Help server and Help files. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages will vary based on the components that you are installing.

Note

If you are upgrading Help server between Microsoft Dynamics AX 2012, Microsoft Dynamics AX 2012 Feature Pack, and Microsoft Dynamics AX 2012 R2, you should review Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3 on TechNet.

2. Advance through the initial wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Help Server, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section.

Note

Validation errors can be resolved through the Prerequisite validation results page only if you are installing the Help server on a supported server operating system. If you are installing on an unsupported client operating system for demonstration or development purposes, you must supply missing prerequisites manually.

8. When no errors remain, click Next.
9. On the Specify a location for configuration settings page, specify whether you want the help server to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click Next.
10. On the **Connect to an AOS instance** page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

- **Note**
  
  If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this screen is not displayed. Subsequent installations on this computer reuse the existing AOS connection.

11. The Help Server must be installed on a 64-bit operating system. When you install Microsoft Dynamics AX components on a 64-bit system, the **Select a file location** page is displayed. Use this page to select the location where 32-bit versions of Microsoft Dynamics AX files should be installed, and then click **Next**.

12. On the **Select a display language** page, select a language and click **Next**.

13. On the **Specify a location for configuration settings** page, indicate whether client and server configuration settings should be stored locally or in a shared configuration file on the network. If you select the shared configuration, enter the network location of the file. Click **Next**.

14. On the **Connect to AOS instance** page, provide the name of the AOS server that the Help server will be using. You can optionally specify the AOS instance name, the AOS TCP/IP port number, and the services WSDL port. Click **Next**.

15. On the **Configure a Web site for Help Server** page, select the website that you have chosen to host the Help server. Verify that the location of the physical directory for the website is displayed. Click **Next**.

16. On the **Specify the Help Server account** page, enter a domain user account and password. This account must be the same as the .NET Business Connector proxy account for the AOS, and it must be a user in Microsoft Dynamics AX. This should be a service account that does not expire. Click **Next**.

17. On the **Language and content selection** page, select the Help language and content types to install. EN-US must be installed, and is checked by default. Click **Next**.

- **Tip**

  To add additional languages or content later, obtain the necessary MSI files and run Setup again.

18. On the **Prerequisite Validation** page, resolve any errors. When no errors remain, click **Next**.

19. On the **Ready to install** page, click **Install**.

20. After the installation is complete, click **Finish** to close the wizard.

After the Microsoft Dynamics AX Help files are installed, they must be indexed by Windows Search Service before you can view them. Depending on system load and the number of files, it may take up to an hour for indexing to finish.

**See also**

- [Set Help system parameters](on TechNet)
Install Help content at an alternative location

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

The Help server folder on the file system contains both system files and content files. The location of this folder is a fixed parameter in Microsoft Dynamics AX. However, you can store the content at a different location by using the virtual directory feature in Internet Information Services (IIS).

The Microsoft Dynamics AX setup utility installs Help server files at C:\inetpub\wwwroot\DynamicsAX6HelpServer. Help content files are located in the Content folder under this directory. The following procedure shows how to move the Content folder to another location on the file system, so that Microsoft Dynamics AX can continue to access the folder.

1. On the Help server computer, create a content folder that is not located under the default directory for the Help server, C:\inetpub\wwwroot\DynamicsAX6HelpServer. In this example, the new folder is D:\content.
2. Move the Help files that are currently under C:\inetpub\wwwroot\DynamicsAX6HelpServer\Content so that they are under D:\content. Delete the original Content folder after it is empty.

⚠️ Important

Do not put any configuration files in the new folder. This folder should contain only subfolders and content-related files, such as HTML, JavaScript, or image files.

3. Give the domain account for the Microsoft Dynamics AX administrative user **Read & execute, List folder contents, Read, and Write** permissions to the new folder. Additionally, give the local IIS user group, IIS_IUSRS, **Read & execute, List folder contents, and Read** permissions to the folder.
4. Click **Start > Control Panel > Indexing Options > Modify**, and add the new folder as an indexed location.
5. Click **Start > Administrative Tools > Internet Information Services (IIS) Manager** to open IIS Manager.
6. In the navigation pane, expand the nodes to display C:\inetpub\wwwroot\DynamicsAX6HelpServer.
7. Right-click **DynamicsAX6HelpServer**, and then select **Add Virtual Directory**.
8. In the **Add Virtual Directory** window, in the **Alias** field, type **Content**. The directory tree that the Help server accesses when it retrieves content is restored, in virtual form.
9. In the **Physical path** field, type the path of the new folder, D:\content. Alternatively, you can navigate to the folder. Then click **OK**, and close IIS Manager.
10. Under C:\inetpub\wwwroot\DynamicsAX6HelpServer, locate the web.config file, and configure this file for the new content location. Open web.config in a text editor, and locate the **basePath** attribute. After the **basePath** attribute, add a new **contentPath** attribute that has the same format, and that contains the new content folder. In this example, the XML element begins as follows.

```xml
<dynamicsHelpConfig basePath="C:\inetpub\wwwroot\DynamicsAX6HelpServer" contentPath="D:\content"...`
11. To trigger indexing of the new folder, click **Start > Administrative Tools > Services**, and then restart the Windows Search Service. The Help system should work correctly after indexing is completed.
Install Management Reporter components

 Applies to: Microsoft Dynamics AX 2012 R3

Management Reporter for Microsoft Dynamics ERP is the recommended financial reporting solution for Microsoft Dynamics AX 2012. Use Management Reporter to create, distribute, and analyze financial statements and other financial reports.

**Note**

Management Reporter components are available in the Setup wizard in AX 2012 R3 and cumulative update 7 for Microsoft Dynamics AX 2012 R2.

This chapter explains how to install Management Reporter components by using the Setup wizard.

Install Management Reporter server components

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

This section describes how to install Management Reporter for Microsoft Dynamics ERP by using the Microsoft Dynamics AX Setup wizard. Management Reporter is a financial reporting tool that is used to create, distribute, and analyze financial statements. For more information about Management Reporter, see the Management Reporter page on CustomerSource (logon is required).

**Note**


If you're not using Microsoft Dynamics AX 2012 R3 or cumulative update 7 or later for AX 2012 R2, you can use the stand-alone installation for Management Reporter. Download and run the installation package that is available on CustomerSource. For information about how to run the stand-alone installation, see the Management Reporter Installation Guide on Microsoft.com (PDF download).

When you install Management Reporter, Microsoft SQL Server change tracking is enabled on the Microsoft Dynamics AX business database.

Before you install Management Reporter

- Create the service account that will be used to run the Windows service for Management Reporter. Additionally, create or select the account that will be used to integrate data between Microsoft Dynamics AX and Management Reporter. For more information about the requirements for these accounts, see the Create service accounts section.

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.
Install Management Reporter

Use this procedure to install Management Reporter. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Management Reporter, and then click Next.
7. On the Connect Management Reporter to an AOS instance page, enter the name, TCP/IP port, and services endpoint port of the instance of Microsoft Dynamics AX Application Object Server (AOS) to use together with Management Reporter. By default, AOS uses port 2712 for TCP/IP communication and port 8201 for the services endpoint. Click Next.
8. On the Connect Management Reporter to a database page, select the server name and database where Microsoft Dynamics AX transaction data is located. Reporting will be enabled for the database that you select. The Management Reporter database will also be created on the selected server. Click Next.
9. On the Select a service account page, enter the account to run the Management Reporter Windows service, and then click Next.
10. On the Configure Management Reporter page, enter the following information:
   - The port number that the Management Reporter application server uses for communication. By default, the application server uses port 4712.
   - The name of the Management Reporter database.
   - The name of the data mart database.
   Click Next.
11. On the Configure an integration user page, enter information about the user account that is used to integrate data between Management Reporter and Microsoft Dynamics AX. If the user does not already exist in Microsoft Dynamics AX, select Create new account. The user will be added, and the Microsoft Dynamics AX user ID will be AxIntUsr. If the user already exists in Microsoft Dynamics AX, select Use existing account, and enter a user ID. Click Next.
12. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
13. On the Ready to install page, click Install.
14. After the installation is completed, click Finish to close the wizard.

✓ Note
The Setup wizard installs Management Reporter in two phases. First, the Management Reporter software is installed. Then, Management Reporter is configured to connect to Microsoft Dynamics AX. If the Setup wizard reports a failure, we recommend that you run the Management Reporter Configuration Console to complete the configuration.
After you install Management Reporter

After installation, you must open the Report Designer client and enter registration keys. After you have entered registration keys, additional configuration might be required before you can add report viewers or users. For information about how to configure Management Reporter, see the Management Reporter Installation Guide on Microsoft.com (PDF download).

Management Reporter is available to Microsoft Dynamics AX users based on role membership in Microsoft Dynamics AX. For information about how Management Reporter integrates with Microsoft Dynamics AX, see the Management Reporter Integration Guide for Microsoft Dynamics AX on Microsoft.com (PDF download).

For information about how to use Management Reporter, see the Management Reporter technical library on TechNet.

See also

- Install Report Designer for Management Reporter
Install business intelligence components

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The business intelligence components for Microsoft Dynamics AX provide reporting and analytical functionality that enables you to view and interpret business data. You can use these components to create and use Microsoft SQL Server Reporting Services reports and Microsoft SQL Server Analysis Services cubes.

Use the information in this chapter to install and configure the business intelligence components.

Install Reporting Services extensions for Microsoft Dynamics AX

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Microsoft SQL Server Reporting Services is the primary reporting platform for Microsoft Dynamics AX. The reports that are included with Microsoft Dynamics AX run on the Reporting Services platform.

To integrate Microsoft Dynamics AX and Reporting Services, you must complete several procedures. You must first install the Reporting Services extensions by running the Microsoft Dynamics AX Setup Wizard and selecting the Reporting Services extensions option. This option installs the extensions and enables you to deploy the reports that are included with Microsoft Dynamics AX.

The following sections provide step-by-step instructions.

Checklist: Install the Reporting Services extensions and deploy reports

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

To install the Microsoft SQL Server Reporting Services extensions and deploy reports, complete the tasks in the following checklist.

<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete the pre-installation tasks:</td>
<td>Before you install the Reporting Services extensions</td>
</tr>
<tr>
<td>1. Verify that you have the permissions that are required to install the Reporting Services extensions.</td>
<td></td>
</tr>
<tr>
<td>2. Install prerequisites.</td>
<td></td>
</tr>
<tr>
<td>3. Configure the Reporting Services instance.</td>
<td></td>
</tr>
<tr>
<td>Install the Reporting Services extensions.</td>
<td>Install the Reporting Services extensions</td>
</tr>
<tr>
<td>Task</td>
<td>More information</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Complete the Reporting Services integration. The directions vary,</td>
<td>Complete the</td>
</tr>
<tr>
<td>depending on whether you are running Reporting Services in native</td>
<td>Reporting Services</td>
</tr>
<tr>
<td>mode or SharePoint integrated mode.</td>
<td>integration</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td>SharePoint integrated mode is supported if you are using AX 2012 R2</td>
<td></td>
</tr>
<tr>
<td>or later.</td>
<td></td>
</tr>
<tr>
<td>If you are running Reporting Services in native mode, complete the</td>
<td></td>
</tr>
<tr>
<td>following procedures:</td>
<td></td>
</tr>
<tr>
<td>1. Deploy the default reports that are included with Microsoft</td>
<td></td>
</tr>
<tr>
<td>Dynamics AX, if you did not already deploy the reports when you</td>
<td></td>
</tr>
<tr>
<td>installed the Reporting Services extensions.</td>
<td></td>
</tr>
<tr>
<td>2. Assign users to the DynamicsAXBrowser role on the Report Manager</td>
<td></td>
</tr>
<tr>
<td>site.</td>
<td></td>
</tr>
<tr>
<td>If you are running Reporting Services in SharePoint integrated</td>
<td></td>
</tr>
<tr>
<td>mode, complete the following procedures:</td>
<td></td>
</tr>
<tr>
<td>1. Create a document library to store reports.</td>
<td></td>
</tr>
<tr>
<td>2. Deploy the default reports that are included with Microsoft</td>
<td></td>
</tr>
<tr>
<td>Dynamics AX.</td>
<td></td>
</tr>
<tr>
<td>3. Grant users permission to view reports in SharePoint.</td>
<td></td>
</tr>
</tbody>
</table>

**Before you install the Reporting Services extensions**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Before you install the Microsoft SQL Server Reporting Services extensions, you must complete the following procedures.

**Verify that you have the required permissions to install the Reporting Services extensions**

To install the Reporting Services extensions, you must have the required permissions. For more information, see the Verify that you have the required permissions for installation section.

**Assign system service accounts to the appropriate Active Directory groups**

Identify which accounts are used for the following purposes:

- The account used to run the Microsoft Dynamics AX Application Object Server (AOS)
- The account used as the Business Connector proxy

Assign the accounts listed above to the following Active Directory groups on the domain server:

- Windows Authorization Access group
- Pre-Windows 2000 Compatibility Access group
Install prerequisites

On the computer where Reporting Services is installed, or where you plan to install Reporting Services, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Configure Reporting Services in native mode

If you installed Reporting Services in native mode, you must complete the following procedures to configure the Reporting Services instance.

Configure the Reporting Services instance by using the Reporting Services Configuration Manager tool

Use the following procedure to configure the Reporting Services instance.

**Note**

If you installed the Reporting Services instance in its default configuration, Reporting Services is already configured for you. However, we recommend that you complete this procedure to verify that the options are configured correctly.

1. Click Start > All Programs > Microsoft SQL Server > Configuration Tools > Reporting Services Configuration Manager to open Reporting Services Configuration Manager.

2. Connect to your Reporting Services instance.

3. Configure the options that are described in the following table. For detailed information about each option, see the SQL Server documentation.

<table>
<thead>
<tr>
<th>Click this option</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ServerName][InstanceName]</td>
<td>Verify that the Reporting Services instance is running. If it is not running, click Start.</td>
</tr>
</tbody>
</table>

**Service Account**

The action that you should take depends on the configuration mode that you selected when you installed the Reporting Services instance.

- If you installed the default configuration for native mode, no action is required. The service account is set to the account that you specified when you installed the Reporting Services instance.
- If you installed but did not configure the report server, select the Network Service built-in account.

**Note**

When you install the Reporting Services extensions, the Business Connector proxy account is automatically assigned as the service account for the Reporting Services instance.

**Web Service URL**

Create a virtual directory for the Reporting Services web service. By default, the virtual directory is named ReportServer, and the URL is http://[SSRSServerName]:80/ReportServer.

**Database**

Create a database for the Reporting Services instance. By default, the database is named ReportServer.

**Report Manager URL**

Create a virtual directory for Report Manager. Report Manager is the website that reports are published to. By default, the virtual directory is named Reports, and the URL is http://[SSRSServerName]:80/Reports.
4. Click Exit to close Reporting Services Configuration Manager.

**Configure the Reporting Services instance for local administration**

To administer an instance of the report server locally, you must complete additional configuration steps when you deploy Reporting Services on Windows Server 2008. Windows Server 2008 limits the overuse of elevated permissions by removing administrator permissions when you access applications. If you are a member of the local Administrators group, you run most applications as if you are using the Standard User account because the operating system removes permissions.

Although this practice improves the overall security of your system, it prevents you from using the predefined, built-in role assignments that Reporting Services creates for local administrators. However, by completing additional configuration steps, you can manage the report server’s content and operations by using standard user permissions. For instructions, see [How to: Configure a Report Server for Local Administration on Windows Vista and Windows Server 2008](https://technet.microsoft.com/en-us/library/cc777608.aspx) on TechNet.

After you have configured the Reporting Services instance for local administration, verify that you can access the websites that are listed in the following table.

<table>
<thead>
<tr>
<th>Website</th>
<th>Default URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting Services web service</td>
<td>http://[SSRSServerName]:80/ReportServer</td>
</tr>
<tr>
<td>Report Manager</td>
<td>http://[SSRSServerName]:80/Reports</td>
</tr>
</tbody>
</table>

**Configure Reporting Services in SharePoint integrated mode**

If you installed Reporting Services in SharePoint integrated mode, use one of the following procedures to configure the Reporting Services instance. The procedure that you should use depends on the version of SQL Server that you are using.

**Note**

SharePoint integrated mode is supported if you are using Microsoft Dynamics AX 2012 R2 or later.
Configure Reporting Services 2008 in SharePoint integrated mode

If you are using Reporting Services 2008 or Reporting Services 2008 R2, follow these steps to configure Reporting Services in SharePoint integrated mode.

1. Configure Reporting Services by using the following topics in the SQL Server documentation on TechNet:
   - How to: Install and Configure SharePoint Integration on a Stand-alone Server
   - How to: Install and Configure SharePoint Integration on Multiple Servers

   **Note**
   When you configure Reporting Services, set the Reporting Services service account and execution account to the Business Connector proxy account.

2. Configure the Reporting Services integration in SharePoint Central Administration. For more information, see How to: Configure Report Server Integration in SharePoint Central Administration in the SQL Server documentation on TechNet.

3. Verify that you can access the websites that are listed in the following table.

<table>
<thead>
<tr>
<th>Website</th>
<th>Default URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting Services web service</td>
<td>http://[SSRSServerName]:80/ReportServer</td>
</tr>
<tr>
<td>SharePoint site</td>
<td>The URL of the SharePoint site varies based on the URL that you provided when you created the site collection. The URL of the SharePoint site may be either of the following: http://[SharePointServerName]:[PortNumber] http://[SharePointServerName]:[PortNumber]/sites/[SiteName]</td>
</tr>
</tbody>
</table>

Configure Reporting Services 2012 or 2014 in SharePoint integrated mode

If you are using Reporting Services 2012 or 2014, follow these steps to configure Reporting Services in SharePoint integrated mode.

1. Configure Reporting Services by using the following topics in the SQL Server documentation on TechNet.

   - Install Reporting Services SharePoint Mode for SharePoint 2010
     **Important**
     When installing Reporting Services 2012 in SharePoint integrated mode, be sure that you do not mark the Reporting Services – Native option on the Feature Selection page of the SQL Server Setup Wizard.
   - Add an Additional Report Server to a Farm (SSRS Scale-out)
   - Add an Additional Reporting Services Web Front-end to a Farm

   - Install Reporting Services SharePoint Mode for SharePoint 2013
     **Important**
     When installing Reporting Services 2012 in SharePoint integrated mode, be sure that you do not mark the Reporting Services – Native option on the Feature Selection page of the SQL Server Setup Wizard.
   - Add an Additional Report Server to a Farm (SSRS Scale-out)
   - Add an Additional Reporting Services Web Front-end to a Farm
2. If you did not create a site collection when installing and configuring SharePoint, create one now. If you are using SharePoint 2010, see these instructions on TechNet. If you are using SharePoint 2013, see these instructions on TechNet.

3. Verify that you can access the websites that are listed in the following table.

<table>
<thead>
<tr>
<th>Website</th>
<th>Default URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting Services web service</td>
<td>The URL of the Reporting Services web service varies based on the URL that you provided when you created the site collection. The URL of the Reporting Services web service may be either of the following:</td>
</tr>
<tr>
<td></td>
<td>• http://[SharePointServerName]:[PortNumber]/_vti_bin/ReportServer</td>
</tr>
<tr>
<td></td>
<td>• http://[SharePointServerName]:[PortNumber]/sites/[SiteName]/_vti_bin/ReportServer</td>
</tr>
<tr>
<td>SharePoint site</td>
<td>The URL of the SharePoint site varies based on the URL that you provided when you created the site collection. The URL of the SharePoint site may be either of the following:</td>
</tr>
<tr>
<td></td>
<td>• http://[SharePointServerName]:[PortNumber]</td>
</tr>
<tr>
<td></td>
<td>• http://[SharePointServerName]:[PortNumber]/sites/[SiteName]</td>
</tr>
</tbody>
</table>

4. For more information about how to verify that the integration is configured correctly, see Verify a Reporting Services Installation in the SQL Server documentation on TechNet.

Install the Reporting Services extensions

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Use this procedure to install the Microsoft SQL Server Reporting Services extensions. You must complete this procedure on the computer that is running Reporting Services. This procedure assumes that you are installing the Reporting Services extensions on a dedicated server where no other Microsoft Dynamics AX components are installed. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.


2. Advance through the initial wizard pages.

3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.

4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.

5. On the Select installation type page, select Custom installation. Click Next.

6. On the Select components page, follow these steps:
   a. Select the Reporting Services extensions check box. When you select the option to install the Reporting Services extensions, the management utilities are automatically selected for installation, also.
   b. A message is displayed that states that you must complete the code upgrade checklist if you are upgrading. Click OK.
   c. Click Next.
7. On the **Prerequisite Validation** page, resolve any errors. For more information about how to resolve prerequisite errors, see the [Check prerequisites](#) section. When no errors remain, click **Next**.

8. On the **Select a file location** page, select the location in which to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.

9. On the **Specify a location for configuration settings** page, specify whether you want the Reporting Services extensions to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click **Next**.

10. On the **Connect to an AOS instance** page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

**Note**

You can connect to an AOS instance that is part of an AOS cluster. However, do not connect to an AOS instance that serves as the dedicated load balancer for a cluster. For more information about how to integrate Reporting Services with an AOS scale-out deployment, see Planning for reporting in Microsoft Dynamics AX on TechNet.

11. On the **Specify Business Connector proxy account information** page, enter the password for the proxy account that is used by Business Connector. Click **Next**.

12. On the **Specify a Reporting Services instance** page, complete the action listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action you should take</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance name</td>
<td>Select the name of the Reporting Services instance. If you are using Reporting Services 2012 or 2014 in SharePoint integrated mode, select <em>@Sharepoint</em>.</td>
<td>SharePoint integrated mode is supported if you are using Microsoft Dynamics AX 2012 R2 or later.</td>
</tr>
<tr>
<td>Site URL</td>
<td>Select the URL of the SharePoint site that has been integrated with Reporting Services.</td>
<td>This field is displayed only when Reporting Services 2012 or 2014 is running in SharePoint integrated mode.</td>
</tr>
<tr>
<td>Deploy reports</td>
<td>Select the check box to deploy the default reports that are included with Microsoft Dynamics AX. If you do not deploy the reports now, you can deploy them later by using Windows PowerShell commands. For more information, see the <a href="#">Deploy the default reports</a> section.</td>
<td>This check box is displayed only when Reporting Services is running in native mode. If Reporting Services is running in SharePoint integrated mode, you must deploy the reports after you complete this wizard. Deploy the reports by using Windows PowerShell commands. For more information, see the <a href="#">Deploy the default reports</a> section.</td>
</tr>
</tbody>
</table>

13. Click **Next**.

14. On the **Prerequisite Validation** page, resolve any errors. When no errors remain, click **Next**.

15. On the **Ready to install** page, click **Install**.

If you selected to deploy the reports in step 11, a Windows PowerShell window is displayed. This window shows the progress of the deployment, which may take several minutes. Do not close this window. When the reports are deployed, the window closes automatically.
16. Click **Finish** to close the Setup wizard.

   If you selected to deploy the reports in step 11, you can close the Setup wizard before the reports have finished being deployed. The deployment of the reports is not affected.

17. The **Microsoft Dynamics AX 2012 Setup Summary Report** is displayed. This report lists additional procedures that you must complete to integrate Microsoft Dynamics AX and Reporting Services. For more information about the procedures, see the [Complete the Reporting Services integration](#) section.

---

**Complete the Reporting Services integration**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

To fully integrate Microsoft Dynamics AX and Microsoft SQL Server Reporting Services, you must complete additional configuration procedures. The procedures vary, depending on whether you are running Reporting Services in native mode or SharePoint integrated mode.

**Note**

SharePoint integrated mode is supported if you are using Microsoft Dynamics AX 2012 R2 or later.

If you are running Reporting Services in native mode, complete the following procedures:

1. [Deploy the default reports](#)
2. [Grant users access to reports](#)

If you are running Reporting Services in SharePoint integrated mode, complete the following procedures:

1. [Create a document library to store reports](#)
2. [Deploy the default reports](#)
3. [Grant users access to reports](#)

---

**Create a document library to store reports**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

If you are using Microsoft Dynamics AX 2012 R2 or later, and if Microsoft SQL Server Reporting Services is running in SharePoint integrated mode, create a document library in SharePoint to store your reports. Complete this procedure before you deploy the default reports that are included with Microsoft Dynamics AX.

**Note**

This procedure does not apply to you if you are running Reporting Services in native mode.

---

**Create a document library**

Create a document library on your SharePoint site to store reports. For information about how to create a document library, see the SharePoint documentation.

After you create the document library, add Reporting Services content types to the library. For more information, see [Add Report Server Content Types to a Library (Reporting Services in SharePoint Integrated Mode)](https://docs.microsoft.com/en-us/dynamicsax/2012-administration/add-report-server-content-types-to-a-library) in the SQL Server documentation on TechNet.
Specify the URL of the document library

After you have created the document library, complete the following procedure to specify the URL of the document library in the Report servers form in Microsoft Dynamics AX.

1. Open Microsoft Dynamics AX.
2. Click System administration > Setup > Business intelligence > Reporting Services > Report servers.
3. In the Configuration ID field, enter a name that identifies the Reporting Services instance and the Application Object Server (AOS) instance that you are connecting.
4. In the Description field, enter a brief description to help you identify the Reporting Services instance and the AOS instance that you are connecting.
5. Select the Default configuration check box to make the Reporting Services and AOS instances that are specified in this record the active connection.
6. On the Reporting Server information tab, enter the following information:
   a. In the Server name field, enter the name of the server that is running Reporting Services.
   b. In the Server instance name field, enter the name of the Reporting Services instance.

   **Note**

   If you are using Reporting Services 2012 or 2014, enter @Sharepoint.

c. Leave the Report Manager URL field blank. This field becomes unavailable when you select the SharePoint integrated mode check box in a later step.

d. In the Web service URL field, enter the URL of the Reporting Services web service.
   - If you are using Reporting Services 2008, the URL is typically http://[SSRSServerName]/ReportServer.
   - If you are using Reporting Services 2012 or 2014, the URL is typically http://[SharePointServerName]/_vti_bin/ReportServer or http://[SharePointServerName]/sites/[SiteName]/_vti_bin/ReportServer.

e. Select the SharePoint integrated mode check box.

f. In the Microsoft Dynamics AX report folder field, enter the URL of the document library that you created to store reports.
   For example, suppose that you have created a document library that is named Reports on a SharePoint site that is named Contoso. In this example, the URL is as follows:
   http://[SharePointServerName]/sites/Contoso/Reports

7. On the Application Object Server information tab, select the name of the AOS instance.

Deploy the default reports

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Microsoft Dynamics AX includes many default reports that you must deploy. If you did not deploy the reports when you installed the Microsoft SQL Server Reporting Services extensions, you can deploy them by using Windows PowerShell. The following procedures can help you deploy the reports.
Before you begin

Before you can deploy the reports by using Windows PowerShell, you must complete the following tasks:

- Verify that Windows PowerShell 2.0 is installed on the computer that you are using.
- Verify that your Windows domain account is a member of the Administrators group on the server that is running Reporting Services.

**Note**

If your Windows domain account is assigned to a group that is a member of the Administrators group, it may take some time to validate that you are a member of the Administrators group. If you experience a delay when you deploy reports, consider adding your Windows domain account directly to the Administrators group.

- If Reporting Services is running in native mode, verify that you are assigned to the System Administrator role on the Report Manager website.
- If Reporting Services is running in SharePoint integrated mode, verify that you have been granted Contribute permission to the document library where you plan to deploy the reports.

**Note**

SharePoint integrated mode is supported if you are using Microsoft Dynamics AX 2012 R2 or later.

Open Windows PowerShell and view a list of reports

Complete the following procedure to open Windows PowerShell and view a list of the reports that are included with Microsoft Dynamics AX.

1. Open Windows PowerShell as an administrator by following these steps:
   a. Click **Start > Administrative Tools**.
   b. Right-click the **Microsoft Dynamics AX 2012 Management Shell** option.
   c. Click **Run as administrator**.

2. Retrieve a list of the reports that are included with Microsoft Dynamics AX, and store the list in a local variable by entering the following command:

```
$reports = Get-AXReport -ReportName *
```


3. View the list of reports by entering the following command:

```
$reports
```

Filter the list of reports

In the previous procedure, you displayed a list of all the reports that are included with Microsoft Dynamics AX. To modify and filter the list, you can use the following commands:

- To modify the list so that only the **Name** and **ChangedDate** fields are displayed, enter the following command:

```
$reports | Select-Object Name,ChangedDate
```

- To filter the list so that only specific reports are listed, enter keywords or report names. For example, to filter the list so that only reports that contain the word `CustTrans` are listed, enter the following command:

```
$reports | Select-Object Name,ChangedDate | Where { $_.Name -like "CustTrans*" }
```
Deploy the reports

After you have retrieved a list of reports, you can deploy the reports. The Publish-AXReport command is used to deploy the reports. The following examples show how to use this command. For more information, see Publish-AXReport on Microsoft.com.

- To deploy a specific report, enter the name of the report. For example, to deploy the CustTransList report, enter the following command:

  `Publish-AXReport -ReportName CustTransList`

- To deploy two or more specific reports, enter the names of the reports. For example, to deploy the CustTransList and CustTransOpenPerDate reports, enter the following command:

  `Publish-AXReport -ReportName CustTransList, CustTransOpenPerDate`

- To deploy all reports, enter the following command:

  `Publish-AXReport -ReportName *`

Redeploy the reports

If you have modified a report’s data source or parameters, you must redeploy the report in order for the changes to take effect. To redeploy a report, follow the previous procedures in this section. After you redeploy a report, complete the following tasks.

Restart the Reporting Services service

If you’re running Reporting Services 2008 (in either native or SharePoint integrated mode) or Reporting Services 2012 or 2014 in native mode, restart the service by following these steps:

1. Click **Start > Administrative Tools > Services** to open the **Services** management console.
2. Right-click the **SQL Server Reporting Services** service and choose **Restart**.

If you’re running Reporting Services 2012 or 2014 in SharePoint integrated mode, restart the service by following these steps:

1. Go to the SharePoint Central Administration site.
2. Click **System Settings > Manage services on server**.
3. Stop the SQL Server Reporting Services service.
4. Start the SQL Server Reporting Services service.

Refresh the AOD cache

Complete the following steps to refresh the application object directory (AOD) cache. This will clear cached application object information for all items in the application object tree (AOT) of Microsoft Dynamics AX.

1. Open the Microsoft Dynamics AX client.
2. Open the development workspace.
3. Click **Tools > Caches > Refresh elements**.

   After the cache has been cleared, the Infolog displays a message indicating that AOD elements have been refreshed.
Instruct users to delete usage data

Instruct Microsoft Dynamics AX users to delete usage data. Selections that users make while Microsoft Dynamics AX is running are saved as usage data. This data is used to improve the users’ experiences the next time that they run Microsoft Dynamics AX.

Instruct users to delete usage data by following these steps:

1. Open the Microsoft Dynamics AX client.
2. Click **File > Tools > Options**. The **Options** form is displayed.
3. Click **Usage data**.
4. On the **General** tab, click **Reset**.

See also

- Administering Microsoft Dynamics AX by using Windows PowerShell (on TechNet)
- Windows PowerShell for Microsoft Dynamics AX (on TechNet)
- Piping and the Pipeline in Windows PowerShell (on Microsoft.com)

Grant users access to reports

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section explains how to give users access to reports. Two procedures are described in this section. The procedure that you should use depends on whether you are running Microsoft SQL Server Reporting Services in native mode or SharePoint integrated mode.

**Note**

SharePoint integrated mode is supported if you are using Microsoft Dynamics AX 2012 R2 or later.

Assign users to the DynamicsAXBrowser role on the Report Manager site

If you are running Reporting Services in native mode, you must assign users or groups to the DynamicsAXBrowser role on the Report Manager site. The following procedure explains how to complete this task.

1. Open the Report Manager website for the Reporting Services instance. By default, the URL is http://[SSRSServerName]:80/Reports.
2. Click the **DynamicsAX** folder.
3. Click **Folder Settings**.
4. Click **Security**.
5. Click **New Role Assignment**.
6. Enter the Active Directory user name or group to assign to the DynamicsAXBrowser role.
7. Select the **DynamicsAXBrowser** role.
8. Click **OK**.

Grant users permission to view reports in SharePoint

If you are running Reporting Services in SharePoint integrated mode, you must grant users permission to view reports in SharePoint. To grant this permission, grant users **Read** permission to the document library that stores
the reports. Alternatively, if the document library inherits permissions from the site, you can grant users Read permission to the site. The following procedure describes how to grant users Read permission to the site.

⚠️ Important
If the SharePoint site is configured for claims-based authentication, you must also grant the following accounts Read permission to the document library or site:

- The account that is used as the Business Connector proxy
- The account that is used to run the Microsoft Dynamics AX Application Object Server (AOS) service.

1. Open your browser and navigate to the SharePoint site that contains the document library that stores the reports.
2. Click Site Actions > Site Permissions.
3. Click Grant Permissions. The Grant Permissions window is displayed.
4. In the Users/Groups field, enter the Active Directory names of the users or groups that you want to view reports.
5. In the Grant Permissions area, select the Grant users permission directly option.
6. Select the Read check box.

✅ Note
If you want users of Enterprise Portal for Microsoft Dynamics AX to be able to filter reports by using a custom parameter value, select the Design check box. For more information about the permissions that are required to use Enterprise Portal, see Enable users to access Enterprise Portal on TechNet.

7. Click OK.

See also
- Security settings for reports (on TechNet)

Deploy language-specific versions of a report

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Typically, when you deploy a report, one version of the report is deployed. This version can then be rendered automatically in every language that is supported by Microsoft Dynamics AX. However, you can configure Microsoft Dynamics AX so that language-specific versions of a report are deployed. A language-specific version of a report is sometimes referred to as a static version.

A language-specific version of a report is rendered more quickly for the following reasons:

- Labels are not resolved at run time.

✅ Note
Labels are resolved when you deploy the report. Therefore, if you deploy a report and later change a label, the updated label is not displayed on the report. In this scenario, you must redeploy the report to view the updated label.

- Columns are not collapsed at run time.

✅ Note
A language-specific version of a report is designed to render quickly. If you are a developer designing a language-specific version of a report, we recommend that you do not include drill-through links to other reports on the report that you are designing.
When language-specific versions of reports are deployed

The following table explains when and how language-specific versions of reports are deployed.

<table>
<thead>
<tr>
<th>Event</th>
<th>Are language-specific versions deployed?</th>
</tr>
</thead>
<tbody>
<tr>
<td>You select the <strong>Deploy reports</strong> check box when you run the Microsoft Dynamics AX Setup wizard.</td>
<td>No.</td>
</tr>
</tbody>
</table>
| While you are completing the Initialization Checklist or the Partition Initialization Checklist, you set up system parameters in the **System parameters** form. | No. However, at this point, the **Report deployment settings** form is populated with a list of reports for which we recommend that you deploy language-specific versions. This list includes the following reports:  
  • FreeTextInvoice  
  • ProdPickList  
  • ProdRouteCard  
  • PurchPackingSlip  
  • PurchPurchaseOrder  
  • PurchReceiptsList  
  • SalesConfirm  
  • SalesInvoice  
  • SalesPackingSlip  
  • SalesQuotation  
  • SalesQuotationConfirmation  
  • VendInvoiceDocument  
  • WMSBillOfLading  
  • WMSPickingList_OrderPick  
  The next time that you deploy or redeploy these reports, language-specific versions are deployed. |
| You redeploy all reports by using Windows PowerShell. | Yes. Language-specific versions are deployed for each report for which the **Use static report design** check box is selected in the **Report deployment settings** form. |

Deploy language-specific versions of a report

To deploy language-specific versions of a report, complete the following procedure.

1. Open Microsoft Dynamics AX.
2. Click **System administration > Setup > Business intelligence > Reporting Services > Report deployment settings**.
3. Click **New**.
4. In the **Report name** field, select the report for which you want to deploy language-specific versions.
5. In the **Report design name** field, select a report design.
6. Select the **Use static report design** check box.
7. Close the **Report deployment settings** form.
8. Deploy the report by following the instructions in the Deploy the default reports section. A language-specific version of the report is deployed for each language that is enabled in your Microsoft Dynamics AX installation.

If Reporting Services is running in native mode, the language-specific versions are deployed to the DynamicsAX\StaticReports folder on the Report Manager website.

If Reporting Services is running in SharePoint integrated mode, the language-specific versions are deployed to the StaticReports folder in the document library that stores all of your Microsoft Dynamics AX reports.

Run the SRSReportServerWarmup class

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

Microsoft SQL Server Reporting Services periodically restarts, and each restart clears the Reporting Services cache. After the cache has been cleared, it may take some time for the next report that is run to display. To minimize the effect of Reporting Services restarts, a new class that is named SRSReportServerWarmup is included with cumulative update 7 for Microsoft Dynamics AX 2012 R2. When the SRSReportServerWarmup class runs, it prepares the report server for use by performing the following tasks:

1. Loads Microsoft Dynamics AX business logic assemblies
2. Connects to Reporting Services
3. Runs a sample report that is named SRSReportServerWarmup

As a best practice, you should run the SRSReportServerWarmup class after Reporting Services restarts. The following procedures explain how to use the SRSReportServerWarmup class.

Deploy the SRSReportServerWarmup report

When the SRSReportServerWarmup class runs, it prepares the report server for use by running a sample report that is named SRSReportServerWarmup. You must deploy this report to the report server. For information about how to deploy a report, see the Deploy the default reports section.

Create a batch group

A batch job is used to run the SRSReportServerWarmup class. (You’ll create this batch job in the next procedure.) We recommend that this batch job run within the context of a batch group. Complete the following procedure to create a batch group.

1. Click System administration > Setup > Batch group.
2. Click New to create a new batch group.
3. In the Group field, enter a unique name for the batch group. For example, enter SSRS.
4. In the Description field, enter a description to help you identify the batch group.
5. Click the Batch servers tab.
   The Selected servers list displays the AOS instances that the batch group runs on. The Remaining servers list displays the remaining AOS instances that are available as batch servers.
6. Use the arrow buttons to add servers to the Selected servers list or to remove servers from the Selected servers list.

Create a batch job

Complete the following procedure to create a batch job that will run the SRSReportServerWarmup class.

1. Open the Microsoft Dynamics AX Application Object Tree (AOT).
2. Expand the Classes node.
3. Right-click the **SRSReportServerWarmup** class, and then click **Open**. A form is displayed that lets you configure the batch job.
4. Select the **Batch processing** check box.
5. In the **Task description** field, enter a description for this batch job.
6. In the **Batch group** list, select the batch group that you created in the previous procedure.
7. Select the **Private** check box if you want to restrict other users from running this batch job. A private batch job can be run only by the user who created it and only on the computer where the user is logged on.
8. Click **Recurrence** to specify how often this batch job will run.
   
   For example, if your report server restarts each night, you might want to schedule this batch job to run every morning. In this case, we recommend that you schedule the batch job to run before your employees start to work each day.
9. Click **Alerts** to send notifications when this batch job ends, has an error, or is canceled.

**Extend the SRSReportServerWarmup class**

When the SRSReportServerWarmup class runs, it prepares the report server for use by running a sample report that is named SRSReportServerWarmup. You can customize the SRSReportServerWarmup class so that it runs additional, specific reports.

For example, assume that Phyllis, the Accounts Payable manager in your organization, runs the Vendor Aging report every morning. To ensure that this report renders quickly for Phyllis, you can customize the SRSReportServerWarmup class so that it runs the Vendor Aging report every morning. To do this, you’ll need to create a new method that runs the Vendor Aging report and then configure the SRSReportServerWarmup class to call this new method.

Microsoft Dynamics AX provides sample code to help you create a new method. The following procedure explains how to use this sample code to create a method, and then configure the SRSReportServerWarmup class to call the new method.

1. Open the AOT.
2. Expand the **Classes > SRSReportServerWarmup** node.
3. Is the report that you’re going to run based on a report data provider (RDP) class?
   - **Yes** – If the report is based on an RDP class, right-click **runSampleRdpReportWithParameters**, and then click **View Code**. Copy the sample code that is displayed. You’ll use this code as a template for the new method that you create.
   - **No** – If the report is not based on an RDP class, right-click **runSampleRdlReportWithParameters**, and then click **View Code**. Copy the sample code that is displayed. You’ll use this code as a template for the new method that you create.

   For more information about RDP classes, see [How to: Use a Report Data Provider Class in a Report](https://technet.microsoft.com/en-us/library/ee659065(v=exchg.140).aspx) on TechNet.
4. Create the new method. To do this, follow these steps:
   a. Right-click the **SRSReportServerWarmup** class, and then click **New > Method**.
   b. Select the code that is displayed, right-click, and then click **Paste**. The sample code that you copied in step 3 is displayed.
   c. Customize the code. For example, specify the report design to use. Additionally, if the report requires parameters, enter values for the parameters.
d. Save the new method.

5. Configure the SRSReportServerWarmup class to call the new method. To do this, follow these steps:
   a. Right-click the run method, and then click View Code.
   b. Add code to call the new method that you created in step 4.
   c. Save the run method.

6. Right-click the SRSReportServerWarmup class, and then click Compile.
   The method should compile without errors or warnings.

7. Click Build > Generate Incremental CIL.
   When the process is completed, you receive a message that states that the incremental CIL was generated.

---

How to: Deploy reports to a report server

 Applies to: Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to deploy reports to a report server from Microsoft Dynamics AX and from Microsoft Visual Studio.

SQL Server Reporting Services is the reporting platform for Microsoft Dynamics AX. Reporting Services enables developers to create and publish traditional, paper-based reports, and interactive Web-based reports. When you deploy a report, the report design, data sources, and associated business logic assemblies are deployed to the SQL Server Reporting Services server.

Deploying reports to Reporting Services does the following:
- Uploads the Report Definition Language (RDL) file, which is the report, to the Reporting Services server
- Copies the business logic assemblies to the Reporting Services server
- Ensures that the cross referenced report and business logic assemblies are present to have a valid report deployed

To deploy an Microsoft Dynamics AX reporting project in Visual Studio, you must start Visual Studio with administrative privileges or start Microsoft Dynamics AX and the Developer Workspace with administrative privileges. To do this, you must right-click on the icon for Visual Studio or Microsoft Dynamics AX and then choose Run as administrator. The following table describes the options to deploy reports:

<table>
<thead>
<tr>
<th>Deploy option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Dynamics AX</td>
<td>Reports can be deployed individually from a developer workspace in Microsoft Dynamics AX. In the AOT, expand the SSRS Reports node, expand the Reports node, right-click the report, and then click Deploy Element. The reports are deployed for all the translated languages.</td>
</tr>
<tr>
<td>Microsoft Visual Studio</td>
<td>Reports can be deployed individually from Visual Studio. In Solution Explorer, right-click the reporting project that contains the reports that you want to deploy, and then click Deploy. The reports are deployed for the neutral (invariant) language only.</td>
</tr>
<tr>
<td>Microsoft PowerShell</td>
<td>Used to deploy the default reports that are provided with Microsoft Dynamics AX. For information about how to deploy from Windows PowerShell, see the Deploy the default reports section.</td>
</tr>
</tbody>
</table>
For more information about deployment, see Report Integration and Customization Overview on TechNet. For information about the reporting install, see the Install business intelligence components chapter.

**To deploy reports from Microsoft Dynamics AX**

1. In the AOT, expand the SSRS Reports node.
2. Expand the Reports node.
3. Right-click the report that you want to deploy, and then click Deploy Element.

**To deploy reports from Microsoft Visual Studio**

- In Solution Explorer, right-click the reporting project that contains the reports that you want to deploy, and then click Deploy. Reports are deployed for the neutral (invariant) language only.

**See also**

- Report Integration and Customization Overview (on TechNet)
- How to: Add Reports to Microsoft Dynamics AX (on TechNet)
- How to: Create a Menu Item for a Report (on TechNet)
- How to: Customize a Report (on TechNet)

**Configure Analysis Services**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Microsoft SQL Server Analysis Services is a server-based solution that provides online analytical processing (OLAP) functionality. Analytical reports help users examine business data and identify trends that they might not otherwise discover when viewing data on traditional reports.

To integrate Microsoft Dynamics AX and Analysis Services, you must complete several procedures. You must first run the Microsoft Dynamics AX Setup wizard and select the Analysis Services configuration option. This option configures Analysis Services so that it can be used with Microsoft Dynamics AX. This section provides step-by-step instructions.

**Checklist: Configure Analysis Services and deploy cubes**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

To configure Microsoft SQL Server Analysis Services for use with Microsoft Dynamics AX and to deploy the cubes that are included with Microsoft Dynamics AX, complete the tasks in the following checklist.
<table>
<thead>
<tr>
<th>Task</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete the prerequisite tasks:</td>
<td>Before you configure Analysis Services</td>
</tr>
<tr>
<td>1. Verify that you have the permissions that are required to configure Analysis Services.</td>
<td></td>
</tr>
<tr>
<td>2. Create a domain account to run the Analysis Services service.</td>
<td></td>
</tr>
<tr>
<td>3. Assign the .NET Business Connector proxy account to the server administrator role in Analysis Services.</td>
<td></td>
</tr>
<tr>
<td>4. Install prerequisites.</td>
<td></td>
</tr>
<tr>
<td>Configure Analysis Services by running the Microsoft Dynamics AX Setup Wizard.</td>
<td>Configure Analysis Services by running Setup</td>
</tr>
<tr>
<td>Complete the Analysis Services integration:</td>
<td></td>
</tr>
<tr>
<td>1. Install SQL Server Shared Management Objects on Microsoft Dynamics AX client computers.</td>
<td>• Install SQL Server Shared Management Objects</td>
</tr>
<tr>
<td>2. Verify that information about exchange rates has been entered.</td>
<td>• Verify that exchange rate information has been entered</td>
</tr>
<tr>
<td>3. Deploy the default cubes that are included with Microsoft Dynamics AX.</td>
<td>• Deploy the default cubes</td>
</tr>
<tr>
<td>4. Update the data source for online analytical processing (OLAP) if your Analysis Services database is not named Dynamics AX.</td>
<td>• Update the OLAP data source</td>
</tr>
<tr>
<td>• Install SQL Server Shared Management Objects</td>
<td>• Configure an Existing SQL Server Analysis Services Project</td>
</tr>
<tr>
<td>• Verify that exchange rate information has been entered</td>
<td>• Grant users access to cubes</td>
</tr>
<tr>
<td>• Deploy the default cubes</td>
<td>• Automate the processing of cubes</td>
</tr>
<tr>
<td>• Update the OLAP data source</td>
<td>• How to: Create a date dimension for a cube</td>
</tr>
<tr>
<td>• Configure an Existing SQL Server Analysis Services Project</td>
<td>• How to: Add a financial dimension to a cube</td>
</tr>
<tr>
<td>• Grant users access to cubes</td>
<td></td>
</tr>
<tr>
<td>• Automate the processing of cubes</td>
<td></td>
</tr>
<tr>
<td>• How to: Create a date dimension for a cube</td>
<td></td>
</tr>
<tr>
<td>• How to: Add a financial dimension to a cube</td>
<td></td>
</tr>
</tbody>
</table>

**Before you configure Analysis Services**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Before you configure Microsoft SQL Server Analysis Services for use with Microsoft Dynamics AX, you must complete the following procedures.

**Verify that you have the required permissions to configure Analysis Services**

To configure Analysis Services, you must have the required permissions. For more information, see the [Verify that you have the required permissions for installation](#) section.
Create a domain account to run the Analysis Services service
Create a domain account that can run the Analysis Services service. For more information, see the Create service accounts section.

Assign the Business Connector proxy account to the Analysis Services server administrator role
The proxy account for Business Connector must be assigned to the server administrator role in Analysis Services. To complete that task, follow these steps.

1. Open Microsoft SQL Server Management Studio and connect to your Analysis Services instance.
2. In the tree view, right-click the Analysis Services instance, and then click Properties. The Analysis Services Properties window is displayed.
3. In the Select a page area, click Security.
4. Click Add. The Select Users or Groups form is displayed.
5. Enter the Business Connector proxy account in the following format: [DomainName]\[UserName]. Click OK.

Install prerequisites
On the computer where Analysis Services is installed, or where you plan to install Analysis Services, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Configure Analysis Services by running Setup
Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Use this procedure to configure Microsoft SQL Server Analysis Services for use with Microsoft Dynamics AX. You must complete this procedure on the computer that is running Analysis Services.

This procedure assumes that you are configuring Analysis Services on a dedicated server where no Microsoft Dynamics AX components are installed. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the initial wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, select Custom installation. Click Next.
6. On the Select components page, follow these steps:
   a. Select the Analysis Services configuration check box.
   b. A message is displayed that states that you must complete the code upgrade checklist if you are upgrading. Click OK.
c. We recommend that you select the Management utilities check box so that you can deploy cubes by using Windows PowerShell commands.

d. Click Next.

7. On the Prerequisite Validation page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.

8. On the Select a file location page, select the location in which to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.

9. On the Specify a location for configuration settings page, specify whether you want the cubes to access configuration information from the registry on the local computer or from a shared configuration file. If you select to use a shared configuration file, you must enter the network location of the file. Click Next.

10. On the Connect to an AOS instance page, enter the name of the computer that is running the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click Next.

✓ Note
   If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on this computer reuse the existing AOS connection.

11. On the Specify Business Connector proxy account information page, enter the password for the proxy account that is used by Business Connector. Click Next.


13. On the Connect to a SQL Server Database page, follow these steps:
   a. Select the computer that hosts your Microsoft Dynamics AX online transaction processing (OLTP) database.
   b. Select the Microsoft Dynamics AX OLTP database.
   c. Click Next.

14. The domain account that the Analysis Services service runs as must have access to the Microsoft Dynamics AX OLTP database in order to process the cubes. The Specify user accounts page lists the accounts that currently have access to the OLTP database. If the account that the Analysis Services service runs as is not listed, click Add user to add it.

15. Click Next.

16. On the Prerequisite Validation page, resolve any errors. When no errors remain, click Next.

17. On the Ready to install page, click Install.

18. Click Finish to close the Setup wizard.

19. The Microsoft Dynamics AX 2012 Setup Summary Report is displayed. This report lists additional procedures that you must complete to integrate Microsoft Dynamics AX and Analysis Services. For more information about the procedures, see the Complete the Analysis Services integration section.

**Complete the Analysis Services integration**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Complete the following procedures to integrate Microsoft Dynamics AX with Microsoft SQL Server Analysis Services.
Install SQL Server Shared Management Objects

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

You must install the Shared Management Objects for Microsoft SQL Server on Microsoft Dynamics AX client computers that you plan to use to complete the following tasks:

- Run the SQL Server Analysis Services project wizard.
- Use the **Analysis servers** form.

Download the Shared Management Objects for the version of SQL Server that you are using. You can download the Shared Management Objects from one of the following pages on Microsoft.com:

- [SQL Server 2008 Feature Pack page](#)
- [SQL Server 2008 R2 Feature Pack page](#)
- [SQL Server 2012 Feature Pack page](#)

Verify that exchange rate information has been entered

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Complete the following procedures to make sure that information about exchange rates is available to the cubes. Complete these procedures by using the Microsoft Dynamics AX client.

**Select a system currency and an exchange rate type**

Complete the following procedure to select a system currency and an exchange rate type. When Microsoft SQL Server Analysis Services generates monetary amounts in a cube, the amounts are calculated by using the system currency and exchange rate type.

1. Click **System administration** > **Setup** > **System parameters**.
2. From the **System currency** list, select a currency.
3. From the **System exchange rate type** list, select an exchange rate type.

**Verify the exchange rate information**

Complete the following procedure to verify that the system currency and exchange rate type that you selected in the previous procedure are displayed in the **System currency and exchange rate type** form.

1. Click **System administration** > **Setup** > **Business intelligence** > **Analysis Services** > **System currency and exchange rate type**.
2. Verify that the system currency and exchange rate type that you selected in the previous procedure are displayed in this form.

Deploy the default cubes

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This article explains how to deploy the default OLAP (online analytical processing) cubes that are included with Microsoft Dynamics AX. There are two ways to deploy these cubes: by using the Analysis Services Project Wizard in Microsoft Dynamics AX, or by using Windows PowerShell.
Tasks

- See what cubes are available
- Deploy the default cubes by using the Analysis Services Project Wizard
- Deploy the default cubes by using Windows PowerShell

More information

- Cube and KPI reference for Microsoft Dynamics AX (on TechNet)
- Windows PowerShell for Microsoft Dynamics AX cmdlet reference (on TechNet)

See what cubes are available

To deploy the default cubes that are included with Microsoft Dynamics AX, you must deploy a Microsoft SQL Server Analysis Services project. The following table lists the Analysis Services projects that you can deploy, and the cubes that they contain.

<table>
<thead>
<tr>
<th>Analysis Services project</th>
<th>Cubes in the project</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamics AX</td>
<td>• Accounts payable cube</td>
<td>This project must be deployed before any other Analysis Services projects are deployed.</td>
</tr>
<tr>
<td></td>
<td>• Accounts receivable cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Budget control cube*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Budget plan cube*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Environmental sustainability cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Expense management cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• General ledger cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Human resources cube**</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Inventory value cube*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Payroll cube**</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Production cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Profit tax totals cube*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Project accounting cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Purchase cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Retail cube*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sales and marketing cube*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sales cube</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Trade allowance management cube***</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Workflow cube</td>
<td></td>
</tr>
<tr>
<td>Demand Forecast</td>
<td>Demand forecast cube***</td>
<td>This project is available with Microsoft Dynamics AX 2012 R3.</td>
</tr>
<tr>
<td>Demand Forecast Accuracy</td>
<td>Demand forecast accuracy cube***</td>
<td>This project is available with Microsoft Dynamics AX 2012 R3.</td>
</tr>
</tbody>
</table>

* Indicates cubes that are available with Microsoft Dynamics AX 2012 R2 or later.
** Indicates cubes that are available with cumulative update 7 for Microsoft Dynamics AX 2012 R2 or later.
*** Indicates cubes that are available with Microsoft Dynamics AX 2012 R3 or later.
Deploy the default cubes by using the Analysis Services Project Wizard

The following procedure explains how to deploy an Analysis Services project—and process the cubes that it contains—by using the Analysis Services Project Wizard in Microsoft Dynamics AX.

To complete this procedure, you must be assigned to the System Administrator role or the Information Technology Manager role in Microsoft Dynamics AX.

**Note**

If you are using the initial version of Microsoft Dynamics AX 2012, you must be assigned to the System Administrator role to complete this procedure. If you install cumulative update 1 for Microsoft Dynamics AX 2012, users in the Information Technology Manager role can also complete this procedure.

1. Open the Microsoft Dynamics AX client.
2. Click **File > Tools > Business Intelligence (BI) tools > SQL Server Analysis Services project wizard**.
3. On the **Analysis Services project wizard** page, click **Next**.
4. On the **Select an option** page, click **Deploy**, and then click **Next**.
5. On the **Select an existing Analysis Services project** page, click **Select a project from the AOT**. Select the project you want to deploy from the list, and then click **Next**.

**Note**

You must deploy the Dynamics AX project first. After you deploy that project, you can deploy other projects.

6. On the **Deployment options** page, follow the instructions for the version of Microsoft Dynamics AX that you are using.

<table>
<thead>
<tr>
<th>If you are using this version</th>
<th>Follow these steps</th>
</tr>
</thead>
</table>
| Microsoft Dynamics AX 2012 R3 | 1. Select the **Deploy** check box. The Analysis Services project will be associated with the Microsoft Dynamics AX partition that you are currently logged into.  
If the name of the Analysis Services server is incorrect, click **Cancel** to close this wizard. Then open the **Analysis servers** form (System administration > Setup > Business intelligence > Analysis Services > Analysis servers) to enter the correct name of the server.  
2. By default, the database that is created is named in the following way: [Analysis Services project name] + [Partition Key Name]. If you want the database to have a different name, click the name. Then enter the new name.  
3. Select the **Process the project after it is successfully deployed** check box.  
4. Click **Next** to deploy the project and process the cubes that are in it. |
<table>
<thead>
<tr>
<th>If you are using this version</th>
<th>Follow these steps</th>
</tr>
</thead>
</table>
| Microsoft Dynamics AX 2012 R2                                     | 1. Select the **Deploy** check box that is associated with the Microsoft Dynamics AX partition that you are currently logged into. If the name of the Analysis Services server that is used by the partition is incorrect, click **Cancel** to close this wizard. Then open the Analysis servers form (System administration > Setup > Business intelligence > Analysis Services > Analysis servers) to enter the correct name of the server.  
2. By default, the database that is created for each partition is named **Dynamics AX [Partition Key Name]**. If you want the database to have a different name, click the name. Then enter the new name.  
3. Select the **Process the project after it is successfully deployed** check box.  
4. Click **Next** to deploy the project and process the cubes that are in it. |
| The initial version of Microsoft Dynamics AX 2012 or Microsoft Dynamics AX 2012 Feature Pack | 1. Select the **Deploy the project** check box.  
2. Enter the name of the server that is running Analysis Services.  
3. Click **Create new database**. By default, the database is named **Dynamics AX**. If you want the database to have a different name, enter a new name.  
  
**Important**  
If you enter a new name for the database, you must modify the DynamicsAXOLAP data source. For more information, see the Update the OLAP data source section.  
4. Select the **Process the project after it is successfully deployed** check box.  
5. Click **Next** to deploy the project and process the cubes that are in it. |

7. On the **Deploying** page, click **Next** when the deployment is completed.  
8. Click **Finish** to close the wizard.

**Deploy the default cubes by using Windows PowerShell**  
The following procedure explains how to deploy an Analysis Services project—and process the cubes that it contains—by using Windows PowerShell.  
To complete this procedure, you must meet the following requirements:  
- You must be using Microsoft Dynamics AX 2012 R2 or later.  
- You must be assigned to the System Administrator role in Microsoft Dynamics AX.  
- You must be assigned to the Administrators group on the computer from which you’ll run Windows PowerShell.  
- You must install the SQL Server 2008 R2 Analysis Management Objects (AMO) on the computer from which you’ll run Windows PowerShell. You can download AMO from this page on Microsoft.com.  
- You must be assigned to the Server Administrator role in Analysis Services.  
- You must be assigned to the Administrators group on the server that runs Analysis Services.
1. Open Windows PowerShell as an administrator by following these steps:
   a. Click **Start > Administrative Tools**.
   b. Right-click the **Microsoft Dynamics AX 2012 Management Shell** option.
   c. Click **Run as administrator**.
2. View a list of the Analysis Services projects that are in the Application Object Tree (AOT) by entering the following command:
   ```
   Get-AXAnalysisProjectDetail
   ```
   **Note**
   You must deploy the **Dynamics AX** project first. After you deploy that project, you can deploy other projects.
3. Deploy an Analysis Services project. The **Publish-AXAnalysisProject** command is used to deploy and process a project. The following examples show how to use this command. For more information, see **Publish-AXAnalysisProject** on TechNet.
   - To deploy and process a project for all partitions in your Microsoft Dynamics AX installation, enter the following command:
     ```
     Publish-AXAnalysisProject -ProjectName [SSASProjectName] -ServerName [SSASServerName]
     ```
   - To deploy and process a project for a specific partition in your Microsoft Dynamics AX installation, enter the following command:
     ```
     Publish-AXAnalysisProject -ProjectName [SSASProjectName] -PartitionKeys [PartitionKey1] -ServerName [SSASServerName]
     ```
   - To deploy and process a project for two specific partitions in your Microsoft Dynamics AX installation, enter the following command:
     ```
     Publish-AXAnalysisProject -ProjectName [SSASProjectName] -PartitionKeys [PartitionKey1], [PartitionKey2] -ServerName [SSASServerName]
     ```

**Update the OLAP data source**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

By default, when you deploy the cubes that are included with Microsoft Dynamics AX 2012 or Microsoft Dynamics AX 2012 Feature Pack, the database that is created in Microsoft SQL Server Analysis Services is named **Dynamics AX**. If you entered a new name for the Analysis Services database when you deployed the cubes, you must modify the DynamicsAXOLAP data source. To modify the data source, complete the following procedures on the server that runs Microsoft SQL Server Reporting Services.

**Note**
If you are using Microsoft Dynamics AX 2012 R2 or later, the following procedures do not apply to you.

**Modify the DynamicsAXOLAP data source in Report Manager**

Follow these steps to modify the DynamicsAXOLAP data source on the Report Manager website.
1. Open Report Manager. By default, the URL is http://[SSRSServerName]:80/Reports.
2. Click the **DynamicsAX** folder.
3. Click the **DynamicsAXOLAP** data source.
4. In the **Connection string** field, locate the text **Initial Catalog=Dynamics AX**.

5. Change **Dynamics AX** to the new name of the Analysis Services database.

**Modify the DynamicsAXOLAP data source in the AOT**

Follow these steps to use Windows PowerShell to modify the DynamicsAXOLAP data source in the Application Object Tree (AOT) of Microsoft Dynamics AX.

1. Open Windows PowerShell as an administrator by following these steps:
   a. Click **Start > Administrative Tools**.
   b. Right-click the **Microsoft Dynamics AX 2012 Management Shell** option.
   c. Click **Run as administrator**.

2. Enter the following command. In this command, note the following information:
   - *[SSASServerName]* is the name of the server that runs Analysis Services. If you have a named instance of Analysis Services, enter *[SSASServerName\InstanceName]*.
   - *[DatabaseName]* is the name of the Analysis Services database.

   ```powershell
   Set-AXReportDataSource -DataSourceName DynamicsAXOLAP -ConnectionString "Provider=MSOLAP.4;Integrated Security=SSPI;Persist Security Info=True;Data Source=[SSASServerName];Initial Catalog=[DatabaseName]"
   ```

   For more information about the `Set-AXReportDataSource` command, see [Set-AXReportDataSource](https://docs.microsoft.com/en-us/previous-versions/office/2010/ms145572(v=office.14)) on Microsoft.com.

**See also**

- [Administering Microsoft Dynamics AX by using Windows PowerShell](https://docs.microsoft.com/en-us/previous-versions/office/2010/ms145572(v=office.14)) (on TechNet)

**Configure an Existing SQL Server Analysis Services Project**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Microsoft Dynamics AX includes several default cubes. If you deploy these cubes before you modify your license configuration, you must update the cubes that you deployed by using the Analysis Services project wizard.

**Deploying the default cubes**

You can use SQL Server Business Intelligence Development Studio (BIDS) or the Analysis Services project wizard to deploy the default cubes.

**To deploy the default cubes**

- Follow the steps in the [Deploy the default cubes](https://docs.microsoft.com/en-us/previous-versions/office/2010/ms145572(v=office.14)) section.

**Changing the configuration**

During implementation, it is common to change configuration keys. You should update the default cubes after the configuration phase is completed. You configure Microsoft Dynamics AX by entering license codes in the **License information** form, and by enabling or disabling configuration keys in the **License configuration** form.

**Note**

If you change your Microsoft Dynamics AX configuration more than one time, you can use the **Configure** option in the Analysis Services project wizard the first time, but you should use the **Update** option to update your Analysis Services project to reflect any subsequent configuration changes.
To configure Microsoft Dynamics AX

- Follow the steps in Configure application functionality on TechNet.

Configuring analysis cubes

After you configure Microsoft Dynamics AX, you must configure any analysis cubes that were already deployed based on the original configuration. Use the Analysis Services project wizard to remove measures, dimensions, and all dependent objects that are not available due to the Microsoft Dynamics AX configuration change.

You can create Key Performance Indicators (KPIs) in SQL Server Business Intelligence Development Studio (BIDS) after you create an Analysis Services project. KPIs are also included with the default cubes. When you configure or update the Analysis Services project, the KPIs will be updated based on the following:

- If the KPI is in both the source and the target Analysis Services projects, the KPI from the source will override the KPI in the target.
- If the KPI is in the source only, the KPI from the source will be added to the updated Analysis Services project.
- If the KPI is in the target only, the KPI from the target will remain unchanged in the Analysis Services project. In this case, the KPI may become invalid if it uses data that has been removed from the Analysis Services project. You must validate your KPIs in this scenario.

**Note**

When you configure an Analysis Services project by using the wizard, the old project is overwritten by a new Analysis Services project. A backup copy of the project folder is available in your temp directory. For example, the project folder may be located in C:\Users\User1\AppData\Local\Temp\1.

To configure analysis cubes

1. Click Tools > Business Intelligence (BI) tools > SQL Server Analysis Services project wizard. Click Next.
2. On the Select an option page, select Configure. Click Next.
3. On the Select an existing Analysis Services project page, select the project to update. You can select a project from the AOT or from disk. Click Next. After the project builds, click Next again.
4. Select the Apply the Microsoft Dynamics AX configuration to the Analysis Services project check box. Click Next.
5. Select additional languages for which to provide label translations and then click Next.

**Note**

Language translations are supported if you use Microsoft SQL Server 2008 Enterprise Edition or Microsoft SQL Server 2008 R2 or later for your Analysis Services server. Do not include translations in the project if you are using a Microsoft SQL Server 2008 Standard Edition Analysis Services server. If you do and you get an error, you can delete the Analysis Services project in the AOT and then redeploy the Analysis Services project by using the SQL Server Analysis Services project update wizard. Alternatively, you can edit the Analysis Services project in BIDS to remove the translations. To do this, open the Analysis Services project in BIDS. Open each cube and dimension, and then click the Translations tab. Right-click the column for each translation that is not a Default translation, and then click Delete translation. After you have removed the translations, import the project into the AOT.

6. After the project is generated, click Next.
7. On the Deployment options page, specify whether to deploy the project and whether to process the project. If you do not process the project, you will not be able to browse cube data. Click Next until you reach the end of the wizard.
**Note**

The fixed database schema that Microsoft Dynamics AX uses means that related data is not removed from the database when a configuration key is disabled. When you disable a license or configuration key, some data and functionality in Microsoft Dynamics AX is removed from cubes. You must remove all reports and KPIs that rely on the data that is unavailable.

Information is logged in the global log file path that is specified in the Analysis servers form. (For more information, see Analysis servers (form) [AX 2012] on TechNet.) Log files are not generated if you do not specify the global log file path.

**See also**
- How to: Create and Apply a Configuration Key (on TechNet)
- About license codes and configuration keys (on TechNet)
- Configure application functionality (on TechNet)

**Grant users access to cubes**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Security for analysis cubes is set up independently from security for Microsoft Dynamics AX. To grant users access to cubes, you must assign the users to database roles in Microsoft SQL Server Analysis Services.

When you deploy the cubes that are included with Microsoft Dynamics AX, default roles are created in the database where you deploy the cubes. The following procedures explain how you can assign users to these default roles.

**Important**

Keep the following information in mind when assigning users to roles in Analysis Services:

- Role members have permission to view all data in the cubes that the role has access to. For example, if you assign a user to the Project supervisor role, that user will have access to all data in the Project accounting cube.
- The default roles that are created in Analysis Services are not synchronized with the security roles in Microsoft Dynamics AX. For example, if you modify the permissions of the Accountant role in Microsoft Dynamics AX, it does not affect the Accountant role in Analysis Services.

**Assign users to a database role**

Complete the following procedure to assign users to a database role.

1. In SQL Server Management Studio, connect to your Analysis Services instance.
2. In the tree view, expand the Databases > [Database Name] > Roles node.
3. Right-click the appropriate role, and then click Properties. The Edit Role – [Role Name] form is displayed.
4. In the Select a page area, click Membership.
5. Click Add. The Select Users or Groups form is displayed.
6. Add the appropriate Active Directory users or user groups to this role.
   - To add an Active Directory user to the role, enter the user’s name in the following format: [DomainName]\[UserName]. Click OK.
   - To add an Active Directory group to the role, complete the following steps:
     i. Click Object Types.
     ii. In the Object Types form, select the Groups check box. Click OK.
iii. The **Select Users or Groups** form is redisplayed. Enter the name of the user group in the following format: [DomainName]\[UserGroupName]. Click **OK**.

**Note**

Analysis Services supports Windows authentication only. Users who do not have Active Directory accounts will not be able to access cube data. This means that users who access Enterprise Portal for Microsoft Dynamics AX using claims-based authentication will not be able to view cube data in reports and web parts.

If you configure Enterprise Portal to use claims-based authentication, you should remove the reports and web parts that were designed to display cube data. For more information about using claims-based authentication with Enterprise Portal, see Flexible Authentication in Microsoft Dynamics AX 2012 on TechNet.

**Specify which cubes a database role has access to**

Complete the following procedure to specify which cubes a database role has access to. To see a list of the cubes each role has access to by default, see Default Analysis Services roles on TechNet.

1. In SQL Server Management Studio, connect to your Analysis Services instance.
2. In the tree view, expand the **Databases > [Database Name] > Roles** node.
3. Right-click the appropriate role, and then click **Properties**. The **Edit Role – [Role Name]** form is displayed.
4. In the **Select a page** area, click **Roles**. A list of the cubes that are contained in the database is displayed.
5. In the **Access** column, specify the type of access that you want the selected role to have for each cube. You can select **None**, **Read**, or **Read/Write**.
6. Click **OK**.

**Automate the processing of cubes**

** Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

When a cube is processed, the data in the cube is updated with data from the online transaction processing (OLTP) database. Microsoft SQL Server Analysis Services provides several options that you can use to process cubes. This section provides a high-level overview of some of the options that are available to automate the processing of cubes. This section also includes information about how to manually process cubes.

For more information about the processing options that are available, see the SQL Server documentation on TechNet.

**Automated processing**

The following tools are available to help you automate the processing of cubes:

- **SQL Server Agent** – SQL Server Agent is a Windows service that runs scheduled administrative tasks, or **jobs**. For example, you can create a job that processes a cube and then performs a backup of the cube. For more information, see Automating Administrative Tasks (SQL Server Agent) on TechNet.

- **SQL Server Integration Services** – SQL Server Integration Services is a platform that is used to build enterprise-level data integration and data transformation solutions. You can use an Integration Services package to automatically process cubes. The package that you create should include at least two Analysis Services Processing tasks. The first task should process the dimensions, and the second task should process the cubes. For more information, see the Analysis Services Processing Task topic and the Cube Processing discussion on TechNet.
Manual processing
You can manually process an Analysis Services database and all the objects that it contains, such as cubes and dimensions. You can manually process a specific cube, as well.

To process an Analysis Services database and all the objects that it contains, follow these steps.
1. In SQL Server Management Studio, connect to your Analysis Services instance.
2. In the tree view, right-click the database, and then click Process. The Process Database – [Database Name] window is displayed.
3. Click OK to process the database.

To process a specific cube, follow these steps.
1. In SQL Server Management Studio, connect to your Analysis Services instance.
2. In the tree view, right-click the cube, and then click Process. The Process Cube – [Cube Name] window is displayed.
3. Click OK to process the cube.

Processing options and settings
When you process objects in Analysis Services, you can select a processing option to control the type of processing that occurs for each object. You can also enable Analysis Services to determine the appropriate type of processing. Processing methods vary, depending on the type of object and on the change that has been made to the object since the last time that the object was processed. If you enable Analysis Services to automatically select a processing method, Analysis Services uses the method that returns the object to a fully processed state in the shortest time.

Processing settings let you control the objects that are processed and the methods that are used to process those objects.
For more information about the processing options and settings that are available, see Processing Options and Settings on TechNet.

How to: Create a date dimension for a cube
Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012
Microsoft Dynamics AX provides a default calendar definition called the Date dimension. You can modify this calendar definition, but changes you make to the Date dimension will affect all cubes that use the Date dimension. Instead you may want to create a new date dimension.

To create a date dimension
1. Open the Date dimensions form. For more information, see Date dimensions (form) on TechNet.
2. Click New.
3. In the Calendar properties pane, type a name and label for the calendar.
4. Specify calendar properties.
5. Click Hierarchies. Select the date dimension hierarchies to include.
6. Click Close.

To add the new date dimension to an Analysis Services project
1. Click Tools > Business Intelligence (BI) tools > Analysis Services project wizard.
2. Click Next. Click Update and then click Next again.
3. Select the project to which you want to add a Date dimension and then click **Next**. After the Analysis Services project is verified, click **Next** again.

4. Select the perspectives that correspond to the cubes to which you want to add a date dimension.

5. Click **Next** two times.

6. Select the dimension you created and move it to the **Selected** pane.

7. Complete the **Analysis Services project wizard**. For more information, see **Working with Analysis Services Projects** on TechNet.

You cannot remove a date dimension by using the **Analysis Services project wizard**. You must delete it by using Microsoft SQL Server Business Intelligence Development Studio (BIDS).

---

**How to: Add a financial dimension to a cube**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Financial dimensions in Microsoft Dynamics AX help you analyze finance data. You can add financial dimensions to an Analysis Services project. The **MainAccount** financial dimension is included with Microsoft Dynamics AX, but you can include other financial dimensions in your Analysis Services project if you define additional financial dimensions.

**Adding financial dimensions to an Analysis Services project**

To add a financial dimension, run the Analysis Services project wizard and select the **Update** option. On the Add Microsoft Dynamics AX dimensions screen, select financial dimensions you want to include in your Analysis Services project.

**To add a financial dimension**

1. Click **Tools** > **Business Intelligence (BI) tools** > **SQL Server Analysis Services project wizard**. Click **Next**.
2. Select **Update** and then click **Next**.
3. Select an Analysis Services project to add the financial dimension to, and then click **Next**. After the project builds, click **Next** again.
4. On the **Select perspectives** screen, click **Next**.
5. On the Select Microsoft Dynamics AX dimensions screen, select financial dimensions you want to include in your Analysis Services project.
6. Complete the wizard.

**Note**

Financial dimensions only work in the partition they are created in. Only deploy Analysis Services projects to the partition you are currently in.

**See also**

- **Financial dimensions (form)** (on TechNet)
Install client components

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This chapter provides information about how to install the client components for Microsoft Dynamics AX.

Install the Microsoft Dynamics AX client

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The Microsoft Dynamics AX client is an interface to Microsoft Dynamics AX data and functionality. This section provides information about how to install a Microsoft Dynamics AX client.

Install a client

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

When you install a Microsoft Dynamics AX client, the following components are included:

- The Microsoft Dynamics AX interface that connects to an instance of Application Object Server (AOS)
- The Microsoft Dynamics AX Configuration utility

You can access the Microsoft Dynamics AX Configuration utility from the Administrative Tools menu. On computers that run Windows 7, Administrative Tools is an item in Control Panel.

If you are installing many clients, we recommend that you install them from a file server and create a shared configuration file. For more information, see the Mass deployment of the Microsoft Dynamics AX Windows client section.

Note

If you are upgrading clients between AX 2012, AX 2012 Feature Pack, AX 2012 R2, and AX 2012 R3, you should review Scenario: Perform in-place upgrade to AX 2012 R2 or AX 2012 R3 on TechNet.

Before you install a client

Complete the following tasks before you install a Microsoft Dynamics AX client.

- Read Client security and protection on TechNet to learn about deployment best practices that can help secure the Microsoft Dynamics AX client.

- On the computer where you plan to install the client, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

- Install the Microsoft Dynamics AX databases and AOS in the environment.
Install a client

Use this procedure to install a Microsoft Dynamics AX client by using the Setup wizard. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Client, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. If you are installing on a 64-bit operating system, the Select a file location page is displayed. Select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Select client preferences page, select the display language that is used in the client, and specify whether you want Setup to create a desktop shortcut for the client. Additionally, select one of the following installation types:
   - Business user – The basic client is installed. This type of client installation is appropriate for most users.
   - Developer – The client, the developer workspace, and additional files that are required for development tasks are installed.
   - Administrator – The client and additional files that are required for administrative tasks are installed. Administrative tasks include the deployment of artifacts and the creation of users.
   Click Next.
10. On the Specify a location for configuration settings page, specify whether you want the client to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file.

   If you use a shared configuration file, client configuration settings are not stored locally, and the Microsoft Dynamics AX Configuration utility is not installed on the client computer.

   ✓ Note
   If you install the client at the same time as an AOS instance, this screen is not displayed, and configuration settings are saved in the registry automatically.

   For more information about how to use a shared configuration file, see the Configure clients to use a shared configuration section.

   Click Next.
11. On the **Connect to an AOS instance** page, enter the name of the computer that runs the AOS instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services.

If you do not know the name of the AOS instance or the port information, contact the Microsoft Dynamics AX administrator.

**Note**

If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

Click **Next**.

12. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

13. On the **Ready to install** page, click **Install**.

14. After the installation is completed, click **Finish** to close the wizard.

**Configure clients to use a shared configuration**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

By default, the Microsoft Dynamics AX client reads configuration information from the registry on the local computer. If you deploy many Microsoft Dynamics AX clients, it can be difficult to maintain or troubleshoot configurations. To enhance security and simplify client administration, we recommend that large deployments run the Microsoft Dynamics AX client as a Windows Server RemoteApp. For more information, see the Windows Server RemoteApp documentation on Microsoft on TechNet. If your organization cannot deploy the Microsoft Dynamics AX client as a remote application, we recommend that you deploy the client by using one of the methods that are listed in the following table.

<table>
<thead>
<tr>
<th>Deployment method</th>
<th>For more information</th>
</tr>
</thead>
</table>
| Microsoft System Center Configuration Manager | • [Deploy the client by using Microsoft System Center Configuration Manager 2007](#)  
|                                     | • [Deploy the client by using Microsoft System Center 2012 Configuration Manager](#) |
| Group Policy                       | [Deploy the client by using Group Policy](#)                                           |

If you deploy the Microsoft Dynamics AX client by using one of these methods, we recommend that you configure clients to access configuration information from a file that is stored on a network share. A shared configuration file can reduce the time that you spend administering or troubleshooting clients.

**Before you begin**

If your business or organization runs Microsoft Dynamics AX 2012 clients on both 32-bit and 64-bit versions of the Windows operating system, you must create multiple configuration files. Microsoft Dynamics AX clients that run on a 32-bit version of Windows must connect to a client configuration file that was created on a 32-bit version of Windows. Similarly, Microsoft Dynamics AX clients that run on a 64-bit version of Windows must connect to a client configuration file that was created on a 64-bit version of Windows.
Create a shared configuration file
1. On a file server or the server that hosts Application Object Server (AOS), create the directory that the clients share. Configure the directory so that all users of the Microsoft Dynamics AX client have read access.
2. Use the Microsoft Dynamics AX 2012 Configuration utility to save a Microsoft Dynamics AX configuration as a file. For more information, see Manage a client configuration on TechNet. If your business or organization runs both 32-bit and 64-bit versions of Windows, you must save a separate configuration file for each operating system. Open the Microsoft Dynamics AX 2012 Configuration utility on each operating system, and save a configuration as a file. We recommend that you give each configuration a name that identifies the version, such as 32bit.axc and 64bit.axc.
3. Copy the configuration files to the share that you created in step 1.

Set up clients to use the shared configuration file
The following table lists three methods that you can use to set up clients to use a shared configuration file. For more information, see the Install a client section.

<table>
<thead>
<tr>
<th>Method</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the Setup wizard, enter the path of the shared configuration file when you install the Microsoft Dynamics AX client.</td>
<td>Install a client</td>
</tr>
<tr>
<td>Log on to a client computer, and use the <strong>Set Configuration Store</strong> option in the Microsoft Dynamics AX 2012 Configuration utility to specify the new shared configuration file. This method is useful when a client is already installed and configured to read configurations from the registry on the local computer.</td>
<td>Manage a client configuration (on TechNet)</td>
</tr>
<tr>
<td>Use the <code>ClientConfigFile</code> setup parameter, and specify the path of the shared configuration file. This method can be used for client installations that are run in silent mode. The following example shows the format of the parameter. <code>ClientConfigFile=&quot;%Drive%:\&lt;name of configuration file&gt;.axc&quot;</code></td>
<td>Run Setup in silent mode</td>
</tr>
</tbody>
</table>

**Tip**
If you want to install clients, but you do not want to install the Microsoft Dynamics AX 2012 Configuration utility, set the `ClientConfig` parameter to 0 (zero).

See also
- Mass deployment of the Microsoft Dynamics AX Windows client
- Client security and protection (on TechNet)
Configure clients to access data in a partition

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

Microsoft Dynamics AX 2012 R2 enables data isolation by using data partitions. Data partitions provide a logical separation of data in the Microsoft Dynamics AX database. Partitions are defined in the **Partitions** form, where the system administrator creates the partition and provides a *partition key*. A partition key identifies a partition by using a unique string value that the system administrator specifies. Microsoft Dynamics AX displays the partition key in the title bar of the client application. For more information about partitions, see [Data partitioning architecture](https://technet.microsoft.com) on TechNet.

This section describes two ways to configure Microsoft Dynamics AX clients to access data in a specific partition.

**Before you begin**

Before you configure clients to access data in a partition, verify the following.

1. You are an administrator in Microsoft Dynamics AX.
2. You are an administrator on the local client computer where you will create a configuration by using the Microsoft Dynamics AX 2012 Configuration utility. This requirement is only necessary if you use the configuration file procedure later in this section.
3. You have the partition key(s) from the **System administration > Setup > Partitions** form.
4. All users who require access to a designated partition are listed on the **Users** form for that partition.

**Configure clients to access data in a partition by using a configuration file**

This procedure describes how to configure clients to access data in a partition by using a Microsoft Dynamics AX client configuration file. If your business or organization has only one partition, you can create a partition-specific configuration and then deploy the configuration by using a shared-configuration file. For more information, see the [Configure clients to use a shared configuration](#) section. If your business or organization has multiple partitions, you can create multiple client configurations and then deploy those configurations by using the system tools available for mass-client deployments. For more information, see the [Mass deployment of the Microsoft Dynamics AX Windows client](#) section. For multiple partitions, you can also configure clients to access data in a partition by creating multiple client shortcuts as described in the next procedure in this section.

1. Open the configuration utility. Click **Start > Control Panel > Administrative Tools > Microsoft Dynamics AX 2012 Configuration**.
2. In the **Configuration target** list, select **Local client**.
3. Click **Manage**, and then click **Create configuration**.
4. In the **Create configuration** dialog box, in the **Name** box, type a name.
5. You can copy settings from either the active configuration or the original configuration, which is the default configuration. Select the configuration that you want to copy settings from, and then click **OK**.
6. On the **General** tab, enter a partition key in the **Partition** field. Click **OK** to save your changes or save your changes to a file for shared-configuration client deployments.
7. Open the Microsoft Dynamics AX client and verify that you see the partition key in the title bar.
Configure clients to access data in a partition by using a Windows shortcut

You can also configure clients to access data in a specific partition by adding the –partition= key argument to the Microsoft Dynamics AX client shortcut.

1. On a computer where the Microsoft Dynamics AX client is installed, click Start > All Programs, and then right-click the Microsoft Dynamics AX 2012 shortcut.

2. Click Properties.

3. In the Target field, add the –partition= key argument to the end of the path.
   For example: “C:\Program Files (x86)\Microsoft Dynamics AX\60\Client\Bin\Ax32.exe” -partition=test

4. Click OK, and then double-click the shortcut to verify that the client opens in the specified partition.

5. Repeat this procedure to create shortcuts to different partitions.

Install Office Add-ins

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes how to install Microsoft Office Add-ins by using the Microsoft Dynamics AX Setup wizard. In Microsoft Dynamics AX 2012 R3 and cumulative update 7 for Microsoft Dynamics AX 2012 R2, the Microsoft Project client add-in is included with the Office Add-ins.

Use the Office Add-ins for Microsoft Dynamics AX to integrate the Microsoft Dynamics AX client with Microsoft Excel or Microsoft Word. When you install the Office Add-ins, a new contextual tab for Microsoft Dynamics AX is created on the ribbon in Excel and Word. Users can use the controls on this tab to create and update data in an Excel spreadsheet or a Word document.

With the Microsoft Project client add-in, users can take advantage of features in both Microsoft Dynamics AX and Microsoft Project to manage a project. These features include assigning workers to projects and managing work breakdown structures.

Before you install the Office Add-ins

On the computer where you are installing this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install the Office Add-ins

Use this procedure to install the files for the Office Add-ins on a client computer. If you install other Microsoft Dynamics AX components at the same time, the installation screens vary, depending on the components that you are installing.


2. Advance through the first wizard pages.

3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.

4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.

6. On the **Select components** page, select **Office Add-ins**. When you select **Office Add-ins**, Remote Desktop Services integration is selected automatically. Click **Next**.

7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

8. If you are installing the Office Add-ins on a 64-bit operating system, the **Select a file location** page is displayed. Select the location where you want 32-bit versions of Microsoft Dynamics AX files to be installed, and then click **Next**.

9. On the **Specify a location for configuration settings** page, specify whether you want the Office Add-ins to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file.
   If you use a shared configuration file, client configuration settings are not stored locally, and the Microsoft Dynamics AX Configuration utility is not installed on the client computer.
   For more information about how to use a shared configuration file, see the **Configure clients to use a shared configuration** section.
   Click **Next**.

10. On the **Connect to an AOS instance** page, enter the name of the computer that runs the Application Object Server (AOS) instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services.
   If you do not know the name of the AOS instance or the port information, contact the Microsoft Dynamics AX administrator.

   □ **Note**
   If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.
   Click **Next**.

11. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

12. On the **Ready to install** page, click **Install**.

13. After the installation is completed, click **Finish** to close the wizard.

14. The first time that you open Excel or Word on a computer where the Office Add-ins component was installed, you are prompted to install the add-in. Click **Install** to continue with the installation.

### After you install the Office Add-ins

For information about how to configure Office Add-ins in Microsoft Dynamics AX, see **Set up integration with Microsoft Office Add-ins** on TechNet. For information about how to configure the Microsoft Project client add-in, see **Specify options for Microsoft Project integration** on TechNet.

**See also**
- **Integrating Microsoft Dynamics AX with Microsoft Office** (on TechNet)
Install Remote Desktop Services integration

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The Remote Desktop Services integration components for Microsoft Dynamics AX support integration with local applications, such as Microsoft Word and Microsoft Excel, when Microsoft Dynamics AX is hosted on a Remote Desktop server. Install the Remote Desktop Services integration components on local client computers. The Remote Desktop Services integration components are selected automatically when you install the Office Add-ins for Microsoft Dynamics AX.

Before you install the Remote Desktop Services integration components

On the computer where you plan to install the components, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install the Remote Desktop Services integration components

Use this procedure to install the Remote Desktop Services integration components on a client computer. If you install other Microsoft Dynamics AX components at the same time, the installation screens vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Specify a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you're installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Remote Desktop Services integration**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.
8. On the **Ready to install** page, click **Install**.
9. After the installation is completed, click **Finish** to close the wizard.

Install Report Designer for Management Reporter

**Applies to:** Microsoft Dynamics AX 2012 R3

This section describes how to install Report Designer by using the Microsoft Dynamics AX Setup wizard. Report Designer is a component of Management Reporter for Microsoft Dynamics ERP that is used to create the building
blocks that define a report. For more information about Management Reporter, see the Management Reporter page on CustomerSource (logon is required).

**Note**


If you’re not using Microsoft Dynamics AX 2012 R3 or cumulative update 7 or later for AX 2012 R2, you can use the stand-alone installation for Management Reporter. For more information, see the Management Reporter Installation Guide on Microsoft.com.

**Before you install Report Designer**

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

**Install Report Designer**

Use this procedure to install Report Designer. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Ready to install page, click Install.
9. After the installation is completed, click Finish to close the wizard.

**After you install Report Designer**

For information about how to use Report Designer, see the Management Reporter technical library on TechNet.

See also

- Install Management Reporter server components

**Troubleshoot installation issues with client components**

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012
This section provides information that can help you troubleshoot issues that you may encounter when you install the Microsoft Dynamics AX client components.

**User not recognized error when you try to start the client**

If you are not a user in the system, the client returns the following error: “User not recognized.” An administrative user can add you to the system as a user, and then assign you to the appropriate security roles. The person who installed Microsoft Dynamics AX is the first administrative user. For more information, see the Microsoft Dynamics AX [Technical Library](#) on TechNet.

**Open the client configuration utility**

You can access the Microsoft Dynamics AX Configuration utility from the **Administrative Tools** menu. On computers that run Windows 7, **Administrative Tools** is an item in Control Panel.

**Connection with Application Object Server cannot be established**

When you try to start the client, you may receive the following error: “Connection with the Application Object Server cannot be established.”

This error can indicate that the Microsoft Dynamics AX Object Server service is not running. On the server computer for Application Object Server (AOS), verify the status of the service by using the **Services** control panel. (Click **Start > Administrative Tools > Services**.)

If you specified a shared configuration file when you installed the client, you might receive this error the first time that you start the client. To resolve this issue, click **OK** to close the client, and then restart the client.

**Mass deployment of the Microsoft Dynamics AX Windows client**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides information that can help you deploy many Windows clients for Microsoft Dynamics AX at the same time.

**See also**

- [Plan system topology](#) (on TechNet)

**Deploy the client by using Microsoft System Center Configuration Manager 2007**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Microsoft System Center Configuration Manager 2007 is a comprehensive solution that is used to assess, deploy, and update servers, clients, and devices across physical, virtual, distributed, and mobile environments. This section describes how to use Configuration Manager to deploy Microsoft Dynamics AX clients in a medium to large organization.

This section does not provide information about how to set up the network infrastructure, such as the Active Directory directory service, Microsoft SQL Server, and System Center Configuration Manager.
Overview of the deployment process
To deploy Microsoft Dynamics AX clients by using Configuration Manager, you must create and define the following objects:

- **Collections** – A collection is a group of resources, such as users, user groups, or computers. A collection defines the target of a software deployment.
  
  For more information about collections, see Collections Overview in the Configuration Manager documentation on Microsoft.com.

- **Packages** – A package is the set of installation source files that Configuration Manager manages and distributes for a software deployment. Packages include distribution points and the programs that are used to deploy the software.
  
  For more information about packages, see About Packages in the Configuration Manager documentation on Microsoft.com.

- **Programs** – Programs contain command-line switches and additional parameters that are used by designated source files in packages, such as Setup.exe.
  
  For more information about programs, see About Programs in the Configuration Manager documentation on Microsoft.com.

- **Distribution points** – Distribution points are site systems for Configuration Manager that store packages that can be deployed to Configuration Manager clients. When the client receives and processes an advertisement, the client contacts a distribution point to download the package and start the installation process.
  
  For more information about distribution points, see About Distribution Points in the Configuration Manager documentation on Microsoft.com.

- **Advertisements** – Advertisements let administrators target a software deployment to collections of computers or users. An advertisement specifies a package, a program, and the collection to which the advertisement is sent and deployed.
  
  For more information about advertisements, see About Advertisements in the Configuration Manager documentation on Microsoft.com.

Example: Deploy Microsoft Dynamics AX clients by using Configuration Manager
This section provides an example of a network environment for the Configuration Manager infrastructure. This section also describes how Configuration Manager is used to deploy Microsoft Dynamics AX clients in this environment.

You can use this example as a guide when you use Configuration Manager to deploy Microsoft Dynamics AX clients in your implementation.
Network environment
The following illustration shows an example of a network environment.

All the computers are members of the Contoso.com domain.

Servers A, B, and C run Windows Server 2008. The applications and roles on each computer are as follows:

- **A** – The domain controller that runs Active Directory, the Domain Name System (DNS) Server role, and the Dynamic Host Configuration Protocol (DHCP) Server role
- **B** – The database server that runs Microsoft SQL Server 2008
- **C** – The management point and distribution point that runs System Center Configuration Manager
- **D** – The client computer that runs Windows 7 Professional and the System Center Configuration Manager client

**Note**
In the network environment in this example, server C performs multiple roles in the site system. However, we do not recommend this configuration in production environments that have many resources.

Create a collection
This section explains how to use direct membership rules to create a collection in System Center Configuration Manager 2007. For more information about membership rules, see [About Membership Rules](#) in the Configuration Manager documentation on Microsoft.com.

1. In the Configuration Manager Console, click **System Center Configuration Manager > Site Database > Computer Management > Collections**.
2. Right-click **Collections**, and then click **New Collection**. On the **General** page of the New Collection Wizard, enter a name for the collection.
3. On the **Membership Rules** page, click the computer icon to open the Create Direct Membership Rule Wizard. Click **Next**.
4. On the **Search for Resources** page, in the **Resource class** field, select **System Resource**. Then, in the **Attribute name** field, select **Name**. In the **Value** field, enter %, and then click **Next**.
5. On the **Collection Limiting** page, click **Browse**, select **All Windows Workstation or Professional Systems**, click **OK**, and then click **Next**.
6. On the **Select Resources** page, select the check box for each computer resource that you want to target. Click **Next**.
7. On the **Finished** page, click **Finish**.
8. On the **Membership Rules** page of the New Collection Wizard, click **Next**.
9. On the **Advertisements** page, you cannot assign an advertisement, because you have not yet created an advertisement. Click **Next**.
10. On the **Security** page, accept the default values, click **Next**, and then click **Close**.

**Prepare the source directory for the package**

The source directory for a package contains all the files and subdirectories that are required to run the programs in a package. For Microsoft Dynamics AX, the source directory must contain a copy of the installation media for Microsoft Dynamics AX.

For more information about source directories for packages, see [How to Set Up a Package Source Directory](#) in the Configuration Manager documentation on Microsoft.com.

**Create a package for Microsoft Dynamics AX**

This section explains how to create a package that contains the parameters that are used to install the Microsoft Dynamics AX client.

In this example, the Microsoft Dynamics AX client and its prerequisites are contained in one package that has multiple programs. You can also deploy the programs in separate packages.

The location from which the package is distributed is known as the distribution point.

1. In the Configuration Manager Console, click **System Center Configuration Manager > Site Database > Computer Management > Software Distribution > Packages**.
2. Right-click **Packages**, point to **New**, and then click **Package**.
3. On the **General** page of the New Package Wizard, enter the name, version, manufacturer, and language. For example, enter **Microsoft Dynamics AX 2012 EN**. Click **OK**, and then click **Next**.
4. Click **Next** on all the remaining pages of the wizard to accept the default settings. On the **Wizard Completed** page, click **Close**.

**Determine which parameters are used for a silent installation**

Before you create programs that are used to install the Microsoft Dynamics AX client and its prerequisites, you must determine which command-line parameters are required to silently install the software. A silent installation is an installation that does not require user interaction.

To install client components, use parameters for the Microsoft Dynamics AX Setup program. For information about individual parameters, see the [Setup parameters reference](#) on TechNet. Setup can also configure some required prerequisites, such as operating system features and roles, and redistributable components that are on the installation media for Microsoft Dynamics AX. If you want Setup to automatically configure these prerequisites, include the parameter `ConfigurePrerequisites=1` when you create the program that installs the client.

You can silently install other prerequisites by running the individual programs from the command line. You must create a separate program for each of these prerequisites. To determine the command-line parameters that are required, we recommend that you run the Microsoft Dynamics AX prerequisite verification utility on a representative client. When you use the utility to configure prerequisites, the log file indicates the commands that were used.

For more information about how to find the appropriate command-line parameters for a silent installation, see the [Run Setup in silent mode](#) section.
Create programs

Next, you must create the programs that are included in the package.

Create one program that contains the parameters that are used to silently install the Microsoft Dynamics AX client. In addition, create a separate program for every prerequisite of Microsoft Dynamics AX that cannot be configured automatically by the Microsoft Dynamics AX Setup program.

Create a program to install the Microsoft Dynamics AX client

Use the following procedure to create a program that installs the Microsoft Dynamics AX client.

1. In the Configuration Manager Console, right-click Programs, point to New, and then click Program.
2. On the General page of the New Program Wizard, enter a name for the package in the Name field. In the Command line field, enter the Setup parameters that you want to use. For example, type the following command.

   ```
   setup.exe RunMode=Custom HideUI=1 AcceptLicenseTerms=1 ByPasswarnings=0 InstallClientUI=1
   ClientAOSServer=Ax62-AOS01 AOSPort=2712 AOSWsdIPort=8101 ClientLanguage=en-us
   ConfigurePrerequisites=1 LogDir="c:\Temp"
   ```

   **Important**

   If you want Setup to automatically configure the prerequisites that it can configure, specify the parameter `ConfigurePrerequisites=1`.

   If you do not want the Microsoft Dynamics AX Configuration utility to be installed when clients are installed, specify the parameter `ClientConfig=0`. To set up clients so that they use a shared configuration file, set the `ClientConfigFile` parameter to the path of the configuration file in the shared directory. For example, specify the parameter as follows.

   ```
   ClientConfigFile="X:\<name of configuration file>.axc"
   ```

   For more information about whether to install the Configuration Utility, and about using shared configuration files, see [About the Microsoft Dynamics AX 2012 Configuration utility](https://technet.microsoft.com) on TechNet.

3. In the Run field, select Hidden. In the After running field, verify that No action required is selected. Click Next, and then accept the default values on the Requirements page.
4. On the Environment page, in the Program can run field, select Whether or not a user is logged on. The Run mode field is automatically set to Run with administrative rights. Make sure that the Drive mode field is set to Runs with UNC name, and then click Next.
5. On the Advanced page, select Suppress program notifications, and then click Next.

   **Note**

   If you want a notification about the installation to be displayed on each user’s desktop, clear Suppress program notifications.

6. On the Summary page, click Next. The Wizard Completed page is displayed.
7. To exit the New Program Wizard, click Close.
Create programs to install prerequisites

You must create a program for every prerequisite that cannot be configured automatically by the Microsoft Dynamics AX Setup program. The following example shows how to create a program that installs Report Viewer 2012.

1. In the Configuration Manager Console, right-click Programs, point to New, and then click Program.

2. On the General page of the New Program Wizard, enter a name for the package in the Name field. For example, enter Report viewer 2012 installation. In the Command line field, type the command that is used to install the prerequisite. For Report Viewer 2012, type the following command.

   `Redist\ReportViewer2010\ReportViewer /passive`

3. In the Run field, select Hidden. In the After running field, verify that No action required is selected. Click Next, and then accept the default values on the Requirements page.

4. On the Environment page, in the Program can run field, select Whether or not a user is logged on. The Run mode field is automatically set to Run with administrative rights. Make sure that the Drive mode field is set to Runs with UNC name, and then click Next.

5. On the Advanced page, select Suppress program notifications, and then click Next.

   **Note**

   If you want a notification about the installation to be displayed on each user’s desktop, clear Suppress program notifications.

6. On the Summary page, click Next. The Wizard Completed page is displayed.

7. To exit the New Program Wizard, click Close.

Select a distribution point

To use a server as a distribution point that distributes packages to client computers, you must first designate a site system as a distribution point. In this example, the site server that is named SCCM is configured as both a management point and a distribution point.

1. In the Configuration Manager Console, right-click Distribution Points, click New Distribution Points, click Next, and then select the check box for the distribution point. In this example, the new distribution point is server C. Click Next.

2. When you have finished running the New Distribution Points Wizard, click Close.

Before you advertise the package, we recommend that you verify that the package is stored on the distribution point. For more information about how to verify the status of a package, see How to View the Status of a Package in the Configuration Manager documentation on Microsoft.com.

Create an advertisement for the Microsoft Dynamics AX client package

Next, you must advertise the package that contains both the Configuration Manager distribution point and the programs that are used to deploy the Microsoft Dynamics AX client and its prerequisites. This example shows how to create an advertisement of the Microsoft Dynamics AX client package.

1. In the Configuration Manager Console, right-click Advertisements, point to New, and then click Advertisement.

2. On the General page of the New Advertisement Wizard, enter a name in the Name field. Click the Browse button for the Package field, and then click the package that you want to advertise. Click OK. Click the Browse button for the Collection field, click the collection, click OK, and then click Next.

3. On the Schedule page, in the Advertisement start time fields, enter the date and time when the advertisement becomes available, and then click the asterisk (*) button for Mandatory Assignments.
4. On the **Assignment Schedule** page, click **Schedule**, and then enter the same date and time that you entered in the **Advertisement start time** fields on the Schedule page. Click **OK**.

5. On the **Schedule** page, select the check boxes for **Enable Wake On LAN**, **Ignore maintenance windows when running program**, and **Allow system restart outside maintenance windows**, and then click **Next**.

   ☑ Note

   In your production environment, policies may require that you select different values for the assignment schedule than the values that are shown in this example. For more information about these options, see **Advertisement Name Properties; Schedule Tab** in the SCCM documentation on Microsoft.com.

6. Accept the default values on the remaining pages. On the **Wizard Completed** page, click **Close**.

The package is advertised to the targeted collection, and the silent installation of Microsoft Dynamics AX client starts.

For information about how to monitor the status of an advertisement, see **How to View the Status of an Advertisement** in the Configuration Manager documentation on Microsoft.com.

---

**Deploy the client by using Microsoft System Center 2012 Configuration Manager**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Microsoft System Center 2012 Configuration Manager is a comprehensive solution that is used to assess, deploy, and update servers, clients, and devices across physical, virtual, distributed, and mobile environments. This section describes how to use Configuration Manager to deploy Microsoft Dynamics AX clients in a medium to large organization.

This section does not provide information about how to set up the network infrastructure, such as the Active Directory directory service, Microsoft SQL Server, or Configuration Manager.

For more information about how to set up and use Configuration Manager, see the [Documentation Library for System Center 2012 Configuration Manager](https://technet.microsoft.com) on TechNet.

---

**Overview of the deployment process**

To deploy Microsoft Dynamics AX clients by using Configuration Manager, you must create and define the following objects:

- **Collections** – A collection is a group of resources, such as users, user groups, or computers. A collection defines the target of a software deployment.
  
  For more information about collections, see [Collections in Configuration Manager](https://technet.microsoft.com) on TechNet.

- **Packages** – A package is the set of installation source files that Configuration Manager manages and distributes for a software deployment. Packages include distribution points and the programs that are used to deploy the software.
  
  For more information about packages, see [Packages and Programs in Configuration Manager](https://technet.microsoft.com) on TechNet.

- **Distribution points** – Distribution points are site systems for Configuration Manager that store packages that can be deployed to Configuration Manager clients. When the client receives a deployment, the client contacts a distribution point to download the package and start the installation process.
  
  For more information about distribution points, see [Introduction to Content Management in Configuration Manager](https://technet.microsoft.com) on TechNet.
Create a collection

This section explains how to use direct membership rules to create a collection in System Center 2012 Configuration Manager. For more information about membership rules, see Collections in Configuration Manager on TechNet.

1. In the Configuration Manager console, click Assets and Compliance.
2. In the Assets and Compliance workspace, click Device Collections.
3. On the Home tab, in the Create group, click Create Device Collections.
4. On the General page of the New Collection Wizard, enter a name and description for the collection. In the Limiting collection field, select All systems.
5. On the Membership Rules page, in the Add Rule list, click Direct rule.
6. On the Search for Resources page of the Create Direct Membership Rule Wizard, specify the following information:
   - Resource class – In the list, select the type of resource to search for and add to the collection. Select System Resource to search for inventory data that is returned from client computers. Select Unknown Computer to select among values that are returned by unknown computers.
   - Attribute name – In the list, among the attributes that are associated with the selected resource class, select the attribute to search for. For example, if you want to select computers by their NetBIOS name, select System Resource in the Resource class list and NetBIOS name in the Attribute name list.
   - Exclude resources marked as obsolete – If a client computer is marked as obsolete, do not include this value in the search results.
   - Exclude resources that do not have the Configuration Manager client installed – If the search results include a resource for which a Configuration Manager client is not installed, do not include this value in the search results.
   - Value – Enter a value for which to search the selected attribute name. You can use the percent sign (%) as a wildcard character. For example, if you want to search for computers that have a NetBIOS name that starts with 'M', enter M% in this field.
7. On the Select Resources page of the Create Direct Membership Rule Wizard, in the Resources list, select the resources to add to the collection, and then click Next.
8. Complete the Create Direct Membership Rule Wizard.

Prepare the source directory for the package

The source directory for a package contains all the files and subdirectories that are required to run the programs in the package. For Microsoft Dynamics AX, the source directory must contain a copy of the installation media for Microsoft Dynamics AX.

Create a command file for installation parameters

Before you create a package to install the Microsoft Dynamics AX client and its prerequisites, you must create a command (.cmd) file that contains the command-line parameters that are used to install the software.

To install client components, use parameters for the Microsoft Dynamics AX Setup program. For information about individual parameters, see Setup parameters reference on TechNet. Setup can also configure some required prerequisites, such as operating system features and roles. Additionally, Setup can configure redistributable components that are on the installation media for Microsoft Dynamics AX. If you want Setup to automatically configure these prerequisites, include the parameter ConfigurePrerequisites=1.
You can silently install other prerequisites by running the individual programs from the command line. You must create a separate program for each prerequisite. To determine the command-line parameters that are required, we recommend that you run the Microsoft Dynamics AX prerequisite verification utility on a representative client. When you use the utility to configure prerequisites, the log file indicates the commands that were used.

For more information about how to find the appropriate command-line parameters for a silent installation, see the Run Setup in silent mode section.

When you have determined which parameters to use, create a parameter file in a text editor, such as Notepad. For example, create a text file that contains the following command:

```
setup.exe RunMode=Custom HideUI=1 AcceptLicenseTerms=1 ByPasswarnings=0 InstallClientUI=1
ClientAOSServer=Ax62 AOSPort=2712 AOSWsdPort=8101 ClientLanguage=en-us ConfigurePrerequisites=1
LogDir="c:\Temp"
```

Save the file so that it has the .cmd file name extension.

**Create a package for the Microsoft Dynamics AX client**

This section explains how to create the package that is used to install the Microsoft Dynamics AX client. For more information about how to create packages, see How to Create Packages and Programs in Configuration Manager on TechNet.

1. In the Configuration Manager console, click Software Library.
2. In the Software Library workspace, expand Application Management, and then click Packages.
3. On the Home tab, in the Create group, click Create Package.
4. On the Package page of the Create Package and Program Wizard, specify the following information:
   - **Name** – Specify a name for the package. For example, enter Microsoft Dynamics AX 2012.
   - **Description** – Optional: Enter a description for the package.
   - **Manufacturer** – Optional: Specify a manufacturer name to help you identify the package in the Configuration Manager console. For example, enter Microsoft.
   - **Language** – Optional: Specify the language version of the package. For example, enter U.S. English.
   - **Version** – Optional: Specify the version number for the package. For example, enter R2.
   - **This package contains source files** – Select this option to use distribution points.
   - **Source folder** – Click Browse to open the Set Source Folder dialog box, and then specify the location of the source files for the package.
5. On the Program Type page of the Create Package and Program Wizard, select Standard Program, and then click Next.
6. On the Standard Program page of the Create Package and Program Wizard, enter a name for the program. In the Command Line field, browse to the location of the .cmd file that you created. Optionally, specify a startup folder for the program. For all other options on the Standard Program page, accept the default values.
   Click Next.
7. On the Requirements page of the Create Package and Program Wizard, specify your requirements, or accept the default values. Click Next.
8. On the Summary page of the wizard, review the actions that will be taken, and then complete the wizard. The new package and program are displayed in the Packages node of the Software Library workspace.
Deploy the package for the Microsoft Dynamics AX client

Next, you must deploy the package that contains both the distribution point and the programs that are used to deploy the Microsoft Dynamics AX client and its prerequisites.

For more information about how to deploy packages, see How to Deploy Packages and Programs in Configuration Manager on TechNet.

1. In the Configuration Manager console, click Software Library.
2. In the Software Library workspace, expand Application Management, and then click Packages.
3. Select the package to deploy, and then, on the Home tab, in the Deployment group, click Deploy.
4. On the General page of the Deploy Software Wizard, specify the name of the package and program to deploy, the collection to deploy the package and program to, and optional comments for the deployment.
5. On the Content page of the wizard, click Add. Select the distribution points to which to deploy the content that is associated with the package and program.
6. On the Deployment Settings page of the wizard, accept the default values.
7. On the Scheduling page of the wizard, specify when this package and program are deployed or made available to client computers.
8. On the User Experience page of the wizard, select the options that are appropriate to your implementation.
9. On the Distribution Points page of the wizard, under Deployment options, select Download content from distribution point and run locally.
10. On the Summary page of the wizard, review the actions that will be taken, and then complete the wizard.

Deploy the client by using Group Policy

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Group Policy provides an infrastructure that lets you centrally manage the configuration of operating systems and applications. This section describes the processes and procedures that you must use to deploy Microsoft Dynamics AX clients by using Group Policy.

When you publish the Microsoft Dynamics AX client by using Group Policy, the program becomes available from the Install a program from the network option in the Programs and Features Control Panel. Users can install the Microsoft Dynamics AX client by using the settings that you specify.

For more information about Group Policy, see the Group Policy Planning and Deployment Guide on TechNet.

Overview of the deployment process

You must perform the following procedures to deploy Microsoft Dynamics AX clients by using Group Policy.

1. Create a distribution point – Create the location from which the software is installed.
2. Create a transform for the ClientOba.msi file – Modify the Microsoft Windows Installer package, or .msi file, for the Microsoft Dynamics AX client to enable the client to be deployed by using Group Policy. There are two versions of the .msi file: ClientOba.msi, which is for 32-bit systems, and ClientOba64.msi, which is for 64-bit systems.
3. Create a Group Policy object – Create a Group Policy object and publish it to the domain.
4. (Optional) Update Group Policy settings on client computers – Run the Gpupdate utility if you want the changes to be applied to a client computer immediately. If you do not use Gpupdate, you must wait the default update interval or restart the computer.
Create a distribution point
To publish the Microsoft Dynamics AX installation by using Group Policy, you must first create a distribution point on the publishing server.

1. Log on to the server computer as an administrator.
2. Create a shared network folder where you can put the .msi file for the Microsoft Dynamics AX client components.
3. Set permissions on the shared network folder to allow access to the distribution package. Make sure that all users who must install Microsoft Dynamics AX have Read access to this directory.
4. Install the package to the distribution point. From the folder where you saved the Microsoft Dynamics AX DVD image, run the msiexec tool. In the command, include the /a parameter, and specify the location of the distribution point. For example, you might use the following command to install the 64-bit Microsoft Dynamics AX client components to the distribution point:

```bash
msiexec /a ClientOba64.msi TARGETDIR=\<Server>\<Directory>\<SharedFolder>
```

**Note**
The msiexec tool lets you install, modify, and perform operations on Windows Installer files from the command line. For more information about how to use msiexec, see [Msiexec (command-line options)](https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2003/ww660971(v=ws.10)) on TechNet.

Create a transform for the ClientOba.msi file
The .msi file for the Microsoft Dynamics AX client components must be modified before it can be published by using Group Policy. You can use the Orca database editor to modify .msi files. For more information about how to install and use Orca, see the Microsoft Knowledge Base article [How to use the Orca database editor to edit Windows Installer files](https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2003/ww660971(v=ws.10)).

1. Open ClientOba.msi or ClientOba64.msi by using the Orca editor.
2. Click **Transform** > **New Transform**.
3. Select the features that you want to install. In the left pane, select the **Feature** table. In the right pane, use the **Level** column to specify whether features are installed on client computers. The following table shows the possible values.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The feature is not available for installation.</td>
</tr>
<tr>
<td>&lt;150</td>
<td>The feature is installed on the local hard disk.</td>
</tr>
<tr>
<td>&gt;150</td>
<td>The feature is available for installation, but it is not installed by default.</td>
</tr>
</tbody>
</table>

**Note**
If you do not want a feature to be installed automatically on client computers, set the level to 0. If a parent feature has a level of 0, all child features are also unavailable.
4. Set information about the connection to Application Object Server (AOS). In the left pane, select the Property table. In the right pane, double-click to add a line for each property and value. The following table describes the properties that you can set.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOS2</td>
<td>(Required) Enter the name of the AOS instance that clients connect to.</td>
</tr>
<tr>
<td>&lt;BientAOSServer</td>
<td>(Required) Enter the name of the AOS instance that clients connect to.</td>
</tr>
<tr>
<td>AOSPort</td>
<td>Enter the TCP/IP port for the AOS. By default, the AOS uses port 2712.</td>
</tr>
<tr>
<td>AOSWSDLPort</td>
<td>Enter the WSDL port for the AOS. By default, the AOS uses port 8101.</td>
</tr>
<tr>
<td>InstallDir</td>
<td>(Required) Specify the location where program files for Microsoft Dynamics AX are installed. By default, the path is <code>&lt;Drive&gt;:\Program Files\Microsoft Dynamics AX\60</code>.</td>
</tr>
<tr>
<td>InstallDir32</td>
<td>(Required for 64-bit operating systems) Specify the location where 32-bit versions of program files for Microsoft Dynamics AX are installed. You cannot specify the same path for both 64-bit files and 32-bit files.</td>
</tr>
<tr>
<td>DIRECTEXECUTE</td>
<td>(Required) Enter 1 to enable the .msi file to be run directly.</td>
</tr>
</tbody>
</table>

5. Click Transform > Generate Transform. Enter a name and location for the .mst file.

**Create a Group Policy object**

An Active Directory–based Group Policy object (GPO) is a virtual collection of policy settings. Active Directory–based GPOs can be linked to a domain, site, or organizational unit. The settings in GPOs can be applied to users or computers. GPOs are stored in a domain and replicated to all the domain controllers for the domain.

Use the following procedure to create a GPO that installs the Microsoft Dynamics AX client components.

1. On the domain controller, click Administrative Tools > Group Policy Management to open the Group Policy Management console.
2. Under the domain for which you want to create a GPO, right-click Group Policy Objects and then click New.
3. Specify a name for the GPO and then click OK.
4. Select the new GPO and then click the Settings tab.
5. Under User Configuration, right-click, and then select Edit to open the Group Policy Management Editor.
7. Right-click Software Installation, and then select New Package.
8. Browse to the distribution point that you set up.
9. Click Advanced.
   - On the Deployment tab, select a deployment type of Published.
   - On the Modification tab, select the .mst file that you created.
10. Click OK to finish configuring the GPO.
(Optional) Update Group Policy settings on client computers

Typically, after you modify group policy settings, you must wait a default update interval or restart the computer. The default update interval is 90 minutes on domain members and 5 minutes on domain controllers. However, if you want the changes to be applied immediately, you can run the Gpupdate utility at a command prompt. For more information about how to use the Gpupdate utility, see Gpupdate on TechNet.
Install developer tools

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This chapter provides information about how to install the developer tools.

Use the developer tools to customize Microsoft Dynamics AX. For example, you can use the developer tools to create customizations or extensions to Enterprise Portal for Microsoft Dynamics AX, and to create advanced production reports by using Microsoft SQL Server Reporting Services. The developer tools include the debugger, Microsoft Visual Studio Tools, and the Trace Parser.

Install the debugger

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The debugger tool provides debugging capabilities for X++ developers. The debugger tool communicates with the Microsoft Dynamics AX client, .NET Business Connector, or batch jobs that run on the Microsoft Dynamics AX server.

**Note**

To use the Help documentation for the debugger, the Microsoft Dynamics AX client must also be installed.

Before you install the debugger

On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](#) on Microsoft.com.

Install the debugger

Use this procedure to install the debugger. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you're installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Debugger**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the [Check prerequisites](#) section. When no errors remain, click **Next**.
8. If you are installing on a 64-bit operating system, the **Select a file location** page is displayed. Select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.

9. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

10. On the **Ready to install** page, click **Install**.

11. After the installation is completed, click **Finish** to close the wizard.

**After you install the debugger**

To use the debugger, users must belong to the **Microsoft Dynamics AX Debugging Users** local group on the computer. The person who installed the debugger is automatically added to this group.

**Install Visual Studio Tools**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Visual Studio Tools integrate the development of Microsoft Dynamics AX with Microsoft Visual Studio. Developers can use these tools to create managed code that accesses X++ objects. Developers can also use the tools to create or modify controls for Enterprise Portal for Microsoft Dynamics AX and reports for Microsoft SQL Server Reporting Services. For more information about Visual Studio Tools, see [Visual Studio Development for Microsoft Dynamics AX](https://technet.microsoft.com) on TechNet.

*Note*

If you want to have access to all the development capabilities, we recommend that you install the Microsoft Dynamics AX client on the same computer as Visual Studio Tools.

**Before you install Visual Studio Tools**

Complete the following tasks before you install Visual Studio Tools:

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](https://technet.microsoft.com) section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](https://microsoft.com) on Microsoft.com.

- If Visual Studio is running, we recommend that you close it before you install Visual Studio Tools.

**Install Visual Studio Tools**

Use this procedure to install Visual Studio Tools. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.

2. Advance through the first wizard pages.

3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.

4. If you’re installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.

5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Visual Studio Tools**. When you select **Visual Studio Tools**, the **Management utilities** component is selected automatically. Click **Next**.

7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

8. If you are installing on a 64-bit operating system, the **Select a file location** page is displayed. Select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.

9. On the **Specify a location for configuration settings** page, specify whether you want Visual Studio Tools to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file. Click **Next**.

10. On the **Connect to an AOS instance** page, enter the name of the computer that runs the instance of Application Object Server (AOS) that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

   **Note**
   
   If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

11. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

12. On the **Ready to install** page, click **Install**.

13. After the installation is completed, click **Finish** to close the wizard.

**See also**

- [Visual Studio Integration](on TechNet)

---

### Install the Trace Parser

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The Trace Parser consolidates information from multiple sources, such as RPC and SQL, to provide an integrated view of the application’s performance at run time.

**Before you install the Trace Parser**

On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the **Check prerequisites** section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](on Microsoft.com).

**Install the Trace Parser**

Use this procedure to install the Trace Parser. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.

4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.

5. On the Select installation type page, click Custom installation, and then click Next.

6. On the Select components page, select Trace Parser. When you select Trace Parser, .NET Business Connector is automatically selected. Click Next.

7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.

8. If you are installing on a 64-bit operating system, the Select a file location page is displayed. Select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.

9. On the Select a display language page, select the language in which you want to run Microsoft Dynamics AX for the first time.

   ✓ Note
   .NET Business Connector is a kind of Microsoft Dynamics AX client. Therefore, if .NET Business Connector is the first client that you install on a computer, Setup requires that you set the display language.

10. On the Specify a location for configuration settings page, specify whether you want .NET Business Connector to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file. Click Next.

11. On the Connect to an AOS instance page, enter the name of the computer that runs the instance of Application Object Server (AOS) that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click Next.

   ✓ Note
   If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

12. On the Specify Business Connector proxy account information page, enter the password for the proxy account that is used by .NET Business Connector. Click Next.

13. On the Prerequisite validation results page, resolve any errors. When no errors remain, click Next.

14. On the Ready to install page, click Install.

15. After the installation is completed, click Finish to close the wizard.
Troubleshoot installation issues with the developer tools

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides information that can help you troubleshoot issues that you may encounter when you install the developer tools for Microsoft Dynamics AX.

**Trace Parser installation fails**

If you install Trace Parser at the same time as other Microsoft Dynamics AX components, the Trace Parser installation may fail. In the Setup log, you see the following error: "Component installation task stopped due to an error." To resolve this issue, uninstall and then reinstall the Trace Parser component.
Install integration components

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This chapter provides information about how to install the integration components for Microsoft Dynamics AX. Integration components enable Microsoft Dynamics AX to be integrated with external applications. The integration components include web services on Internet Information Services (IIS), .NET Business Connector, and the synchronization proxy and synchronization service for Microsoft Project Server.

Install web services on IIS

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section describes installation of the Microsoft Dynamics AX web services on Internet Information Services (IIS).

**Note**

Web services on IIS is an optional component. The Application Object Server (AOS) is the Windows Communication Foundation (WCF) service host for Microsoft Dynamics AX services. The AOS-hosted services are available to users and applications across an intranet. To consume services over the Internet, you must host services on Internet Information Services (IIS). Skip this procedure if you do not need to expose the Microsoft Dynamics AX services over the Internet.

**Before you install the Web services on IIS**

Verify that the following steps are completed before you install the Microsoft Dynamics AX web services on IIS:

- On the computer where you will install the web services, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

  **Caution**

  Do not install web services on IIS on a server that is a network domain controller.

- Create a domain account that will be used as the Business Connector proxy account. For more information, see the Create service accounts section.

- Make sure that you have the required permissions to install the web services. For more information, see the Verify that you have the required permissions for installation section.
Install and configure the Web Server (IIS) role

Use the following steps to verify that the Web Server role is configured properly:

1. When you ran the prerequisite validation utility in the preceding section, it configured the Web Server role. However, the prerequisite validation utility does not install the ASP.NET role service. Use the following steps to install the ASP.NET role service. For more information about role services, see Available Role Services by Category on TechNet.
   a. Start Server Manager. Expand the Server Manager (computer_name) node. Right-click Web Server (IIS), and then click Add Role Services.
   b. On the Select Role Services dialog, expand the Web Server (Installed) > Application Development (Installed) node, and then select ASP.NET. Click Next and step through the wizard pages. Restart the server.

2. Create a website that Setup will use to install the Microsoft Dynamics AX web services. You can create a new website or use an existing one, such as Default Web Site on IIS. See the IIS documentation for instructions about how to create a new website.

   Tip
   For ease of administration, we recommend that you create a new website before installing Microsoft Dynamics AX web services.

Install the web services on IIS

Use this procedure to install the Microsoft Dynamics AX web services on IIS. If you are installing other Microsoft Dynamics AX components at the same time, the installation pages vary based on the components that you are installing.

2. Advance through the initial wizard pages.
3. If the setup support files have not yet been installed, the Select a file location page is displayed. The setup support files are required for installation. Provide a file location or accept the default location and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Web services on IIS, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. If you are installing on a 64-bit operating system, the Select a file location page is displayed. Select the location where 32-bit versions of Microsoft Dynamics AX files should be installed and then click Next.
9. On the Connect to an AOS instance page, enter the name of the computer that is running the AOS instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the Web Services Description Language (WSDL) port for services. Click Next.

   Note
   If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on this computer reuse the existing AOS connection.
10. On the Specify Business Connector proxy account information page, enter the password for the proxy account used by the .NET Business Connector. Click Next.
11. On the **Configure IIS for Web services** page, accept default values or provide information for the website, application pool, and virtual directory. Setup will create a virtual directory and an application pool for the Microsoft Dynamics AX web services under the selected website. The application pool will run as the .NET Business Connector proxy user that you entered in the previous step.

   **Important**
   
   You must restart IIS after Setup installs the web services. Select **Restart IIS after installation is complete** to automatically restart IIS.

12. Click **Next** to continue.

13. On the **Specify an AOS account** page, provide the service accounts for the AOS instances that you will use with web services on IIS. For more information about AOS accounts, see, the [Create service accounts](#) section.
   
   Click **Next** to continue.

14. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

15. On the **Ready to install** page, click **Install**.

16. After the installation is complete, click **Finish** to close the wizard.

### After you install the Web services on IIS

This section provides instructions for how to configure and test web services on IIS.

#### Configure IIS

For IIS 7.0, use the following steps to configure the application pool that is associated with Microsoft Dynamics AX web services. This step is required to set the correct version of the .NET Framework.

1. In Server Manager, expand the **Server Manager > Roles > Web Server (IIS)** node and then click **Internet Information Services (IIS) Manager**.

2. In the **Connections** pane, expand the node for your server name and then click **Application Pools**.

3. In the **Application Pools** pane, right-click the application pool that is associated with the Microsoft Dynamics AX web services and click **Basic Settings**.

4. In the **Edit Application Pool** dialog box, select .NET Framework 4.0 or a later version, such as V4.0.30319. Select **Integrated** from the **Managed pipeline mode** list. Notice that the **Start application pool immediately** option is selected. Click **OK** to return to Server Manager.

5. Restart the server.

#### Verify the website registration in Microsoft Dynamics AX

Use the following steps to register the website in Microsoft Dynamics AX.

1. Click **System administration > Setup > Services and Application Integration Framework > Web sites**.

2. On the **Web sites** form, verify that the website was created and has appropriate values for the **Name**, **Virtual directory share path**, **Description**, and **URL** fields. The default name is `computername-Default Web Site-MicrosoftDynamicsAXAif60`. The default URL is `http://computername:8101/MicrosoftDynamicsAXAif60`. The default share path for the virtual directory is `\computername\MicrosoftDynamicsAXAif60`.

3. Click **Validate**. Verify that the Infolog dialog confirms:
   - The website is configured properly.
   - You can access the computer and the website.
For information about how to add or configure websites, see Add or configure websites on TechNet.

**Note**

When you install web services on IIS, a record for the new website is added to AifWebsites table. If you uninstall web services on IIS, this record is not deleted from the table. This record may cause a warning to be displayed if you reinstall web services on IIS. You can manually delete the record from the AifWebsites table or simply ignore the warning.

Create an enhanced integration port

For information about managing integration ports, see Services and AIF operations on TechNet.

See also

- Walkthrough: Exchanging documents by using the HTTP adapter (on TechNet)

## Install .NET Business Connector

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

.NET Business Connector for Microsoft Dynamics AX enables applications to interact with instances of Application Object Server (AOS). .NET Business Connector provides a set of managed classes that make it easier for applications to access X++ functionality.

.NET Business Connector is installed automatically for Microsoft Dynamics AX components that require it. .NET Business Connector can also be installed as a stand-alone component and used to develop third-party applications that can be integrated with Microsoft Dynamics AX. You must install .NET Business Connector on each computer where the integrated application is installed. The application then communicates with AOS through the instance of .NET Business Connector on the local computer.

Some components require that .NET Business Connector be configured to connect to Microsoft Dynamics AX by using a proxy account. When a proxy account is used, .NET Business Connector can connect to an AOS instance on behalf of Microsoft Dynamics AX users. For more information, see Specify the .NET Business Connector proxy account on TechNet.

When you install .NET Business Connector, the Microsoft Dynamics AX Configuration utility is also installed.

**Note**

Windows Communication Foundation (WCF) services are the preferred method for integration with Microsoft Dynamics AX. The .NET Business Connector installation is provided for backward compatibility.

## Before you install .NET Business Connector

Complete the following tasks before you install .NET Business Connector.

- On the computer where you plan to install .NET Business Connector, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.
- Install the Microsoft Dynamics AX databases and AOS in the environment. Alternatively, you can install these components when you install .NET Business Connector.
Install .NET Business Connector

Use this procedure to install .NET Business Connector. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you're installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **.NET Business Connector**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
8. If you are installing on a 64-bit operating system, the **Select a file location** page is displayed. Select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.
9. On the **Select a display language** page, select the language in which you want to run Microsoft Dynamics AX for the first time.

**Note**

.NET Business Connector is a kind of Microsoft Dynamics AX client. Therefore, if .NET Business Connector is the first client that you install on a computer, Setup requires that you set the display language.

10. On the **Specify a location for configuration settings** page, specify whether you want .NET Business Connector to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file. Click **Next**.

**Note**

If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

11. On the **Connect to an AOS instance** page, enter the name of the computer that runs the instance of Application Object Server (AOS) that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

**Note**

If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

12. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.
13. On the **Ready to install** page, click **Install**.
14. After the installation is completed, click **Finish** to close the wizard.
Install the synchronization proxy for Microsoft Project Server

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The synchronization proxy for Microsoft Project helps support the synchronization of project data in Microsoft Dynamics AX with data in Microsoft Project Server.

To use this functionality, you must install both the synchronization proxy and the synchronization service. You can install the synchronization service and the synchronization proxy at the same time. This section explains only how to install the synchronization proxy.

The synchronization proxy uses Message Queuing to connect to Project Server and Microsoft Dynamics AX. You must install the synchronization proxy on the same computer as Project Server.

Before you install the synchronization proxy

Complete the following tasks before you install the synchronization proxy:

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.
- Verify that you have the permissions that are required to install the synchronization proxy. For more information, see the Verify that you have the required permissions for installation section.

Install the synchronization proxy

Use this procedure to install the synchronization proxy. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Synchronization proxy for Microsoft Project Server, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. If you are installing on a 64-bit operating system, the Select a file location page is displayed. Select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Specify a location for configuration settings page, specify whether you want the synchronization proxy to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file. Click Next.
10. On the **Connect to an AOS instance** page, enter the name of the computer that runs the instance of Application Object Server (AOS) that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

**Note**

If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

11. On the **Specify Business Connector proxy account information** page, enter the password for the proxy account that is used by .NET Business Connector. Click **Next**.

12. On the **Synchronization proxy/Message Queuing: Enter the service account information** page, enter the domain user account for the synchronization service, and then click **Next**.

13. On the **Connect to Microsoft Project Server** page, enter the name of the Project Server and the name of the database that is used for Project Server reporting. In the **Project web access URL** box, enter the URL of the website that is used to access Project Server.

**Note**

If the synchronization proxy must connect to multiple URLs for Project Server, use the first URL when you install the synchronization proxy. However, you must then uninstall and reinstall the synchronization proxy. When you reinstall the synchronization proxy, use a different URL. Uninstalling the proxy does not affect the proxy’s ability to synchronize with URLs that were specified during previous installations.

14. Click **Next**.

15. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

16. On the **Ready to install** page, click **Install**.

17. After the installation is completed, click **Finish** to close the wizard.

## Install the synchronization service for Microsoft Project Server

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The Microsoft Project synchronization service synchronizes project data in Microsoft Dynamics AX with data in Microsoft Project Server.

To use this functionality, you must install both the synchronization proxy and the synchronization service. You can install the synchronization service and the synchronization proxy at the same time. This section explains only how to install the synchronization service.

If Project Server uses a Microsoft Database Engine (MSDE) database or a Microsoft SQL Server Express Edition database, install the synchronization service on the computer that runs Project Server.

When you install the synchronization service, Setup configures a message queue for the service. Setup also installs and starts the synchronization service.
Before you install the synchronization service

Complete the following tasks before you install the synchronization service:

- On the computer where you are installing this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

- Install the Microsoft Dynamics AX databases and Application Object Server (AOS) in the environment.

- Configure a domain account that the synchronization service can run as. For more information, see the Create service accounts section.

Install the synchronization service

Use the following procedure to install the synchronization service. If you install other Microsoft Dynamics AX components at the same time, the installation screens vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Synchronization service for Microsoft Project Server, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. If you are installing the synchronization service on a 64-bit operating system, the Select a file location page is displayed. Select the location where you want 32-bit versions of Microsoft Dynamics AX files to be installed, and then click Next.
9. On the Specify a location for configuration settings page, specify whether you want the synchronization service to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file. Click Next.
10. On the Connect to an AOS instance page, enter the name of the computer that runs the AOS instance that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click Next.

  ☑ Note
  
  If you entered AOS connection information for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

11. On the Specify Business Connector proxy account information page, enter the password for the proxy account that is used by .NET Business Connector. Click Next.
12. On the Enter the password for the service account page, enter the account information for the synchronization service. Click Next.
13. On the **Connect to a message queue** page, specify whether you want to create a new message queue or connect to an existing message queue.
   - If you want to create a new queue, Setup creates a private queue by default. Private queues can be accessed only from the local computer. Select **Make this a public queue** to allow other computers to access the queue.
   - If you want to connect to an existing queue, enter the queue address.
   
   Click **Next**.

14. On the **Specify service accounts for synchronization message queues** page, enter the service accounts that communicate through message queues. You must provide a domain account that is used by the Project Server eventing service, and the service account of at least one AOS instance. Otherwise, Setup cannot configure the correct permissions. Click **Next**.

15. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

16. On the **Ready to install** page, click **Install**.

17. After the installation is completed, click **Finish** to close the wizard.
Install management utilities

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Management utilities let you configure and manage Microsoft Dynamics AX components and artifacts. Use these utilities to deploy artifacts, such as reports and Web controls, from the metadata store.

**Before you install management utilities**

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.
  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](#) on Microsoft.com.
- Make sure that the Windows Update service is running on the computer where you will install this component.

**Install management utilities**

Use this procedure to install the Microsoft Dynamics AX management utilities. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you're installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Management utilities**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the [Check prerequisites](#) section. When no errors remain, click **Next**.
8. If you are installing on a 64-bit operating system, the **Select a file location** page is displayed. Select the location where you want to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.
9. On the **Specify client configuration options** page, specify whether you want management utilities to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, enter the network location of the file. Click **Next**.
10. On the **Connect to an AOS instance** page, enter the name of the computer that runs the instance of Application Object Server (AOS) that you want to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

**Note**

If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.
11. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.
12. On the **Ready to install** page, click **Install**.
13. After the installation is complete, click **Finish** to close the wizard.
Install retail components

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

**Note**
This chapter includes information about features that were added or changed for Microsoft Dynamics AX 2012 R3 Cumulative Update 8. More information is provided later in this chapter.

This chapter provides information about how to install the retail components for Microsoft Dynamics AX.

**Note**
Retail components are available with Microsoft Dynamics AX 2012 R3, AX 2012 R2, and AX 2012 Feature Pack.

Retail provides mid-market and large retailers a complete solution for the head office and point of sale (POS). Retail can help retailers increase financial returns, improve service, manage growth, and streamline efficiencies. Retail consists of several components that are typically distributed across multiple computers and locations.

### Install retail components in AX 2012 R3

In AX 2012 R3, we recommend that you install Retail components in the following order:

1. Install Retail Headquarters
2. Install Commerce Data Exchange: Real-time Service (Retail Transaction Service)
3. Install Commerce Data Exchange: Async Server
4. Install Commerce Data Exchange: Async Client
5. Install a retail channel database
6. Install the POS components that you require:
   - Install Retail POS
   - Install the Retail Channel Configuration Utility (Retail Store Database Utility)
   - Install Retail Modern POS
   - Install Retail Server
   - Install Retail Hardware Station
7. Install a Retail online store (e-commerce)
8. Install optional components:
   - Install Commerce Data Exchange: Synch Service (Retail Store Connect)
   - Install the Retail mass deployment toolkit
   - Install Retail SDK (Retail POS Plug-ins)

### Install retail components in AX 2012 R2 and AX 2012 Feature Pack

To use the retail components in Microsoft Dynamics AX 2012 Feature Pack, you must select the **Extensions** model file when you install the Microsoft Dynamics AX database. For more information about how to install model files, see the [Install the Microsoft Dynamics AX databases](#) section.
In AX 2012 R2 and AX 2012 Feature Pack, the available components differ from AX 2012 R3. Most importantly, you must install Synch Service instead of installing Async Client and Async Server. For more information, see the Deployment topologies for Retail and Install Commerce Data Exchange: Synch Service (Retail Store Connect) sections.

**Install Retail essentials**

Retail essentials is a retail-centric configuration option for Microsoft Dynamics AX. Retail essentials provides a simplified, streamlined user experience that is optimized for organizations that use only the retail management functions of Microsoft Dynamics AX.

⚠️ **Important**

To install Retail essentials, you must slipstream Microsoft Dynamics AX 2012 R3 Cumulative Update 8.

- [Install Retail essentials at headquarters](#)
- [Install Retail essentials at the store or at the point of sale](#)

**Deployment topologies for Retail**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

✅ **Note**

This section includes information about features that were added or changed for Microsoft Dynamics AX 2012 R3 Cumulative Update 8. More information is provided later in this section.

Before you install Microsoft Dynamics AX 2012 for Retail, you must decide on the system topology. This section describes common topologies for a Retail system.

The topology at the head office is a standard Microsoft Dynamics AX deployment, with additional computers for retail functions. Depending on the requirements of your organization, you can use a computer for more than one purpose. We recommend that you load balance across multiple computers whenever load balancing is possible.

✅ **Note**

For development and testing, you can install the complete Retail system on a single computer. However, a deployment of this kind is not a supported production scenario.
Deployment topologies for Retail in AX 2012 R3

The following table lists the types of computers that are used in a typical Retail deployment with AX 2012 R3.

<table>
<thead>
<tr>
<th>Deployment location</th>
<th>Types of computers</th>
</tr>
</thead>
</table>
| Head office         | • AOS computer with Retail headquarters component installed  
                      • Database server  
                      You must modify the Microsoft Dynamics AX database server only if the settings for Microsoft SQL Server do not comply with the Payment Card Industry (PCI) Data Security Standard. For more information about PCI-compliant settings, see the [Implementation Guide for PCI Compliance](http://microsoft.com) on Microsoft.com.  
                      • Communications server that hosts Commerce Data Exchange: Real-time Service and Async Server (or Synch Service for versions prior to AX 2012 R3). If you prefer, you can have two communications servers, one for each of these applications.  
                      • Microsoft Dynamics AX client computers with Retail headquarters component installed  
                      • Retail Server, if you are using Retail Modern POS  
                      • Web servers that host the online channel |
| Brick-and-mortar stores | • Computer that hosts the channel database and Async Client (or Synch Service for versions prior to AX 2012 R3)  
                         • Retail Server (required for Retail Modern POS)  
                         • Point of sale (POS) registers  
                         • Point of sale (POS) registers |

Topology diagrams for POS in AX 2012 R3

The following figures illustrate typical deployment topologies for a POS system in AX 2012 R3.
Each component of a POS system is hosted on a dedicated computer

In the following figure, each component is hosted on a dedicated physical computer or virtual machine. Components that support multiple instances, such as AOS, Async Server and Real-time Service could be installed on additional computers for load balancing. This deployment topology is appropriate for a large retailer.

POS components are hosted on shared servers

In the following figure, on the head office side, the Async Server instance, Real-time Service, and Enterprise Portal for Microsoft Dynamics AX have been combined on a single computer. A midsize retailer might want to consolidate these services on one computer or run them on virtual machines on a single physical server. On the store side, Async Client is installed on the same computer as the channel database server.
Store-side database topologies

For Retail POS registers, the following store-side database topologies are supported:

- POS registers have offline databases that are synchronized with the channel database within the store when the POS registers are connected.
- POS registers do not have databases and must always be connected to the channel database within the store.

For Retail Modern POS, the following store-side database topologies are supported:

- Retail Modern POS registers have offline databases that are synchronized with the channel database.
- Retail Modern POS registers do not have databases and must always be connected to a Retail Server.
- Retail Modern POS registers connect directly to a channel database without connecting to a Retail Server.

The following figure illustrates the two supported topologies. In the POS portable topology, the POS device uses the channel database by default, and synchronizes its local database and the channel database. If the channel database becomes inaccessible, the POS device uses its offline database until the connection to the channel database is re-established. In the POS always online topology, the POS device must always be online to connect with the channel database.

![Diagram of store-side database topologies]

- **Note**
  Async Server, Async Client, and Real-time Service have been omitted from the preceding figure, because they are not affected.
Topography diagrams for online stores in AX 2012 R3

The following figures illustrate typical deployment topologies for an online store system in AX 2012 R3.

Each component of an online store is hosted on a dedicated computer

In the following figure, each component is hosted on a dedicated physical computer or virtual machine. Components that support multiple instances, such as AOS and online store sites, could be installed on additional computers for load balancing.

![Diagram of online store components hosted on dedicated computers]

Online store components are hosted on shared servers

In the following figure, Async Client, Real-time Service, and Enterprise Portal have been combined on a single computer. A midsize retailer might want to consolidate these services on one computer or run them on virtual machines on a single physical server.

![Diagram of online store components hosted on shared servers]
Deployment topologies for Retail in AX 2012 R2 and AX 2012 Feature Pack

The following table lists the types of computers that are used in a typical Retail deployment with AX 2012 R2 or AX 2012 Feature Pack.

<table>
<thead>
<tr>
<th>Deployment location</th>
<th>Types of computers</th>
</tr>
</thead>
</table>
| Head office               | • AOS computer  
                          | • Database server  
                          | You must modify the Microsoft Dynamics AX database server only if the settings for Microsoft SQL Server do not comply with the Payment Card Industry (PCI) Data Security Standard. For more information about PCI-compliant settings, see the Implementation Guide for PCI Compliance on Microsoft.com.  
                          | • Communications server that hosts Commerce Data Exchange: Real-time Service and Commerce Data Exchange: Synch Service  
                          | If you prefer, you can have two communications servers, one for each of these applications.  
                          | • Microsoft Dynamics AX client computers  
                          | • Web servers that host the online store |
| Brick-and-mortar stores   | • Database server  
                          | • Communications server that hosts Synch Service  
                          | • Point of sale (POS) registers |

Typically, head office and store computers where Synch Service is installed also have SQL Server Express Edition installed. However, this instance of SQL Server is used only for the Synch Service message database.
**Topology diagrams for POS in AX 2012 R2 and AX 2012 Feature Pack**

The following figures illustrate typical deployment topologies for a POS system in AX 2012 R2 and AX 2012 Feature Pack.

**Each component of a POS system is hosted on a dedicated computer**
In the following figure, each component is hosted on a dedicated physical computer or virtual machine. Components that support multiple instances, such as AOS and Synch Service, could be installed on additional computers for load balancing. This deployment topology is appropriate for a large retailer.

**POS components are hosted on shared servers**
In the following figure, on the head office side, the Synch Service instance, Real-time Service, and Enterprise Portal for Microsoft Dynamics AX have been combined on a single computer. A midsize retailer might want to consolidate these services on one computer or run them on virtual machines on a single physical server. On the store side, Synch Service is installed on the same computer as the store database server.
Store-side database topologies
Retail supports the following store-side database topologies:

- POS registers have offline databases that are synchronized with the store database when the POS registers are connected.
- POS registers do not have databases and must always be connected to the store database.

The following figure illustrates the two supported topologies. In the **POS portable** topology, the POS register uses the store database by default, and synchronizes its local database and the store database. If the store database becomes inaccessible, the POS register uses its offline database until the connection to the store database is re-established. In the **POS always online** topology, the POS register must always be online to connect with the store database.

*Note*

Synch Service and Real-time Service have been omitted from the preceding figure, because they are not affected.
Topology diagrams for online stores in AX 2012 R2 and AX 2012 Feature Pack
The following figures illustrate typical deployment topologies for an online store system in AX 2012 R2 and AX 2012 Feature Pack.

Each component of an online store is hosted on a dedicated computer
In the following figure, each component is hosted on a dedicated physical computer or virtual machine. Components that support multiple instances, such as AOS, Synch Service, and online store sites, could be installed on additional computers for load balancing.
Online store components are hosted on shared servers

In the following figure, Synch Service, Real-time Service, and Enterprise Portal have been combined on a single computer. A midsize retailer might want to consolidate these services on one computer or run them on virtual machines on a single physical server.

See also
- [Point of Sale](on TechNet)
- [Create a store database or an offline database (AX 2012 R2 and AX 2012 Feature Pack)](on TechNet)

Install Retail Headquarters

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

The Retail Headquarters component installs runtime components that are required to enable key aspects of Retail functionality, such as the screen layout designer. This component must be installed on the Application Object Server (AOS) computer and on Microsoft Dynamics AX client computers.

**Note**

Retail components are available with Microsoft Dynamics AX 2012 R3, AX 2012 R2, and AX 2012 Feature Pack.
Before you install Retail Headquarters

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.
  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](#) on Microsoft.com.

- Before you install Retail Headquarters, we recommend that you install the AOS, Microsoft Dynamics AX clients, and the Microsoft Dynamics AX databases with all required models.

Install Retail Headquarters

Use this procedure to install Retail Headquarters. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. On the **Modify Microsoft Dynamics AX installation** page, click **Add or modify components**, and then click **Next**.
4. On the **Add or modify components** page, select **Retail headquarters**, and then click **Next**.
5. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the [Check prerequisites](#) section. When no errors remain, click **Next**.
6. On the **Ready to install** page, click **Install**.
7. After the installation is completed, click **Finish** to close the wizard.

After you install Retail Headquarters

After you install the Retail Headquarters component on AOS computers and Microsoft Dynamics AX client computers, you must initialize the retail configuration.

⚠️ **Important**

Before you initialize the retail configuration, make sure that you have specified a language and a postal address for each legal entity where you will set up retail stores.

1. Open the Microsoft Dynamics AX client.
2. Click **Retail > Setup > Parameters > Retail parameters**.
3. Click **Initialize**.
5. In Windows, open the **Services** control panel.
6. Restart the **Microsoft Dynamics AX Object Server** service.
Install Retail POS

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

Retail POS is a component that is required for the day-to-day operation of Retail at a store. When you install the Retail POS component, the Retail Salt Utility is also installed. The Retail Salt Utility provides extra encryption for the passwords and credentials that are associated with the Retail system.

**Note**
Retail components are available with Microsoft Dynamics AX 2012 R3, AX 2012 R2, and AX 2012 Feature Pack.

At the store, install this component on each register computer. If you plan to use a stand-alone database server at the store, you must also install Retail POS on the database server, even if Retail POS will not be used on that computer. This step is required to set up the database. Additionally, install Retail POS on a communications server if that computer will also be used to process transactions.

In AX 2012 R3, you can use the Retail mass deployment toolkit to deploy Retail POS to a large number of client computers. For more information, see Mass deploy Retail components by using System Center Configuration Manager on TechNet.

**Note**
If you are upgrading Retail POS, you should review Scenario: Upgrade a Retail system on TechNet.

**Before you install Retail POS**

On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

**Install Retail POS**

Use this procedure to install Retail POS. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you’re installing AX 2012 R3, in the **Select an installation option** page, click **Microsoft Dynamics AX**.
5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
6. On the **Select components** page, select **Retail POS**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.
8. On the **Ready to install** page, click **Install**.
9. After the installation is completed, click **Finish** to close the wizard.
After you install Retail POS

1. If an offline database is required, create and configure the offline database for each POS register by using the Retail Channel Configuration Utility. For more information, see Create a channel database or an offline database (AX 2012 R3) or Create a store database or an offline database (AX 2012 R2 and AX 2012 Feature Pack) on TechNet.

2. Configure Retail POS database connections by using the Retail Channel Configuration Utility. For more information, see Configure database connections for a POS register on TechNet.

3. Configure Retail POS for your business. For more information, see Point of Sale on TechNet.

Install Retail Modern POS

Apply to: Microsoft Dynamics AX 2012 R3

Retail Modern POS is a point of sale application designed for Windows 8.1 computers, laptops, and more. It is touchscreen ready and low on overhead, while providing the full functionality of an integrated interface with Retail. This section includes the information about how to install and configure Retail Modern POS.

⚠️ Important

The RTM release of Modern POS was delivered in Microsoft Dynamics AX 2012 R3 Cumulative Update 8. If you installed a pre-release copy of Modern POS, you must uninstall the pre-release application prior to installing the RTM application that is included in AX 2012 R3 CU8.

Before you install Retail Modern POS

- Retail Modern POS clients must be able to connect to a computer that is running Microsoft Dynamics AX Retail Server. Verify that Retail Server is installed on a computer at the head office.

- Locate the URL for your Retail Server installation. You must specify this URL Setup for device activation. By default, the URL is in the format: https://<server name>:port/<name of web application>/v1 as it will be required for device activation.

- In AX 2012 R3 CU8, set up a register and a device to represent the Modern POS computer or device. For more information, see the “Setting up Retail Modern POS” topic. Be sure to select a Modern POS Windows 8 layout for the register and a Windows 8 client or Windows 8 phone device type.

- You do not have to install Retail Modern POS in a domain. You can install it as part of a work group on a single computer.

- Verify that WinJS and VCLibs libraries are installed on the device where you want to install this component. For more information, see Manually install Retail Modern POS prerequisites on TechNet.

- If you installed a pre-release copy of Modern POS, you must completely uninstall the pre-release application prior to installing the RTM application that is included in AX 2012 R3 CU8.

Install Retail Modern POS

Use this procedure to install the default Microsoft Dynamics AX Retail Modern POS app on a supported device. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on
the components that you are installing. For information about how to install a customized Retail Modern POS app on a supported device, see the next section.

Note
If you installed a pre-release copy of Modern POS, you must completely uninstall the pre-release application prior to installing the RTM application that is included in AX 2012 R3 CU8.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select components page, select Retail Retail Modern POS, and then click Next.
5. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
6. After the installation is completed, click Finish to close the wizard.

Note
If you install Retail Modern POS on a Windows 8.1 Professional or non-domain joined computer, Setup might prompt you to provide an enterprise side-loading key. This key is included with your Enterprise Volume License.

Install a customized Retail Modern POS app on a computer
The Retail SDK includes source samples and tools to help you customize the Retail Modern POS app for Windows 8.1. If you customize a Retail Modern POS app then you must use on the following methods to side-load it to supported devices.
- Windows Intune (on Microsoft.com)
- System Center Configuration Manager
- A third-party mobile device management service
- Create a custom installer to deploy the app
- Install the app by using Windows PowerShell scripts
For more information about customizing and installing a customized Retail Modern POS app, see Modern Point of Sale in the Retail Modern POS documentation roadmap on TechNet.

After you install Retail Modern POS
Start the Microsoft Dynamics AX Retail Modern POS app. In the Device Activation page, enter the URL for the Retail Server, information about the register and device for the Windows 8.1 computer or device, and credentials for a manager of the store that the register is associated with.

If you encounter connectivity issues after installing, see Troubleshoot connectivity problems for Retail Modern POS devices on TechNet.
Uninstall Retail Modern POS

You can uninstall Retail Modern POS either by running AxSetup.exe and selecting the component for removal, or by uninstalling it from Add or Remove Programs.

**Note**

If multiple Windows users have been using an installation of Retail Modern POS, we recommend that you start with a reimaged computer whenever possible. Alternatively, you must explicitly remove the application for every user that logged in to the computer. Do this by right-clicking the application on the Start screen. When that is complete, you can remove the installer from Add or Remove Programs.

See also
- [Modern Point of Sale](on TechNet)

Manually install Modern POS prerequisites

**Applies to:** Microsoft Dynamics AX 2012 R3

Use the information in this section to install prerequisites for Modern POS if you are installing on a Windows Server or Windows Embedded operating system. If you are installing Modern POS on a supported Windows client operating system or a Windows RT operating system, these prerequisites are already installed.

This section explains how to install the following prerequisites:
- Windows Library for JavaScript (WinJS) (version 1.0.9600.16408 or higher)
- Microsoft Visual C++ Runtime Package (VCLibs) (version 12.0.2.1005.1 or higher)

**Important**

The Retail Modern POS is comprised of pre-release components. All pre-release features and functionality are preliminary based on current expectations, and are subject to change without notice.

**Option 1: Download Visual C++ Runtime Package from the Microsoft Download Center**

Download and install Visual C++ Runtime Package.

You’ll still need to install Windows Library for JavaScript using one of the other methods described in this section.

**Option 2: Install another Windows app that includes the prerequisites**

The prerequisites are installed with the Bing News app from the Windows Store. To obtain the prerequisites, you can download this app onto the computer where you plan to install Modern POS.

If you are using a server operating system, you must first use the Add Roles and Features Wizard to add the Desktop Experience feature that is available under User Interfaces and Infrastructure. Then you’ll have access to the Windows Store. To download apps from the Windows Store, you must sign in with a Microsoft Account.
Option 3: Install Microsoft Visual Studio Express 2013 and manually install the prerequisites

You can install Visual Studio Express 2013 to obtain the files, and then manually install the prerequisites for Modern POS.

2. Copy and paste the following files to the specified locations.

<table>
<thead>
<tr>
<th>File</th>
<th>Copy from</th>
<th>Paste to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft.WinJS.2.0.appx</td>
<td>\Program Files (x86)\Microsoft SDKs\Windows\v8.1\ExtensionSDK\Microsoft.WinJS.2.0\1.0\</td>
<td>\Program Files (x86)\Microsoft Dynamics AX\60\Retail Modern POS\x64\Dependencies\</td>
</tr>
<tr>
<td>Microsoft.VCLibs.x64.12.00.appx (64-bit operating systems only)</td>
<td>\Program Files (x86)\Microsoft SDKs\Windows\v8.1\ExtensionSDK\Microsoft.VCLibs\12.0\AppX\Retail\64\</td>
<td>\Program Files (x86)\Microsoft Dynamics AX\60\Retail Modern POS\x64\Dependencies\x64\</td>
</tr>
<tr>
<td>Microsoft.VCLibs.x86.12.00.appx (32-bit operating systems only)</td>
<td>\Program Files (x86)\Microsoft SDKs\Windows\v8.1\ExtensionSDK\Microsoft.VCLibs\12.0\AppX\Retail\x86\</td>
<td>\Program Files (x86)\Microsoft Dynamics AX\60\Retail Modern POS\x86\Dependencies\x86\</td>
</tr>
</tbody>
</table>

3. Manually install the prerequisites.
   a. Open a Windows PowerShell session as an administrator.
   b. Run the following command to install WinJS.

   ```cmd
   Add-AppxPackage "<Drive>:\\Program Files (x86)\\Microsoft Dynamics AX\\60\\Retail Modern POS\\x64\\Dependencies\\Microsoft.WinJS.2.0.appx"
   ```
   c. Run one of the following commands to install VCLibs.

   On a 64-bit operating system:

   ```cmd
   Add-AppxPackage "<Drive>:\\Program Files\\Microsoft Dynamics AX\\60\\Retail Modern POS\\x64\\Dependencies\\x64\\Microsoft.VCLibs.x64.12.00.appx"
   ```
   On a 32-bit operating system:

   ```cmd
   Add-AppxPackage "<Drive>:\\Program Files (x86)\\Microsoft Dynamics AX\\60\\Retail Modern POS\\x86\\Dependencies\\x86\\Microsoft.VCLibs.x86.12.00.appx"
   ```

Install a retail channel database

**Applies to:** Microsoft Dynamics AX 2012 R3

This section explains how to create a retail channel database by using Setup or Windows PowerShell. Channel databases hold retail data for one or more retail channels, such as online stores or brick-and-mortar stores. Typically, there is one channel database per retail store location that uses Retail POS or Modern POS, or per e-commerce installation. The channel database for a Retail POS is typically located at a brick-and-mortar store, whereas the channel databases for Modern POS or e-commerce installations are typically located at the head office. The data for a channel can be included in more than one channel database.
You can also use the Retail Channel Configuration Utility to create a channel database. For more information, see Create a channel database or an offline database (AX 2012 R3) on TechNet.

**Note**
Channel databases are used only with Microsoft Dynamics AX 2012 R3. In earlier versions of Microsoft Dynamics AX, the store database provided the functionality now provided by the channel database.

To deploy channel databases from a central location, use the Retail mass deployment toolkit together with System Center Configuration Manager. For more information, see Mass deploy Retail components by using System Center Configuration Manager on TechNet.

**Before you install a retail channel database**

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

  **Note**
  Regardless of the version of Microsoft SQL Server that you are installing on, the prerequisite validation utility requires that you install the SQL Server 2008 R2 version of SQL Server Shared Management Objects (SMO). From the location that is provided in the prerequisite details, install the package that is appropriate for your architecture (either x86 or x64).

- Make sure that Microsoft SQL Server is set up correctly for Microsoft Dynamics AX 2012 for Retail databases. For more information, see Configure SQL Server for the Retail databases on TechNet.

- We recommend that you install Commerce Data Exchange: Async Server and Commerce Data Exchange: Real-time Service in the environment before you install channel databases.

**Option 1: Install a retail channel database by using Setup**

Use this procedure to install a retail channel database by using the Setup wizard. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Retail channel database, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the **Create a channel database** page, select the **Configure Retail Channel database** option to configure a channel database by using Setup. If you clear this option, the application files are installed, but a channel database is not configured.

   If you're configuring a channel database, enter the name of the server on which to create the database and the name of the database.

   - **Note**
     If you’re using a named instance of SQL Server, enter the server name in the format `ServerName_InstanceName`.

9. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

10. On the **Ready to install** page, click **Install**.

11. After the installation is completed, click **Finish** to close the wizard.

**Option 2: Install a retail channel database by using Windows PowerShell**

Use this procedure to install a retail channel database manually by using Windows PowerShell. Manual installations are often performed by businesses and organizations that automate deployments by using scripts.

**Extract installation files**

Use Microsoft Dynamics AX Setup to extract the files that are required for manual installation.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. On the **Modify Microsoft Dynamics AX installation** page, click **Add or modify components**, and then click **Next**.
3. On the **Add or modify components** page, select **Retail channel database**, and then click **Next**.
4. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
5. On the **Create a channel database** page, clear the **Configure retail channel database** option.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
7. On the **Ready to install** page, click **Install**.
8. After the installation is completed, click **Finish** to close the wizard.

**Configure settings in the channeldb-settings.xml file**

After you extract the installation files by using Setup, you must configure settings in the channeldb-settings.xml file.

1. Open the folder where the installation files are installed. By default, the files are located at `C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Channel Database\Tools`.
2. Create a copy of the channeldb-settings.xml file for each channel database that you are deploying. We recommend that you not change the original file.
3. Open your copy of the channeldb-settings.xml file in Microsoft Visual Studio or a text editor, such as Notepad.
4. Enter a value for the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enter this value</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChannelDatabaseServerName</td>
<td>The name of the server that hosts the channel database. The script is case-sensitive. For example, enter value=&quot;DatabaseServer&quot; /&gt;.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelDatabaseServerNamedInstanceName</td>
<td>The name of the SQL Server instance that hosts the channel database.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>&lt;Note&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The format for a SQL Server instance name is either the server name or the full instance name. For example, valid names are localhost, localhost\instance2, server1, and server1\instance2.</td>
<td></td>
</tr>
<tr>
<td>ChannelDatabaseName</td>
<td>The name of the channel database.</td>
<td>None</td>
</tr>
</tbody>
</table>

5. Save your changes.

**Run Windows PowerShell scripts to configure a channel database**

After you configure the parameters in the channeldb-settings.xml file, you can run the Windows PowerShell scripts that configure a channel database.

**Note**

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to Restricted, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to RemoteSigned by using the Set-ExecutionPolicy cmdlet. This setting allows you to run scripts that you’ve written and scripts that have been signed by a trusted publisher.

1. On the server where you want to run the script, open Windows PowerShell to the folder where the scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Channel Database\Tools.
   - If you’re using Windows Server 2012 or a later operating system, use Windows Explorer to open the folder where the scripts are installed, and then click **File > Open Windows PowerShell > Open Windows PowerShell as administrator**.
   - If you’re using Windows Server 2008 R2 or an earlier operating system, start Windows PowerShell as the administrator, and then change the directory by using the following command: `CD "<Path to directory>"`.

2. Run the following command to create the channel database:

   ```
   .\Deploy-Databases.ps1 -SettingsXmlFilePath .\channeldb-settings-updated.xml -TopologyXmlFilePath .\channeldb-topology.xml -Verbose $true
   ```
Example:

```
.
DeployDatabases.ps1 -SettingsXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Channel Database\Tools\channeldb-settings-updated.xml" -TopologyXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Channel Database\Tools\channeldb-topology.xml" –Verbose $true
```

**After you install a retail channel database**

After you install a channel database, you must complete the following tasks.

- Set up a Retail scheduler profile for the database. For more information, see [Set up a channel database profile](#) on TechNet.

- On each register where you install Retail POS, configure Retail POS to use the channel database by using the Retail Channel Configuration Utility. For more information, see [Configure database connections for a POS register by using the Retail Channel Configuration Utility](#) on TechNet.

- Optional: Add the database to a data group. For more information, see [Create a channel data group](#) on TechNet.

**Install Commerce Data Exchange: Synch Service (Retail Store Connect)**

**Applies to:** Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

Commerce Data Exchange: Synch Service is a service that shares data among retail components. These components include the head office, stores, and individual point of sale (POS) terminals. When you install Synch Service, the Retail Salt Utility is also installed. The Retail Salt Utility provides extra encryption for the passwords and credentials that are associated with the Retail system.

**Note**

Retail components are available with Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, and Microsoft Dynamics AX 2012 Feature Pack. In AX 2012 Feature Pack, Synch Service is called Retail Store Connect.

In AX 2012 R3, Synch Service has been replaced by Commerce Data Exchange: Async Server and Commerce Data Exchange: Async Client

In AX 2012 R3, deploy this component only if you must support earlier versions of Microsoft Dynamics AX for Retail POS while you upgrade (N-1). For more information, see [Scenario: Upgrade a Retail system](#) on TechNet.

To deploy Synch Service on multiple computers in an environment, you can run Setup on each computer.
Before you install Synch Service

- Determine how many instances of Synch Service you want to install, and on which computers.

  In a basic deployment of Retail, one instance of Synch Service is installed at the head office, and one instance is installed at each store. In this scenario, the head-office instance communicates with Microsoft Dynamics AX Application Object Server (AOS), and a store instance communicates with the store database.

  Operations in a large organization might scale more efficiently if you install multiple Synch Service instances at each site, either on a single server or on multiple servers. For more information, see Run multiple instances of Synch Service on TechNet.

  **Caution**
  Although a single instance of Synch Service can manage all communications for the organization, excessive load or network latency might decrease performance.

  If Retail Scheduler will be used on a Microsoft Dynamics AX client computer to run jobs and send data to stores, install Synch Service on the client system.

- Determine whether you want to use Network Load Balancing (NLB) and Internet Protocol security (IPsec).

  Retail supports NLB for data that comes from the store to Microsoft Dynamics AX, but not for outgoing data. If you’re using multiple instances of Synch Service, NLB can distribute incoming data among them, but all instances must have the same service name. If IPsec is enabled, we recommend that you not use NLB.

- Select a service account for the Synch Service service. For information about the requirements for service accounts, see the Create service accounts section.

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

- At the head office, .NET Business Connector must be installed on the same computer as Synch Service. Synch Service uses .NET Business Connector to communicate with AOS.

Install Synch Service

Use this procedure to install Synch Service. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you’re installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you’re installing AX 2012 R3, on the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Synch Service, and then click Next.
7. On the **Configure Commerce Data Exchange: Synch Service** page, select the check box to configure Synch Service by using Setup. If you clear this check box, the application files are installed, but Synch Service is not configured.
   - To create a message database for Synch Service, enter the name of the server on which to create the database, and then enter a name for the new database.
   - To configure the service account for Synch Service, enter a user name and password.

   If you want to change this information later or configure other settings, such as a port and a service name, you must use the Synch Service Settings Wizard. For more information, see [Configure settings for Synch Service](#) on TechNet.

8. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the [Check prerequisites](#) section. When no errors remain, click **Next**.

9. On the **Ready to install** page, click **Install**.

10. After the installation is completed, click **Finish** to close the wizard.

---

### Install Commerce Data Exchange: Real-time Service (Retail Transaction Service)

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

This section explains how to install Commerce Data Exchange: Real-time Service. Real-time Service is an integrated service that provides real-time communication between Microsoft Dynamics AX and retail channels. Real-time Service enables individual point of sale (POS) computers and online stores to retrieve specific data from Microsoft Dynamics AX in real time.

**Note**

Components of Microsoft Dynamics AX 2012 for Retail are available with Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, and Microsoft Dynamics AX 2012 Feature Pack.

At the head office, install Real-time Service on the communications server. Deployment steps vary, depending on the version that you are installing:

- In AX 2012 R3 and AX 2012 R2, Real-time Service is a Windows Communication Foundation (WCF) service that must be installed on a website in Internet Information Services (IIS).
- In AX 2012 Feature Pack, Real-time Service is a Windows service that is called Retail Transaction Service.

When you install this component, the Retail Salt Utility is also installed. The Retail Salt Utility provides extra encryption for the passwords and credentials that are associated with the Retail system.

**Before you install Real-time Service**

- Create the service account that will be used as the application pool identity for the Real-time Service website. In AX 2012 Feature Pack, this account is used as the identity for the Windows service. For more information about the requirements for this account, see the [Create service accounts](#) section.
- Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) When you run Setup, you will need to enter the thumbprint for the certificate. To view the thumbprint in IIS Manager, double-click the certificate and click the **Details** tab.
On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Real-time Service requires .NET Business Connector. The .NET Business Connector enables Real-time Service to interact with instances of Microsoft Dynamics AX Application Object Server (AOS). If .NET Business Connector is not already installed, it is selected automatically when you select to install Real-time Service.

Option 1: Install Real-time Service by using Setup (AX 2012 R3)

Use this procedure to install Real-time Service for AX 2012 R3. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing. To deploy Real-time Service on multiple computers in a cluster, you can run Setup on each computer. Alternatively, you can use the Retail mass deployment toolkit to deploy Real-time Service from a central location. For information about how to set up an IIS cluster, see the Network Load Balancing Deployment Guide on TechNet. For more information about mass deployment, see Mass deploy Retail components by using System Center Configuration Manager on TechNet.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select an installation option page, click Microsoft Dynamics AX, and then click Next.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Real-time Service, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. If you are installing on a 64-bit operating system, the Select a file location page is displayed. Select the location in which to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Select a display language page, select the language in which to run Microsoft Dynamics AX for the first time.

**Note**

.NET Business Connector is a kind of Microsoft Dynamics AX client. Therefore, if .NET Business Connector is the first client that you install on a computer, Setup requires that you set the display language.

10. On the Specify a location for configuration settings page, specify whether you want .NET Business Connector to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file. Click Next.
11. On the Connect to AOS instance page, enter the name of the computer that runs the instance of AOS to connect to. You can optionally specify the name of the AOS instance and the TCP/IP port number. Click Next.

**Note**

If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

12. On the Specify Business Connector proxy account information page, enter the password for the proxy account that is used by .NET Business Connector. Click Next.

13. On the Configure Real-time Service page, select the check box to configure Real-time Service by using Setup. If you clear this check box, the application files are installed, but Real-time Service is not configured. If you’re configuring Real-time Service, enter the following information:
   - **Application name** – The name of the web application that hosts Real-time Service.
   - **Website name** – The name of the website that hosts Real-time Service.
   - **App pool name** – The name of the application pool that Real-time Service runs in.
     We recommend that you specify separate application pools if multiple Retail components are installed on the same computer. Multiple web applications can share an application pool if resources on the computer are limited. However, if the shared application pool fails, all of the applications that use it will stop responding. In addition, if one application is heavily used, it can negatively affect the performance of the other applications in the pool.
   - **User name** and **Password** – The credentials for the application pool identity.
   - **HTTPS port** – The port on which Real-time Service receives secure HTTP requests. You can specify any available port. Verify that the port is open in Windows Firewall.
     **Caution**
     To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.
   - **TCP port** – The port on which Real-time Service receives TCP requests. You can specify any available port. Verify that the port is open in Windows Firewall.
   - **SSL certificate thumbprint** – The thumbprint for your Secure Sockets Layer (SSL) encryption certificate. You must obtain a valid, registered certificate from a provider.

14. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.

15. On the Ready to install page, click Install.

16. After the installation is completed, click Finish to close the wizard.

**Option 2: Install Real-time Service by using Windows PowerShell (AX 2012 R3)**

Use this procedure to manually install Real-time Service for AX 2012 R3 by using Windows PowerShell. To install multiple instances of Real-time Service on the same computer, you must use a manual installation. Manual installations are often performed by businesses and organizations that automate deployments by using scripts.
Extract installation files
Use Microsoft Dynamics AX Setup to extract the files that are required for manual installation.
1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. On the **Modify Microsoft Dynamics AX installation** page, click **Add or modify components**, and then click **Next**.
3. On the **Add or modify components** page, select **Real-time Service**, and then click **Next**.
4. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
5. On the **Configure Real-time Service** page, clear the **Configure Real-time Service** option.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
7. On the **Ready to install** page, click **Install**.
8. After the installation is completed, click **Finish** to close the wizard.

Configure settings in the rts-settings.xml file
After you extract the installation files by using Setup, you must configure settings in the rts-settings.xml file.
1. Open the folder where the Windows PowerShell scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Real-time Services\Tools.
2. Create a copy of the rts-settings.xml file for each instance of Real-time Service that you plan to deploy. We recommend that you not change the original file.
3. Open your copy of the rts-settings.xml file in Microsoft Visual Studio or a text editor, such as Notepad.
4. Enter a value for the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enter this value</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebAppPoolName</td>
<td>The name of the application pool that hosts the Real-time Service web application.</td>
<td>CDXRealtimeServiceAppPool</td>
</tr>
<tr>
<td>WebSiteName</td>
<td>The name of the website that hosts Real-time Service.</td>
<td>CDXRealtimeServiceWebsite</td>
</tr>
<tr>
<td>WebSiteHttpsPort</td>
<td>The port on which Real-time Service receives secure HTTP requests. You can specify any available port. Verify that the port is open in Windows Firewall.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Caution**
To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enter this value</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSiteTcpPort</td>
<td>The port on which Real-time Service receives TCP requests. You can specify any available port. Verify that the port is open in Windows Firewall.</td>
<td>None</td>
</tr>
<tr>
<td>WebApplicationName</td>
<td>The name of the web application that hosts Real-time Service.</td>
<td>None</td>
</tr>
<tr>
<td>WebAppPoolUser</td>
<td>The user name for the account that is used as the application pool identity.</td>
<td>None</td>
</tr>
<tr>
<td>WebSiteSSLCertificateThumbprint</td>
<td>The thumbprint for your SSL encryption certificate. You must obtain a valid, registered certificate from a provider.</td>
<td>None</td>
</tr>
<tr>
<td>WebSiteSSLCertificateRootStore</td>
<td>The name of the root store where the SSL certificate that is used to help secure the website is installed.</td>
<td>LocalMachine</td>
</tr>
<tr>
<td>WebSiteSSLCertificateStore</td>
<td>The name of the certificate store where the SSL certificate that is used to help secure the website is installed.</td>
<td>My</td>
</tr>
<tr>
<td>WebApplicationServiceBinarySourceFolder</td>
<td>The location where the installer copied binary components. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Real-time Services\6.3.</td>
<td>None</td>
</tr>
<tr>
<td>WebApplicationAOSServer</td>
<td>Not applicable</td>
<td>None</td>
</tr>
<tr>
<td>WebSiteWorkingFolder</td>
<td>The path of the physical folder where website files are stored.</td>
<td>None</td>
</tr>
<tr>
<td>EnableMetadataExchange</td>
<td>A value that indicates whether the WCF service returns debugging information. In a production environment, this option should be set to false.</td>
<td>false</td>
</tr>
<tr>
<td>WebApplicationWorkingFolder</td>
<td>The path of the physical folder where web application files are stored.</td>
<td>[WebSiteWorkingFolder][WebApplicationName]</td>
</tr>
</tbody>
</table>

5. Save your changes.
Run Windows PowerShell scripts to configure Real-time Service

After you configure the parameters in the rts-settings.xml file, you can run the Windows PowerShell scripts that configure Real-time Service.

Note

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to Restricted, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to RemoteSigned by using the Set-ExecutionPolicy cmdlet. This setting allows you to run scripts that you've written and scripts that have been signed by a trusted publisher.

1. On the server where you want to run the script, open Windows PowerShell to the folder where the scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Real-time Services\Tools.
   - If you're using Windows Server 2012 or a later operating system, use Windows Explorer to open the folder where the scripts are installed. Then click File > Open Windows PowerShell > Open Windows PowerShell as administrator.
   - If you're using Windows Server 2008 R2 or an earlier operating system, start Windows PowerShell as the administrator. Then, change the directory by using the following command: CD "<Path to directory>".

2. In the Windows PowerShell console, run the following command to create a credential object for the application pool identity.

   ```
   $Cred = @((New-Object System.Management.Automation.PSCredential('domain\user', (ConvertTo-SecureString 'password' -AsPlainText -Force))))
   ```

3. Run the following command to configure Real-time Service.

   ```
   .\DeployRealtimeService.ps1 -SettingsXmlFilePath .\rts-settings.xml -TopologyXmlFilePath .\rts-topology.xml -Credentials $Cred -Verbose $true
   ```

   Example:
   ```
   .\DeployRealtimeService.ps1 -SettingsXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Real-time Services\Tools\rts-settings.xml" -TopologyXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Real-time Services\Tools\rts-topology.xml" -Credentials $Cred -Verbose $true
   ```

Install Real-time Service (AX 2012 Feature Pack or AX 2012 R2)

Use this procedure to install Real-time Service for AX 2012 Feature Pack or AX 2012 R2. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select installation type page, click Custom installation, and then click Next.
5. On the Select components page, select Real-time Service, and then click Next.
6. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
7. If you are installing on a 64-bit operating system, the **Select a file location** page is displayed. Select the location in which to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.

8. On the **Select a display language** page, select the language in which to run Microsoft Dynamics AX for the first time.

   ✓ **Note**
   
   .NET Business Connector is a kind of Microsoft Dynamics AX client. Therefore, if .NET Business Connector is the first client that you install on a computer, Setup requires that you set the display language.

9. On the **Specify a location for configuration settings** page, specify whether you want .NET Business Connector to access configuration information from the registry on the local computer or from a shared configuration file. If you want to use a shared configuration file, you must enter the network location of the file. Click **Next**.

10. On the **Connect to an AOS instance** page, enter the name of the computer that runs the instance of AOS to connect to. You can optionally specify the name of the AOS instance, the TCP/IP port number, and the WSDL port for services. Click **Next**.

   ✓ **Note**
   
   If you entered information about the AOS connection for other Microsoft Dynamics AX components that are installed on this computer, this page is not displayed. Subsequent installations on the same computer reuse the existing AOS connection.

11. On the **Specify Business Connector proxy account information** page, enter the password for the proxy account that is used by .NET Business Connector. Click **Next**.

12. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

13. On the **Ready to install** page, click **Install**.

14. After the installation is completed, click **Finish** to close the wizard.

**Deploy Real-time Service (required for AX 2012 R2 only)**

After you install Real-time Service for Microsoft Dynamics AX 2012 R2, you must deploy and configure the web service.

✓ **Note**

   If you are not using AX 2012 R2, you can skip this procedure. In AX 2012 Feature Pack, Real-time Service is not a web service. In AX 2012 R3, Setup performs these steps for you.

When you install Real-time Service for AX 2012 R2 by using the Setup wizard, the following resources are installed:

- A folder that contains the binaries and configuration files for the WCF service
- A folder that contains sample Windows PowerShell scripts

Use these resources to manually deploy and configure the WCF service that is used by Real-time Service.
Request and install a server certificate for the website

Because this component uses SSL encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) When you run the script to install Real-time Service, you have to enter the thumbprint for the certificate. To view the thumbprint in IIS Manager, double-click the certificate, and then click the Details tab. We recommend that you first copy the thumbprint, paste it into a text file, and remove all spaces. Then copy the reformatted thumbprint, and paste it into Windows PowerShell.

⚠️ Caution

The beginning of the thumbprint value can contain hidden characters. You must delete these extra characters before you paste the thumbprint.

Install a certificate by using Windows PowerShell

If you have already received a certificate from your provider, or if you are migrating a certificate from a different server, the file might be in .pfx format. In this case, you can use a sample Windows PowerShell script to install the certificate.

1. Open a Windows PowerShell session that has Administrator permissions.
2. At the Windows PowerShell command prompt, run the InstallServerCertificate.ps1 script. For example, enter the following command.

   ```cmd
   & "C:\Program Files (x86)\Microsoft Dynamics AX\60\Commerce Data Exchange\Real-time Services\6.2\Sample Deployment Scripts\InstallServerCertificate.ps1"
   ```
3. When you are prompted, enter the path of the .pfx file and the private key password.

Deploy the web service by using Windows PowerShell

A sample Windows PowerShell script is provided to help you deploy the WCF service for Real-time Service.

1. Open a Windows PowerShell session that has Administrator permissions.
2. At the Windows PowerShell command prompt, run the InstallCommerceDataExchangeRealtimeService.ps1 script. For example, enter the following command.

   ```cmd
   & "C:\Program Files (x86)\Microsoft Dynamics AX\60\Commerce Data Exchange\Real-time Services\6.2\Sample Deployment Scripts\InstallCommerceDataExchangeRealtimeService.ps1"
   ```
3. When you are prompted, enter the following information:
   - **User account** – The user account to run the service as. Enter the user account in the following format: domain\user. This user account must be a Microsoft Dynamics AX user who has the appropriate permissions.
   - **Password** – The password for the user account.
   - **Service binary source folder path** – The location of the .dll files for Real-time Service. By default, the path is "C:\Program Files (x86)\Microsoft Dynamics AX\60\Commerce Data Exchange\Real-time Services\6.2\". The .dll files are copied to the website that is created.

   **Tip**

   Do not include the bin subfolder in the path.

   - **Server certificate thumbprint** – The thumbprint of the certificate that is installed on the IIS server. Enter only the characters that are included in the thumbprint value. Omit all spaces.

     To obtain the thumbprint, in IIS Manager, double-click **IIS**, and then click **Server Certificates**. Double-click the certificate, and then select **Details**.
Test and troubleshoot Real-time Service

For more information about how to configure, test, and troubleshoot the installation of Real-time Service, see the following posts on the AX Support Blog:

- AX for Retail 2012 R2: Installing the Real-time Service
- AX for Retail 2012 R2: Troubleshooting the Real-time Service

After you install and deploy Real-time Service

Next, set up profiles for Real-time Service, and assign the profiles to channels. For more information, see Set up a Real-time Service profile on TechNet.

Install Commerce Data Exchange: Async Server

**Applies to:** Microsoft Dynamics AX 2012 R3

Commerce Data Exchange: Async Server is part of the asynchronous system that shares data between the Microsoft Dynamics AX database and channel databases. Async Server is installed at headquarters and communicates with Microsoft Dynamics AX. In addition to Async Server, Commerce Data Exchange includes Commerce Data Exchange: Async Client, which is installed at channels and communicates with the channel database.

When you install Async Server, the Retail Salt Utility is also installed. The Retail Salt Utility provides extra encryption for the passwords and credentials that are associated with the Microsoft Dynamics AX 2012 for Retail system.

**Note**

Async Server is available only with Microsoft Dynamics AX 2012 R3.

To deploy Async Server on multiple computers in a cluster, you can run Setup on each computer. Alternatively, you can use the Retail mass deployment toolkit to deploy Async Server from a central location. For information about how to set up an Internet Information Services (IIS) cluster, see the Network Load Balancing Deployment Guide on TechNet. For information about how to use the mass deployment toolkit, see Mass deploy Retail components by using System Center Configuration Manager on TechNet.

Before you install Async Server

- Determine how many instances of Async Server you want to install, and on which computers.
  
  In a basic deployment of Retail, one instance of Async Server is installed at headquarters. Operations in a large organization might scale more efficiently if you install multiple Async Server instances, either on a single server or on multiple servers. For more information, see the Deployment topologies for Retail section.

  **Caution**

  Although a single instance of Async Server can manage all communications for the organization, excessive load or network latency might decrease performance.

- Select a service account to run the application pool for Async Server. For information about the requirements for this account, see the Create service accounts section.

- Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate
in IIS.) When you run Setup, you will need to enter the thumbprint for the certificate. To view the thumbprint in IIS Manager, double-click the certificate and click the Details tab.

If you deploy Async Server with a self-signed certificate, this certificate must be trusted by the computer running the corresponding Async Client component.

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

- The SQLCMD utility is required to install Async Server. This utility is typically installed with Microsoft SQL Server. If a version of SQL Server is not installed on the computer where you install Async Server, you can download and install Microsoft Command Line Utilities 11 for SQL Server to meet this requirement.

**Option 1: Install Async Server by using Setup**

Use this procedure to install Async Server by using the Setup wizard. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Async Server, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Configure Async Server page, select the check box to configure Async Server by using Setup. If you clear this check box, the application files are installed, but Async Server is not configured.

If you’re configuring Async Server, enter the following information:

- **Application name** – The name of the web application that hosts Async Server.
- **App pool name** – The name of the application pool that the web application runs under.

  We recommend that you specify separate application pools if multiple Retail components are installed on the same computer. Multiple web applications can share an application pool if resources on the computer are limited. However, if the shared application pool fails, all of the applications that use it will stop responding. In addition, if one application is heavily used, it can negatively affect the performance of the other applications in the pool.

- **Website name** – The name of the website that Async Server runs on.
- **User name** and **Password**– The credentials for the application pool identity.
- **HTTPS port** – The port on which Async Server receives HTTPS requests. You can specify any available port. Verify that the port is open in Windows Firewall, and record the port number. The port is used to create the URL for Async Server in the following format: `https://<server name>:port/<web application name>`. This URL is required when you configure instances of Async Client that connect to this instance of Async Server.

  **Caution**
  To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.

- **TCP port (optional)** – The port on which Async Server receives TCP requests. Specify a TCP port if your environment uses high-performance data synchronization. You can specify any available port. Verify that the port is open in Windows Firewall.

- **AOS service user** – The user account that the instance of Microsoft Dynamics AX Application Object Server (AOS) runs as.

- **SSL certificate thumbprint** – The thumbprint for the Secure Sockets Layer (SSL) encryption certificate. You must obtain a valid, registered certificate from a provider.

9. On the **Select a database to use with Async Server** page, create a new message database for Async Server. If you install a subsequent instance of Async Server for load balancing, you must select the same message database.

  **Note**
  You must set up a separate message database for each partition in Microsoft Dynamics AX.

10. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

11. On the **Ready to install** page, click **Install**.

12. After the installation is completed, click **Finish** to close the wizard.

### Option 2: Install Async Server by using Windows PowerShell

Use this procedure to install Async Server manually by using Windows PowerShell. To install multiple instances of Async Server on the same computer, you must use a manual installation. Manual installations are often performed by businesses and organizations that automate deployments by using scripts.

**Extract installation files**

Use Microsoft Dynamics AX Setup to extract the files that are required for manual installation.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.

2. On the **Modify Microsoft Dynamics AX installation** page, click **Add or modify components**, and then click **Next**.

3. On the **Add or modify components** page, select **Async Server**, and then click **Next**.

4. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

5. On the **Configure Async Server** page, clear the **Configure Async Server** option.

6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
7. On the **Ready to install** page, click **Install**.
8. After the installation is completed, click **Finish** to close the wizard.

**Configure settings in the ss-settings.xml file**

After you extract the installation files by using Setup, you must configure settings in the ss-settings.xml file.

1. Open the folder where the Windows PowerShell scripts are installed. By default, the files are located at `C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Server\Tools`.
2. Create a copy of the ss-settings.xml file for each instance of Async Server that you plan to deploy. We recommend that you not change the original file.
3. Open your copy of the ss-settings.xml file for each instance of Async Server that you plan to deploy. We recommend that you not change the original file.
4. Enter a value for the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enter this value</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HQMessageDatabaseServerName</td>
<td>The name of the server that hosts the message database for Async Server. The script is case sensitive. For example, enter <code>value=&quot;DatabaseServer&quot;</code> /&gt;</td>
<td>None</td>
</tr>
<tr>
<td>HQMessageDatabaseServerNamedInstanceName</td>
<td>The name of the Microsoft SQL Server instance that hosts the message database. The format for a SQL Server instance name is either the server name or the full instance name. For example, valid formats are <code>localhost</code>, <code>localhost\instance2</code>, <code>server1</code>, and <code>server1\instance2</code>.</td>
<td>None</td>
</tr>
<tr>
<td>HQMessageDatabase</td>
<td>The name of the message database.</td>
<td>None</td>
</tr>
<tr>
<td>HQMessageDatabaseServerOverride</td>
<td>(Optional) The name of the database server that is used to connect to the message database. By default, the computer name that was used to deploy the database is used.</td>
<td>[HQMessageDatabaseServerName]</td>
</tr>
<tr>
<td>WebSiteName</td>
<td>The name of the website that hosts Async Server.</td>
<td>AsyncServerSite</td>
</tr>
<tr>
<td>AppPoolName</td>
<td>The name of the application pool for the Async Server web application.</td>
<td>AsyncServer</td>
</tr>
<tr>
<td>AppPoolUser</td>
<td>The credentials for the application pool identity.</td>
<td>None</td>
</tr>
<tr>
<td>AOSServiceUser</td>
<td>The user account that the AOS instance runs as.</td>
<td>NT Authority\Network Service</td>
</tr>
<tr>
<td>WebApplicationName</td>
<td>The name of the web application that hosts Async Server.</td>
<td>AsyncServer</td>
</tr>
<tr>
<td>Parameter</td>
<td>Enter this value</td>
<td>Default value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>WebApplicationServiceBinarySourceFolder</td>
<td>The location where the installer copied binary components. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Server\6.3.</td>
<td>None</td>
</tr>
<tr>
<td>WebSiteHttpsPort</td>
<td>The port on which Async Server receives HTTPS requests.</td>
<td>None</td>
</tr>
<tr>
<td>WebSiteTcpPort</td>
<td>The port on which Async Server receives TCP requests. Specify a TCP port if your environment uses high-performance data synchronization.</td>
<td>808</td>
</tr>
<tr>
<td>WebSiteSSLCertificateThumbprint</td>
<td>The thumbprint for the SSL encryption certificate. You must obtain a valid, registered certificate from a provider.</td>
<td>None</td>
</tr>
<tr>
<td>WebSiteSSLCertificateRootStore</td>
<td>The name of the root store where the SSL certificate that is used to help secure the website is installed.</td>
<td>LocalMachine</td>
</tr>
<tr>
<td>WebSiteSSLCertificateStore</td>
<td>Enter the name of the certificate store where the SSL certificate that is used to help secure the website is installed.</td>
<td>My</td>
</tr>
<tr>
<td>WebSiteWorkingFolder</td>
<td>The path of the physical folder where website files are stored.</td>
<td>%SystemDrive%\inetpub\AsyncServerSite</td>
</tr>
<tr>
<td>WebApplicationWorkingFolder</td>
<td>The path of the physical folder where web application files are stored.</td>
<td>[WebSiteWorkingFolder][WebApplicationName]</td>
</tr>
</tbody>
</table>

5. Save your changes.

**Run Windows PowerShell scripts to configure Async Server**

After you configure the parameters in the ss-settings.xml file, you can run the Windows PowerShell scripts that configure Async Server.

**Note**

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to **Restricted**, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to **RemoteSigned** by using the `Set-ExecutionPolicy` cmdlet. This setting allows you to run scripts that you’ve written and scripts that have been signed by a trusted publisher.
1. On the server where you want to run the script, open Windows PowerShell to the folder where the scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Server\Tools.
   - If you’re using Windows Server 2012 or a later operating system, use Windows Explorer to open the folder where the scripts are installed. Then click File > Open Windows PowerShell > Open Windows PowerShell as administrator.
   - If you’re using Windows Server 2008 R2 or an earlier operating system, start Windows PowerShell as the administrator. Then change the directory by using the following command: CD "<Path to directory>".
2. In the Windows PowerShell console, run the following command to create a secure credential object for the application pool identity.
   ```powershell
   $Cred = @((New-Object System.Management.Automation.PSCredential('domain\user', (ConvertTo-SecureString 'password' -AsPlainText -Force)))
   ```
3. Run the following command to deploy Async Server.
   ```powershell
   .\DeployAsyncServer.ps1 -TopologyXmlFilePath $topologyFileName -SettingsXmlFilePath $updatedSettingsFileName -Credentials $Cred
   ``
   Example:
   ```powershell
   .\DeployAsyncServer.ps1 -SettingsXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Server\Tools\ss-settings.xml" -TopologyXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Server\Tools\ss-topology.xml" -Credentials $Cred -Verbose $true
   ```

After you install Async Server
After you install Async Server, you must complete the following tasks.
- Set message database information in the Retail scheduler parameters form. Then click the Sync metadata button. For more information, see Enter parameters for Retail Scheduler on TechNet.
- Create a scheduler profile for Async Server. For more information, see Set up a profile for Async Server on TechNet.
- Set up working folders. For more information, see Specify working folders for Commerce Data Exchange on TechNet.

Install Commerce Data Exchange: Async Client

Apply to: Microsoft Dynamics AX 2012 R3

Commerce Data Exchange: Async Client is part of the asynchronous system that shares data between the Microsoft Dynamics AX database and channel databases. Async Client is installed at the channel and communicates with the channel database. In addition to Async Client, Commerce Data Exchange includes Commerce Data Exchange: Async Server. Async Server is installed at headquarters and communicates with the Microsoft Dynamics AX database.

When you install Async Client, the Retail Salt Utility is also installed. The Retail Salt Utility provides extra encryption for the passwords and credentials that are associated with the Microsoft Dynamics AX 2012 for Retail system. The Async Client Configuration Tool is also installed together with Async Client. This tool lets you test connections and specify whether to use streaming. The streaming option is ideal for initial high-speed data synchronization.
However, for ongoing synchronization, the non-streaming option is more reliable. For more information, see Configure settings for Async Client on TechNet.

**Note**

Async Client is available only with Microsoft Dynamics AX 2012 R3.

To deploy Async Client on multiple computers in an environment, you can use the Retail mass deployment toolkit to deploy Async Client from a central location. For more information, see Mass deploy Retail components by using System Center Configuration Manager on TechNet.

**Before you install Async Client**

- Determine how many instances of Async Client you want to install, and on which computers.
  
  In a basic deployment of Retail, one instance of Async Client is installed for each channel database. If you want to install more than one instance of Async Client on a single computer, you must run the Windows PowerShell installation scripts manually for subsequent installations. For more information, see the Option 2: Install Async Client by using Windows PowerShell section.

- Select a service account for Async Client. For information about the requirements for service accounts, see the Create service accounts section.

- Create the channel database that will be used with this instance of Async Client. When you install a channel database, the groups that have permissions on the database are created. During the Async Client installation, the service user is added to this group. For more information, see the Install a retail channel database section.

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

- The SQLCMD utility is required to install Async Client. This utility is typically installed with Microsoft SQL Server. If a version of SQL Server is not installed on the computer where you install Async Client, you can download and install Microsoft Command Line Utilities 11 for SQL Server to meet this requirement.

**Option 1: Install Async Client by using Setup**

Use this procedure to install Async Client by using the Setup wizard. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.

2. Advance through the first wizard pages.

3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.

4. On the **Select an installation option** page, click **Microsoft Dynamics AX**.

5. On the **Select installation type** page, click **Custom installation**, and then click **Next**.

6. On the **Select components** page, select **Async Client**, and then click **Next**.

7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.
8. On the **Configure Async Client** page, select the check box to configure Async Client by using Setup. If you clear this check box, the application files are installed, but Async Client is not configured.

If you’re configuring Async Client, enter the following information:

- **Async Server URL** – The URL for the instance of Async Server. Typically, the URL is in the format https://<server name>:port/<web application name>.
  
  If Async Server is installed in a cluster that has a load balancer, enter the URL to the service on the load balancer.

- **Channel database ID** – The identifier in Microsoft Dynamics AX for the channel database that is used by the selected instance of Async Client.

- **User name** and **Password** (Async Server connection) – The credentials for the user that connects to Async Server. These credentials must match the credentials that are specified in the channel database profile. Credentials are case sensitive. The credentials are used to identify and authenticate Async Client.

- **User name** and **Password** (Async Client) – The credentials for the user that runs the Windows service for Async Client. The user does not have to be a domain account. The user can be a member of a workgroup on the local computer. Credentials are case sensitive.

Optionally, click **Test connection** to verify that Async Client is configured correctly. For information about how to troubleshoot errors that you might encounter, see [Troubleshoot issues in Async Server or Async Client](#) on TechNet.

Click **Next**.

9. On the **Select or specify a database to use with Async Client** page, enter server and database information for the message database and the channel database that will be used by Async Client. Then click **Next**.

You can connect to an existing channel database only. Setup does not create a new channel database if you enter a channel database name that doesn’t exist. If you specify a message database name that doesn’t exist, Setup creates a new message database.

10. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

11. On the **Ready to install** page, click **Install**.

12. After the installation is completed, click **Finish** to close the wizard.

### Option 2: Install Async Client by using Windows PowerShell

Use this procedure to install Async Client manually by using Windows PowerShell. To install multiple instances of Async Client on the same computer, you must use a manual installation. Manual installations are often performed by businesses and organizations that automate deployments by using scripts.

**Extract installation files**

Use Microsoft Dynamics AX Setup to extract the files that are required for manual installation.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
3. On the **Select components** page, select **Async Client**, and then click **Next**.
4. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
5. On the **Configure Async Client** page, clear the **Configure Async Client** option.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

7. On the **Ready to install** page, click **Install**.

8. After the installation is completed, click **Finish** to close the wizard.

---

**Configure settings in the sc-settings.xml file**

After you extract the installation files by using Setup, you must configure settings in the sc-settings.xml file.

1. Open the folder where the Windows PowerShell scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Client\Tools.

2. Create a copy of the sc-settings.xml file for each instance of Async Client that you plan to deploy. We recommend that you not change the original file.

3. Open your copy of the sc-settings.xml file in Microsoft Visual Studio or a text editor, such as Notepad.

4. Enter a value for the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enter this value</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChannelMessageDatabaseServer</td>
<td>The name of the server that hosts the message database. The script is case sensitive. For example, enter value=&quot;DatabaseServer&quot; /&gt;.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelMessageDatabaseServerNamedInstanceName</td>
<td>The name of the Microsoft SQL Server instance that hosts the message database. The format for a SQL Server instance name is either the server name or the full instance name. For example, valid formats are localhost, localhost\instance2, server1, and server1\instance2.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelMessageDatabaseName</td>
<td>The name of the message database.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelDatabaseServer</td>
<td>The name of the server that hosts the channel database.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelDatabaseServerNamedInstanceName</td>
<td>The name of the SQL Server instance that hosts the channel database. The format for a SQL Server instance name is either the server name or the full instance name. For example, valid formats are localhost, localhost\instance2, server1, and server1\instance2.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelDatabaseName</td>
<td>The name of the channel database.</td>
<td>None</td>
</tr>
<tr>
<td>ServiceName</td>
<td>The name that is displayed for the service in the <strong>Services</strong> control panel item.</td>
<td>CommerceDataExchangeAsyncClientService</td>
</tr>
<tr>
<td>Parameter</td>
<td>Enter this value</td>
<td>Default value</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>SynchServiceHeadOfficeURL</td>
<td>The URL for the instance of Async Server. Typically, the URL is in the format https://&lt;server name&gt;:port/&lt;web application name&gt;.</td>
<td>None</td>
</tr>
<tr>
<td>ServiceUser</td>
<td>The account that will be used to run the Async Client service. Enter the account in the form value=&quot;Domain or Computer Name\User&quot;.</td>
<td>None</td>
</tr>
<tr>
<td>ServiceBinarySourceFolder</td>
<td>The folder where the .dll files for Async Client are installed. By default, the folder is located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Client\Package.</td>
<td>None</td>
</tr>
<tr>
<td>ServiceInstallFolder</td>
<td>The folder where Async Client files will be installed.</td>
<td>%SystemDrive%\AsyncClientService</td>
</tr>
<tr>
<td>DataStoreName</td>
<td>The channel database ID in Microsoft Dynamics AX for the channel database that is used by the selected instance of Async Client. To find or set the channel database name, use the Channel database form in Microsoft Dynamics AX. (Click Retail &gt; Setup &gt; Retail scheduler &gt; Channel integration &gt; Channel database.)</td>
<td>None</td>
</tr>
<tr>
<td>DataStoreUserName</td>
<td>The user name that Async Client uses to connect to Async Server. To find or set the user name, use the Channel database form in Microsoft Dynamics AX. (Click Retail &gt; Setup &gt; Retail scheduler &gt; Channel integration &gt; Channel database.) Credentials are case sensitive.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelMessageDatabaseServerOverride</td>
<td>The name of the channel database server, if the name differs from what was specified.</td>
<td>[ChannelMessageDatabaseServer]</td>
</tr>
</tbody>
</table>

5. Save your changes.
Run Windows PowerShell scripts to configure Async Client

After you configure the parameters in the sc-settings.xml file, you can run the Windows PowerShell scripts that configure Async Client.

**Note**

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to **Restricted**, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to **RemoteSigned** by using the `Set-ExecutionPolicy` cmdlet. This setting allows you to run scripts that you’ve written and scripts that have been signed by a trusted publisher.

1. On the server where you want to run the script, open Windows PowerShell to the folder where the scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Client\Tools.
   - If you’re using Windows Server 2012 or a later operating system, use Windows Explorer to open the folder where the scripts are installed. Then click **File > Open Windows PowerShell > Open Windows PowerShell as administrator**.
   - If you’re using Windows Server 2008 R2 or an earlier operating system, start Windows PowerShell as the administrator. Then, change the directory by using the following command: `CD "<Path to directory>"`.

2. In the Windows PowerShell console, run the following command to create a Windows PowerShell credential object on the local computer for the application pool identity.
   ```powershell
   $Cred = @((New-Object System.Management.Automation.PSCredential('domain\username', (ConvertTo-SecureString 'password' -AsPlainText -Force)))
   ``
   For more information about how to create credential objects, see Create Windows PowerShell Scripts that Accept Credentials on Microsoft.com.

3. Run the following command to create a credential object for the account that is used to connect to Async Server.
   ```powershell
   $Cred += @((New-Object System.Management.Automation.PSCredential('domain\username', (ConvertTo-SecureString 'password' -AsPlainText -Force)))
   ``

4. Run the following command to deploy Async Client.
   ```powershell
   .\DeployAsyncClient.ps1 -SettingsXmlFilePath <path> -TopologyXmlFilePath <path> -Credentials $Cred -Verbose $true
   ``
   Example:
   ```powershell
   .\DeployAsyncClient.ps1 -SettingsXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Client\Tools\sc-settings.xml" -TopologyXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\CDX\Async Client\Tools\sc-topology.xml" -Credentials $Cred -Verbose $true
   ```

After you install Async Client

1. Use the Async Client Configuration Tool to test the connections to Async Server, the channel database, and the channel message database. You can also use the utility to set advanced options. For more information, see Configure settings for Async Client on TechNet.

2. After you have determined that all connections are working, run the distribution schedule that sends data to each channel database. Click **Retail > Setup > Retail scheduler > Channel integration > Channel database**. Click **Full data sync**, and then select the **Full sync** distribution schedule.
Install the Retail Channel Configuration Utility (Retail Store Database Utility)

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

Install the Retail Channel Configuration Utility on computers where you must create a channel database or configure a Retail POS connection to a channel database. A channel database may be created either on a stand-alone database server or on a POS computer.

This section explains how to install the Retail Channel Configuration Utility by using the Setup wizard.

**Note**

Retail components are available only with Microsoft Dynamics AX 2012 R3, AX 2012 R2, and AX 2012 Feature Pack. In AX 2012 R2 and AX 2012 Feature Pack, Retail Channel Configuration Utility was called Retail Store Database Utility.

The Retail Channel Configuration Utility can be used to complete the following tasks:

- Configure Retail POS and Offline Sync Service
- Create a channel database
- Create or re-provision an offline database

Before you install the Retail Channel Configuration Utility

On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install the Retail Channel Configuration Utility (AX 2012 R3)

Use this procedure to install the Retail Channel Configuration Utility for AX 2012 R3. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select an installation option page, click Microsoft Dynamics AX, and then click Next.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Retail Channel Configuration Utility, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Ready to install page, click Install.
9. After the installation is completed, click Finish to close the wizard.
Install the Retail Store Database Utility (AX 2012 Feature Pack and AX 2012 R2)

Use this procedure to install the Retail Store Database Utility for AX 2012 Feature Pack or AX 2012 R2. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select installation type page, click Custom installation, and then click Next.
5. On the Select components page, select Retail Store Database Utility, and then click Next.
6. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
7. On the Configure Retail store databases and POS page, select the check box if you want to create store databases and associate them with a POS system.
   - To create a store database, enter the name of the server where you want to create the database, and then enter a name for the new database.
     When creating a shared store database, do not enter anything in the Offline database name or Offline server name fields. After you have created the shared store database, you can open the Retail Store Database Utility to designate this database as an offline database, but you cannot perform both actions at the same time.
   - To create an offline database, enter the name of the server where you want to create the database, and then enter a name for the new database.
   - Enter POS identification information.
     **Important**
     Dummy values are required in the Identification fields because of a known issue.
     - In the Store ID field, type the ID of the store that the POS terminal is associated with. The store record does not need to be created before you complete this step. However, the ID must match later when the record is created and the profile is linked.
     - In the Terminal ID field, type a unique ID for the POS terminal. The terminal ID that you enter must be listed in the POS terminals form.
     - In the Company field, type the applicable company code.
8. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
10. After the installation is completed, click Finish to close the wizard.
After you install the Retail Channel Configuration Utility

For information about how to use the Retail Channel Configuration Utility, see the following topics on TechNet:

- Create a channel database or an offline database (AX 2012 R3)
- Create a store database or an offline database (AX 2012 R2 and AX 2012 Feature Pack)
- Configure database connections for a POS register

Install Retail Server

Applies to: Microsoft Dynamics AX 2012 R3

Retail Server provides services and business logic for Retail Modern POS (point of sale) clients. To deploy Retail Server on multiple computers in a cluster, you can run Setup on each computer or you can manually copy the web application to each computer. Alternatively, you can use Retail mass deployment toolkit with System Center Configuration Manager to deploy Retail Server from a central location. For more information, see Mass deploy Retail components by using System Center Configuration Manager on TechNet.

Note
Retail Server is available only with Microsoft Dynamics AX 2012 R3.

Before you install Retail Server

- Be aware that you do not have to install Retail Server in a domain. You can install it as part of a work group on a single computer.
- Create a service account. This service account is used for the identity of the application pool for Retail Server. This account does not have to be a domain account. It can be a work group account. For more information, see the Create service accounts section.
- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.
- Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) When you run Setup, you will need to enter the thumbprint for the certificate. To view the thumbprint in IIS Manager, double-click the certificate and click the Details tab.

Option 1: Install Retail Server by using Setup

Use this procedure to install Retail Server. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select installation type page, click Custom installation, and then click Next.
5. On the **Select components** page, select **Retail Server**, and then click **Next**.

6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

7. On the **Configure Retail Server** page, enter the following information about the website where Retail Server will run.

   - **Configure Retail Server** – On the **Configure Retail Server** page, select the check box to configure Retail Server by using Setup. If you clear this option, the application files are installed, but Retail Server is not configured. If you’re configuring Retail Server, enter the following information:

   - **Application name** – The name of an existing web application in your server environment or the name of an application that you want Setup to create.

   - **Website name** – The name of an existing website in your server environment or the name of a site that you want Setup to create.

   - **App pool name** – The name of an existing web application pool in your server environment or the name of an application pool that you want Setup to create.

   - **User name** and **Password** – The credentials for the application pool identity. The user does not have to be a domain account. It can be a member of a work group on the local computer.

   - **HTTP port** and **HTTPS port** – You can specify any available ports. Verify that these ports are open in Windows firewall. Also, make a note of these port numbers. The port is used to create the URL for Retail Server in the format: https://<ServerName>:Port/<WebApplicationName>. This URL is required to activate Retail Modern POS devices that connect to Retail Server.

     **Caution**
     
     To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.

   - **SSL certificate thumbprint** – The thumbprint for your Secure Sockets Layer (SSL) encryption certificate.

8. On the **Select a database to use with Retail Server** page, select an existing database. To create a new channel database you must install the Retail channel database component.

9. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

10. On the **Ready to install** page, click **Install**.

11. After the installation is completed, click **Finish** to close the wizard.

**Option 2: Install Retail Server by using Windows PowerShell**

Use this procedure to install Retail Server manually by using Windows PowerShell. Manual installations are often performed by businesses and organizations that automate deployments by using scripts.

**Extract installation files**

Use Microsoft Dynamics AX Setup to extract the files that are needed for manual installation.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.

2. On the **Select installation type** page, click **Custom installation**, and then click **Next**.

3. On the **Select components** page, select **Retail Server**, and then click **Next**.

4. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
5. On the **Configure Retail Server** page, clear the **Configure Retail Server** option.

6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.

7. On the **Ready to install** page, click **Install**.

8. After the installation is completed, click **Finish** to close the wizard.

### Configure settings in the rs-settings.xml file

After you extract the installation files by using Setup, you must configure settings in the rs-settings.xml file.

1. Open the folder where the installation files are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Server\Tools.

2. Create a copy of the rs-settings.xml file. We recommend that you do not change the original file.

3. Open the rs-settings.xml file in Microsoft Visual Studio or a text editor, such as Notepad.

4. Enter a value for the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What to enter</th>
<th>Default value</th>
</tr>
</thead>
</table>
| ChannelDatabaseServerName     | The name of the server that hosts the channel database. The script is case-sensitive. For example, `value="DatabaseServer" />
<p>|                               | None                                                                         |
| ChannelDatabaseServerNamedInstanceName | The name of the SQL Server instance that hosts the channel database. The format for a SQL Server instance name is either the server name or the full instance name. For example, valid names are &quot;localhost&quot;, &quot;localhost\instance2&quot;, &quot;server1&quot;, and &quot;server1\instance2&quot;. | None                   |
| ChannelDatabaseName           | The name of the channel database.                                            | None                   |
| RetailServerWebAppPoolName    | The name of an existing web application or the name of an application that you want Setup to create. | RetailServerAppPool    |
| RetailServerWebSiteName       | The name of an existing website or the name of a site that you want Setup to create. | RetailServerWebsite    |
| RetailServerWebSiteHttpPort   | You can specify any available port. Verify that the port is open in Windows firewall. Also, note the port number. The port is used to create the URL for Retail Server in the format: https://&lt;server name&gt;:port/&lt;web application name&gt;. This URL is required to activate Retail Modern POS devices that connect to Retail Server. | None                   |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>What to enter</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RetailServerWebSiteHttpsPort</td>
<td>You can specify any available port. Verify that the port is open in Windows firewall. Also, note the port number. The port is used to create the URL for Retail Server in the format: https://&lt;servername&gt;:port/&lt;web application name&gt;. This URL is required to activate Retail Modern POS devices that connect to Retail Server.</td>
<td>None</td>
</tr>
<tr>
<td>RetailServerWebApplicationName</td>
<td>The name of an existing web application or the name of an application that you want Setup to create.</td>
<td>RetailServer</td>
</tr>
<tr>
<td>RetailServerWebSiteSSLCertificateStore</td>
<td>The Certificates store specified when the certificate was created or imported.</td>
<td>My</td>
</tr>
<tr>
<td>RetailServerWebSiteSSLCertificateRootStore</td>
<td>The server where the certificate is stored.</td>
<td>LocalMachine</td>
</tr>
<tr>
<td>RetailServerWebSiteWorkingFolder</td>
<td>The folder where you want Windows PowerShell to create a new IIS virtual directory.</td>
<td>%SystemDrive%\inetpub\wwwroot</td>
</tr>
<tr>
<td>RetailServerWebAppPoolUser</td>
<td>Enter a domain account for the application pool. Enter the account in the form value=&quot;Domain\User&quot;.</td>
<td>None</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| RetailServerWebSiteSSLCertificateThumbprint   | The thumbprint for your Secure Sockets Layer (SSL) encryption certificate. You must obtain a valid, registered certificate from a provider. Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) You will need to paste the thumbprint for the certificate into the settings file. To view the thumbprint in IIS Manager, double-click the certificate and click the Details tab. We recommend that you paste the thumbprint into a text file and remove all spaces before you paste it into the settings file. **Caution**  
A thumbprint can contain hidden characters at the beginning of the thumbprint value. You must delete these extra characters before you paste the thumbprint into the settings file. | None          |
| RetailServerWebApplicationServiceBinarySourceFolder | This folder contains required files for deploying Retail Server. By default, this folder is: C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Server\Package folder | None          |
| RetailServerWebApplicationWorkingFolder       | The folder from where the web service will run. You can specify the RetailServerWebApplicationServiceBinarySourceFolder or any available folder.                                                                                                                                                                                                                                                                                    | [RetailServerWebSiteWorkingFolder]\[RetailServerWebApplicationName] |
### RetailServerAllowAnonymousMetadata Parameter

This setting controls OData $metadata accessibility for anonymous users.

**Default value:** False

**Description:**
- In a developer environment, we recommend setting this parameter to true. Setting this to true enables the system to reference the OData $metadata service to generate client proxy code.
- In a production environment, this setting should be false.

### RetailServerRequireSSL Parameter

This option can be used to bypass the SSL requirement in a demonstration environment. In a production environment, you must set the option to true and specify values for the other SSL properties in the configuration file.

**Default value:** True

**Description:**
- If you deployed Retail Server in a web farm with a load balancer, you must specify a machine key to ensure that client connections retain session. For more information, see [WIF and Web Farms](https://microsoft.com) on Microsoft.com.

---

5. Save your changes.

**Important**

If you deployed Retail Server in a web farm with a load balancer, you must specify a machine key to ensure that client connections retain session. For more information, see [WIF and Web Farms](https://microsoft.com) on Microsoft.com.

### Run Windows PowerShell scripts to deploy and configure Retail Server

After you configure the parameters in the rs-settings.xml file, you can run the Windows PowerShell scripts that deploy and configure Retail Server.

1. On the server where you want to run the script, open the folder where the Windows PowerShell scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\RetailServer\Tools

2. If you're using Windows Server 2012 or a later operating system, use Windows Explorer to open the folder where the scripts are installed. Then click **File > Open Windows PowerShell > Open Windows PowerShell as administrator**.

   If you're using Windows Server 2008 R2 or an earlier operating system, start Windows PowerShell as the administrator. Then, change the directory by using the following command: `CD "<Path to directory>"`.

3. In the Windows PowerShell console, run the following command to create a credential object in Active Directory for the service account. Replace ‘domain\useraccount’ and ‘password’ with credentials that have permission to create sites in IIS:

   ```powershell
   $Cred = @((New-Object System.Management.Automation.PSCredential('domain\useraccount',(ConvertTo-SecureString 'password' -AsPlainText -Force))))
   ```

4. Run the following command to deploy and configure Retail Server:

   ```powershell
   .\DeployRetailServer.ps1 -SettingsXmlFilepath .\rs-settings.xml -TopologyXmlFilepath .\rs-topology.xml -Credentials $Cred -Verbose $true
   ```
For example:

`.\DeployRetailServer.ps1 -SettingsXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\RetailServer\Tools\rs-settings.xml" -TopologyXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\RetailServer\Tools\rs-topology.xml" -Credentials $Cred -Verbose $true`

### After you install Retail Server

You must create a channel profile and a channel database profile for Retail Server in the Microsoft Dynamics AX client. For more information, see [Set up a channel profile](#) and [Set up a channel database profile](#) on TechNet.

After you create the channel and channel database profiles, you can verify Retail Server configurations by opening a store in the **Retail channels > Retail stores** form. In the **Profiles** section, verify that the **Channel profile** and the **Live channel database** fields display the correct channel profile values.

After Retail Server is deployed and configured, you can deploy Microsoft Dynamics AX Retail Modern POS on supported clients. For more information, see the [Install Retail Modern POS](#) section.

**See also**

- [Install Retail Hardware Station](#)

### Install Retail Hardware Station

**Applies to:** Microsoft Dynamics AX 2012 R3

Microsoft Dynamics AX Retail Hardware Station provides services for Microsoft Dynamics AX Retail Retail Modern POS (point of sale) clients and peripherals such as printers, cash drawers, or payment devices that enable these devices to communicate with Microsoft Dynamics AX Retail Server. This section includes information about how to install and configure Hardware Station.

**Note**

Hardware Station is available only with Microsoft Dynamics AX 2012 R3.

### Before you begin

- Be aware that you do not have to install Hardware Station in a domain. You can install it as part of a work group on a single computer.

- Create a service account. This service account is used for the identity of the application pool for Hardware Station. This account does not have to be a domain account. It can be a work group account. For more information, see the [Create service accounts](#) section.

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](#) on Microsoft.com.

- Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) When you run Setup, you will need to enter the thumbprint for the certificate. To view the thumbprint in IIS Manager, double-click the certificate and click the **Details** tab.
Option 1: Install Hardware Station by using Setup

Use this procedure to install Hardware Station. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
5. On the **Select components** page, select **Retail Hardware Station**, and then click **Next**.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
7. On the **Configure Retail Hardware Station** page, enter the following information about the website where Hardware Station will run.
   - **Configure Hardware Station**: On the **Configure Hardware Station** page, select the check box to configure Hardware Station by using Setup. If you clear this option, the application files are installed, but Hardware Station is not configured. If you’re configuring Hardware Station, enter the following information:
     - **Application name** – The name of an existing web application or the name of an application that you want Setup to create.
     - **Website name** – The name of an existing website or the name of a site that you want Setup to create.
     - **App pool name** – The name of an existing web application pool in your server environment or the name of an application pool that you want Setup to create.
     - **User name** and **Password** – The credentials for the application pool identity. The user does not have to be a domain account. It can be a member of a work group on the local computer.
     - **HTTP port** and **HTTPS port** – You can specify any available ports. Verify that these ports are open in Windows firewall.
     - **SSL certificate thumbprint** – The thumbprint for your Secure Sockets Layer (SSL) encryption certificate.
     - **Retail Server URL** – The URL specified when Retail Server was installed. By default, the URL is created by using the following parameters:
       https://<Fully Qualified Server Name>:Port/<WebApplicationName>/v1
   8. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
9. On the **Ready to install** page, click **Install**.
10. After the installation is completed, click **Finish** to close the wizard.
Option 2: Install Hardware Station by using Windows PowerShell

Use this procedure to install Hardware Station manually by using Windows PowerShell. Manual installations are often performed by businesses and organizations that automate deployments by using scripts.

Extract installation files

Use Microsoft Dynamics AX Setup to extract the files that are needed for manual installation.

2. On the Select installation type page, click Custom installation, and then click Next.
3. On the Select components page, select Retail Hardware Station, and then click Next.
4. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
5. On the Configure Retail Hardware Station page, clear the Configure Retail Server option.
6. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
7. On the Ready to install page, click Install.
8. After the installation is completed, click Finish to close the wizard.

Configure settings in the hs-settings.xml file

After you extract the installation files by using Setup, you must configure settings in the hs-settings.xml file.

1. Open the folder where the installation files are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\HardwareStation\Tools.
2. Create a copy of the hs-settings.xml file. We recommend that you do not change the original file.
3. Open the hs-settings.xml file in Microsoft Visual Studio or a text editor, such as Notepad.
4. Enter a value for the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What to enter</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebAppPoolName</td>
<td>The name of an existing web application or the name of an application that you want Setup to create.</td>
<td>HardwareStationAppPool</td>
</tr>
<tr>
<td>WebSiteName</td>
<td>The name of an existing website or the name of a site that you want Setup to create.</td>
<td>HardwareStationWebsite</td>
</tr>
<tr>
<td>WebSiteHttpPort</td>
<td>You can specify any available port. Verify that the port is open in Windows firewall. Also, note the port number. The port is used to create the URL for Retail Server in the format: https://&lt;server name&gt;:port/&lt;web application name&gt;. This URL is required to activate Retail Modern POS devices that connect to Retail Server.</td>
<td>None</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>WebSiteHttpsPort</td>
<td>You can specify any available port. Verify that the port is open in Windows firewall. Also, note the port number. The port is used to create the URL for Retail Server in the format: https://&lt;server name&gt;:port/&lt;web application name&gt;. This URL is required to activate Retail Modern POS devices that connect to Retail Server.</td>
<td>None</td>
</tr>
<tr>
<td>WebApplicationName</td>
<td>The name of an existing web application or the name of an application that you want Setup to create.</td>
<td>HardwareStation</td>
</tr>
<tr>
<td>WebSiteSSLCertificateStore</td>
<td>The Certificates store specified when the certificate was created or imported.</td>
<td>My</td>
</tr>
<tr>
<td>WebSiteSSLCertificateRootStore</td>
<td>The server where the certificate is stored.</td>
<td>LocalMachine</td>
</tr>
<tr>
<td>WebSiteWorkingFolder</td>
<td>The folder where you want Windows PowerShell to create a new IIS virtual directory.</td>
<td>%SystemDrive%\inetpub\Hardware Station</td>
</tr>
<tr>
<td>WebAppPoolUser</td>
<td>Enter a domain account for the application pool. Enter the account in the form value=&quot;Domain\User&quot;.</td>
<td>None</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>WebSiteSSLCertificateThumbprint</td>
<td>The thumbprint for your Secure Sockets Layer (SSL) encryption certificate. You must obtain a valid, registered certificate from a provider. Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) You will need to paste the thumbprint for the certificate into the settings file. To view the thumbprint in IIS Manager, double-click the certificate and click the <strong>Details</strong> tab. We recommend that you paste the thumbprint into a text file and remove all spaces before you paste it into the settings file. <strong>Caution</strong> A thumbprint can contain hidden characters at the beginning of the thumbprint value. You must delete these extra characters before you paste the thumbprint into the settings file.</td>
<td>None</td>
</tr>
<tr>
<td>WebApplicationServiceBinarySourceFolder</td>
<td>By default, this folder is: C:\Program Files (x86)\Microsoft Dynamics AX\60\HardwareStation\Package folder</td>
<td>None</td>
</tr>
<tr>
<td>WebApplicationWorkingFolder</td>
<td>The folder from where the web service will run. You can specify the WebApplicationServiceBinarySourceFolder or any available folder.</td>
<td>[RetailServerWebSiteWorkingFolder][RetailServerWebApplicationName]</td>
</tr>
<tr>
<td>RetailServerURL</td>
<td>The URL specified when Retail Server was installed. By default, the URL uses the following format: https://&lt;ServerName&gt;:Port/&lt;Web ApplicationName&gt;</td>
<td>None</td>
</tr>
</tbody>
</table>

5. Save your changes.
Run Windows PowerShell scripts to deploy and configure Hardware Station

After you configure the parameters in the hs-settings.xml file, you can run the Windows PowerShell scripts that deploy and configure Hardware Station.

1. On the server where you want to run the script, open the folder where the Windows PowerShell scripts are installed. By default, the files are located at C:\Program Files (x86)\Microsoft Dynamics AX\60\HardwareStation\Tools

2. If you’re using Windows Server 2012 or a later operating system, use Windows Explorer to open the folder where the scripts are installed. Then click File > Open Windows PowerShell > Open Windows PowerShell as administrator.

   If you’re using Windows Server 2008 R2 or an earlier operating system, start Windows PowerShell as the administrator. Then, change the directory by using the following command: CD "<Path to directory>".

3. In the Windows PowerShell console, run the following command to create a credential object in Active Directory for the service account. Replace ‘domain\useraccount’ and ‘password’ with credentials that have permission to create sites in IIS:

   `$cred = @((New-Object System.Management.Automation.PSCredential('domain\useraccount', (ConvertTo-SecureString 'password' -AsPlainText -Force))))`

4. Run the following command to deploy and configure Hardware Station:

   `.\DeployHardwareStation.ps1 -SettingsXmlFilePath .\hs-settings.xml -TopologyXmlFilePath .\hs-topology.xml -Credentials $cred -Verbose $true`

   For example:

   `.\DeployHardwareStation.ps1 -SettingsXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\HardwareStation\Tools\hs-settings.xml" -TopologyXmlFilePath "C:\Program Files (x86)\Microsoft Dynamics AX\60\HardwareStation\Tools\hs-topology.xml" -Credentials $cred -Verbose $true`

After you install Hardware Station

For information about how to install Modern POS, see the Install Retail Modern POS section. To install Retail Server, see the Install Retail Server section.

See also

- Modern Point of Sale (on TechNet)

Install a Retail online store (e-commerce)

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

This section describes how to install a Microsoft Dynamics AX Retail online store. The Retail online store is also called the Microsoft Dynamics AX e-commerce store. This section includes procedures for single server and server farm deployments. You can install the online store by using Setup.exe or by using Windows PowerShell scripts. Both options are described in this section. After you complete the installation procedures described in this section, a starter store is deployed in your computing environment. You can then configure, customize, and rebrand the starter store to meet your needs.
### Before you begin

You must complete the following tasks before you deploy the Microsoft Dynamics AX Retail online store.

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that your computing environment meets all system requirements</td>
<td>- Verify that the SharePoint server(s) that will host the Retail online store meet the following requirements: 16 GB of RAM recommended; 10 GB of RAM and 4 processors, minimum.&lt;br&gt;- Verify that the SQL server is not running SQL Express. The retail online store is not supported with SQL Express.&lt;br&gt;For more information about system requirements, see [Hardware and software requirements](on TechNet).</td>
</tr>
<tr>
<td>Install URL Rewrite</td>
<td>Verify that you installed the <a href="64-bit">URL Rewrite Module 2.0</a> on each SharePoint server.</td>
</tr>
<tr>
<td>Deploy and configure SharePoint</td>
<td>- Deploy and configure SharePoint Server 2013 Service Pack 1 or later (Enterprise edition). For more information, see [Overview of SharePoint 2013 installation and configuration](on Microsoft.com).&lt;br&gt;- Download and install all cumulative updates for SharePoint Server 2013. To improve update installation times, use the Windows PowerShell script described in this [MSDN blog](.</td>
</tr>
<tr>
<td>Verify that Microsoft Dynamics AX and all updates are installed in your computing environment</td>
<td>- [Install Microsoft Dynamics AX 2012](on TechNet)&lt;br&gt;- [Apply updates and hotfixes](on TechNet)</td>
</tr>
<tr>
<td>Verify that Microsoft Dynamics AX Retail features are installed in your computing environment</td>
<td>You must install the following Retail features:&lt;br&gt;- Retail headquarters&lt;br&gt;- Commerce Data Exchange components&lt;br&gt;- Retail SDK&lt;br&gt;- Retail channel database&lt;br&gt;For more information, see the information at the beginning of this chapter.</td>
</tr>
<tr>
<td>Prepare the developer environment</td>
<td>Set up the development environment for a Retail online store.</td>
</tr>
<tr>
<td>Verify that SharePoint application pools are running in IIS</td>
<td>Verify that all SharePoint application pools are running in IIS Manager.&lt;br&gt;Important&lt;br&gt;If the SharePoint Web Services Root application pool is stopped, you must start it.</td>
</tr>
<tr>
<td>Verify that required SharePoint services are running</td>
<td>In SharePoint Central Administration, click <strong>Application Management &gt; Service Applications &gt; Manage Services on Server</strong> and verify that, at a minimum, the following services are running:&lt;br&gt;- Central Administration&lt;br&gt;- Managed Metadata Web Service&lt;br&gt;- Microsoft SharePoint Foundation Workflow Timer Service&lt;br&gt;- Microsoft SharePoint Foundation Web Application&lt;br&gt;- Search Host Controller Service&lt;br&gt;- Search Query and Site Settings Service&lt;br&gt;- SharePoint Server Search</td>
</tr>
<tr>
<td>Task</td>
<td>Details</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Verify role requirements</td>
<td>- If you did not install and configure Microsoft Dynamics AX, verify that you are a member of the system administrator role in Microsoft Dynamics AX.</td>
</tr>
<tr>
<td></td>
<td>- If you did not install and configure SharePoint, verify that you are a member of the farm administrator role in SharePoint and that you have administrator access to each site collection in the farm.</td>
</tr>
<tr>
<td></td>
<td>- If you did not install and configure Microsoft SQL Server, Microsoft Dynamics AX, or SharePoint, verify that you are a member of the sysadmin role on the Microsoft Dynamics AX databases and all SharePoint databases.</td>
</tr>
<tr>
<td>Create domain user accounts</td>
<td>Verify or create the following domain accounts. You will specify these accounts when you deploy the Retail online store later in this section.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Product Catalog Web App Pool User</strong>: This account must be a member of the SharePoint Farm Administrators group so that it can edit properties in the root website. This account will be specified later in this section.</td>
</tr>
<tr>
<td></td>
<td>- <strong>StoreFront Web App Pool User</strong>: This account must be a member of the SharePoint Farm Administrators group so that it can edit properties in the root website. This account will be specified later in this section.</td>
</tr>
<tr>
<td></td>
<td>- <strong>STS Web App Pool User</strong>: This account must be a member of the SharePoint Farm Administrators group so that it can edit properties in the root website. This account was specified when you installed SharePoint. It is the account under which the Security Token Service application pool runs in IIS Manager.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Retail Job User</strong>: This account was specified when you installed SharePoint. It is the account under which the SharePoint Timer Service runs.</td>
</tr>
<tr>
<td>Acquire Secure Sockets Layer (SSL) certify</td>
<td><strong>Encryption settings</strong>: The Retail store publishing portal uses SSL encryption. For production environments, you must register your domain and obtain a valid, registered SSL certificate from a provider. For developer and evaluation environments, you can use a self-signed certificate (see Create and export a self-signed certificate on Microsoft.com). For information about how to work with certificates, see Certificate Overview on Microsoft.com.</td>
</tr>
<tr>
<td>Verify SQLCMD utility</td>
<td>The SQLCMD utility is required to install the Retail online store. This utility is typically installed with Microsoft SQL Server. If a version of SQL Server is not installed on the computer where you install the online store, you can download and install Microsoft Command Line Utilities 11 for SQL Server to meet this requirement.</td>
</tr>
<tr>
<td>Verify warehouse requirement</td>
<td>You cannot configure a Microsoft Dynamics AX Retail store (online store or brick-and-mortar store) to use a warehouse that is managed by the Warehouse Management module. The module was introduced in AX 2012 R3. You can configure a Retail online store to use a warehouse that is managed by the Inventory Management module.</td>
</tr>
</tbody>
</table>
Verify SharePoint Managed Metadata connection properties
You must verify that the SharePoint Managed Metadata connection required options are enabled.

1. In SharePoint Central Administration, under **Application Management**, click **Manage service applications**.
2. Highlight the **Managed Metadata Service Connection** row and then click **Properties**.

3. Verify that the following options are selected.
   - **Managed Metadata Service Connection**
   - **Select the settings for this Managed Metadata Service Connection.**
   - [ ] This service application is the default storage location for Keywords.
   - [ ] This service application is the default storage location for column specific term sets.
   - [ ] Consumes content types from the Content Type Gallery.
   - [ ] Push-down Content Type Publishing updates from the Content Type Gallery to sub-sites and lists using the content type.

4. Save your changes.

5. If you are installing Microsoft Dynamics AX 2012 R3 Cumulative Update 8, you must also complete the following steps:
   a. In Central Administration, under **Application Management**, click **Manage Service Applications**.
   b. Click **Managed Metadata Service**.
   c. In the Term Store Management tool, add the user name in the Term Store Administrators field. Ensure that the user name is the same as the service account for SharePoint Timer Service.
   d. Click **Check Names**, and then click **Save**.
Prepare your developer environment for signing updated source code

After you install the online store as described in this section, you will be ready to customize the store you deployed. The process of customizing the Retail online store requires that you recompile the source code in the Visual Studio projects. After you recompile, the fully-qualified name of the rebuilt assemblies will be different than the assemblies originally provide by Microsoft. Before you can recompile the assemblies, you must provide a code signing key file (also called a strong name key file) to sign the customized code. If your business has a code signing key file (.snk file), you can reuse this file. If you do not have a code signing key file, Visual Studio can create one for you. You must create a new project and enable code signing. Then, create a second project that references the .dll of the output of the first project. You can locate the thumbprint in the assembly reference of the .csproj file in the second project. When you have the .snk file, you must do the following:

1. Save the file in the Retail SDK folder and give it a name *Name*.snk.
2. Edit the UpdateAssemblyIdentities.ps1 file in the Retail SDK folder. You must update the version number and the thumbprint of the key file (lines 97, 98).
3. Update the source code to use the strong name certificate by executing the UpdateAssemblyIdentities.ps1 script. This script can take several minutes to complete.

Additional steps and recommendations for developers are described in the Next steps for developers section.

Option 1: Install the Retail online store by using Setup

You can install the Retail online store by using Microsoft Dynamics AX Setup or by using Windows PowerShell scripts. If you prefer to install the Retail online store manually, see the Option 2: Deploy the Retail online store by using Windows PowerShell section.

If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select installation type page, click Custom installation, and then click Next.
5. On the Select components page, select Retail online channel, and then click Next.
6. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
7. On the Configure a Microsoft Dynamics AX Retail online store page, enter the following information about the website where the online store will run.
   - On the Configure the Retail online channel page, select the check box to configure online store by using Setup. If you clear this option, the application files are installed, but the online store is not deployed or configured.
     If you’re configuring the online store, enter the following information:
     - **Storefront to deploy**: Select a Retail starter store to deploy. The Contoso starter store is modeled after an online electronics retailer. The Fabrikam starter store is modeled after an online clothing retailer.
     - **Database server**: The name of the server that will host the Retail online store databases
     - **Channel database name**: The name of the Retail channel database. If this database does not exist, you must cancel Setup and install a Retail channel database.
- **User name** and **Password**: The credentials for a domain account that has permission to create web applications and execute Windows PowerShell scripts in SharePoint.
- **Pfx file path**: The path to the Pfx file for the SSL certificate.
- **Password**: The password for the Pfx file.
- **Channel operating unit number**: A channel operating unit number is specified when you create an online channel in the Microsoft Dynamics AX client. You must create the channel before you deploy the Retail online store. To locate this operating unit number, click Retail > Retail channels > Online Stores.

8. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.

9. On the **Ready to install** page, click **Install**.

10. After the installation is completed, click **Finish** to close the wizard.

If the deployment succeeded, proceed to the Verify deployment section. If the deployment failed check the Microsoft Dynamics AX log file and the Windows event logs for information. For additional troubleshooting support, see “Troubleshooting deployment issues” in the Troubleshoot installation issues for a Retail online store topic.

**Option 2: Deploy the Retail online store by using Windows PowerShell**

Use this procedure to install the Retail online store manually by using Windows PowerShell. Manual installations are often performed by businesses and organizations that automate deployments by using scripts.

**Extract installation files**

Use Microsoft Dynamics AX Setup to extract the files that are needed for manual installation. Perform this procedure on the SharePoint server that will host the online store.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. On the **Select installation type** page, click **Custom installation**, and then click **Next**.
5. On the **Select components** page, select **Retail online channel**, and then click **Next**.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.
7. On the **Configure a Microsoft Dynamics AX Retail online store** page, clear the **Configure Retail online store** option. Click **Next**.
8. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click **Next**.
9. On the **Ready to install** page, click **Install**.
10. After the installation is completed, click **Finish** to close the wizard. Setup extracts files and creates the following folder on the local server:

C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel
Configure settings in the Retail online store XML file

After you extract the installation files by using Setup, you must configure settings in the oob-settings.xml file.

Before you begin

If you deployed SharePoint on Windows Server 2012, then you must complete the following procedure to ensure that the Microsoft.Web.Administration.dll is not overwritten in the global assembly cache when you execute deployment scripts later in this section. You do not need to perform this procedure on Windows Server 2008 R2.

1. Open the manifest.xml file in the following directory on the SharePoint server:
   C:\...\Retail Online Channel\StoreFront\SP
2. Delete the following line of code from the manifest.xml file:
   
   `<Assembly Location="Microsoft.Web.Administration.dll" DeploymentTarget="GlobalAssemblyCache" />`
3. Save and close the file.

The Microsoft.Web.Administration.dll in the global assembly cache will not be overwritten when you execute Windows PowerShell commands later in this section.

Configure settings in the oob-settings.xml file

This section describes how to configure settings in the oob-settings.xml file.

1. Open the following directory:
   C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel\tools
2. Open the oob-settings.xml file in Microsoft Visual Studio or a text editor, such as Notepad.
3. Enter a value for the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What to enter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>StoreFront_Name</td>
<td>Enter the name of the online store to deploy. You must enter either Contoso or Fabrikam.</td>
<td>Contoso</td>
</tr>
<tr>
<td>StoreFront_Design</td>
<td>Microsoft Dynamics AX uses this value to determine which customizations to apply to the publishing portal. Change this value if, for example, a developer creates a new design template.</td>
<td>Default</td>
</tr>
<tr>
<td>StoreFront_CountryCode</td>
<td>Enter an ISO country code. This code displays the country string, for example, when a customer places an order. Customers of your site do not see this code. This value is not published.</td>
<td>USA</td>
</tr>
<tr>
<td>StoreFront_CountryName</td>
<td>Enter the name of the country. Customers of your site do not see this code. This value is not published.</td>
<td>United States</td>
</tr>
<tr>
<td>StoreFront_CurrencyTemplate</td>
<td>Enter a currency template. This template determines how currency amounts are displayed in the online store.</td>
<td>$(0)</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SharepointPackageInstanceIdentifier</td>
<td>Enter any alphanumeric value to uniquely identify this deployment. This value must be unique across all Retail online store deployments in the server farm.</td>
<td>None, but we recommend a value of 1.</td>
</tr>
<tr>
<td>StoreFront_ItemAvailabilityThreshold</td>
<td>Enter a threshold value for the number of items in stock for any product. If the number of items in stock for a specific product is below this value, the system could display a banner to the customer that lets them know how many items are left in stock. A developer would need to customize the store to create a banner.</td>
<td>10</td>
</tr>
<tr>
<td>StoreFront_ShoppingCartExpiryTerm</td>
<td>Enter the number of days to retain a shopping cart. If no value is entered, the store deletes the shopping cart after 24 hours.</td>
<td>None</td>
</tr>
<tr>
<td>StoreFront_LanguageId</td>
<td>Enter a language code identifier (LCID). This ID must match the language pack for your SharePoint deployment. For more information about deploying the online store in multiple languages, see the Install multiple Microsoft Dynamics AX Retail online stores section.</td>
<td>1033</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>StoreFront_DeviceChannelsListName</td>
<td>This value is the name of a SharePoint Design Manager list that stores device channels. For more information about device channel lists, see SharePoint 2013 Design Manager device channels on Microsoft.com. The name of this value varies based on locale. For example, if you are deploying the online store by using the en-US locale then the name should be Device Channels. If you are deploying for an online store for fr-FR (French) locale then this name should be Canaux des appareils. <strong>Note</strong> The value of this property and the value of the previous property (StoreFront_DeviceChannelsListName) work together. For example, an en-US online store uses the 1033, Device Channels values and an fr-FR online store uses the 1036, Canaux des appareils values.</td>
<td>Device Channels</td>
</tr>
<tr>
<td>LoggingServiceName</td>
<td>The name of the logging service for this deployment as it appears in SharePoint Central Administration. You can change the default string value (Dynamics AX Retail Logging Service) if you want. However, we recommend that you do not change the place holder value ([SharepointPackageInstanceIdentifier]) unless you are a developer and understand the repercussions of making a change.</td>
<td>Dynamics AX Retail Logging Service [SharepointPackageInstanceIdentifier]</td>
</tr>
<tr>
<td>LoggingCategoryName</td>
<td>The SharePoint diagnostics logging category where events for this deployment will be logged. We recommend that you do not change the place holder value ([SharepointPackageInstanceIdentifier]) unless you are a developer and understand the repercussions of making a change.</td>
<td>General Logging [SharepointPackageInstanceIdentifier]</td>
</tr>
</tbody>
</table>

Microsoft Dynamics AX 2012 Installation Guide
<table>
<thead>
<tr>
<th>Parameter</th>
<th>What to enter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>MonitoringEventLogSourceName</td>
<td>For events logged in the Windows NT Event Viewer, this parameter identifies the source of the event. You can change the string value (Dynamics AX Retail Monitoring) if you want. However, we recommend that you do not change the place holder value ([SharepointPackageInstanceIdentifier]) unless you are a developer and understand the repercussions of making a change.</td>
<td>Dynamics AX Retail Monitoring [SharepointPackageInstanceIdentifier]</td>
</tr>
<tr>
<td><strong>Ports and URLs</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>StoreFrontUrlPort_Public</td>
<td><strong>The port for the public online store site:</strong> You can specify any available port.</td>
<td>• 40002&lt;br&gt;• 50002 for the Fabrikam starter store</td>
</tr>
<tr>
<td>StoreFrontUrlPort_SSL_Public</td>
<td><strong>The port for the public online store site for encrypted communications:</strong> You can specify any available port.</td>
<td>• 40004&lt;br&gt;• 50004 for the Fabrikam starter store</td>
</tr>
<tr>
<td>StoreFrontUrlPort_Internal</td>
<td><strong>The port for the internal online store site:</strong> You can specify any available port. This URL is only accessed by domain users with permission to make changes to the site collection by using SharePoint site settings. It is not required, but you can change this port value if you want the internal online store to use a different port.</td>
<td>• 40003&lt;br&gt;• 50003 for the Fabrikam starter store</td>
</tr>
<tr>
<td>ProductCatalogUrlPort_Internal</td>
<td><strong>The port for the internal product catalog site:</strong> You can specify any available port. This URL is only accessed by domain users with permission to make changes to the site collection by using SharePoint site settings. It is not required, but you can change this port value if you want the internal product catalog to use a different port.</td>
<td>• 40001&lt;br&gt;• 50001 for the Fabrikam starter store</td>
</tr>
<tr>
<td>ResetSearchIndex</td>
<td>Setting this parameter to true clears the SharePoint index cache and initiates a full crawl across the farm.</td>
<td>False</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>StoreFrontSiteCollectionRootUrl_Fo rmsAuth</td>
<td>The local web address of the Retail online store (as opposed to a public address like <a href="http://www.contoso.com">www.contoso.com</a>.) Enter a valid server name and remove the % signs. We recommend that you do not change the place holder value ([StoreFrontUrlPort_Public]) unless you are a developer and understand the repercussions of making a change.</td>
<td>http://%COMPUTERNAME%:[StoreFrontUrlPort_Public]</td>
</tr>
<tr>
<td>StoreFrontSiteCollectionRootUrl_W indowsAuth</td>
<td>The local web address of the 40003 site. Enter a valid server name and remove the % signs. We recommend that you do not change the place holder value ([StoreFrontUrlPort_Internal]) unless you are a developer and understand the repercussions of making a change.</td>
<td>http://%COMPUTERNAME%:[StoreFrontUrlPort_Internal]</td>
</tr>
<tr>
<td>StoreFrontSiteCollectionRootUrl_Fo rmsAuth_Public</td>
<td>This is the customer facing URL. For example with a port 80 site, it could be <a href="http://www.contoso.com">http://www.contoso.com</a>. With a port 3000 site it could be <a href="http://www.contoso.com:3000">http://www.contoso.com:3000</a>.</td>
<td><a href="http://www.%5BStoreFront_Name%5D.com:%5BStoreFrontUrlPort_Public">http://www.[StoreFront_Name].com:[StoreFrontUrlPort_Public</a>]</td>
</tr>
<tr>
<td><strong>SSL</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>StoreFrontSiteCollectionRootUrl_SS L_FomsAuth</td>
<td><strong>The internal URL for the online store encrypted communications site:</strong> Enter a valid server name and remove the % signs. We recommend that you do not change the place holder value ([StoreFrontUrlPort_SSL_Public]) unless you are a developer and understand the repercussions of making a change.</td>
<td>https://%COMPUTERNAME%:[StoreFrontUrlPort_SSL_Public]</td>
</tr>
<tr>
<td>StoreFrontSiteCollectionRootUrl_SS L_FomsAuth_Public</td>
<td><strong>The public URL for the online store encrypted communications site:</strong> The https site customers use for secure transactions and processing.</td>
<td><a href="https://www.%5BStoreFront_Name%5D.com:%5BStoreFrontUrlPort_SSL_Public">https://www.[StoreFront_Name].com:[StoreFrontUrlPort_SSL_Public</a>]</td>
</tr>
<tr>
<td>PublishingPortalRelativePath</td>
<td>This relative path is combined with URLs specified earlier to create a complete path for the publishing portal. We recommend that you do not leave this blank and use a format similar to &quot;/sites/XYZ&quot;. Leaving this field blank would require customizations to the oob-topology.xml file, and should be attempted by advanced users only.</td>
<td>/sites/RetailPublishingPortal</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>StoreFrontPublicSSLCertThumbprint</td>
<td>The thumbprint for your Secure Sockets Layer (SSL) encryption certificate. You must obtain a valid, registered certificate from a provider. Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) You will need to paste the thumbprint for the certificate into the settings file. To view the thumbprint in IIS Manager, double-click the certificate and click the <strong>Details</strong> tab. We recommend that you paste the thumbprint into a text file and remove all spaces before you paste it into the settings file. <strong>Caution</strong> A thumbprint can contain hidden characters at the beginning of the thumbprint value. You must delete these extra characters before you paste the thumbprint into the settings file.</td>
<td>None</td>
</tr>
<tr>
<td>StoreFrontPublicSSLCertDirectory</td>
<td>The source directory where Microsoft Dynamics AX retrieves the .pfx file for the SSL certificate. This value can be a network share.</td>
<td>None</td>
</tr>
<tr>
<td>StoreFrontPublicSSLCertLocalDirectory</td>
<td>The destination folder where Microsoft Dynamics AX stores a local copy of the certificate. This location <strong>cannot</strong> be the same as the <strong>StoreFrontPublicSSLCertDirectory</strong> value. <strong>Important</strong> This path cannot contain any special characters. If the path contains a special character deployment fails.</td>
<td>None</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>StoreFrontPublicSSLCertPfxFileName</td>
<td>Enter the file name and extension. By default the extension is .pfx. To create a .pfx file for a self-signed certificate, you must export the certificate from IIS Manager. To do this, right-click the certificate, click <strong>Export</strong>, and then complete the export wizard. You must then import the .pfx file into the local certificate store. Right-click the .pfx file in the directory where you just created it, click <strong>Import</strong>, and then complete the import wizard.</td>
<td>None</td>
</tr>
<tr>
<td>StoreFrontPublicSSLCertPfxPassword</td>
<td>Enter the password of the .pfx file. This password cannot contain any restricted XML characters such as the following: exclamation point (!), greater than sign (&gt;), less than sign (&lt;), ampersand (&amp;), apostrophe (‘), or a quotation mark (”).</td>
<td>None</td>
</tr>
</tbody>
</table>

**Domain Accounts and Miscellaneous**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What to enter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>StoreFrontWebAppPoolUser</td>
<td>Enter a domain account for the application pool of the online store. Enter the account in the form <code>value=“Domain\User”</code>. This account must be a member of the SharePoint Farm Administrators group because it must edit properties in the root website.</td>
<td>None</td>
</tr>
<tr>
<td>ProductCatalogSiteCollectionRootUrl_WindowsAuth</td>
<td>The local web address of the product catalog. Enter a valid server name and remove the % signs. We recommend that you do not change the place holder value ([ProductCatalogUrlPort_Internal]) unless you are a developer and understand the repercussions of making a change.</td>
<td>http://%COMPUTERNAME%:[ProductCatalogUrlPort_Internal]</td>
</tr>
<tr>
<td>ProductCatalogWebAppPoolUser</td>
<td>Enter a domain account for the application pool of the catalog site. Enter the account in the form <code>value=“Domain\User”</code>. This account must be a member of the SharePoint Farm Administrators group because it must edit properties in the root website.</td>
<td>None</td>
</tr>
<tr>
<td>ProductCatalogName</td>
<td>Enter any name for the product catalog. This value is not displayed to customers.</td>
<td>Retail Product Catalog</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>STSWebAppPoolUser</td>
<td>This account must be a member of the SharePoint Farm Administrators group. Also, this is the domain account used by the Security Token Service Application Pool. You specified this account when you installed SharePoint. To locate the account in IIS Manager, click <strong>Application Pools</strong>, right-click <strong>SecurityTokenServiceApplication Pool</strong>, and then click <strong>Advanced Settings</strong>. The account for this application pool is listed under <strong>Process Model &gt; Identity</strong>. Enter the account in the form <code>value=&quot;Domain\User&quot;</code>.</td>
<td>None</td>
</tr>
<tr>
<td>RetailJobUser</td>
<td>This account must be a member of the SharePoint Farm Administrators group. Also, this is the account used by the SharePoint Timer service. You specified this account when you installed SharePoint. Enter the account in the form <code>value=&quot;Domain\User&quot;</code>.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelOperatingUnitNumber</td>
<td>A channel operating unit number is specified when you create an online channel in the Microsoft Dynamics AX client. You must create the channel before you deploy the Retail online store. To locate this operating unit number, click <strong>Retail &gt; Retail channels &gt; Online Stores</strong>.</td>
<td>None</td>
</tr>
<tr>
<td>DestinationId</td>
<td>A value that uniquely identifies an endpoint to Commerce Runtime (CRT). This value must be a GUID. If necessary, create a GUID by using Visual Studio.</td>
<td>None</td>
</tr>
<tr>
<td>PublishingConnectorServiceInstanc eServers</td>
<td>A comma-separated list of servers where the Retail online store publishing job must run. The Windows PowerShell script is case sensitive. For example, <code>value=&quot;RetailTestOne, RetailTestTwo&quot; /&gt;</code>.</td>
<td>None</td>
</tr>
<tr>
<td>FarmAdministratorAlias</td>
<td>Enter a domain account and alias of a SharePoint farm administrator. Enter the account in the form <code>value=&quot;Domain\User&quot;</code>.</td>
<td>None</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>FarmAdministratorEmail</td>
<td>Enter the e-mail address of a SharePoint farm administrator. Enter the address in the form value=&quot;<a href="mailto:Username@YourDomain.com">Username@YourDomain.com</a>&quot;.</td>
<td>None</td>
</tr>
<tr>
<td>SharePointRelyPartyUrl</td>
<td></td>
<td><a href="https://www.%5BStoreFront_Name%5D.com:%5BStoreFrontUrlPort_SSL_Public%5D/_trust/">https://www.[StoreFront_Name].com:[StoreFrontUrlPort_SSL_Public]/_trust/</a></td>
</tr>
<tr>
<td><strong>Database Details</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ChannelDatabaseServerName</td>
<td>If you have not already done so, use Microsoft Dynamics AX Setup.exe to deploy a Retail channel database. For this parameter, enter the server name. The Windows PowerShell script is case sensitive. For example, value=&quot;RetailTestOne&quot; /&gt;.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelDatabaseServerNamedInstanceName</td>
<td>If you installed the retail channel database as part of a SQL named instance, enter the named instance. This parameter cannot be empty. The format for a SQL instance name is either the server name or the full instance name. For example, valid names are: “localhost”, “localhost\instance2”, “server1”, “server1\instance2”.</td>
<td>None</td>
</tr>
<tr>
<td>ChannelDatabaseName</td>
<td>If you have not already done so, use Microsoft Dynamics AX Setup.exe to deploy a Retail channel database. For this parameter, enter the database name.</td>
<td>None</td>
</tr>
<tr>
<td>IdentityProviderDatabaseServerName</td>
<td>The identity provider database is used for authentication and authorization of online store registered users. If there are multiple Retail online store deployments in the same farm, then the IdentityProviderDatabase and CustomClaimsProviderDatabase must be the same for all Retail online store deployments in the farm. Enter a server name. The Windows PowerShell script is case sensitive. For example, value=&quot;RetailTestOne&quot; /&gt;.</td>
<td>None</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>IdentityProviderDatabaseServerNamedInstanceName</td>
<td>If you installed the identity provider database as part of a SQL named instance, enter the named instance. This parameter cannot be empty. The format for a SQL instance name is either the server name or the full instance name. For example, valid names are: “localhost”, “localhost\instance2”, “server1”, “server1\instance2”.</td>
<td>None</td>
</tr>
<tr>
<td>CustomClaimsProviderDatabaseServerName</td>
<td>The custom claims provider database is used for authentication and authorization of online store registered users. If there are multiple Retail online store deployments in the same farm, then the IdentityProviderDatabase and CustomClaimsProviderDatabase must be the same for all Retail online store deployments in the farm. Enter a server name. The Windows PowerShell script is case sensitive. For example, value=&quot;RetailTestOne&quot; /&gt;.</td>
<td>None</td>
</tr>
<tr>
<td>CustomClaimsProviderDatabaseServerNamedInstanceName</td>
<td>If you installed the custom claims provider database as part of a SQL named instance, enter the named instance. You can leave this parameter empty if the database is not part of a named instance.</td>
<td>None</td>
</tr>
<tr>
<td>BingMapsId</td>
<td>If you want your Retail online store to work with Bing Maps, then you must register with Bing Maps. Specify the Bing Maps ID here.</td>
<td>None</td>
</tr>
<tr>
<td>ShowDebugErrorMessages</td>
<td>For a testing environment, set this value to True to see detailed error messages in the online store. For production sites set the value to False.</td>
<td>None</td>
</tr>
</tbody>
</table>

⚠️ **Important**

To keep a record of the settings and parameters you specified, we recommend that you make a copy of the oob-settings.xml file after you finished entering parameters.
Configure Facebook integration

The Retail online store can authenticate users who sign in to your site by using their Facebook credentials. This section describes how to configure your environment for Facebook authentication.

⚠️ Important

Facebook integration is optional. However, if you do not want to use Facebook authentication, then you must disable this feature in the oob-topology.xml file. If you do not disable it, the deployment scripts fail. For more information, see the Disable Facebook integration section.

Create a Facebook application

Use the following procedure to create a Facebook application that enables Facebook logon to your site.

1. Log on to the Facebook developer site.
2. Register as a developer on the Facebook developer site.
3. Click Create New App and then follow the prompts to create a new application.
4. In the Select how your application integrates with Facebook section, click the Website with Facebook Login option and specify the Site URL.
5. Click Save Changes.
6. On the applications landing page, select the application that you just created.
7. In the oob-settings.xml file, search for FacebookApplicationId. Replace the value with the Facebook ID. Retain the quotation marks.
8. In the oob-settings.xml file, search for FacebookApplicationSecret. Replace the value with the secret you created for your Facebook application. Retain the quotation marks.
9. Save your changes in the oob-settings.xml file.

Certificates

Use the following procedure to create certificates for Facebook authentication. For production environments, you must register your domain and obtain a valid, registered SSL certificate from a provider. For developer and evaluation environments, you can use a self-signed certificate (see Create and export a self-signed certificate on Microsoft.com). For information about how to work with certificates see Certificate Overview on Microsoft.com.

1. Search in the oob-settings.xml file for the parameters listed in the following table. Enter a value for each parameter. For each value, retain quotation marks (“”) but remove percent signs (%).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What to enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>FacebookApplicationId</td>
<td>The ID created when you registered a Facebook application.</td>
</tr>
<tr>
<td>FacebookApplicationSecret</td>
<td>The secret specified when you registered a Facebook application.</td>
</tr>
<tr>
<td>FacebookCertificateDirectory</td>
<td>The source directory where Microsoft Dynamics AX retrieves the .pfx file for the SSL certificate. This value can be a network share.</td>
</tr>
<tr>
<td>FacebookCertificateLocalCopyDirectory</td>
<td>The destination folder where Microsoft Dynamics AX stores a local copy of the certificate. This location cannot be the same as the StoreFrontPublicSSLCertDirectory value.</td>
</tr>
<tr>
<td>FacebookSigningCertificateCerFileName</td>
<td>Enter a value with the name of the certificate .cer file in the form value=“CertificateName.cer”.</td>
</tr>
<tr>
<td>FacebookSigningCertificatePfxFileName</td>
<td>Enter a value with the name of the certificate .pfx file in the form value=“CertificateName.pfx”.</td>
</tr>
<tr>
<td>Parameter</td>
<td>What to enter</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FacebookSigningCertificatePfxPassword</td>
<td>This is a password for a test certificate. For production environments, do not enter a password here. It will be prompted during deployment. This password cannot contain any restricted XML characters such as the following: exclamation point (!), greater than sign ($&gt;$), less than sign ($&lt;$), ampersand (&amp;), apostrophe (’), or a quotation mark (“).</td>
</tr>
</tbody>
</table>
| FacebookSigningCertificateThumbprint         | The thumbprint for your Secure Sockets Layer (SSL) encryption certificate. You must obtain a valid, registered certificate from a provider. Because this component uses Secure Sockets Layer (SSL) encryption, you must install a server certificate that was issued by a trusted certification authority. (For test environments, you can create a self-signed certificate in IIS.) You will need to paste the thumbprint for the certificate into the settings file. To view the thumbprint in IIS Manager, double-click the certificate and click the Details tab. We recommend that you paste the thumbprint into a text file and remove all spaces before you paste it into the settings file.  

⚠️ Caution  

A thumbprint can contain hidden characters at the beginning of the thumbprint value. You must delete these extra characters before you paste the thumbprint into the settings file. |
| FacebookSignInUrl                             | The page that will contact Facebook to authenticate users. For example:  

http://www.[StoreFront_Name].com:[StoreFrontUrlPort_Public ][PublishingPortalRelativePath]/pages/Login.aspx |
| FacebookSslCertificateAuthorityCerFileName   | Enter the file name.                                                                                                                                 |
| FacebookSslCertificateAuthorityThumbprint    | Enter the thumbprint. Remove all spaces.                                                                                                         |

2. Save your changes in the oob-settings.xml file.

✅ Note

You can enable Facebook integration in developer environments that are not using a fully registered domain name (for example, www.[DomainName.com]). To do this, you must create host file entries on each computer that will browse the online store. The URL for host file entries must be in the form:  

http://www.[DomainName.com/sites/RetailPublishingPortal.]

**Update the prerequisite script for Facebook**

A known issue in this version of the Microsoft Dynamics AX Retail online store can cause an installation to fail if you configure Facebook as an identity provider. If you plan to use Facebook as an identity provider, perform the following procedure before you install the online store. If you do not plan to use Facebook as an identity provider, you can skip this procedure.

1. Open the following folder:

   C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel\tools

2. Open the Install-Prerequisites.ps1 file in Microsoft Visual Studio.
3. Search for line 155:

   $trustedIdentityTokenIssuerConfig.SigningCertificateCerFileName
   $trustedIdentityTokenIssuerConfig.SigningCertificatePfxFileName

4. Replace that line with the following:

   $trustedIdentityTokenIssuerConfig.SigningCertificateCerFileName
   $trustedIdentityTokenIssuerConfig.SigningCertificatePfxFileName
   $trustedIdentityTokenIssuerConfig.SslCertificateAuthorityCerFileName

5. Save your changes.

**Disable Facebook integration**

If you do not want to enable Facebook authentication for your Retail online store you must disable it, as described in the following procedure. If you previously enabled and configured Facebook authentication you can also use this procedure to disable it.

1. Open the oob-topology.xml file in Microsoft Visual Studio or a text editor, such as Notepad.
2. Search in the oob-topology.xml file for the parameter listed in the following table. Enter a value for each parameter. For each value, retain quotation marks (""") but remove percent signs (%).

<table>
<thead>
<tr>
<th>Search for</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;TrustedIdentityTokenIssuer id=&quot;Facebook&quot; install=&quot;true&quot; deleteifexists=&quot;true&quot;&gt;</td>
<td>Change both flags to “false”. For example: &lt;TrustedIdentityTokenIssuer id=&quot;Facebook&quot; install=&quot;false&quot; deleteifexists=&quot;false&quot;&gt;</td>
</tr>
</tbody>
</table>

3. Save your changes in the oob-topology.xml file.

**Run Windows PowerShell scripts to create and configure the online store**

After you configure the parameters in the oob-settings.xml file, you can run the Windows PowerShell scripts that deploy and configure the online store.

In this section, you will execute the following scripts to create and configure the online store.

- InstallPrereqs-SPFarm
- Generate-WSP
- Deploy-FarmSolutions

**Toggling options if re-running scripts**

If you re-run the Windows PowerShell deployment scripts in this section, by default, existing databases, web applications, features, and settings are deleted. You can, however, toggle different parameters in the oob-topology.xml file to preserve databases, web applications, features, and settings. Preserving an object means that you change a “true” flag to “false”. For example, in the oob-topology file, in the &lt;Channel&gt; section, the Database is configured as follows.

   &lt;Database install="true" dropifexists="true"&gt;

By changing each flag to “false” the deployment scripts preserve the existing databases.
InstallPrereqs-SPFarm.ps1

This script performs the following actions on the server.

<table>
<thead>
<tr>
<th>Area</th>
<th>Actions</th>
</tr>
</thead>
</table>
| **Database actions performed by this script** | • Create Windows NT user groups  
• Add process users to Windows NT user groups  
• Create SQL Server logins for Windows NT user groups |
| **SharePoint Server actions performed by this script** | • Creates trusted identity token issuer for Facebook integration (on every web front-end server, when executed in a server farm)  
• Creates SharePoint web applications  
• Creates SSL binding (on every web front-end server, when executed in a server farm)  
• Creates SharePoint sites  
• Configures sites and web application properties  
• Disables versioning of the Retail Online Store Publishing Portal web application  
• Configures site URLs (for different zones)  
• Enables trusted authentication providers for Facebook (if option was configured) |

If you re-run this script, the system performs the following actions before creating or configuring SharePoint. You can, however, toggle options to preserve settings, as described earlier in this document.

• Deactivates Retail online store features  
• Removes WSP solution files, if installed  
• Deletes Retail online store sites  
• Removes SSL bindings (on every web front-end server, when executed in a server farm)  
• Deletes Retail online store web applications  
• Deletes trusted identity token issuer (on every web front-end server, when executed in a server farm)
### Other actions performed by the script

The script performs the following pre-deployment checks, by default. You can customize which checks are performed.

<table>
<thead>
<tr>
<th>Area</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Verifies that the folders and files referenced in the oob-topology.xml and oob-settings.xml files exist</td>
<td></td>
</tr>
<tr>
<td>• Verifies that the configured database server can be pinged.</td>
<td></td>
</tr>
<tr>
<td>• Verifies that the SharePoint server names configured for the publishing job are correct and that they are joined to the current SharePoint farm.</td>
<td></td>
</tr>
<tr>
<td>• Verifies that the SharePoint installation is of the correct version. SharePoint 2013 is required.</td>
<td></td>
</tr>
<tr>
<td>• Verifies that every SharePoint server that acts as an application server has the URL Rewrite module installed.</td>
<td></td>
</tr>
<tr>
<td>• Verifies that any ports are not already used by web applications with different names.</td>
<td></td>
</tr>
</tbody>
</table>

If any of these checks fail, the script will not perform the installation.

#### Run InstallPrereqs-SPFarm.ps1

Use the following procedures to run this script.

⚠️ **Caution**

SQL Server work-around for cumulative update 1

Cumulative update 1 has a known issue where the InstallPrereqs-SPFarm.ps1 script fails if SQL Server is not installed on the server where you are running this script. If SQL Server is not installed on the server and if you do not intend to install any databases, complete the following steps before you run the InstallPrereqs-SPFarm.ps1 script.

a. Open the following folder:

   C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel\tools

b. Open the Custom-Scripts.ps1 file in Microsoft Visual Studio or a text editor, such as Notepad.

c. Search for and delete the following line of code:

   ```powershell
   (if((Test-Connection $value -Count 1 -Quiet) -ne $True))
   ```

d. Save your changes.

#### Run the script

⚠️ **Note**

Windows PowerShell includes a security setting called the execution policy that determines how scripts are run. By default, the execution policy is set to **Restricted**, which prevents any scripts from running. To run the installation scripts for Microsoft Dynamics AX components, we recommend that you set the execution policy to **RemoteSigned** by using the `Set-ExecutionPolicy` cmdlet. This setting allows you to run scripts that you've written and scripts that have been signed by a trusted publisher.
1. On the server where you want to run the script, open the tools folder where the Windows PowerShell scripts are installed.

2. If you’re using Windows Server 2012 or a later operating system, use Windows Explorer to open the folder where the scripts are installed. Then click **File > Open Windows PowerShell > Open Windows PowerShell as administrator**.

   If you’re using Windows Server 2008 R2 or an earlier operating system, start pw_wps as the administrator. Then, change the directory by using the following command: `CD "<Path to directory>"`.

3. Run the following command to verify and install prerequisites for the online store:
   
   ```
   .\InstallPrereqs-SPFarm.ps1 oob-topology.xml oob-settings.xml
   ```

   When the system finishes the operation, you can run the next script.

**Generate-WSP.ps1**

This script creates a SharePoint solution package (.WSP file) for your computing environment. The solution package includes properties such as connection strings, URLs, and ports from the oob-topology.xml and oob-settings.xml files. The solution package also includes binaries and static web files that were deployed by Microsoft Dynamics AX Setup to the Retail Online Channel directory.

**Run Generate-WSP.ps1**

In the Windows PowerShell console, run the following command to generate the WSP file for the online store:

```
.\Generate-WSP.ps1 oob-topology.xml oob-settings.xml
```

**Important**

Due to a known issue, the following script can fail with a file access error. If the script fails, re-run it. It should finish successfully the second time.

When the system finishes the operation, you can execute the next script.

**Deploy-FarmSolutions.ps1**

This script performs the following actions on the server.

- Deploys the new SharePoint solution package
- Activates features
- Runs post-deployment custom scripts (deploy mode)

If you re-run this script, the system performs the following actions before deploying the solution package or activating features. You can toggle options to preserve settings, as described earlier in this document.

1. Deactivates features
2. Uninstalls solution packages
3. Runs post-deployment custom scripts (retract mode)

**Run Deploy-FarmSolutions.ps1**

In the Windows PowerShell console, run the following command to deploy the solution to SharePoint.

```
.\Deploy-FarmSolutions.ps1 oob-topology.xml oob-settings.xml
```

When the system finishes the operation, you can verify the deployment.
Verify deployment

If all deployment scripts completed without errors, use this section to help verify the online store deployment. If the deployment scripts returned errors, see the Troubleshoot installation issues for a Retail online store topic.

Verify that the Connector Service is running: After a successful deployment, the Retail Publishing Connector Service 1 is running in SharePoint Central Administration. At this point, the service displays an error “No channel configuration could be found in the database,” which means that the channel has not been configured in Microsoft Dynamics AX yet. For information about configuring a channel, see the “Set up the online store in Microsoft Dynamics AX” section of the Online Store on TechNet.

Use the following procedure to verify that the Dynamics AX Publishing Connector service is running.

1. In SharePoint Central Administration under System Settings, click Manage services on server.
2. Verify that the Retail Publishing Connector Service 1 is running.
3. In SharePoint Central Administration, click Monitoring, and then click Check job status.
4. Verify that you see jobs listed for the C1 Application for Retail Store Front – Internal and the Out of box Store front – Public.

Verify that site collections exist and can be browsed: After a successful deployment, you can view the Retail online store web applications and site collections in SharePoint Central Administration. If you specified different URLs for your web applications, you must adjust the URLs below accordingly.

Note

If you installed the Fabrikam starter store, change port values below from the 40,000 range to the 50,000 range. For example: The Contoso starter store product catalog site is http://ServerName:40001/sites/RetailProductCatalog. The Fabrikam starter store product catalog site is http://ServerName:50001/sites/RetailProductCatalog.

1. In SharePoint Central Administration, click Application Management, and then click View all site collections.
2. On the C1 Application for Retail Store Front – Internal web application, copy the http://ServerName:40001/sites/RetailProductCatalog URL and paste it into a browser. Verify that the Welcome to your product catalog site displays.
3. In SharePoint Central Administration, click the Web application drop-down list and then click Change web application.
4. Click the Out of box Store front – Public web application.
5. In the URL section, verify that you see the following URLs:
   - http://ServerName:40002/sites/RetailPublishingPortal
   - http://ServerName:40002
6. Copy and paste each URL into a browser. Verify that you see the Contoso electronic superstore site and the Contoso electronic superstore sign-in site. If the sign-in site displays a certificate warning, click Continue to this web site. This warning appears if you used a self-signed certificate.

Verify that you can create and sign-in with a new forms-based user account: You should be able to register a new user account and logon from the public URL. By completing the sign-up process you verify SQL Server connectivity, SSL port settings, and SSL certificate bindings.

1. Paste the public URL into a browser and press Enter. For example: http://ServerName:40002/sites/RetailPublishingPortal
2. Click Register a new account.
3. Enter an email address and a strong password in the required fields and then click **Create account**. Note that if you see more than one email and password field on the page, it means that you executed the Deploy-FarmSolutions.ps1 script multiple times on this server. This is a known issue. To create the forms-based user account, you must enter the email address and strong password in each field. Also note that you receive an error after you register the account because the online channel has not been configured in Microsoft Dynamics AX.


5. Click the **Sign In** link and enter the information for the account that you just created. The system logs you onto the Contoso electronics site as a registered user.

**Verify that you can browse the public URL:** If you registered a domain, you should be able to browse the web address for your site. For example, you should be able to browse http://www.<your_domain>.com/sites/RetailPublishingPortal. If you have not yet registered the domain then you must create a hosts file entry and disable proxy settings in your browser (if applicable) before you attempt to browse the web address.

### Next steps for developers

<table>
<thead>
<tr>
<th>Step</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review the quick guide for customizing the online store.</td>
<td>See <a href="http://technet.microsoft.com/en-us/library/ee530806">Quick Guide: How to customize a Microsoft Dynamics AX for Retail online store</a> on TechNet.</td>
</tr>
</tbody>
</table>
| Set up the online channel | After you deploy the Microsoft Dynamics AX Retail online store, you must setup the online channel in Microsoft Dynamics AX. See the [Online store setup checklist](http://technet.microsoft.com/en-us/library/hh779152) . The checklist is available in the Microsoft Dynamics AX client: Retail > Setup > Online store setup checklist.  
  
  **Note**  
  If the online channel has already been set up in Microsoft Dynamics AX then you only need to publish the channel and publish a catalog. For information, see “Publish an online store” in [Set up an online store](http://technet.microsoft.com/en-us/library/ee530806) and “Publish a catalog” in [Key tasks: Create retail product catalogs](http://technet.microsoft.com/en-us/library/ee530806) on TechNet. |
| Customize and rebrand the starter store | See the “Extend” section of the [Online Store](http://technet.microsoft.com/en-us/library/ee530806) on TechNet. |
| Deploy a second online store | [Install multiple Microsoft Dynamics AX Retail online stores](http://technet.microsoft.com/en-us/library/ee530806) |
| Deploy to production | See “Deploy your solution to a production environment” in [Quick Guide: How to customize a Microsoft Dynamics AX for Retail online store](http://technet.microsoft.com/en-us/library/ee530806) on TechNet. |

### Uninstall an online store

The method that you use to uninstall an online store varies depending on the method you used to install the store.

**Caution**

Before you uninstall, we strongly recommend that you back up your SharePoint farm. If you don’t follow the instructions completely, your content database may be corrupted.
Uninstall if you used Setup to install

If you installed an online store by using Setup, then you can either run Setup again to remove it, or use Control Panel > Add or Remove Programs.

Uninstall if you installed with Windows PowerShell

If you used settings and topology files to configure the online store, then Run the undeploy script from the Microsoft Dynamics Windows PowerShell prompt. The following example removes the default instance deployed by Setup.

C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel\Tools\UnDeployRetailOnlineChannel.ps1 -TopologyXmlFilePath oob-topology-updated.xml - SettingsXmlFilePath oob-settings-updated.xml

To remove a non-default instance, change the name of the xml file in the parameters to the appropriate file.

C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel\Tools\UnDeployRetailOnlineChannel.ps1 -TopologyXmlFilePath oob-topology-updatedFabrikam.xml - SettingsXmlFilePath oob-settings-updatedFabrikam.xml

☑️ Note

If you have multiple online channels, you must use run the script with the appropriate settings and topology file for each online channel.

Uninstall if you installed with Windows PowerShell and no longer have the original settings and topologies file

Use the following procedure if you installed with a settings file, but no longer have the file.

1. In SharePoint Central Administration, under System Settings, click Manage Farm Features.

2. Clear Claims Provider, Logging Service, and Publishing Job. If these features are not present, skip this step.

☑️ Note

Site level features will be automatically uninstalled when we uninstall the parent solutions.

3. In Central Administration, under System Settings, click Manage Farm Solutions. For each of the following solutions, choose to retract immediately, and then click OK.

   - Publisher Job
   - StoreFront
   - Common Global Modules

☑️ Note

This package is shared across all instances of storefront.

☑️ Note

While you are completing these steps, an IIS reset will occur, and Central Administration might become unavailable. If so, wait and try again.

4. After all the solutions have been retracted, remove the solution for each entry.

   a. In Central Administration, under Manage Web Applications, delete all of the Web Applications by clicking Delete, and then clicking Delete Web Application.

   b. Click Yes when you are prompted to delete content databases and to delete IIS websites. This step can take some time to complete.
See also
- Online Store (on TechNet)

Install multiple Microsoft Dynamics AX Retail online stores

**Applies to:** Microsoft Dynamics AX 2012 R3

This section describes how to create a second Microsoft Dynamics AX Retail online store. You deploy a second online store by using Windows PowerShell after you make changes in the oob-settings.xml and oob-topology.xml files. The second online store shares some components with the first or primary online store. In the context of the Microsoft Dynamics AX Retail online store, these shared components are combined into an entity called **Common Global Modules**.

**Before you begin**

You must complete the following tasks before you deploy a second Retail online store.

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the primary online store</td>
<td>A second online store shares global components with the primary online store. You must install a primary online store before you install a second store. For more information, see the Install a Retail online store (e-commerce) section.</td>
</tr>
<tr>
<td>Create a copy of the primary online store XML files</td>
<td>Locate the oob-settings.xml and oob-topology.xml files for the primary online store in the following folder: C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel\tools Make a copy of these files so that you have a record of the settings used for the primary online store.</td>
</tr>
</tbody>
</table>

**Install a second online store**

You must install the second online store by using Windows PowerShell. And you must configure the following parameters in the oob-settings and oob-topology XML files. Because you made a copy of the primary online store XML files, you can update parameters directly in the XML files in the C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Online Channel\tools folder.

**Oob-settings.xml**

Specify unique values for the following parameters in the oob-settings.xml file.

- SharepointPackageNameInstanceIdentifier
- StoreFrontUrlPort_Public
- StoreFrontUrlPort_SSL_Public
- StoreFrontUrlPort_Internal
- ProductCatalogUrlPort_Internal
- DestinationId
- ChannelOperatingUnitNumber
The following values must be identical for multiple online stores in a SharePoint web farm.


IdentityProviderDatabaseServerName



CustomClaimsProviderDatabaseServerName

The following values can be identical or different for multiple online stores in a SharePoint web farm.


ChannelDatabaseServerName



ChannelDatabaseServerNamedInstanceNam

Oob-topology.xml
Update the following parameters in the oob-topology.xml file.
1.

Disable deployment for the CommonGlobalModules. These globally shared components were installed with
the primary online store deployment. Set the following parameters to false, as shown here:
<WSPPackage generate="false" deploy="false" retract="false">
<RootFolder>..\CommonGlobalModules</RootFolder>

2.

Disable the custom claims provider feature. These globally shared components were installed and activated
with the primary online store deployment. Set the following parameter to false, as shown here:
<FeatureToActivate activate="false"
name="SharePoint.Web.Storefront_CustomClaimsProviderSettingsFeature_[SharepointPackageInstanceIdentif
ier]" urlXpath="Settings/SiteCollection[@id='RetailPublishingPortal']/Url" />

3.

Disable the TrustedIdentityTokenProvider. You will reuse the identity providers that were installed with the
primary online store deployment. Set the following parameters to false, as shown here:
<TrustedIdentityTokenIssuer id="Facebook" install="false" deleteifexists="false">

4.

Save your changes.

5.

Run the Windows PowerShell commands to install the second online store. For more information, see the
Install a Retail online store (e-commerce) section.

See also


Online Store (on TechNet)

Install the Retail mass deployment toolkit
Applies to: Microsoft Dynamics AX 2012 R3
The Retail mass deployment toolkit lets you use System Center Configuration Manager to deploy retail
components. Install the toolkit on the computer where the Configuration Manager console is installed.
To export retail topologies from Microsoft Dynamics AX, the toolkit must be able to connect to Microsoft
Dynamics AX via .NET Business Connector. To run all other toolkit operations that require Configuration Manager,
you must install the toolkit on the same computer as the central administration site for Configuration Manager, if
Configuration Manager has multiple primary sites. If Configuration Manager has only one primary site, install the
toolkit on the same computer as the primary site. You can’t use the toolkit on the computer for a secondary site.
Note
The Retail mass deployment toolkit is available only with Microsoft Dynamics AX 2012 R3.

Microsoft Dynamics AX 2012 Installation Guide

318


Before you install the Retail mass deployment toolkit

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install the Retail mass deployment toolkit

Use this procedure to install the Retail mass deployment toolkit. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Retail mass deployment toolkit, and then click Next.
7. On the Connect to an AOS instance page, enter information about the instance of Microsoft Dynamics AX Application Object Server (AOS) to connect to. Click Next.
8. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
10. After the installation is completed, click Finish to close the wizard.

After you install the Retail mass deployment toolkit

Follow these steps to initialize the toolkit.

1. Share the content root folder. By default, the folder is located at C:\Program Files (x86)\Microsoft Dynamics AX\60\Retail Scaleout Deployment\ConfigManagerContent. Note the folder location. You must enter the Universal Naming Convention (UNC) path of this location when you run the initialization command.
2. Run the following command in the toolkit:

```
RetailConfigMgrToolkit.exe -o CreateApplications -contentRootFolder <UNC Path to the content root folder>
```
3. You are prompted to confirm that the application will open specific ports on your behalf on target computers. Press Y to confirm.

See also

- Mass deploy Retail components (on TechNet)
Install Retail SDK (Retail POS Plug-ins)

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

The Retail Software Development Kit (SDK) includes sample code and templates that can be used to customize Retail for Microsoft Dynamics AX. For information about how to customize your Retail implementation, see Retail SDK (on TechNet).

Note
Retail components are available only with Microsoft Dynamics AX 2012 R3, AX 2012 R2, and AX 2012 Feature Pack. In AX 2012 Feature Pack, the Retail SDK component is called Retail POS Plug-ins.

Before you install Retail SDK
On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install Retail SDK
Use this procedure to install Retail SDK. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Retail SDK, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Ready to install page, click Install.
9. After the installation is completed, click Finish to close the wizard.

The Retail SDK is installed in the documents folder of the user who ran the installation.
Install Retail Online Channel

 Applies to: Microsoft Dynamics AX 2012 R2

Retail Online Channel includes components that are needed to provision an online sales channel using Microsoft SharePoint products. This component allows you to integrate data from Microsoft Dynamics AX into the SharePoint site. You can also administer the online channel by using the Microsoft Dynamics AX client.

⚠️ Note

Retail Online Channel is available only with Microsoft Dynamics AX 2012 R2.

Before you install Retail Online Channel

On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install Retail Online Channel

Use this procedure to install Retail Online Channel. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select installation type page, click Custom installation, and then click Next.
5. On the Select components page, select Retail Online Channel, and then click Next.
6. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
7. On the Ready to install page, click Install.
8. After the installation is completed, click Finish to close the wizard.

After you install Retail Online Channel

For information about how to use Retail Online Channel to build an online store, see Documentation roadmap for a Microsoft Dynamics AX Retail online store on TechNet.
Install Retail essentials at headquarters

**Applies to:** Microsoft Dynamics AX 2012 R3

This section explains how to install Retail essentials at headquarters.

Retail essentials is a retail-centric configuration option for Microsoft Dynamics AX. Retail essentials provides a simplified, streamlined user experience that is optimized for organizations that use only the retail management functions of Microsoft Dynamics AX.

⚠ **Important**

To install Retail essentials, you must slipstream Microsoft Dynamics AX 2012 R3 Cumulative Update 8.

Install and configure Retail essentials at headquarters before you install and configure Retail essentials at the store. For more information about how to install Retail essentials at the store, see the Install Retail essentials at the store or at the point of sale section.

You will typically have the following computers at headquarters.

---

**Microsoft Dynamics AX server**

Install most headquarters components on the Microsoft Dynamics AX server.

- AOS
- Retail essentials
- AX client
- Async Server

**Database server**

Install the Microsoft Dynamics AX database on a database server.

You can also use this server to host other databases, such as the channel database and SharePoint databases that are needed for an online store.

**Online store web server**

Install Retail online channel on the web server.

A web server is required only if you are installing an online store. If you have a web server, you can install other IIS-based components on it, such as Async Server and Real-time Service.
Recommended topology

Install the following components on the Microsoft Dynamics AX server.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOS</td>
<td>AOS is a Windows service that controls communications among Microsoft Dynamics AX clients, databases, and applications.</td>
</tr>
<tr>
<td>Client</td>
<td>The Microsoft Dynamics AX client is the interface that is used to connect to an AOS instance.</td>
</tr>
<tr>
<td>Retail essentials</td>
<td>Retail essentials includes components that are required to use Retail functionality in Microsoft Dynamics AX.</td>
</tr>
<tr>
<td>Commerce Data Exchange: Async Server</td>
<td>Async Server is part of the asynchronous system that shares data between the Microsoft Dynamics AX database and channel databases. Async Server is installed at headquarters and communicates with Microsoft Dynamics AX.</td>
</tr>
<tr>
<td>Real-time Service</td>
<td>Real-time Service is an integrated service that provides real-time communication between Microsoft Dynamics AX and retail channels. Real-time Service enables individual point of sale (POS) computers to retrieve certain data from Microsoft Dynamics AX in real time.</td>
</tr>
<tr>
<td>Data Import/Export Framework server and client components</td>
<td>The Data Import/Export Framework for Microsoft Dynamics AX 2012 is an extension that helps you import and export data in Microsoft Dynamics AX. This component is required if you plan to migrate data from another system. To install and use Data Import/Export Framework, you must install SQL Server Integration Services (SSIS) on the database server.</td>
</tr>
</tbody>
</table>

Install the following components on the database server.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Databases</td>
<td>Microsoft Dynamics AX Application Object Server (AOS) connects to the Microsoft Dynamics AX database to process transactions. AOS connects to the model store to display forms and reports.</td>
</tr>
<tr>
<td>Data Import/Export Framework service component</td>
<td>The Data Import/Export Framework for Microsoft Dynamics AX 2012 is an extension that helps you import and export data in Microsoft Dynamics AX. This component is required if you plan to migrate data from another system. To install and use Data Import/Export Framework, you must install SQL Server Integration Services (SSIS) on the database server.</td>
</tr>
</tbody>
</table>

To view reports in Retail essentials, you must also install Microsoft SQL Server Reporting Services and the Reporting Services extensions for Microsoft Dynamics AX. For more information, see the Checklist: Install the Reporting Services extensions and deploy reports section.
Install the following components on the online store server.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retail online channel</td>
<td>The Retail online store is an online sales channel that is fully integrated with Microsoft Dynamics AX. Starter stores accelerate the development of a highly customized online channel. To install and use the Retail online store, you must install Microsoft SharePoint Server 2013.</td>
</tr>
</tbody>
</table>

Install Retail essentials on the database server

Before you install Retail essentials on the database server

- Select a service account for the Data Import/Export Framework service. For information about the requirements for this account, see the Create service accounts section.
- On the computer where you plan to install these components, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install components of Retail essentials on the database server

Use this procedure to install Retail essentials on the database server. If you select to install additional components, or if you clear the default selections, the installation steps will vary.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next.
4. On the Ready to install page, click Install.
5. On the Select an installation option page, click Microsoft Dynamics Retail essentials. Select the Headquarters option, and then click Next.
6. On the Add or modify components page, the components that are required to install Retail essentials at headquarters are automatically selected. Review and change the selections as you require, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Select a file location page, select the location in which to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Select databases page, select whether you want to create new databases by using Setup, or whether you want to configure existing databases.
10. If you want Setup to create the databases, on the **Create new databases** page, in the **Server name** list, select the name of the computer that runs Microsoft SQL Server. Provide database names, or accept the default database names. By default, the transaction database is named **MicrosoftDynamicsAX**. The baseline database is optional. By default, the baseline database is named **MicrosoftDynamicsAXBaseline**.

If you want to connect to an existing database, on the **Connect to the databases** page, select the name of the computer that runs SQL Server, and then select the names of the existing databases to configure.

⚠️ **Important**

The database name must not include any spaces or any of the following characters: backslashes (\), slashes (/), periods (.), commas (,), colons (:), brackets ([ ]), parentheses ([ ]), or hyphens (-). For more information about characters that are allowed by SQL Server, see the **Identifiers** topic on MSDN.

Click **Next**.

11. On the **Select additional models** page, select models in the **Available Models** list. Setup lists all the models that are contained in the Models folder and its subfolders. Required models are selected by default, and you cannot clear the selection.

⚠️ **Security Note**

You might have models, or .axmodel files, that are not electronically signed. The Setup program cannot verify the publisher of an unsigned model file. If you import an unsigned model file into the model store, you create a security risk. Setup displays an error message if a selected model file does not have a digital signature. Before you decide whether to continue or cancel the installation, carefully review the models that you have selected.

12. If you install models other than the Foundation models, you must complete the **Compile application** task when you run the initialization checklist. If you do not complete the **Compile application** task, you encounter errors when you run the **Synchronize database** task in the initialization checklist. For more information about the initialization checklist, see **Initialize Microsoft Dynamics AX** on TechNet.

13. Click **Next** to continue.

14. On the **Configure the Data Import/Export Framework service** page, specify the service account that will run the Data Import/Export Framework service. Click **Next**.

15. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

16. On the **Ready to install** page, click **Install**.

17. After the installation is completed, click **Finish** to close the wizard.

### Install Retail essentials on the Microsoft Dynamics AX server

#### Before you install Retail essentials on the Microsoft Dynamics AX server

- Select service accounts for AOS, the .NET Business Connector proxy, Real-time Service, and Async Server. For information about the requirements for these accounts, see the **Create service accounts** section.
- Obtain SSL certificates for Async Server and Real-time Service.
- On the computer where you plan to install these components, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the **Check prerequisites** section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the **system requirements** on Microsoft.com.
Install components of Retail essentials on the Microsoft Dynamics AX server

Use this procedure to install Retail essentials on the Microsoft Dynamics AX server. If you select to install additional components, or if you clear the default selections, the installation steps will vary.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click **Next**.
4. On the **Ready to install** page, click **Install**.
5. On the **Select an installation option** page, click **Microsoft Dynamics Retail essentials**. Select the **Headquarters** option, and then click **Next**.
6. On the **Add or modify components** page, the components that are required to install Retail essentials at headquarters are automatically selected. Review and change the selections as you require, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
8. On the **Select a file location** page, select the location in which to install 32-bit versions of Microsoft Dynamics AX files, and then click **Next**.
9. On the **Configure an Application Object Server (AOS) instance** page, assign a name to the AOS instance. Optionally, you can specify the ports that are listed in the following table.

<table>
<thead>
<tr>
<th>Port</th>
<th>Purpose</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP port</td>
<td>Other Microsoft Dynamics AX components use this port to communicate with AOS.</td>
<td>2712</td>
</tr>
<tr>
<td>Services WSDL port</td>
<td>External applications use this port to access the WSDL for AOS-based Microsoft Dynamics AX web services.</td>
<td>8101</td>
</tr>
<tr>
<td>Services endpoint port</td>
<td>External applications use this port to access AOS-based Microsoft Dynamics AX web services.</td>
<td>8201</td>
</tr>
</tbody>
</table>

10. On the **Specify an AOS account** page, select the Network Service account of the local computer (recommended only for development environments), a managed service account, or a domain account for the AOS service. If you select to use a managed service account, make sure that you specify the account in the format Domain\AccountName$.

⚠️ **Caution**

The process of manually changing the service account for an AOS instance is complex and prone to error. Therefore, if you must change the service account for an AOS instance, we recommend that you uninstall and reinstall the AOS instance by using Setup.exe. For more information, see Change the account used by AOS on TechNet.
11. On the **Select client preferences** page, select the display language that is used in the client, and specify whether you want Setup to create a desktop shortcut for the client. Additionally, select one of the following installation types:

- **Business user** – The basic client is installed. This type of client installation is appropriate for most users.
- **Developer** – The client, the developer workspace, and additional files that are required for development tasks are installed.
- **Administrator** – The client and additional files that are required for administrative tasks are installed. Administrative tasks include the deployment of artifacts and creating users.

Click **Next**.

12. On the **Specify Business Connector proxy account information** page, enter the password for the proxy account that is used by .NET Business Connector. Click **Next**.

13. On the **Configure Async Server** page, select the check box to configure Async Server by using Setup. Enter the following information:

- **Application name** – The name of the web application that hosts Async Server.
- **App pool name** – The name of the application pool that the web application runs under.
  
  We recommend that you specify separate application pools if multiple Retail components are installed on the same computer. Multiple web applications can share an application pool if resources on the computer are limited. However, if the shared application pool fails, all of the applications that use it will stop responding. In addition, if one application is heavily used, it can negatively affect the performance of the other applications in the pool.

- **Website name** – The name of the website that Async Server runs on.
- **User name** and **Password** – The credentials for the application pool identity.
- **HTTPS port** – The port on which Async Server receives HTTPS requests. You can specify any available port. Verify that the port is open in Windows Firewall, and also record the port number. The port is used to create the URL for Async Server in the following format: https://<server name>:port/<web application name>. This URL is required when you configure instances of Commerce Data Exchange: Async Client that connect to this instance of Async Server.

  **Caution**

  To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.

- **TCP port (optional)** – The port on which Async Server receives TCP requests. Specify a TCP port if your environment uses high-performance data synchronization. You can specify any available port. Verify that the port is open in Windows Firewall.
- **AOS service user** – The user account that the AOS instance runs as.
- **SSL certificate thumbprint** – The thumbprint for the Secure Sockets Layer (SSL) encryption certificate. You must obtain a valid, registered certificate from a provider.

Click **Next** to continue.

14. On the **Select a database to use with Async Server** page, create a new message database for Async Server. If you install a subsequent instance of Async Server for load balancing, you must select the same message database.

**Note**

You must set up a separate message database for each partition in Microsoft Dynamics AX.
Click **Next**.

15. On the **Configure Real-time Service** page, select the check box to configure Real-time Service by using Setup.

Enter the following information:

- **Application name** – The name of the web application that hosts Real-time Service.
- **Website name** – The name of the website that hosts Real-time Service.
- **App pool name** – The name of the application pool that Real-time Service runs in.
  
  We recommend that you specify separate application pools if multiple Retail components are installed on the same computer. Multiple web applications can share an application pool if resources on the computer are limited. However, if the shared application pool fails, all of the applications that use it will stop responding. In addition, if one application is heavily used, it can negatively affect the performance of the other applications in the pool.

  - **User name** and **Password** – The credentials for the application pool identity.
  - **HTTPS port** – The port on which Real-time Service receives secure HTTP requests. You can specify any available port. Verify that the port is open in Windows Firewall.

  **Caution**
  
  To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.

  - **TCP port** – The port on which Real-time Service receives TCP requests. You can specify any available port. Verify that the port is open in Windows Firewall.
  - **SSL certificate thumbprint** – The thumbprint for your SSL encryption certificate. You must obtain a valid, registered certificate from a provider.

Click **Next** to continue.

16. On the **Configure the Data Import/Export Framework extensions** page, specify the name of the computer where the Data Import/Export Framework service is installed. By default, the local computer is used. Click **Next**.

17. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

18. On the **Ready to install** page, click **Install**.

19. After the installation is completed, click **Finish** to close the wizard.

The AOS service can take several minutes to start the first time after it is installed. To determine whether the AOS service has started, click **Administrative tools > Services**, and review the status of the **Microsoft Dynamics AX Object Server** service.

**After you install Retail essentials on the Microsoft Dynamics AX server**

Open the Microsoft Dynamics AX client. The initialization checklist opens automatically. You must complete the checklist before you can complete any tasks in Retail essentials. For more information, see **Initialization checklists** on TechNet.

Install Retail essentials at the store and at the point of sale. For more information, see **Install Retail essentials at the store or at the point of sale** section.

Customize the online store for your company. For more information, see **Getting started with customizing the Retail online sample store** on TechNet.
Install Retail essentials on the online store web server

Before you install Retail essentials on the online store web server

- Select service accounts for the SharePoint services for the online store. For information about the requirements for these accounts, see the Create service accounts section.
- Prepare for the installation. For more information, see Before you begin in the Install a Retail online store (e-commerce) section.
- Obtain SSL certificates for online store.
- On the computer where you plan to install these components, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install components of Retail essentials on the online store web server

Use this procedure to install Retail essentials on the online store server. If you select to install additional components, or if you clear the default selections, the installation steps will vary.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next.
4. On the Ready to install page, click Install.
5. On the Select an installation option page, click Microsoft Dynamics Retail essentials. Select the Headquarters option, and then click Next.
6. On the Add or modify components page, the components that are required to install Retail essentials at headquarters are automatically selected. Review and change the selections as you require, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Select a file location page, select the location in which to install 32-bit versions of Microsoft Dynamics AX files, and then click Next.
9. On the Configure a Microsoft Dynamics AX Retail online store page, select the check box to configure the online store by using Setup.

Enter the following information:

- **Storefront to deploy**: Select a Retail starter store to deploy. The Contoso starter store is modeled after an online electronics retailer. The Fabrikam starter store is modeled after an online clothing retailer.
- **Database server**: The name of the server that will host the Retail online store databases.
- **Channel database name**: The name of the Retail channel database. If this database does not exist, you must cancel Setup and install a Retail channel database.
- **User name and Password**: The credentials for a domain account that has permission to create web applications and execute Windows PowerShell scripts in SharePoint.
• **Pfx file path**: The path to the Pfx file for the SSL certificate.

   **Important**
   
   This path cannot contain any special characters. If the path contains a special character deployment fails.

• **Password**: The password for the Pfx file.

• **Channel operating unit number**: A channel operating unit number is specified when you create an online channel in the Microsoft Dynamics AX client. You must create the channel before you deploy the Retail online store. To locate this operating unit number, click **Navigation Path Not Found**

10. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

11. On the **Ready to install** page, click **Install**.

12. After the installation is completed, click **Finish** to close the wizard.

### After you install Retail essentials on the online store web server

Install Retail essentials at the store and at the point of sale. For more information, see the [Install Retail essentials at the store or at the point of sale](#) section.

Customize the online store for your company. For more information, see [Getting started with customizing the Retail online sample store](#) on TechNet.

### Install Retail essentials at the store or at the point of sale

**Applies to**: Microsoft Dynamics AX 2012 R3

This section explains how to install Retail essentials on the store server and on point of sale registers.

Retail essentials is a retail-centric configuration option for Microsoft Dynamics AX. Retail essentials provides a simplified, streamlined user experience that is optimized for organizations that will use only the retail management functions of Microsoft Dynamics AX.

**Important**

To install Retail essentials, you must slipstream Microsoft Dynamics AX 2012 R3 Cumulative Update 8. Install and configure Retail essentials at headquarters before you install and configure Retail essentials at the store. For more information, see the [Install Retail essentials at headquarters](#) section.
You will typically have the following computers at the store.

### COMPONENTS AT THE STORE

**Store server**
- Install Async Client and the channel database on the store server.
- If you're using Modern POS, you should also install Retail Server on this computer.

**Point-of-sale devices**
- Install either Retail POS or Modern POS on point-of-sale devices.
- If the device hosts an offline database, you must also install the Retail Channel Configuration Utility.

---

**Recommended topology**

Install the following components on the store server.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Commerce Data Exchange: Async Client | Async Client is part of the asynchronous system that shares data between the Microsoft Dynamics AX database and channel databases. Async Client is installed at the channel and communicates with the channel database.  
Install Async Client on the store server. Clear this check box if you are installing on register computers.  
The Async Client Configuration Tool is installed with Async Client. This tool enables you to test connections and specify whether to use streaming. The streaming option is ideal for initial high speed data synchronization, however for ongoing synchronization the non-streaming option is more reliable. For more information, see [Configure settings for Async Client](https://technet.microsoft.com) on TechNet. |
| Retail Channel Configuration Utility | The Retail Channel Configuration Utility can be used to configure Retail POS and Offline Sync Service, create a channel database, and create or re-provision an offline database.  
Install the Retail Channel Configuration Utility on computers that host a retail database or an instance of Retail POS.  
A channel database may be created either on a stand-alone database server or on a POS computer. |
| Retail Server                       | Retail Server provides services and business logic for Modern POS (point of sale) clients.  
Clear this check box if you are using the Retail POS client.  
Install Retail Server on the store server. Clear this check box if you are installing on point of sale devices. |
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retail channel database</td>
<td>Channel databases hold retail data for one or more retail channels, such as online stores or brick-and-mortar stores. Install one channel database per store, on the store server. Clear this check box if you are installing on register computers.</td>
</tr>
<tr>
<td>Retail Hardware Station</td>
<td>Retail Hardware Station provides services that enable Modern POS clients and peripherals such as printers, cash drawers, or payment devices, to communicate. Install Hardware Station on the store server. Clear this check box if you are installing on point of sale devices. This component is not required if you are using the Retail POS client.</td>
</tr>
</tbody>
</table>

Install one of the following components on point of sale devices.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retail POS</td>
<td>Retail POS is a type of POS client that is used in the day-to-day operations at a store. If you are using this type of POS client, install this component on each register computer at the store.</td>
</tr>
<tr>
<td>Modern POS</td>
<td>Modern POS is a type of POS client for personal computers and tablets that are running Windows 8.1 Update 1 or later. Sales staff can process sales transactions and customer orders and perform daily operations and inventory management with mobile devices anywhere in the store, as well as at PC-based registers. Install this component on each point of sale device at the store. Clear this check box if you are using the Retail POS client.</td>
</tr>
</tbody>
</table>

### Install Retail essentials on the store server

**Before you install Retail essentials on the store server**

- Decide which POS client you are going to use: Retail POS or Modern POS. Depending on the type of client you choose, you will need to install different components.
- Select service accounts for Async Client. You’ll need an account to run the Async Client Windows service and an account to connect to Async Server. You’ll also need accounts for .NET Business Connector, Retail Server, and Retail Hardware Station. For information about the requirements for service accounts, see the [Create service accounts](#) section.
- Create the channel database that will be used with this instance of Async Client. When you install a channel database, the groups that have permissions on the database are created. During the Async Client installation, the service user is added to this group. For more information, see the [Install a retail channel database](#) section.
- If you’re using Modern POS, obtain SSL certificates for Hardware Station and Retail Server.
- On the computer where you plan to install these components, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the [Check prerequisites](#) section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the [system requirements](#) on Microsoft.com.
Install Retail essentials on the store server for Retail POS clients

Use this procedure to install Retail essentials on the store server. If you select to install additional components, or if you clear the default selections, the installation steps will vary.

2. Advance through the initial wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select an installation option page, click Microsoft Dynamics Retail essentials. Select the Point of sale option, and then click Next.
5. On the Add or modify components page, the components that are required to install Retail essentials at the point of sale are automatically selected. Review and change the selections as needed, and then click Next.
6. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
7. On the Configure Async Client page, select the check box to configure Async Client by using Setup.
   Enter the following information:
   - Async Server URL – The URL for the instance of Async Server. Typically, the URL is in the format https://<server name>:port/<web application name>. If Async Server is installed in a cluster with a load balancer, enter the URL to the service on the load balancer.
   - Channel database ID – The identifier in Microsoft Dynamics AX for the channel database that is used by the selected instance of Async Client.
   - User name and Password (Async Server connection) – The credentials for the user that connects to Async Server. These credentials must match the credentials that are specified in the channel database profile. Credentials are case sensitive. The credentials are used to identify and authenticate Async Client.
   - User name and Password (Async Client) – The credentials for the user that runs the Windows service for Async Client. The user does not have to be a domain account. It can be a member of a workgroup on the local computer. Credentials are case sensitive.
   Optionally, click Test connection to verify that Async Client is configured correctly.
   Click Next.
8. On the Select or specify a database to use with Async Client page, enter server and database information for the message database and the channel database that will be used by Async Client.
   You can connect to only an existing channel database. Setup does not create a new channel database if you enter a channel database name that doesn’t exist. If you specify a message database name that doesn’t exist, Setup creates a new message database.
   Click Next.
9. On the Create a channel database page, select the check box to configure a channel database by using Setup.
   Enter the name of the server on which to create the database and the name of the database.
   ▪ Note
      If you’re using a named instance of SQL Server, enter the server name in the format ServerName\InstanceName.
10. On the Prerequisite validation results page, resolve any errors. When no errors remain, click Next.
11. On the **Ready to install** page, click **Install**.
12. After the installation is complete, click **Finish** to close the wizard.

**Install Retail essentials on the store server for Modern POS clients**

Use this procedure to install Retail essentials on the store server. If you select to install additional components, or if you clear the default selections, the installation steps will vary.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the initial wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. On the **Select an installation option** page, click **Microsoft Dynamics Retail essentials**. Select the **Point of sale** option, and then click **Next**.
5. On the **Add or modify components** page, the components that are required to install Retail essentials at the point of sale are automatically selected. Review and change the selections as needed, and then click **Next**.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
7. On the **Configure Async Client** page, select the check box to configure Async Client by using Setup.
8. Enter the following information:
   - **Async Server URL** – The URL for the instance of Async Server. Typically, the URL is in the format `https://<server name>:port/<web application name>`.
     If Async Server is installed in a cluster with a load balancer, enter the URL to the service on the load balancer.
   - **Channel database ID** – The identifier in Microsoft Dynamics AX for the channel database that is used by the selected instance of Async Client.
   - **User name** and **Password** (Async Server connection) – The credentials for the user that connects to Async Server. These credentials must match the credentials that are specified in the channel database profile. Credentials are case sensitive. The credentials are used to identify and authenticate Async Client.
   - **User name** and **Password** (Async Client) – The credentials for the user that runs the Windows service for Async Client. The user does not have to be a domain account. It can be a member of a workgroup on the local computer. Credentials are case sensitive.

   Optionally, click **Test connection** to verify that Async Client is configured correctly.

   Click **Next**.
9. On the **Select or specify a database to use with Async Client** page, enter server and database information for the message database and the channel database that will be used by Async Client.

   You can connect to only an existing channel database. Setup does not create a new channel database if you enter a channel database name that doesn’t exist. If you specify a message database name that doesn’t exist, Setup creates a new message database.

   Click **Next**.
10. On the **Configure Retail Server** page, select the check box to configure Retail Server by using Setup.

Enter the following information:

- **Application name** – The name of an existing web application in your server environment or the name of an application that you want Setup to create.
- **Website name** – The name of an existing website in your server environment or the name of a site that you want Setup to create.
- **App pool name** – The name of an existing web application pool in your server environment or the name of an application pool that you want Setup to create.
- **User name and Password** – The credentials for the application pool identity. The user does not have to be a domain account. It can be a member of a work group on the local computer.
- **HTTP port and HTTPS port** – You can specify any available ports. Verify that these ports are open in Windows firewall. The port is used to create the URL for Retail Server in the format: https://<ServerName>:Port/<WebApplicationName>. This URL is required to activate Modern POS devices that connect to Retail Server.

**Caution**

To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.

- **SSL certificate thumbprint** – The thumbprint for your Secure Sockets Layer (SSL) encryption certificate.

11. On the **Create a channel database** page, select the check box to configure a channel database by using Setup.

Enter the name of the server on which to create the database and the name of the database.

**Note**

If you’re using a named instance of SQL Server, enter the server name in the format ServerName\InstanceName.

12. On the **Configure Retail Hardware Station** page, select the check box to configure Hardware Station by using Setup.

Enter the following information:

- **Application name** – The name of an existing web application or the name of an application that you want Setup to create.
- **Website name** – The name of an existing website or the name of a site that you want Setup to create.
- **App pool name** – The name of an existing web application pool in your server environment or the name of an application pool that you want Setup to create.
- **User name and Password** – The credentials for the application pool identity. The user does not have to be a domain account. It can be a member of a work group on the local computer.
- **HTTP port and HTTPS port** – You can specify any available ports. Verify that these ports are open in Windows firewall.

**Caution**

To avoid conflicts with the Default Web Site on the computer, we recommend that you do not use the default HTTPS port (443). A nonstandard port number also helps make the website more secure.
• **SSL certificate thumbprint** – The thumbprint for your Secure Sockets Layer (SSL) encryption certificate.

• **Retail Server URL** – The URL specified when Retail Server was installed. By default, the URL is created by using the following parameters:
  
  `https://<ServerName>:Port/<WebApplicationName>`

13. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.
14. On the **Ready to install** page, click **Install**.
15. After the installation is complete, click **Finish** to close the wizard.

### After you install Retail essentials on the store server

• Create a channel database profile in the Microsoft Dynamics AX client. For more information, see Set up a channel database profile (Retail essentials) on TechNet.

• Configure data distribution settings. For more information, see Configure and schedule retail data distribution on TechNet.

• Use the Async Client Configuration Tool to test the connections to Async Server, the channel database, and the channel message database. You can also use the utility to set advanced options. For more information, see Configure settings for Async Client on TechNet.

• After you have determined that all connections are working, run the distribution schedule that sends data to each channel database. Click Retail > Setup > Retail scheduler > Channel integration > Channel database. Then click **Full data sync** and select the **Full sync** distribution schedule.

• If you’re using the Modern POS client, create a channel profile for Retail Server in the Microsoft Dynamics AX client. For more information, see Set up a channel profile on TechNet.

### Install Retail essentials on point of sale devices

#### Before you install Retail essentials on point of sale devices

• Decide which POS client you are going to use: Retail POS or Modern POS. Depending on the type of client you choose, you will need to install different components.

• On the computer where you plan to install these components, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

#### Install Retail essentials on point of sale devices

Use this procedure to install Retail essentials on point of sale devices. If you select to install additional components, or if you clear the default selections, the installation steps will vary.

2. Advance through the initial wizard pages.
3. If the Setup Support files have not yet been installed on the computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. On the **Select an installation option** page, click Microsoft Dynamics Retail essentials. Select the **Point of sale** option, and then click **Next**.
5. On the **Add or modify components** page, the components that are required to install Retail essentials at the point of sale are automatically selected. Review and change the selections as needed, and then click **Next**.

6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

7. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.

8. On the **Ready to install** page, click **Install**.

9. After the installation is complete, click **Finish** to close the wizard.

**After you install Retail essentials on point of sale devices**

- If you’re using the Modern POS client, start the Modern POS app. In the **Device Activation** page, enter the URL for Retail Server. After you enter the URL, the device is queued in the Microsoft Dynamics AX client, where it must be approved. After the device has been approved, the client is ready to use.
Install the RapidStart Connector

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack

The Rapid Start Connector for Microsoft Dynamics AX enables RapidStart Services for Microsoft Dynamics ERP to communicate with an on-premises Microsoft Dynamics AX implementation.

**Note**

The RapidStart Connector is available through the Microsoft Dynamics AX Setup wizard in Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, and Microsoft Dynamics AX 2012 Feature Pack.

RapidStart Services is an online service that provides a questionnaire-based framework to configure and set up Microsoft Dynamics ERP products. This service is extensible and customizable to fit the business processes that must be configured. For more information about RapidStart Services, see [http://www.dynamicsonline.com/](http://www.dynamicsonline.com/).

Install the RapidStart Connector on the server where the Application Object Server (AOS) is installed.

**Before you install the RapidStart Connector**

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the **Check prerequisites** section.
  
  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.
- Create a domain account to use for the RapidStart Connector Windows service. For more information, see the **Create service accounts** section.

**Install the RapidStart Connector**

Use this procedure to install the RapidStart Connector. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the **Select a file location** page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. On the **Modify Microsoft Dynamics AX installation** page, click **Add or modify components**, and then click **Next**.
5. On the **Add or modify components** page, select **RapidStart Connector**, and then click **Next**.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
7. On the **Microsoft Dynamics ERP RapidStart Connector** page, enter the domain user account for the RapidStart Connector Windows service, and then click **Next**.
8. On the **Prerequisite validation results** page, resolve any errors. When no errors remain, click **Next**.
9. On the **Ready to install** page, click **Install**.
10. After the installation is completed, click **Finish** to close the wizard.

**After you install the RapidStart Connector**

Additional configuration is required after you install the RapidStart Connector. For more information, see [Configure Projects for Microsoft Dynamics AX ERP – RapidStart Services](https://microsoft.com) on Microsoft.com.

For information about how to use RapidStart Services, see [Help for Microsoft Dynamics ERP RapidStart Services users](https://microsoft.com) on Microsoft.com.
Install Warehouse Mobile Devices Portal

Applies to: Microsoft Dynamics AX 2012 R3

Warehouse Mobile Devices Portal lets users complete tasks in a warehouse facility by using mobile devices. Warehouse Mobile Devices Portal includes a website that can be accessed by mobile devices, and therefore must be installed on a server that runs Internet Information Services (IIS).

Warehouse Mobile Devices Portal communicates with Microsoft Dynamics AX Application Object Server (AOS) by using Windows Communication Foundation (WCF) services.

If you’re using Warehouse Mobile Devices Portal with multiple companies in Microsoft Dynamics AX, you must install an instance of Warehouse Mobile Devices Portal for each company. Each instance must use a different service account. If the instances are installed on the same computer, they must use different port numbers.

Before you install Warehouse Mobile Devices Portal

- Create service accounts. You must create a separate service account for each instance of Warehouse Mobile Devices Portal that you plan to install. Each service account is used as the application pool identity for a Warehouse Mobile Devices Portal website. For more information, see the Create service accounts section.
- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install Warehouse Mobile Devices Portal

Use this procedure to install Warehouse Mobile Devices Portal. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the Select an installation option page, click Microsoft Dynamics AX.
5. On the Select installation type page, click Custom installation, and then click Next.
6. On the Select components page, select Warehouse Mobile Devices Portal, and then click Next.
7. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.
8. On the Configure the Warehouse Mobile Devices Portal page, enter information in the following fields:
   - Domain, User name, and Password – Enter information about the service account that will run the application pool for the website. If you are installing multiple instances of Warehouse Mobile Devices Portal to support multiple companies in Microsoft Dynamics AX, each instance must use a different service account.
   - Website port – Enter the port number that the website will run on. If multiple instances of Warehouse Mobile Devices Portal are installed on the same computer, use a different port number for each instance.
9. On the **Best practices checklist** page, read about each recommended best practice. Select the corresponding check box to indicate that an item is completed.

⚠️ **Important**

We strongly recommend that you follow the security best practices on this page. However, the list of best practices is included in Setup as a reminder only. You can continue the installation regardless of your selections on this page.

10. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

11. On the **Ready to install** page, click **Install**.

12. After the installation is completed, click **Finish** to close the wizard.

### After you install Warehouse Mobile Devices Portal

Complete the following tasks to complete the setup of Warehouse Mobile Devices Portal.

#### Connect Warehouse Mobile Devices Portal to an AOS instance

You can install Warehouse Mobile Devices Portal on either the same server as the AOS instance that it connects to or a separate server.

By default, Warehouse Mobile Devices Portal is configured to connect to an AOS instance that is installed on the same computer. If the AOS instance is installed on a separate computer, you must modify the web.config file for the instance of Warehouse Mobile Devices Portal. Use this procedure to modify the web.config file.

1. On the web server, open Internet Information Services (IIS) Manager.
2. Right-click the website for an instance of Warehouse Mobile Devices Portal. Click **Explore** to open the physical folder for the site.
3. Before you make any changes, we recommend that you make a copy of the web.config file. You can then easily revert to the previous version if you have to undo your changes.
4. Open the web.config file in a text editor.
5. Locate the net.tcp binding that is named `NetTcpBinding_WHSMobileDevicesService`.
6. Update the endpoint address that is associated with the net.tcp binding.
7. Save and close the web.config file.

#### Configure mobile devices

After you install Warehouse Mobile Devices Portal, complete the configuration procedures for mobile devices. For more information, see **Setting up mobile devices** on TechNet.
Install the Data import/export framework (DIXF, DMF)

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

**Note**

The procedure for completing this task changed for cumulative update 7 or later for Microsoft Dynamics AX 2012 R2. The updated procedure also applies to AX 2012 R3. For more information, see the section later in this chapter.

This chapter describes how to install the Microsoft Dynamics AX 2012 Data Import/Export Framework.

Before you begin, your environment must include the following components:

- A running version of AX 2012 that has been configured for your business
- A running version of Microsoft SQL Server Integration Services that is running the same version of SQL Server that is hosting the Microsoft Dynamics AX business and model store database

**Important**

Because the staging environment is highly normalized and might require significant processing bandwidth, we recommend that you increase the Maximum buffer size setting for your environment while you migrate data. Use the Server configuration utility to set the value. For more information, see Tune data access settings on TechNet.

**Install the version of the Data Import/Export Framework that is available in Microsoft Dynamics AX 2012 R3**

To install the version of the framework available in Microsoft Dynamics AX 2012 R3, follow the instructions in the **Install the Data import/export framework (AX 2012 R3)** section.

**Install the version of the Data Import/Export Framework that is available in cumulative update 7 for Microsoft Dynamics AX 2012 R2**

**Important**

If you are running Microsoft Dynamics AX 2012 R2, we strongly recommend that you use the version of the Data Import/Export Framework that is available in cumulative update 7.

Components of the Data Import/Export Framework must be installed on computers that are running Integration Services, on a computer that is running an instance of Microsoft Dynamics AX Application Object Server (AOS), and on a computer that is running the Microsoft Dynamics AX client. You must run the installer locally on each computer.
The Data Import/Export Framework has been released as part of cumulative update 7. Therefore, detailed installation instructions are included in the [Apply updates to database, AOS, and clients](https://technet.microsoft.com/en-us/library/ff961361.aspx) section of [Apply updates to database, AOS, and clients](https://technet.microsoft.com/en-us/library/ff961361.aspx) on TechNet.

**Caution**

If you have previously installed the Data Import/Export Framework from InformationSource, you must fully uninstall it and then reinstall it for cumulative update 7 for Microsoft Dynamics AX 2012 R2. As part of this full uninstallation, you must remove all binary files by using Add/Remove Programs and uninstall the Data Import/Export Framework model. For more information, see [How to: Remove (Uninstall) a Model](https://technet.microsoft.com/en-us/library/ff961405.aspx) on TechNet.

### Install the Data Import/Export Framework from InformationSource

**Important**

Use the version of the Data Import/Export Framework that is available from InformationSource only with AX 2012 RTM or Microsoft Dynamics AX 2012 Feature Pack.

### Install the Data Import/Export Framework binary components (InformationSource)

**Important**

Do NOT use this procedure if you are installing Data Import/Export Framework for cumulative update 7 for Microsoft Dynamics AX 2012 R2 or for AX 2012 R3.

Install the Data Import/Export Framework binary components on a computer that is running Integration Services, on a computer that is running an AOS instance, and on a computer that is running the Microsoft Dynamics AX client using the following procedure. You must run the installer locally on each computer.

1. Download the installation package for the Data Import/Export Framework, DataImportExportFramework.zip, and extract the package to a local folder.
2. Browse to the location where you extracted the files, right-click `Setup.exe`, and then click **Run as administrator**.
3. In the Setup wizard, accept the license terms, and then click **Accept and continue**.
4. On the Select components page, select the components of the Data Import/Export Framework that can be installed on the local computer, and then click **Next**.
5. The prerequisite validation check runs. Address any issues that the prerequisite check finds outside the installer. When all prerequisites have been addressed, restart Setup.
6. If you are installing on the computer that runs Microsoft SQL Server Integration Services, specify a service account and the version of SQL Server that is running. We recommend that you use the AOS service account.
   - or -
   If you are installing on the AOS computer, specify the name of the server that is running SQL Server Integration Services.
7. On the **Ready to install** page, review the summary, and then click **Install**.
8. On the **Installation completed** page, select **Show logs** to display the log files, verify that the files were installed successfully, and then click **Finish**.
   The log file is stored in the same location that Setup was run from.

9. Repeat until all components (Integration Services, AOS instance, and client) have been installed.

### Install the Data Import/Export Framework model (InformationSource)

⚠️ **Important**

Do NOT use this procedure if you are installing Data Import/Export Framework for cumulative update 7 for Microsoft Dynamics AX 2012 R2 or for AX 2012 R3.

After all the components have been installed, you must install the Data Import/Export Framework model.

1. On the client computer, from the location where you installed the Data Import/Export Framework, import the DataImportExportFramework.axmodel file. For more detailed instructions, see [How to: Export and Import a Model](https://technet.microsoft.com) on TechNet.

   ⚤ **Note**
   
   Verify that the Microsoft Dynamics AX Management Shell is pointing to the database that you want to install the model in.

   a. Drain client connections to the AOS instance that you are working with.

   b. Stop the AOS.

   c. Use one of the following command-line tools to import the model.

      The version of the model that you import depends on the version of Microsoft Dynamics AX that you are running:

      - For AX 2012, install the model from the 2012 directory.
      - For AX 2012 Feature Pack, install the model from the 2012 FP directory.
      - For AX 2012 R2, install the model from the 2012 R2 directory.

   **Windows PowerShell**

   
   ```
   Install-AXModel -File "C:\Program Files\Microsoft Dynamics AX 2012 Data Import Export Framework Client Component\<version number>\model\DataImportExportFramework.axmodel"
   ```

   **AXUtil**

   ```
   axutil import /file: "C:\Program Files\ Microsoft Dynamics AX 2012 Data Import Export Framework Client Component \<version number>\model\DataImportExportFramework.axmodel"
   ```

2. Restart the AOS service.

3. Start the client.

4. In the **Model store has been modified** dialog box, click **Compile and synchronize**.

5. When the synchronization is completed, click **Compile into .Net Framework CIL**.

6. If the dialog box does not open by itself, follow these steps:

   a. Compile the application from **System administration > Periodic > Compile**.

   b. Click **System administration > Periodic > Database > SQL administration**. On the **Table actions** menu, click **Synchronize database**.

7. Compile into .NET CIL from **System administration > Periodic > Compile**.

   After the model has been compiled into .NET CIL, the **Data Import/Export Framework** button is added to the navigation pane.
Troubleshoot an installation of the Data Import/Export Framework from cumulative update 7 for Microsoft Dynamics AX 2012 R2

This section describes how to troubleshoot issues with a Data Import/Export Framework installation from cumulative update 7 for Microsoft Dynamics AX 2012 R2.

You receive an “Assembly containing type Microsoft.Dynamics.AX.DMF.ServiceProxy.DmfEntityProxy is not referenced.” error

After you slipstream cumulative update 7 for Microsoft Dynamics AX 2012 R2, the Data Import/Export Framework appears to be installed, but you receive error messages when many forms are opened.

Resolution

When you slipstream install cumulative update 7 for Microsoft Dynamics AX 2012 R2, the Data Import/Export Framework appears to be installed for members of the System Administrators role. However, the binary components of the framework are not present. To fully install the Data Import/Export Framework, you must run the update installer. For more information, see the Apply updates to database, AOS, and clients section of Apply updates to database, AOS, and clients on TechNet.

Troubleshoot an installation of the Data Import/Export Framework from InformationSource

This section describes how to troubleshoot issues with a Data Import/Export Framework installation from InformationSource.

The Data Import/Export Framework does not compile

After you install the Data Import/Export Framework, if you cannot compile, validate that the Data Import/Export Framework was installed correctly.

1. Verify that the Microsoft Dynamics AX Data Import/Export Framework service is running.
2. Verify that the Data Import/Export Framework DLLs are present in C:\Program Files (x86)\Microsoft Dynamics AX\60\Client\Bin folder:
   • Microsoft.Dynamics.AX.DMF.Mapper.dll
   • Microsoft.Dynamics.AX.DMF.PreviewGrid.
   • Microsoft.Dynamics.AX.DMF.ServiceProxy.dll
   • DMFConfig.xml
   • Microsoft.Dynamics.AX.DMF.DriverHelper.dll

Resolution

Copy the DLLs from the installation location (C:\Program Files\Microsoft Dynamics AX 2012 Data Import Export Framework Client Component) to the C:\Program Files (x86)\Microsoft Dynamics AX\60\Client\Bin folder.
Exception message while you use Data Import/Export Framework

While you use the Data Import/Export Framework, you might receive the following error message:

```
System.Reflection.TargetInvocationException: Exception has been thrown by the target of an invocation. ---> System.InvalidOperationException
```

Verify that the following files are present in the C:\Program Files (x86)\Microsoft Dynamics AX\60\Server\Bin folder on the server that is running the AOS instance:

- DMFConfig.xml
- DMFClientConfig.xml
- Microsoft.Dynamics.AX.DMF.ServiceProxy.dll.config

Resolution

Copy the .xml and the config files from the installation location (C:\Program Files\Microsoft Dynamics AX 2012 Data Import Export Framework Server Component) to the C:\Program Files (x86)\Microsoft Dynamics AX\60\Server\Bin folder on the server that is running the AOS instance.

Changes to the location of the Data Import/Export Framework service

If you have to update the location where you run Integration Services and the Data Import/Export Framework service, you can update the endpoint address in the Microsoft.Dynamics.AX.DMF.ServiceProxy.dll.config file to use the new server name.

```
<endpoint address="http://<<NEW MACHINE NAME>>:7000/DMFService/DMFServiceHelper.svc"
```

Note

The Microsoft.Dynamics.AX.DMF.ServiceProxy.dll.config file is located in the C:\Program Files (x86)\Microsoft Dynamics AX\60\Server\Bin folder on the server that is running the AOS instance.

Install the Data import/export framework (AX 2012 R3)

Applies to: Microsoft Dynamics AX 2012 R3

This section describes how to install the Data Import/Export Framework for Microsoft Dynamics AX 2012 R3. Before you begin, your environment must include the following components:

- A running version of AX 2012 R3 that has been configured for your business. For more information about how to install AX 2012 R3, see Install Microsoft Dynamics AX 2012 on TechNet.
- A running instance of Microsoft SQL Server Integration Services. The version of SQL Server must be the same as the version that hosts the Microsoft Dynamics AX business and model store databases. The supported versions are SQL Server 2008 R2, SQL Server 2012, and SQL Server 2014. For more information about how to install SQL Server Integration Services, see Install Integration Services on Microsoft.com.

Caution

If you have previously installed the Data Import/Export Framework from InformationSource, you must fully uninstall it and then reinstall it for AX 2012 R3. As part of the uninstallation, you must remove all binary files by using Add/Remove Programs, and you must also uninstall the Data Import/Export Framework model. For more information, see the “Uninstall Microsoft Dynamics AX” topic and How to: Remove (Uninstall) a Model on TechNet.
Install the version of the Data Import/Export Framework that is available in AX 2012 R3

Components of the Data Import/Export Framework must be installed as follows:

- The Data Import/Export Framework service must be installed on a computer that is running SQL Server Integration Services.
- The Data Import/Export Framework server must be installed on a computer that is running an instance of Microsoft Dynamics AX Application Object Server (AOS).
- The Data Import/Export Framework client must be installed on a computer that is running the Microsoft Dynamics AX client.

These components can be on either the same computer or different computers. You must run the installer locally on each computer.

2. Advance through the first wizard pages. Click Next on each page to accept the default settings.
3. If the Setup Support files have not yet been installed on the computer, the Select a file location page is displayed. The Setup Support files are required for installation. Enter a file location or accept the default location, and then click Next.
4. On the Select components page, select the appropriate component for the computer that you are installing to, and then click Next:
   - On the computer that is running SQL Server Integration Services, select Data Import/Export Framework (DIXF) service.
   - On the AOS instance, select AOS component. A restart of the AOS service is required as part of the installation.
   - On the client computer, select Client component.
5. A prerequisite validation check runs. Address any issues that the prerequisite check finds outside the installer, and then restart the validation check. When all prerequisites have been found, click Next.
6. If the wizard displays the Configure the Data Import/Export Framework service page, specify a service account. We recommend that you use the same service account as that used for the AOS service. Click Next.
7. If the wizard displays the Configure the Data Import/Export Framework extensions page, specify the name of the server that runs the Data Import/Export Framework service. Click Next.
8. Another prerequisite validation check might run. Address any issues that the prerequisite check finds outside the installer, and then restart the validation check. When all prerequisites have been found, click Next.
10. On the Setup was completed successfully page, click Finish.
Configure the Data Import/Export Framework

When you have finished installing the Data Import/Export Framework, follow these steps to configure it.

1. Add the Data Import/Export Framework service account to the Microsoft Dynamics AX Data Import Export Framework Service Users local group on the computer that is running the Data Import/Export Framework service. Then restart that computer.

   ☑ Note
   For more information about how to add a service account to a group, see Add a member to a local group on Microsoft.com.

2. Add the AOS service account to the Microsoft Dynamics AX Data Import Export Framework Service Users local group on the computer that is running the AOS instance. Then restart that computer.

3. Set the Data Import/Export Framework parameters. The Data Import/Export Framework requires a shared directory that the Data Import/Export Framework service account must have read access to. The AOS service account must have read and write access to the directory. The AOS service writes data to the shared directory, so that the Data Import/Export Framework can use SQL Server Integration Services to read the data. For performance reasons, we recommend that the directory be located on the same server as SQL Server Integration Services.

   ✪ Security Note
   Be aware that the shared directory may contain sensitive data, depending on what you are importing and exporting. Ensure that as few users as possible have access to the location, in addition to the AOS service account and the Data Import/Export Framework service account.


5. In the Shared working directory field, enter a shared directory, and then click Validate.

   This step verifies that the AOS account can write to the location, and that the Data Import/Export Framework can read from the location.

   If both these conditions are true, the validation icon turns green.

6. If you want to skip rows that contain errors when data is processed, select Ignore error. If you select Ignore error, you can also select Create error file to write any errors to a file.

7. You can use the Data access mode field to control the method that SQL Server Integration Services uses to load data. You can also use the Maximum insert commit size field to control the size of the batches that are loaded.

Configure the Data Import/Export Framework for use by external services, such as Lifecycle Services

In order to connect to the Data Import/Export Framework from an external service, such as Lifecycle Services, the DMFEntityExecutionService and DMFService service groups must be deployed and enabled to provide inbound ports.

1. In an AX 2012 R3 client, open a development workspace.

2. Under Service Groups, deploy the following two service groups:
   - DMFEntityExecutionService
   - DMFService
Install the AX 2012 R2 CU7 version of the Data import/export framework for use with SQL Server 2014 (DIXF)

**Applies to:** Microsoft Dynamics AX 2012 R2

To use the Data import/export framework for Microsoft Dynamics AX 2012 R2 cumulative update 7 (CU7) with Microsoft SQL Server 2014 Integration Services or later, you must install AX 2012 R2 CU7, and then apply the update [KB 3018235](https://support.microsoft.com/en-us/kb/3018235).

The following instructions apply for an environment in which SQL Server 2014 or a later version is installed. If you are running SQL Server 2008 or SQL Server 2012 Integration Services, you can install the Data Import/Export Framework for AX 2012 R2 CU7 by using the update installer. For more information, see [Apply updates to database, AOS, and clients](https://docs.microsoft.com/en-us/dynamicsax/ax2012-install-update).

To see which versions of Integration Services are supported with the Data Import/Export Framework, see the [Microsoft Dynamics AX 2012 System Requirements](https://support.microsoft.com/en-us/kb/2906961) on Microsoft.com.

**Before you begin**

1. Download the CU7 hotfix package, and extract it to a local folder.
   
   To extract the download, follow the instructions in [Apply updates to database, AOS, and clients](https://support.microsoft.com/en-us/kb/3018235) on TechNet.

2. Download the hotfix package for KB 3018235, and extract it to a local folder ([KB 3018235](https://support.microsoft.com/en-us/kb/3018235)).

**Install the AX 2012 R2 CU7 Data import/export framework for use with SQL Server 2014 Integration Services**

On the computer that is running Integration Services, follow these steps.

1. Run Windows PowerShell.

2. Navigate to the **Support** folder of the hotfix package.


4. Follow the on-screen instructions.

5. You will be asked to locate the Data Import/Export Framework service MSI from Microsoft Dynamics AX 2012 R2 CU7. This file can be found in the `\MSI\DIXF_Service_x64` or `\MSI\DIXF_Service_x86` folder.

   If the script is unable to locate the corresponding MSP you will be asked to locate it. The MSP can be found in the `\MSI\DIXF_Service_x64` or `\MSI\DIXF_Service_x86` folder in the hotfix package folder ([KB 3018235](https://support.microsoft.com/en-us/kb/3018235)).

6. You will be asked if you want the Data Import/Export Framework Service to be installed under the **Network Service** account. If you answer **No**, you will be asked to enter the username (DOMAIN\username format) and password to run the service.

   Installation should start.

**Verify installation**

By default the script’s log will be written to a file that is named `InstallDIXFService-<date>_<time>.log`.

Verify that the file reports a successful installation.

If the installation fails, the log produced by the MSI is named `DIXFService_install-<date>_<time>.log`. Search for it, and investigate the listed issues.
Install the Data import/export framework Client and Server Components

After installation of Data Import/Export Framework Service component has completed, install the Data Import/Export Framework Client and AOS components the ordinary way.

1. Install the CU7 version of the components on the appropriate computers. See Apply updates to database, AOS, and clients on TechNet.
2. Apply hotfix KB 3018235 on the appropriate computers.

Optional: Create a silent installation Windows PowerShell script

If you supply the Install-DIXFService.ps1 script with the appropriate parameters you can use the script to do a silent installation. The following table provides a brief description of the parameters that are available and how to use them.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UseNetworkService</td>
<td>This is a switch:</td>
</tr>
<tr>
<td></td>
<td>- If you want to install the service under the Network Service account, include UseNetworkService in your command.</td>
</tr>
<tr>
<td></td>
<td>- If UseNetworkService is specified, any value specified for ServiceAccount and ServicePassword will be ignored.</td>
</tr>
<tr>
<td>ServiceAccount</td>
<td>Specifies the account the service will be run under. This parameter must be supplied if UseNetworkService is not used. This should be in DOMAIN\username format.</td>
</tr>
<tr>
<td>ServicePassword</td>
<td>Specifies the password for account that the service will run under. This parameter must be supplied if UseNetworkService is not used.</td>
</tr>
<tr>
<td>MSIFileName Required</td>
<td>The path of the dixf_service_&lt;architecture&gt;.msi file from the Microsoft Dynamics AX 2012 R2 CU7 hotfix. This can be a relative or absolute path.</td>
</tr>
<tr>
<td>MSPFileName</td>
<td>The path of the dixf_service_&lt;architecture&gt;.msp file. If the Install-DIXFService.ps1 script is run from the Support folder in a hotfix package, this parameter is not required, because the script should be able to find the file automatically.</td>
</tr>
<tr>
<td>LogFileName</td>
<td>The path of the log file for the script. If this parameter is not set, the current directory is used.</td>
</tr>
<tr>
<td>MSIExecLogFileName</td>
<td>The path of the log file for MSIExec, which is where the actual installation log can be found. If this parameter is not set, the current directory is used.</td>
</tr>
</tbody>
</table>

Example 1: Install under Network Service and use default log file paths

Install-DIXFService.ps1 -UseNetworkService -MSIFileName "C:\CU7Package\MSI\dixf_service_x64\dixf_service_x64.msi"

Example 2: Install as a specific user and specify log file paths

Install-DIXFService.ps1 -ServiceAccount "MYDOMAIN\myuser" -ServicePassword "VerySecure.1234" -MSIFileName "C:\CU7Package\MSI\dixf_service_x64\dixf_service_x64.msi" -LogFileName "C:\MyLogs\DIXFService-script-log.txt" -MSIExecLogFileName "C:\MyLogs\DIXFService-MSIExec-log.txt"
See also

- Configure the version of SQL Server Integration Services used by the Data import/export framework in an environment with multiple versions (DIXF)

## Configure the version of SQL Server Integration Services used by the Data import/export framework in an environment with multiple versions (DIXF)

**Applies to:** Microsoft Dynamics AX 2012 R2

**Note**

This section only applies to environments that are running Microsoft Dynamics AX 2012 R2 with KB 3018235 installed. KB 3018235 is required to use Data Import/Export Framework for AX 2012 R2 CU7 with SQL Server 2014 Integration Services.

If you are in an environment in which two versions of Microsoft SQL Server Integration Services are installed on the same computer, by default, the Data Import/Export Framework Windows service will attach to the oldest version of Integration Services that it can find. SQL Server 2008 Integration Services is the oldest supported version.

You can force the Data Import/Export Framework to use another version of Integration Services by using redirecting assembly versions.

We strongly recommend that you use Data Import/Export Framework in an environment with only one version of SQL Server Integration Services installed.

To see which versions of Integration Services are supported with the Data Import/Export Framework, see the Microsoft Dynamics AX 2012 System Requirements on Microsoft.com.

### Force the Data import/export framework to use a version of Integration Services other than the default

You can force the Data Import/Export Framework to use a version of Integration Services other than the default by redirecting assembly versions. For more information, see [Redirecting Assembly Versions](#) on MSDN.

**Caution**

If the assembly version redirection is setup incorrectly, for example, by redirecting to a version of Integration Services that is not installed, the Data Import/Export Framework will not work correctly.

1. Locate the installation directory of the Data Import/Export Framework service component.
2. Open the file `Microsoft.Dynamics.AX.DMF.SSISHelperService.exe.config` in a text editor.
3. Locate the `<runtime>` element in the file. Inside this element, add the following code.

   ```xml
   <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
     <dependentAssembly>
       <assemblyIdentity name="Microsoft.SqlServer.DTSPipelineWrap" publicKeyToken="89845dcd8080cc91" />
       <bindingRedirect oldVersion="10.0.0.0" newVersion="11.0.0.0" />
     </dependentAssembly>
   </assemblyBinding>
   ```
Code to redirect to SQL Server 2014 Integration Services

<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1"
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.DTSRuntimeWrap"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="11.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.ManagedDTS"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="11.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.PipelineHost"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="11.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.SQLTask"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="11.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.XmlSrc"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="11.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.DTSPipelineWrap"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="12.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.DTSRuntimeWrap"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="12.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.ManagedDTS"
            publicKeyToken="89845dcd8080cc91" />
        <bindingRedirect oldVersion="10.0.0.0" newVersion="12.0.0.0" />
    </dependency>
    <dependency>
        <assemblyIdentity name="Microsoft.SqlServer.PipelineHost"
publicKeyToken="89845dcd8080cc91" />
  </dependentAssembly>
  <dependentAssembly>
    <assemblyIdentity name="Microsoft.SqlServer.SQLTask"
      publicKeyToken="89845dcd8080cc91" />
    <bindingRedirect oldVersion="10.0.0.0" newVersion="12.0.0.0" />
  </dependentAssembly>
  <dependentAssembly>
    <assemblyIdentity name="Microsoft.SqlServer.XmlSrc"
      publicKeyToken="89845dcd8080cc91" />
    <bindingRedirect oldVersion="10.0.0.0" newVersion="12.0.0.0" />
  </dependentAssembly>
</assemblyBinding>

4. Save the file.
5. Restart the Data Import/Export Framework service.
6. Test that your changes are working as expected.

See also

- Install the AX 2012 R2 CU7 version of the Data import/export framework for use with SQL Server 2014 (DIXF)
Install the VSS writer for Microsoft Dynamics AX

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

The Volume Shadow Copy Service writer for Microsoft Dynamics AX (AX VSS writer) can be used together with Microsoft System Center 2012 Data Protection Manager (DPM) to help protect Microsoft Dynamics AX data and servers.

The AX VSS writer coordinates backup and restore operations. For more information, see Protecting Microsoft Dynamics AX environments with System Center 2012 Data Protection Manager (DPM) on TechNet.

Note

The AX VSS writer is available through the Microsoft Dynamics AX Setup wizard in AX 2012 R3 and cumulative update 7 for Microsoft Dynamics AX 2012 R2 (CU 7). For information about how to install the AX VSS writer with CU 7, see the Installation Guide for cumulative update 7 on Microsoft.com.

Before you install the AX VSS writer

- Ensure that a System Center 2012 Data Protection Manager server is installed and configured.
  - Important
    Agents cannot be installed on the Data Protection Manager server. Do not install AX 2012 components on the same server.
  - Create a folder that the AX VSS writer will use to store temporary backup files. This folder should not be used for any other purpose, and access should be limited to the service account for the AX VSS writer.
  - Create a service account for the AX VSS writer. This account must be a local administrator on all the computers that you plan to protect by using this component. Additionally, the account must have read/write permission to the location where temporary backup files are stored.
  - Install a DPM agent on all the computers that you plan to protect by using this component. For more information about Data Protection Manager, see Installing and Configuring Protection Agents on TechNet.
  - On the computers where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.
  - For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

Install the AX VSS writer

Use this procedure to install the AX VSS writer. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. On every computer that you plan to protect, start Microsoft Dynamics AX Setup. Under Install, select Microsoft Dynamics AX components.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.
4. On the **Modify Microsoft Dynamics AX installation** page, click **Add or modify components**, and then click **Next**.
5. On the **Add or modify components** page, select **VSS writer**, and then click **Next**.
6. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.
7. Enter the requested information for the component that you are installing.

<table>
<thead>
<tr>
<th>Component</th>
<th>Required information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Dynamics AX Application Object Server (AOS)</td>
<td>The AOS instance</td>
</tr>
<tr>
<td>Database</td>
<td>• The Microsoft SQL Server instance</td>
</tr>
<tr>
<td></td>
<td>• The database name for the business database</td>
</tr>
<tr>
<td>Microsoft SQL Server Analysis Services</td>
<td>The name of the Analysis Services instance</td>
</tr>
<tr>
<td>Microsoft SQL Server Reporting Services</td>
<td>• The name of the Reporting Services instance</td>
</tr>
<tr>
<td></td>
<td>• The name of the reporting database server</td>
</tr>
<tr>
<td></td>
<td>• The name of the Report Server database</td>
</tr>
<tr>
<td>All</td>
<td>• The name of the DPM server</td>
</tr>
<tr>
<td></td>
<td>• The name of the AX VSS writer service account</td>
</tr>
<tr>
<td></td>
<td>• The password for the AX VSS writer service account</td>
</tr>
<tr>
<td></td>
<td>• The temporary file location that is used to temporarily hold copies of protected media.</td>
</tr>
</tbody>
</table>

**Note**

This location can contain important data. We strongly recommend that you limit access to this location to the AX VSS writer service account, and that you use the location only to store temporary VSS files.

8. On the **Ready to install** page, click **Install**.
9. After the installation is completed, click **Finish** to close the wizard.
10. Repeat these steps for all other components that you plan to protect.

**Next steps**

The following topics describe the next steps:

- [Protect a Microsoft Dynamics AX 2012 R2 environment with System Center 2012 Data Protection Manager](on TechNet)
- [Recover a Microsoft Dynamics AX 2012 R2 environment with System Center 2012 Data Protection Manager](on TechNet)
Install Connector for Microsoft Dynamics

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2

This chapter describes how to install Connector for Microsoft Dynamics by using the Microsoft Dynamics AX Setup wizard. Use Connector to integrate data between Microsoft Dynamics CRM and Microsoft Dynamics AX. For example, you can integrate Microsoft Dynamics AX customers with Microsoft Dynamics CRM accounts. This integration gives you access to up-to-date customer and account information in both systems. For more information about Connector, see the [Connector page](#) on CustomerSource (logon is required).

**Note**

Connector is available through the Microsoft Dynamics AX Setup wizard in cumulative update 7 for Microsoft Dynamics AX 2012 R2 (CU 7) and AX 2012 R3. For information about how to install Connector with CU 7, see the [Installation Guide for cumulative update 7](#) on Microsoft.com.

If you’re not using Microsoft Dynamics AX 2012 R3 or cumulative update 7 or later for AX 2012 R2, you can use the stand-alone installation for Connector. Download and run the .msi file that is available on CustomerSource. For information about how to run the stand-alone installation, see [Installation Guide](#) for Connector on Microsoft.com (PDF download).

You must install Connector on a computer where Microsoft Dynamics AX Application Object Server (AOS), the Microsoft Dynamics AX client, and .NET Business Connector are installed. If these components have not been installed, they will be selected automatically in Setup when you install Connector.

**Before you install Connector for Microsoft Dynamics**

- Create or select the user accounts that will be used to run the Connector service and to integrate data between Microsoft Dynamics AX and Microsoft Dynamics CRM. For more information about the requirements for these accounts, see the Create service accounts section.

- On the computer where you plan to install this component, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the Check prerequisites section.

  For more information about the hardware and software requirements for Microsoft Dynamics AX, see the system requirements on Microsoft.com.

**Install Connector for Microsoft Dynamics**

Use this procedure to install Connector. If you install other Microsoft Dynamics AX components at the same time, the installation pages vary, depending on the components that you are installing.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.
3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click **Next**. On the **Ready to install** page, click **Install**.
4. If you’re installing AX 2012 R3, in the Select an installation option page, click **Microsoft Dynamics AX**.
5. On the Select installation type page, click **Custom installation**, and then click **Next**.
6. On the Select components page, select **Connector for Microsoft Dynamics**, and then click **Next**.
7. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

8. If you are installing Connector on a 64-bit operating system, the **Select a file location** page is displayed. Select the location where you want 32-bit versions of Microsoft Dynamics AX files to be installed, and then click **Next**.

9. On the **Configure the CRM connector installation** page, enter the name of the Microsoft SQL Server instance that will host the Microsoft Dynamics Integration (MSDI) database.

   **Note**
   
   The MSDI database doesn’t have to be on the same physical server as Connector for Microsoft Dynamics.

10. On the **Enter server and port information to connect CRM Connector to an AOS instance** page, enter the name of the server where the AOS instance is installed, and enter the port number that the AOS instance uses for TCP/IP communication.

11. On the **Configure an integration user** page, enter information about the user account that is used to integrate data between Microsoft Dynamics CRM and Microsoft Dynamics AX. If the user does not already exist in Microsoft Dynamics AX, select **Create new account**. The user will be added, and the Microsoft Dynamics AX user ID will be **AxIntUsr**. If the user already exists in Microsoft Dynamics AX, select **Use existing account**, and enter a user ID.

12. On the **Prerequisite validation results** page, resolve any errors. For more information about how to resolve prerequisite errors, see the **Check prerequisites** section. When no errors remain, click **Next**.

13. On the **Ready to install** page, click **Install**.

14. After the installation is completed, click **Finish** to close the wizard.

---

**After you install Connector for Microsoft Dynamics**

After you have installed Connector, you must configure the adapter settings for Microsoft Dynamics CRM and Microsoft Dynamics AX. For more information about how to configure adapter settings for Microsoft Dynamics CRM, see the **Installation Guide** for Connector on Microsoft.com (PDF download). For more information about how to configure adapter settings for Microsoft Dynamics AX, see the **Configuration Guide** for the Microsoft Dynamics AX adapter on Microsoft.com ((PDF download).
Perform a single-computer installation of Microsoft Dynamics AX

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

You can set up Microsoft Dynamics AX on a single computer to create a development, test, pilot, or trial environment.

When you select a single-computer installation, the complete Microsoft Dynamics AX system is automatically installed and configured on the local computer.

This chapter provides information about how to install Microsoft Dynamics AX on a single computer.

**Perform a single-computer installation**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

Use the information in this section to perform a single-computer installation of Microsoft Dynamics AX. Use this type of installation to install a complete Microsoft Dynamics AX system on a single computer for development, demonstration, or testing.

If you install by using the **Single-computer installation** option in Setup, default settings are used to configure all components. User names and passwords are the only input that is required. For more information about the components that are included in the single-computer installation option, see the **Installation types** section. For more information about individual components, see the corresponding sections in this guide.

⚠ **Important**

We do not recommend that you perform a single-computer installation in a production environment. Use this type of installation only for development and testing.

**Before you perform a single-computer installation**

Prerequisites for all components that are included in the single-server installation must be installed before you can use this type of installation. On the computer where you plan to perform the installation, run the prerequisite validation utility to verify that system requirements have been met. For information about how to run the prerequisite validation utility, see the **Check prerequisites** section. For more information about the hardware and software requirements for Microsoft Dynamics AX, see the **system requirements** on Microsoft.com.

If you add Retail components to a single-computer installation, and the computer is a primary domain controller, the operating system must be Windows Server 2008 R2 or a later release.

**Note**

Reports and online analytical processing (OLAP) cubes may display errors if the computer is not connected to a domain.

**Perform a single-computer installation**

This procedure describes how to install Microsoft Dynamics AX for demonstration or development by using the **Single-computer installation** option in Setup.

1. Start Microsoft Dynamics AX Setup. Under **Install**, select **Microsoft Dynamics AX components**.
2. Advance through the first wizard pages.

3. If the Setup Support files have not yet been installed on this computer, the Select a file location page is displayed. The Setup Support files are required for installation. Provide a file location or accept the default location, and then click Next. On the Ready to install page, click Install.

4. If you're installing AX 2012 R3, in the Select an installation option page, click Microsoft Dynamics AX.

5. On the Select installation type page, click Single-computer installation, and then click Next.

6. On the Prerequisite validation results page, resolve any errors. For more information about how to resolve prerequisite errors, see the Check prerequisites section. When no errors remain, click Next.

7. On the Specify an AOS account page, select whether you want to use the Network Service account of the local computer or a domain account to run the Application Object Server (AOS) service. Click Next.

8. On the Specify Business Connector proxy account information page, enter the name and password for the proxy account that is used for .NET Business Connector. Click Next.

9. On the Prerequisite validation results page, resolve any errors. When no errors remain, click Next.

10. On the Ready to install page, click Install.

11. After the installation is completed, click Finish to close the wizard.

✔ Note

If you install Help Server at the same time as other Microsoft Dynamics AX components, the Help Server installation may fail. In the Setup log, you see the following error: “Component installation task stopped due to an error.” To resolve this issue, uninstall and then reinstall the Help Server component.

Considerations for installing multiple instances on a computer

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

In a single environment, you can install multiple instances of Application Object Server (AOS) and the Microsoft Dynamics AX database.

You can install multiple instances of Microsoft Dynamics AX components on separate computers or on the same computer. AOS instances and databases cannot be shared among instances of Microsoft Dynamics AX.

Multiple Microsoft Dynamics AX instances are primarily used in development environments that support multiple customers.

⚠️ Caution

We do not support the installation of multiple versions of Microsoft Dynamics AX components on the same computer in a production environment.

The following table lists the considerations when you install a second instance of a component.

<table>
<thead>
<tr>
<th>Component</th>
<th>Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOS</td>
<td>Each AOS instance is automatically assigned a number between 01 and 99. This</td>
</tr>
<tr>
<td></td>
<td>number is displayed in the Programs and Features item in Control Panel.</td>
</tr>
<tr>
<td></td>
<td>We recommend that you create a group in Active Directory Domain Services to</td>
</tr>
<tr>
<td></td>
<td>manage permissions for the AOS accounts. For more information, see the Install</td>
</tr>
<tr>
<td></td>
<td>an Application Object Server (AOS) instance section.</td>
</tr>
<tr>
<td>Database</td>
<td>During initialization, you can import existing data into the database.</td>
</tr>
<tr>
<td>Component</td>
<td>Considerations</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Components that require .NET Business Connector | You can install only one instance of .NET Business Connector on a computer. In an environment that has multiple AOS instances, use the Microsoft Dynamics AX Configuration utility to make sure that the instance of .NET Business Connector on the local computer connects to the correct AOS instance for the component that you are installing.  
In the utility, in the **Configuration Target** list, select **Business Connector (non-interactive use only)**. On the **Connection** tab, verify that the correct AOS instance is displayed.  
For more information about how to use the Microsoft Dynamics AX Configuration utility, click the **Help** button in the utility.                                                 |
| Reporting Services extensions     | You can install multiple instances of Microsoft SQL Server Reporting Services on the same computer. In this kind of deployment environment, each instance of Reporting Services is connected to an independent Microsoft Dynamics AX installation. You may want to install multiple instances of Reporting Services on the same computer to support development and production installations of Microsoft Dynamics AX, or to support multiple production installations of Microsoft Dynamics AX.  
For information about how to install multiple instances of Reporting Services, see [Install multiple instances of Reporting Services on the same computer (for use with Microsoft Dynamics AX)](https://technet.microsoft.com/en-us/library/hh395136(v=AX.60).aspx) on TechNet.  |
| Enterprise Portal                 | You can install multiple Enterprise Portal instances on the same computer. Portals can be configured to access the same or different Microsoft Dynamics AX AOS instances. For more information, see the [Install multiple Enterprise Portals on the same server](https://technet.microsoft.com/en-us/library/hh395151(v=AX.60).aspx) section.                                               |
Install Microsoft Dynamics AX in silent mode

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

When you run the Setup wizard, Setup runs in interactive mode. In other words, a graphical user interface (GUI) prompts you for the required information. Alternatively, you can run Setup in silent mode. When Setup runs in silent mode, no GUI is displayed. Instead, you supply the required information at the command prompt or in a parameter file. You can install any Microsoft Dynamics AX component in silent mode.

Use the following topics to run Setup in silent mode.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Setup in silent mode</td>
<td>Provides the procedures to run the Setup wizard without the graphical user interface.</td>
</tr>
<tr>
<td>Setup parameters reference</td>
<td>Lists the parameters that can be used for silent installation. This topic is available on TechNet.</td>
</tr>
</tbody>
</table>

**Run Setup in silent mode**

**Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

When you run the Setup wizard, Setup is running in interactive mode. In other words, a graphical user interface (GUI) prompts you for the required information. Alternatively, you can run Setup in silent mode. When Setup runs in silent mode, no GUI is displayed. Instead, you supply the required information at the command prompt or in a parameter file. You can install any Microsoft Dynamics AX component in silent mode.

**Note**

A silent installation is especially useful when you deploy multiple clients at the same time. For more information, see the Mass deployment of the Microsoft Dynamics AX Windows client section.

**Determine which parameters to use**

The same parameters are available whether you enter them at the command prompt or create a parameter file.

To determine which Microsoft Dynamics AX Setup parameters you want to use, we recommend that you review the example parameter file that is included on the Microsoft Dynamics AX DVD. The file is located at `<Path to DVD or shared directory>\Support\ExampleParmFile.txt`. For more information about individual parameters, see the Setup parameters reference on TechNet.

Microsoft Dynamics AX Setup can configure some required prerequisites, such as operating system features and roles and redistributable components that are on the Microsoft Dynamics AX installation media. If you want Setup to automatically configure these prerequisites, include the parameter `ConfigurePrerequisites=1`.

You can install other prerequisites silently by running the individual programs from the command line. To determine the command-line parameters that you want to use, we recommend that you run the stand-alone prerequisite validation utility on a representative client. When you use the utility to configure prerequisites, the log file indicates the commands that were used. By default, the log file is located at `<Drive>\Users\<UserName>\AppData\Local\Microsoft Dynamics AX 6\Prerequisite Utility Logs\DateTime\Log.txt`. 
Specify installation parameters at the command prompt
Use the following procedure to run the installation by entering parameters at the command prompt.
1. Open a Command Prompt window.
2. At the command prompt, type the following command:
   \Setup.exe parameter1="value" parameter2="value"
   When you use multiple parameters, insert a single space between parameters.
   ⚠️ Caution
   If you enter duplicate parameters, Setup fails silently.
3. After you have listed all parameters, press ENTER.

Specify installation parameters by using a parameter file
Use the following procedure to run the installation by specifying a parameter file at the command prompt.
1. Create a text file that lists the appropriate installation parameters and their values. In the parameter file, the
   Name=Value combination for each parameter must be on a separate line.
   ⚠️ Caution
   If you enter duplicate parameters, Setup fails silently.
2. Do not include double quotation marks in parameter files. Because the carriage return is used as a delimiter in
   a parameter file, values that usually require double quotation marks do not require them here.
3. To prevent a line in a parameter file from being read, type a number sign (#) before the line. The line is now
   treated as a comment instead of a command or parameter.
4. Open a Command Prompt window.
5. At the command prompt, type the following command:
   \Setup.exe ParmFile=\path of file\FileName.txt
   The path can be fully qualified or relative to the location of the Setup.exe file. Relative paths can include
   upward qualifiers such as ".\.\".
6. Press ENTER.
Firewall settings for Microsoft Dynamics AX components

** Applies to:** Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

If you use Windows Firewall to help protect your computers, Microsoft Dynamics AX components require the settings in the following table. For more information about Windows Firewall, see the Windows documentation.

<table>
<thead>
<tr>
<th>Component</th>
<th>Computer</th>
<th>Firewall setting</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>Any</td>
<td>Allow outbound HTTP connections.</td>
<td>To access the documentation that is available from the Setup wizard, you must be able to connect to the Internet from the computer where you are running Setup.</td>
</tr>
<tr>
<td>Databases</td>
<td>Database server</td>
<td>Exclude the port that is used by Microsoft SQL Server. By default, SQL Server uses port 1433.</td>
<td>For more information, see the SQL Server documentation.</td>
</tr>
<tr>
<td>Application Object Server (AOS)</td>
<td>AOS server</td>
<td>• Exclude the TCP/IP port that is used by the AOS instance. By default, AOS uses port 2712. Setup automatically creates the inbound rule “Dynamics AX 6.0 – MicrosoftDynamicsAX (RPC)” for the TCP/IP port. • Exclude the services WSDL port that is used by the AOS instance. By default, AOS uses port 8101. Setup automatically creates the inbound rule “Dynamics AX 6.0 – MicrosoftDynamicsAX (WSDL)” for the WSDL port. • Exclude the services endpoint port that is used by the AOS instance. By default, AOS uses port 8201. Setup automatically creates the inbound rule “Dynamics AX 6.0 – MicrosoftDynamicsAX (NetTCP)” for the services endpoint port.</td>
<td>Windows Firewall must be enabled on the computer. Each AOS instance must use a different port number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>❚ Note: By default, every time that you install an additional AOS instance on a computer, the TCP/IP port number and the services endpoint port numbers are incremented by 1. For example, by default, the second AOS instance on a computer is assigned to TCP/IP port 2713.</td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Computer</td>
<td>Firewall setting</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Client</td>
<td>Client workstation</td>
<td>Exclude Ax32.exe.</td>
<td>The client uses a TCP port to connect to the AOS instance.</td>
</tr>
<tr>
<td>Microsoft SQL Server Reporting Services extensions</td>
<td>Report server</td>
<td>Exclude the port that is used by Reporting Services virtual directories, if Reporting Services uses a port other than port 80.</td>
<td>If you are installing Reporting Services extensions in a perimeter network, you may need to add a firewall policy that enables you to connect to the Microsoft Dynamics AX database. For example, if you are using Forefront Threat Management Gateway (TMG), you must add a <strong>Non-Web Server Protocol Rule</strong>. For more information, see <a href="https://technet.microsoft.com/en-us/library/ms142437.aspx">Configuring SQL Server publishing</a> in the Forefront TMG documentation on TechNet.</td>
</tr>
</tbody>
</table>
| Microsoft SQL Server Analysis Services integration | Analysis server | • Exclude the port that is used by Analysis Services. By default, Analysis Services uses port 2383.  
• If you are using SQL Server Browser, you must also exclude port 2382. | For more information about how to configure access to Analysis Services through Windows Firewall, see the SQL Server documentation on MSDN. |
| Management Reporter | | Exclude the port that is used by the Management Reporter application server. By default, the application server uses port 4712. | |
| Debugger | Developer workstation | Exclude AxDebug.exe and its target programs, such as Ax32.exe and AxServ32.exe. | The debugger uses a dynamically allocated TCP port. |
| Enterprise Portal for Microsoft Dynamics AX | Web server | • Enable the Web Server (HTTP).  
• Exclude the port that is used by the Enterprise Portal website, if the site uses a port other than port 80. | If you do not enable the Web Server in Windows Firewall, you can view the site only from the local server. |
<p>| Help Server | Web server | Exclude the port that is used by the Help Server website, if the site uses a port other than port 80. | |
| Enterprise Search | Web server | Exclude the port that is used by the Search website, if the site uses a port other than port 80. | |</p>
<table>
<thead>
<tr>
<th>Component</th>
<th>Computer</th>
<th>Firewall setting</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web services</td>
<td>Web server</td>
<td>Exclude the port that is used by the services website, if the site uses a port other than port 80.</td>
<td>External programs use this port to consume the Microsoft Dynamics AX web services that are based on Internet Information Services (IIS).</td>
</tr>
<tr>
<td>Management utilities</td>
<td>Remotely managed computer</td>
<td>Enable Remote Administration.</td>
<td>You must enable Remote Administration on computers that are administered remotely by using Windows PowerShell. For example, enable Remote Administration on a computer if you deploy reports to that computer from another computer where Windows PowerShell is installed.</td>
</tr>
</tbody>
</table>
| Synch Service   | Head-office communications server          | • Exclude the port that is used by Microsoft SQL Server. By default, SQL Server uses port 1433.  
• Exclude the port that is used by Synch Service. By default, Synch Service uses port 16750.  
• Exclude the port that is used by Real-time Service. By default, Real-time Service uses port 1239. | For instructions, see the PCI Implementation Guide for Microsoft Dynamics AX 2012 Feature Pack on Microsoft.com.                                                                                       |
| Synch Service   | Store communications server                | • Enable Internet Protocol security (IPsec).  
• Exclude the port that is used by Microsoft SQL Server. By default, SQL Server uses port 1433.  
• Exclude the port that is used by Synch Service. By default, Synch Service uses port 16750. | For more information, see the PCI Implementation Guide for Microsoft Dynamics AX 2012 Feature Pack on Microsoft.com.                                                                                       |
| Real-time Service |                                              | Exclude the port that is used by Real-time Service, if the site uses a port other than port 80. | For more information, see the PCI Implementation Guide for Microsoft Dynamics AX 2012 Feature Pack on Microsoft.com.                                                                                       |
| Async Server    |                                            | • Exclude the HTTPS port that is used by Async Server.  
• Exclude the TCP port, if Async Server uses the TCP protocol. |                                                                                                                                                                                                       |
<table>
<thead>
<tr>
<th>Component</th>
<th>Computer</th>
<th>Firewall setting</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Retail POS            | Store communications server | • Exclude the port that is used by Microsoft SQL Server. By default, SQL Server uses port 1433.  
                       |                           | • Exclude the port that is used by Synch Service. By default, Synch Service uses port 16750. | For more information, see the [PCI Implementation Guide for Microsoft Dynamics AX 2012 Feature Pack](https://microsoft.com) on Microsoft.com. |
| Retail POS            | Store database server     | Exclude the port that is used by Microsoft SQL Server. By default, SQL Server uses port 1433.  
                       |                           | On a register that has its own local database, you only need to open the firewall to SQL Server if Synch Service is on a computer other than the register. | For more information, see the [PCI Implementation Guide for Microsoft Dynamics AX 2012 Feature Pack](https://microsoft.com) on Microsoft.com. |
| Retail Server         | Retail Server             | Exclude the port that is used by the Retail Server website.                       |                                                                                                                        |
| Retail Hardware Station| Retail Server             | Exclude the port that is used by the Hardware Station website.                    |                                                                                                                        |
| Retail online store   | Web server                | Exclude the ports that are used by the Retail online store website. For a production environment, the online store uses ports 80 and 443, by default. For a developer environment, the online store uses the following ports, by default.  
                       |                           | • 40002: The online store (this is the port 80 site in production environments)  
                       |                           | • 40004: The online store (this is the port 443 site in production environments with encrypted communications)  
                       |                           | • 40003: The internal online store site (for changing site settings in SharePoint)  
<pre><code>                   |                           | • 40001: The internal product catalog site |                                                                 |
</code></pre>
<table>
<thead>
<tr>
<th>Component</th>
<th>Computer</th>
<th>Firewall setting</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Dynamics ERP RapidStart</td>
<td>Microsoft Dynamics ERP RapidStart Services</td>
<td>• Exclude the executable file for the Microsoft Dynamics ERP RapidStart Connector service. By default, the file is installed in this location: %SystemDrive%\Program Files\Microsoft Dynamics AX\60\RapidStartConnector Service\Microsoft.Dynamics.AX.AppConfig.ConnectorLoaderService.exe</td>
<td></td>
</tr>
<tr>
<td>Connector</td>
<td>Services host machine</td>
<td>• Exclude the endpoint port that is used by the Microsoft Dynamics ERP RapidStart Connector service. By default, the service communicates with the Windows Azure Service Bus on ports 9350-9354, 80, and 443.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Exclude the Windows Azure Cloud Services Protocols.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshoot the installation

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

The following topics can help you find solutions for issues that may occur when you install Microsoft Dynamics AX:

- Troubleshoot general installation issues
- Troubleshoot prerequisite issues
- Troubleshoot installation issues with AOS
- Troubleshoot installation issues with client components
- Troubleshoot issues when running the Setup wizard to install the Reporting Services extensions (on TechNet)
- Troubleshoot issues when running the Setup wizard to configure Analysis Services (on TechNet)
- Troubleshoot installation issues with Enterprise Portal and Role Centers
- Troubleshoot installation issues with Enterprise Search
- Troubleshoot installation issues with the developer tools

Troubleshoot general installation issues

 Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides information that can help you troubleshoot issues that you may encounter when you run the Setup wizard for Microsoft Dynamics AX.

The Setup wizard does not start automatically

If the Setup wizard does not start automatically when you put the DVD in the drive, double-click the setup.exe file in the root directory of the DVD.

Cannot locate file <Drive>\setup.exe AutoRun=1

When you click Microsoft Dynamics AX components in the initial installation screen, you may receive the message, "Cannot locate file: \<Drive>\setup.exe AutoRun=1". This message indicates that the file association has changed for the autorun.hta file that is used by Setup.

By default, HTML Application Host is the program that is associated with the .hta file type. However, if Microsoft Visual Studio is installed on Windows Server 2012, the .hta file type can be associated with Visual Studio instead.

To resolve this issue, you can use one of the following options:

- Before you run Setup, use the Default Programs Control Panel to associate the .hta file type with the HTML Application Host program.
- If you are prompted to choose a program with which to open setup.exe, choose HTML Application Host.
- Right-click the file setup.exe and choose Run as administrator.
- Right-click the file setup.exe and choose Properties. Click the Compatibility tab. Under Compatibility mode, select Windows 7.
Setup fails

If Setup fails, view the setup log that is created every time that Microsoft Dynamics AX is installed.

1. Open the setup log file. By default, the path of this file is %AllUsersProfile%\Microsoft\Dynamics AX\Dynamics AX Setup Logs\DateTime\DynamicsSetupLog.txt.

2. Find the error message that was generated by the failure. For detailed information, review the information immediately after the error message in the log.

Exception: System.Runtime.InteropServices.COMException

During installation, Setup verifies the operating system version of the computer. If Setup is unable to verify the operating system version, Setup can fail. When this issue occurs, the log file displays the message “Setup encountered an unhandled exception and could not be completed” and the message “Exception: System.Runtime.InteropServices.COMException”. To work around this issue, restart the computer and run Setup again.

Exception from HRESULT: 0x8024402C

During installation, Setup tries to connect to the Microsoft Update website to install updates. Error code 0x8024402C indicates that the connection to the Windows Update servers failed. This error may occur if proxy or firewall settings are configured incorrectly. For more information, see Microsoft Knowledge Base article number 900936.

Buttons are not visible on Setup pages

If Windows runs with certain DPI and resolution settings, Setup pages are not displayed correctly, and you cannot continue.

The following table shows the supported and unsupported DPI and resolution settings for Windows 7 and Windows Server 2008 R2.

<table>
<thead>
<tr>
<th>DPI</th>
<th>Resolution</th>
<th>Supported/Not supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>800 x 600</td>
<td>Not supported</td>
</tr>
<tr>
<td>125</td>
<td>800 x 600</td>
<td>Not supported</td>
</tr>
<tr>
<td>150</td>
<td>800 x 600</td>
<td>Not supported</td>
</tr>
<tr>
<td>100</td>
<td>1024 x 768</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> This resolution is not supported on Chinese operating systems.</td>
</tr>
<tr>
<td>125</td>
<td>1024 x 768</td>
<td>Not supported</td>
</tr>
<tr>
<td>150</td>
<td>1024 x 768</td>
<td>Not supported</td>
</tr>
<tr>
<td>100</td>
<td>1280 x 1024</td>
<td>Supported</td>
</tr>
<tr>
<td>125</td>
<td>1280 x 1024</td>
<td>Supported</td>
</tr>
<tr>
<td>150</td>
<td>1280 x 1024</td>
<td>Not supported</td>
</tr>
<tr>
<td>100</td>
<td>1600 x 1200</td>
<td>Supported</td>
</tr>
<tr>
<td>125</td>
<td>1600 x 1200</td>
<td>Supported</td>
</tr>
</tbody>
</table>
The following table shows the supported and unsupported DPI and resolution settings for Windows Vista and Windows Server 2008.

<table>
<thead>
<tr>
<th>DPI</th>
<th>Resolution</th>
<th>Supported/Not supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>1600 x 1200</td>
<td>Supported</td>
</tr>
</tbody>
</table>

You must set a value for the parameter ClientAosServer

When you install Microsoft Dynamics AX silently by using a parameter file, you may incorrectly receive the following error message in the setup log file: “Setup cannot continue. You must set a value for the parameter ClientAosServer.” Verify that the parameter file contains the required value. If Setup continues, and you do not receive any other errors, you can ignore this message.

Label IDs are displayed instead of label text

If label IDs are displayed instead of label text the first time that you start the client, this means that the labels for the selected language are not available. Use one of the following resolutions:

- You may have selected a language that has not yet been released for Microsoft Dynamics AX. To resolve this issue, select a supported language.
- You may have selected a supported language that has not been installed. To install supported languages other than U.S. English, you must install the Foundation Labels model. For information about which languages are available, and about how to install an additional model, see the Install the Microsoft Dynamics AX databases section.

After installing a component that uses Internet Information Services (IIS), such as Help Server or web services on IIS, you may receive the following error: “Could not load type ‘System.ServiceModel.Activation.HttpModule’ from assembly ‘System.ServiceModel, Version=3.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089’.”

This error indicates that Microsoft .NET Framework 4.0 was installed, and then an earlier version of the .NET Framework was installed, or .NET 3.0 WCF HTTP Activation was enabled.

To resolve the problem, follow the instructions in Microsoft Knowledge Base article 2015129.

Troubleshoot prerequisite issues

Applies to: Microsoft Dynamics AX 2012 R3, Microsoft Dynamics AX 2012 R2, Microsoft Dynamics AX 2012 Feature Pack, Microsoft Dynamics AX 2012

This section provides information that can help you troubleshoot issues that you may encounter when you run the prerequisite validation utility.

⚠️ Important

This section does not contain an exhaustive list of prerequisite errors. Before you use the information in this section, try to resolve prerequisite issues by using the instructions that are provided in the prerequisite validation utility.

For more information about how to use the prerequisite validation utility, see the Check prerequisites section.

Prerequisite errors related to Enterprise Portal

For information about how to troubleshoot prerequisite issues for Enterprise Portal, see the Troubleshoot installation issues with Enterprise Portal and Role Centers section.

Prerequisite errors related to Enterprise Search

For information about how to correctly configure software prerequisites for Enterprise Search, see the Install and configure Search prerequisites section.

Prerequisite check for Windows Search Service fails after you configure the service by using the prerequisite validation utility

If you use the prerequisite validation utility to configure Windows Search Service on Windows Server 2012, and the prerequisite check continues to fail, you must restart your computer before you continue with Setup. On Windows Server 2012, the prerequisite validation utility does not detect that a restart is required after it configures Windows Search Service.

Cumulative Update 3 for Microsoft SQL Server 2008 R2 cannot be installed

If the “Required updates for Microsoft SQL Server” prerequisite fails, the prerequisite validation utility instructs you to install Cumulative Update 3 for SQL Server 2008 R2. When you attempt to install Cumulative Update 3, and other Cumulative Updates have already been installed, you may receive a message that states that a higher version number of SQL Server 2008 R2 is already installed. If you receive this message and the prerequisite check still fails, we recommend that you download and install Cumulative update package 8 or higher for SQL Server 2008 R2.
Required restart after you install the Microsoft .NET Framework version 4.0

Most of the time, a pending restart of the computer is not considered a mandatory prerequisite. However, if you just installed the Microsoft .NET Framework version 4.0, the installation of some components may fail if you do not restart the computer. To avoid issues, we recommend that you restart the computer after you install the .NET Framework version 4.0.

Prerequisite check failure for the Microsoft SQL Server Reporting Services service

If you are running the stand-alone prerequisite validation utility, you cannot select the instance of Microsoft SQL Server Reporting Services that is validated for the Reporting Services extensions. By default, the utility validates the first instance that matches the supported version. If multiple instances of Reporting Services are installed, and the instance that the utility validates is not running, the prerequisite check fails. When you run the Setup wizard, you can select a specific instance. In this case, the prerequisite check passes.

Prerequisite check failure for Microsoft Visual Studio 2010 Tools for the Microsoft Office system

The following prerequisites may conflict with each other:

- Required updates for Microsoft Visual Studio 2010
- Visual Studio 2010 Tools for the Microsoft Office system

If you must install both prerequisites on the same computer, we recommend that you install the required updates for Visual Studio first. If you install the Visual Studio updates later, an older version of Visual Studio 2010 Tools for Microsoft Office is installed, and the Office Add-ins for Microsoft Dynamics AX may not work correctly.

Prerequisite check warning for the startup type of the SQL Server Full-text Filter Daemon Launcher service

If multiple instances of SQL Server are installed, the prerequisite check for the startup type of the SQL Server Full-text Daemon Launcher service may generate a warning, even if the startup type is set correctly. This warning is generated because Setup verifies the prerequisite for the default instance of SQL Server instead of the instance that you selected.

There is a workaround for this issue. For the instance of SQL Server where you are installing Microsoft Dynamics AX components, make sure that the startup type for the SQL Server Full-text Daemon Launcher service is set to Automatic. If the startup type is set correctly, you can ignore the prerequisite warning and continue with the installation.